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Autodesk Factory Design Suite 
 

 
 

Autodesk Factory Design Suite is a 2D/3D factory layout solution purpose-built to help you make better layout 

decisions by enabling you to create a Digital Prototype of your factory. It provides tools for integrating 2D layout data 

with 3D models of factory equipment, creating accurate factory models and 3D visual walkthroughs that help teams 

collaborate effectively and make more informed decisions before any equipment is installed and commissioned on 

the factory floor.  

 

Core Products 
Core products in the Suite include AutoCAD Architecture, Autodesk Navisworks, Autodesk Vault, and Autodesk 

Inventor enhanced with the Autodesk Factory Design Utility that gives users a factory-specific parametric work 

environment to better design, optimize, and visualize factory layouts. 
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AutoCAD Architecture 
The most complex and intricate 3D Factory Layout designs begin as simple 2D facility drawings.  The Autodesk Factory 

Design Suite delivers state of the art 2D design capabilities by providing the most versatile and dynamic drawing 

generation package in use today, AutoCAD. 

 

AutoCAD Architecture is the initial 2D design component of the Autodesk Factory Suite.  AutoCAD, as well as the DWG 

file format, has served as the design and documentation standard for both buildings and factory components for over 

25 years.  The development of facility drawings is the primary focus of the initial element in the Autodesk Factory 

Suite.  Designers need a tool to easily layout and develop Walls, Windows, and other architectural elements as the 

initial 2D design comes together. 

 

AutoCAD Architecture provides you the flexibility to work in the traditional AutoCAD environment if required, or in 

the AutoCAD Architectural workspace, where you have access to specific commands for Walls, Doors, Windows, 

Beams, and many more Architectural design elements.  These Architecturally specific commands provide productive 

and efficient methods of creating facility layouts. 

 

Fitting your new Factory Layout into an existing building offers several costly and counterproductive challenges.  

Capturing the “As Built” state of an existing facility with 2D tape measurements is a tedious, time consuming, and 

above all, error prone process. 
 

 
 

The ability to utilize Laser Scan Point Clouds to record the “As Built” state of an existing facility reduces the amount of 

time needed to document the design.  These Point Clouds can be added to your 2D AutoCAD designs to facilitate 

space reservations in context of the “As Built” State of the facility.  
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Generating Factory Layout proposals is “by nature” a costly process.  Often, the “Free Work” necessary to submit 

several proposals only results in a single contract.  Factory Layout designers need a purpose built 2D and 3D solution 

that allows them to quickly and efficiently produce Factory Layouts that communicate their design intent to everyone.  

Autodesk Factory Design Suite extends the benefits of Digital Prototyping to the factory floor.  Purpose built for 

Machine Builders, System Integrators and Manufacturers, it helps you to make better layout decisions earlier in the 

design process in order to meet tighter schedules, optimize your factory layout processes, and, above all, win more 

business.   

 

Autodesk Inventor Enhanced with the Factory Design Utilities 
The nature of the Two Dimensional Factory Layout process requires a good deal of time and attention to numerous 

details.  The Autodesk Factory Design Suite helps factory layout users save hours of effort, so they can spend time 

innovating rather than drafting.  Users can take advantage of their existing layout data and expertise to build an 

accurate digital model of the factory, quickly try multiple layout ‘what if’ scenarios, and communicate the best 

solution to stakeholders and partners.  

 

Autodesk Inventor, enhanced with the Autodesk Factory Design Utility, gives users a factory-specific parametric work 

environment to better design, optimize, and visualize factory layouts.  Users can quickly grasp the simplified workflow 

without expertise in 3D modeling practices. 

 

The Autodesk Factory Design Utility introduces Inventor users to the floor concept.  The customizable Floor provides 

gravity, so anything placed on it will automatically land upright, eliminating the need to understand classic 3D 

paradigms and figure out how to constrain and align components.  Designers can easily leverage existing 2D layout 

drawings, using them to paint reference lines on the Factory Floor. 
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The Factory Model is built by dragging and dropping 3D models of machines and other facility equipment directly on 

the 2D layout from a library of commonly used Factory Assets.  The Assets contain built-in connectors that allow them 

to sense one another and snap together like building bricks.  The Assets also contain built-in parameters that enable 

easy modification to the basic asset design.   

 

You can easily build and include your own 3D factory asset models in the layout.  Any existing models, acquired from 

various sources, can be used as Factory Assets.  The Asset creation process simply requires designers to assign a 

landing surface and connector points to the model.  The Asset is then saved and available via the Asset Browser for 

use in the Factory Layout.   

 

Limited experience in 3D modeling is not a factor when using the Autodesk Factory Design Suite.  Dedicated 

commands make moving and orienting Factory Assets as easy as possible.  Developing your Factory Layout becomes 

as easy as moving pieces to the best strategic location on a game board.  The process enables you to try multiple 

‘what if’ scenarios until the best solution is found. 
 

 
 

2D Layout Drawings are a necessary part of any proposal and Autodesk Inventor provides easy creation of Layout 

Drawings.  Plan Views, Section Views, Detail Views, and Bill of Materials are all created quickly and easily.  The 

drawing also maintains an associative relationship to the model, updating automatically when changes occur. 

 

Digital Prototyping with Autodesk Factory Design Suite, combined with Autodesk’s leadership in Building Information 

Modeling, uniquely positions Autodesk to deliver an integrated workflow that enables better productivity, 

predictability, and control throughout the life of the project.  This integrated workflow is changing the way 

manufacturing and architectural companies think about their design practices and is helping companies build better 

products faster, with greater confidence and fewer costs.  Autodesk is the only company that can offer these solutions 

in a way that is truly scalable, attainable, and cost effective for manufacturers, architects, engineers, and builders. 
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Navisworks 
Validating your Factory Layout requires the comparison and analysis of multiple designs from various stakeholders.  

Your Layout must interface with the Architectural Facility and the Manufacturing designs supplied by the System 

Integrators or Factory Owners.  Putting all this information into a single environment is often beyond the capabilities 

of most software programs. 

 

Navisworks enables Factory Layout Designers to visualize large complex Layouts with thousands of components such 

as complete manufacturing facilities, factory floor layouts, production lines & industrial machinery, all in a single 

digital model by means of real time flythrough and walk through. Customers can combine together CAD data from 

various design systems regardless of file format or size, for complete Factory visualization and analysis. 
 

 
 

Navisworks is compatible with all major native design and laser scan file formats.  This means that 3D design data 

from various CAD systems can be combined together to create a single digital model.   

 

The ability to navigate the entire digital model is extremely important for quality assurance and the design review 

process.  Navisworks’ unique display ability allows models of any size to be loaded and combined with other models 

to create designs beyond the capability of most CAD systems.  Now there is no limit to the size and complexity of your 

Factory Layout. 

 

Navisworks allows users to build complex environments from smaller models by appending, or uniting, multiple 

model files together.  These smaller models can be loaded from any file type supported by Navisworks.  Aggregation 

of 3D data from different CAD systems brings together design, manufacturing, and plant & supplier data into a single 

digital model.  This allows all stakeholders to validate the design by visualizing it in 3D. 

 

Navisworks is a unique technology for interactive visualization of any 3D design regardless of file type or size.  The 

application offers users smooth, real-time, flythrough & Walkthrough capabilities.  Designers can now navigate and 

explore even the largest and most complex models on standard computers.  We can visualize complete 3D layouts of 

manufacturing plants and factories consisting of the products, tooling, fixtures, machines, and plant layouts. 
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The ability to walk through an extensive digital design is just the beginning of the Navisworks interactive experience. 

The Measuring tools enable detailed measurement of distance, area, and angles.  User defined Cross Sections and 

section planes, enable close inspection of all details.  Designers can simulate the real-life experience and appearance 

of manufacturing plants and factory layouts at any time in the installation process, so things go according to plan. 

Material handling equipment can also be simulated moving across the factory floor.  It is easy to see how the 

Navisworks environment can quickly become your digital mockup. 

 

Clash Detection 

3D interferences are very common when you are bringing multiple models together for the first time.  These 

interferences must be discovered as quickly as possible to assure a quality design and reduce construction problems.  

Navisworks enables the effective identification, inspection and reporting of interferences from the digital model with 

a versatile set of Clash Detection tools.  The digital model of factory layouts, work cells and production lines can be 

inspected to detect potential issues such as equipment collisions and space restrictions.  Navisworks also works with 

laser scanned point clouds.  Large volumes of point clouds can be imported into the digital environment to compare 

the “as built” laser scan with the 3D model data.   
  

 
 

Large designs often require input from various sources.  Communicating the design intent to these sources is a crucial 

factor in the design process.  When design problems occur, stakeholders need a method to comment on the situation. 

Navisworks provides a set of Redline tools that allow designers to markup any pre-established Viewpoint with text, 

balloons, clouds, or geometry 

  

Navisworks can publish the single digital model in high compressed, lightweight NDW and 3D DWF format for Free 

viewing giving all stakeholders access to the complete manufacturing plant or factory layout.   

 

You can share your digital design with all the members of your design team.  If members of your team don’t have 

Navisworks, they can download Navisworks Freedom from Autodesk.com.  Navisworks Freedom allows anyone to 

view the NWD files created by Navisworks.  Navisworks Freedom can also view Autodesk 3D Design Review files or 3D 

DWF.   
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About this Course 

This course is designed to cover the basic functions of the Autodesk Factory Design Suite.  The Autodesk Factory 

Design Suite consists of the following four applications: 

§ AutoCAD Architecture 

§ Autodesk Inventor 

§ The Autodesk Factory Design Utilities 

§ Autodesk Navisworks. 

The course does assume that the student has some basic knowledge of AutoCAD drawing practices, but a novice user 

should be able to complete the course with the help of a qualified instructor.  The course in not intended to provide 

advanced and detailed instruction in any specific member application.  For advanced training in AutoCAD 

Architecture, Autodesk Inventor, or Autodesk Navisworks, please contact your local Autodesk support representative. 

 

Class Setup 
The Training files used for this course are located in the following directory. 

C:/Autodesk Learning / Autodesk Factory Design Suite /  
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AutoCAD Architecture 

Basics 
 

 

 

In this chapter, you are introduced to basic concepts that will help you work effectively in 

the AutoCAD Architecture component of the Factory Design Suite. You also learn how to 

use the basic tools that make up the AutoCAD Architecture interface. 

 

This course does not cover the advanced principles of AutoCAD Architecture.  The primary 

goal is to familiarize you with the basic functions and practices of the applications.  

General familiarity with AutoCAD geometry creation is assumed, but a novice user should 

be able to complete all exercises with the aid of a qualified instructor.  For advanced 

training on this application, please consult your Autodesk support representative. 
 

Objectives 
 

After completing this chapter, you will be able to: 

 Navigate the AutoCAD Architecture User Interface. 

 Understand the basic Concepts of AutoCAD Architecture. 
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Understanding the Concepts 
 

What is AutoCAD Architecture 2010? 
 

AutoCAD Architecture is a design and documentation system that supports the design, 

drawings, and schedules required for a building project. 

 

In the AutoCAD Architecture model, every drawing sheet, 2D and 3D view, and schedule is 

a presentation of information from the same underlying building model. As you work in 

drawing and schedule views, AutoCAD Architecture collects information about the 

building project and coordinates this information across all other representations of the 

project. 
 

Designing with Objects 
 

AutoCAD Architecture is an object-based CAD application. When you design in the 

application, you draw from large collections of objects that represent real-world 

architectural components, such as wall, doors, windows, stairs and roofs. 

 

AutoCAD Architecture objects contain information that allows them to function like the 

real-world components that they represent, to relate intelligently to one another, and to 

display in a 2-dimensional (2D) or 3-dimensional (3D) context. 

 

Understanding AutoCAD Architecture Terms 
 

Many of the terms used to identify objects in AutoCAD Architecture are 

common, industry-standard terms. However, some terms are unique to AutoCAD 

Architecture. Understanding the following terms will help you to work effectively 

in the software. 
 

Project: In AutoCAD Architecture, the project is the single database of 

information for your design. The project folder contains all information for the 

building design, from geometry to construction data. This information includes 

components used to design the model, views of the project, and drawings of the 

design. By using a single project folder, AutoCAD Architecture makes it easy for 

you to alter the design and have changes reflected in all associated areas (such as 

plan views, elevation views, section views, and schedules). Having one folder to 

track also makes it easier to manage the project. 
 

Level: Levels are infinite horizontal planes that act as a reference for 

Level-hosted elements, such as roofs, floors, and ceilings. Most often, you use 

levels to define a vertical height or story within a building. You create a level for 

each known story or other needed reference of the building; for example, first 

floor, top of wall, or bottom of foundation. To place levels, you must be in a 

section or elevation view. 
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Divisions: Divisions segment the building in the horizontal plane. A division might 

be a wing of a building. By default, each new project in AutoCAD Architecture has 

one division. 
 

Constructs: Constructs are the main building blocks (or base drawing files) of the 

building model. A construct represents one unique portion of a building, such as a 

building core, an apartment, or an entire floor.  You assign a construct to a level 

and a division within the project. 
 

Elements: An element is a generic building block for multiple uses. For example, 

you can create an element for a typical bathroom layout and reference it multiple 

times into one or more constructs. 
 

Views: After the structure of the building project is defined and constructs are 

assigned to levels and divisions, you can start to create view drawings. A view 

drawing references a number of constructs to present a specific view of the 

building project. 
 

To create a view drawing, you first decide which portion of the building you wish 

to look at and which type of view to generate. View drawings automatically 

reference the appropriate constructs according to their level/division 

assignments within the building. 
 

Sheets: Sheets are the final output of a building design. Sheets are used to plot view 

drawings of your building project. After you create the necessary model views, detail 

views, and section/elevation views, you then drag the views onto the sheets to create 

sheet views. Sheets are collected together to create a sheet set. 
 
 

Working in the Product 
 

AutoCAD Architecture is a powerful CAD product for the Microsoft® Windows 

operating system. Its interface resembles those of other products for Windows, 

featuring a ribbon that contains the tools you use to complete tasks. 

 

The AutoCAD Architecture interface is designed to simplify your workflow. With a few 

clicks, you can change the interface to support the way that you work. For example, 

you can set the ribbon to one of the three display settings for optimum use of the 

interface. You can also display several project views at one time, or layer the views so 

you see only the one on top. 

 

Read the following topics to familiarize yourself with the basic parts of the AutoCAD 

Architecture product.  Then experiment with hiding, showing, and rearranging 

interface components to support the way you work. 
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Ribbon Overview 
 

The ribbon displays automatically at the top of the work area when you create or 

open a file. It provides a palette of all available tools. The ribbon is made up of tabs, 

and each tab is divided into panels. 
 

 
 

You can customize the ribbon by changing the order of the panels, or moving a panel 

off the ribbon to the drawing area or your desktop. You can minimize the ribbon for 

maximum use of the drawing area. 
 

To move panels 
 

1.   Select a panel label and drag the panel to a new location on the ribbon. 

2.   Select a panel label and drag the panel off the ribbon. 

3.   To return the panel to the ribbon, on the border of the floating panel, click

 (Return Panels to Ribbon). 
 

To minimize the ribbon 
 

1.   Click  (Minimize) to the right of the ribbon tabs. 

2.   The minimize behavior cycles through the following minimize options: 
 

 

■    Show Full Ribbon: Shows entire ribbon. 

■    Minimize to Panel Titles: Shows tab and panel labels only. 

■    Minimize to Tabs: Shows tab labels only. 
 

 

Ribbon Tabs and Panels 
 

TIP: When you see a button that shows a line dividing it into two sides, you can 

click the top (or left) side to access the tool you probably use most often. Click 

the other side to display a list of related tools. 

 
Example of button 
that can be  
clicked on two 
sides 
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The following table describes the ribbon tabs and the types of commands they contain: 

 
Extended Panels 

A drop-down arrow next to a panel name (        ) indicates that you can expand the 

panel to display additional tools and controls.  By default, an expanded panel closes 

automatically when you click another panel.  To keep a panel expanded, click the 

push pin (  ) in the bottom left corner of the expanded panel. A dialog-launcher 

arrow near the bottom right of a panel (  ) opens a dialog. 

 

Contextual Ribbon Tabs 
 

When you execute certain commands or select an object, a special contextual ribbon 

tab displays, that contains a set of tools that relate only to the context in which you 

are working. 
 

For example, when you select a door/window assembly, the Door/Window Assembly 

contextual tab displays commands that are commonly used when working with 

door/window assemblies. 
 

 
 

  

Ribbon Tab Includes commands for 

Home Many of the tools you need to 

create the building model. 

Insert Tools to add and manage 

secondary items such as raster 

images, and CAD files. 

Annotate Tools used for adding 2D 

information to a design. 

View Tools used for managing and 

modifying the current view, and for 

switching views. 

Manage project and system parameters and 

set- tings. 
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The Application Menu 
 

Click the application button (  ) to display the application menu. The application 

menu provides access to many common file-related commands and also allows you to 

manage your files using advanced commands such as Export and Publish. 

 

You can perform the following actions on the application menu: 

 

On the application menu 

click… 

to… 

New 

select a template and 

create a new drawing. 

Open 

select a file to open. 

 

Save 

save the current file. 

Save As 

save the current 

drawing with a new 

name. 

Export 

export the current 

drawing. 

Print 

print the current 

drawing. 

Publish 

publish the current project. 

 

Send 

transmit the current 

drawing. 

Utilities 

access tools to 

maintain the current 

drawing. 

Close 

close the current drawing. 

 

Options set various AutoCAD Architecture options. 
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Using the Quick Access Toolbar 

The Quick Access toolbar is located on the AutoCAD Architecture title bar and 

contains the following items by default: 

 

Quick Access Toolbar Item Description 

New 

creates a new drawing. 

Open 

opens a file. 

 

Save 

saves the current drawing. 

Undo 

cancels the last action. 

Displays list of all actions 

taken during the session. 

Redo 

reverses the effects of the 

previous Undo command. 

Print 

prints a drawing. 

 

Project Browser 

opens the Project Browser. 

 

Project Navigator 

opens the Project Navigator. 

 
 

To undo or redo a series of operations, click the drop-down to the right of the Undo 

and Redo buttons.  This displays the command history in a list. Starting with the 

most recent command, you can select any number of previous commands to include 

in the Undo or Redo operation. 
 

The Quick Access toolbar can display below the ribbon. Click  at the right side of 

the Quick Access toolbar, and then click Show Below the Ribbon to change the 

display setting. 
 

You can add an item to the Quick Access toolbar from the drop-down by clicking 

More Commands and dragging the command from the Command List pane to the 

Quick Access toolbar. 
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Project Browser 
 

Use the Project Browser to create, copy, and switch between projects. On the left 

side of the Project Browser, you can create new projects, browse existing projects, 

and select the current project. On the right side of the Project Browser, an 

embedded Internet Explorer allows you to browse your project home page. 
 

To open the Project Browser, on the Quick Access toolbar, click  (Project Browser). 
 

To change the current project, double-click the name of a project in the left pane. 
 
 

Project Navigator 
 

After you select a project in the Project Browser, you use the Project Navigator to 

create, edit, and manage the drawing and construction documentation files within 

the project. Use the Project Navigator to create and open elements, constructs, 

views, and sheets for the current project. 

 

 
 

The Project Navigator has 4 tabs that correspond to the main phases of project creation: 
 

§ The Project tab contains the project information, including the levels and divisions in the 

building model. 

§ The Constructs tab manages the construct and element drawings that make up the 

building model. 

§ The Views tab manages the drawings that contain views of the building model. 

§ The Sheets tab organizes all the plotting sheets (created from referenced views) into a 

single project sheet set. 

 

 

To open the Project Navigator, in the Quick Access toolbar, click  (Project Navigator). 
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Tools and Tool Palettes 
 

AutoCAD Architecture includes a large inventory of tools organized into tool palettes. 

Tools represent the individual objects you can add to a drawing.  For example, there 

are numerous tool palettes containing tools for design, such as tools for working with 

walls, windows, and doors. There are also tool palettes containing documentation 

tools, such as those for annotation and callouts. 
 

 
 

To open the current tool palette, click Home tab > Build panel > Tools drop-

down > Design Tools. 

 

To switch the active tool palette group, right-click the title bar of the currently 

active tool palette group. On the context menu, select the tool palette group that 

you want to display. 
 

Controlling the Appearance of Palettes 
 

Palettes, such as a tool palette or the Properties palettes, remain open as you 

work in AutoCAD Architecture. You can control the behavior of a palette by using 

techniques to hide, dock, or pin it. 
 

You can hide a palette so that it becomes hidden when you move the cursor away 

from it, leaving only the title bar visible. To automatically hide a palette, in the 

title bar of the palette, click  (Auto-hide). To temporarily redisplay a hidden 

palette, move the cursor over the title bar. 
 

                   To disable auto-hide, click          (Auto-hide) again. 

 

You can position palettes in the application window to make the best use of 

your work area. A palette can be docked on the left or right side of your 

workspace, or it can float (undocked). 

 

To dock a palette, right-click the title bar of the palette, and select Allow 

docking.  Position the cursor over the title bar, and drag the palette to the 

left or right side of the workspace. To undock a palette, drag the palette 

from the edge of the workspace. 
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Properties Palette 
 

The Properties palette provides a central location to view the properties of a selected 

object. Use the Properties palette to view and change settings for the style, 

dimensions, location, property set data, and other characteristics of an object. 

 
 

If the Properties palette is not displayed when you 

select an object, you can display it by clicking Home tab 

> Build panel > Tools drop-down > Properties. 

 
 

 

Drawing Window Status Bar 
 

The drawing window status bar is located at the bottom of the drawing window. 

It contains the following information about the current project and drawing: 
 

§ Name of the current project. 

§ Type (construct, element, view, or sheet) and name of the current drawing. 

§ Active scale for the current drawing or viewport. 

§ Display configuration of the current viewport or model space view. 

§ Cut plane height. 

 
Options at the far right of the drawing window status bar provide access to the 

following functions: Surface Hatch Toggle, Layer Key Overrides, Isolate Objects, 

AEC Project Standards, Autodesk Trusted DWG, and Manage Xrefs. 
 

 

Command Line Window 
 

The command line window is located under the drawing window status bar. You can 

use it to enter a command by typing the command name. Some commands have 

abbreviated names. For example, instead of entering line to start the LINE command, 

you can enter l. To find a command, you can type a letter in the command window, 

and press TAB to cycle through all the commands that begin with that letter. To 

repeat a command, press the Up arrow to scroll through recent commands. 
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Application Status Bar 
 

The application status bar is located under the command line window. It contains the 

following information and tools when you drawing is open: 
 

§ Coordinate values 

§ Drawing tools 

§ Quick properties 

§ View tools 

§ Navigation tools 

§ Annotation tools 

§ Workspace 

§ Lock 

§ Elevation 

§ Clear screen 

 

 

 

Style Manager 
 

The Style Manager provides a central location where you can view and work with styles. 

 

A style is a set of parameters that determines the appearance or function of an object in 

AutoCAD Architecture. For example, a door style determines the type of door 

represented in a drawing, such as single, double, bi-fold, or hinged. The door style also 

determines the shape of the door, such as rectangular or arched, as well as default 

frame dimensions, standard sizes, and display properties. You assign the same style to all 

instances of an object that have the same characteristics. For example, you could assign 

one door style to all the office doors in a building and another door style to all fire doors 

in the building. 

To access the Style Manager, click Manage tab > Style & Display panel > Style Manager. 

 

Content Browser 
 

The Content Browser is a library of tool catalogs that contain tools, tool palettes, and 

tool packages. You can locate tools in the content browser either by searching or by 

navigating through the tool catalogs. 

 

You will use the Content Browser in several lessons in the tutorials to obtain tools that 

you use to perform specific tasks. 

To access the Content Browser, click Insert tab    Content Panel    Content Browser. 

  



12 Chapter2: AutoCAD Architecture Basics 

 
 

Chapter Summary 
 
 

This chapter introduced the basic concepts that help you work effectively with the AutoCAD Architecture 

component of the Factory Design Suite. You also learn how to use and navigate the AutoCAD 

Architecture user interface. 

Having completed this chapter, you can: 

§ Navigate the AutoCAD Architecture User Interface. 

§ Understand the basic Concepts of AutoCAD Architecture. 
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Creating the Shell 
 

 
 

AutoCAD Architecture allows designers to easily create a factory facility with simple, easy to use 
commands.  Special architectural commands are dedicated to creating Walls, Doors, and Slabs.  
These elements can be created from scratch or applied to existing linework.  This chapter will focus 
on the process of creating the outer shell of the factory facility using architectural specific 
commands. 

 

 

Objectives 
 

After completing this chapter, you will be able to: 
 

§ Create the shell walls from linework in a drawing. 

§ Use two different techniques to create the structural grid. 

§ Add curtain walls and an entrance to the shell. 

§ Add a Slab to the design. 
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Lesson: Converting Linework to Shell Walls 
 
 

 
 

 

 

After you create the walls, you adjust their position, materials, and height to match the building design 

requirements. 

 

 

 

 

 

 

 

 

  

In this lesson you will create the exterior building shell by converting 2D linework in an AutoCAD drawing 

(DWG) to walls. 

Objectives 

After completing this lesson, you will be able to: 

§ Create the shell walls from linework in a drawing. 

§ Use two different techniques to create the structural grid. 

§ Add curtain walls and an entrance to the shell. 

§ Add a Slab to the design. 
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  3. With the walls selected, zoom in to the 

top left corner of the floor plan. 

 

§ The linework displays in the center of 

the walls.  Because the linework 

represents the interior face of the 

walls, you need to reposition the walls 

so their exterior faces align with the 

linework. Walls have a Justification 

property that lets you control their 

positioning. 

 
4. Change the Wall Justification 

§ On the Properties palette, under 

Dimensions, for Justify, select Right 

and press ESC. 

§ Zoom to the drawing extents. 
 

 The walls are now right justified and 

the linework, although still in the 

drawing, is no longer visible because 

the interior wall faces align with it. 

 

Exercise: Converting Linework

to Shell Walls 
 

In this exercise you create, the exterior building shell by 

converting 2D linework in an AutoCAD drawing (DWG) 

to walls. 

 

The completed exercise 

 

1. Open ACA_001_Linework.dwg. 

 

2. Convert the exterior linework to walls 

§ Turn off the visibility of the Conveyor layer. 

§ On the Design tab of the Design tool 

palette, right-click the Wall tool and click 

Apply Tool Properties to Linework.  

 

 
 

§ Select the green polyline, which represents 

the exterior face of the shell wall that you 

want to create. 

 
 

§ Press ENTER twice to retain linework in the 

drawing so that you can check the position 

of the walls that you create. 
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  8. View the walls in 3D. 

§ Select View panel  View drop-down 

 View, SW Isometric. 

§ Select Visual Styles drop-down  

Visual Styles, Realistic. 

 

 

9.  Close the Drawing without saving. 

5. Turn off the visibility of the linework. 

§ The original linework will be 

preserved for later use in the Factory 

Layout process. Turn off the visibility 

of the Walls-Exterior Layer and the 

Walls Interior Layer. 

 

 

 

6. Change the wall style to match the 

design requirements. 

§ Using the Select Similar command or a 

window selection, select the shell 

walls  

§ On the Properties palette, under 

General, for Style, select Stud-5.5 

Brick-LOWER FLOOR. 

§ Press ESC. 

§ Zoom to the triangulated walls at the 

top of the drawing. 

 
§ The wall displays the multiple layers 

of material specified in the new style. 

However, to ensure that the shell 

walls reach the roof, you need to 

change the wall height. 

 

7. Adjust the wall height. 

§ Select all the walls in the drawing  

§ On the Properties palette, under 

Dimensions, for Base height, enter 

15'. 

§ Press ESC. 
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Lesson: Creating a Layout Grid 
 
 

 
 

 

 

 

 

 
 
 

 

 

 

 

 

  

The Column Grid command can be used to easily create a structural grid for the factory building.  The 

command creates a regularly-spaced rectangular grid by default.  Once the grid is inserted into the design, it 

can be resized to suit any factory layout.  After the grid is modified, the Column Bubble command is used to 

easily annotate the grid lines. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Create a default building grid for the factory layout. 

§ Modify the column grid to suit existing building lines. 

§ Label the building grid with bubbles. 
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  3. Place the grid. 

§ If necessary, on the application status 

bar, click Ortho Mode to turn it off. 

§ Click Object Snap to turn it on. 

§ Right-click Object Snap and select 

Intersection. 

§ Move the cursor to the middle of the 

tick mark in the lower left corner of the 

drawing, and when the Intersection 

Snap displays, select it. 
 

The tick mark is located at the endpoint 

extension of the lower wall and the 

leftmost wall, and exists to aid you in 

placement of the grid. 

 

§ Press Enter twice. 
 

A grid displays, but it is too small. You 

can adjust the overall size of the grid, as 

well as the individual bays by changing 

the grid properties. 

 

4. Resize the grid. 

§ Select the grid. 

§ On the Properties palette, under 

Dimensions: 

o For X-Width, enter 185'. 

o For Y-Depth, enter 95'. 

§ Press ESC. 
 

The grid is still not the correct size for 

the building. Because the bays/grids 

are set to regular spacing, the exact 

dimensions of 185' x 95' cannot be 

created. 

 

 

 

Exercise: Creating a 

Layout Grid 

In this exercise, you create a structural grid 

for the Factory Building. You create the 

grid as a regularly-spaced rectangular grid, 

and then grip-edit it to create the irregular 

shape that the building requires. When 

you complete the grid, you use automatic 

labeling to place bubbles on the ends of 

the grid lines. 

 

The completed exercise 

 

1.  Open ACA_002_Gridwork.dwg. 

 

2. Create a Structural Grid. 

§ In the Design tab of the tool palette, 

click the Column Grid tool. 
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  § Select the top right grid grip, drag it 

over to align with the right vertical 

shell wall, and press ESC. 

 

 

7.  Manually add a horizontal grid line to 

the top of the grid. 

§ On the application status bar, click 

Object Snap to turn it off. 

§ Select the grid, right-click and select Y 

axis  Add Grid Line. 

§ Specify a point on the grid as shown.  

Exact placement of the grid line is not 

necessary, as you adjust the line in 

subsequent steps. 

 

 

8. Automatically label grid lines with a 

preloaded grid bubble block. 

§ Select the grid, right-click and select 

Label. 
 

The X and Y axis both have tabs to 

control how you can label both the 

horizontal and vertical grids. 

 

 

 

 

 

 

 

 

 

5. Convert both X and Y directions of the 

grid to manual placement in order to 

edit the grid 

§ Select the grid, right-click and select X 

Axis  Layout Mode. 

§ Press Enter. 
 

After the layout mode is selected, you 

can make selections on the command 

line. By default, manual is the 

selection made on the command line. 

After you convert to manual, grips 

display on each grid line endpoint. 

 

§ Select the grid, right-click and select Y 

Axis  Layout Mode. 

§ Press Enter 
 

Now you can edit the grid lines like 

linework. 

 

6.  Grip edit the grid. 

§ Select the grid to display grips. 

 

§ Select the top left grid grip, and drag it 

to the top endpoint of the left vertical 

wall. 
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9. In the Column Grid Labeling dialog: 

§ In the Y – Labeling tab, under Labels, 

click in the Number field in the first 

line, enter A, and press ENTER. 
 

The rest of the grid lines in the dialog  

box are assigned letters  
 

§ Under Bubble Parameters, select Left 

and clear Right. 

§ Under Extension, enter 10'. 

§ Click the X – Labeling tab. 

§ On the X – Labeling tab, under Labels 

in the X - Direction, click in the 

Number field in the first line, enter 1, 

and press ENTER.  

§ Under Bubble Parameters, select Top 

and clear Bottom. 

§ Under Extension, enter 10'. 

§ Click OK. 

 

 

10.  Close the drawing without saving. 
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Lesson: Creating a Layout from Linework 
 
 

 
 

 

 

 

 
 
 

 

 

 

 

 

 

It is a common practice to develop architectural elements from simple AutoCAD geometry.  A custom 

building grid can be easily created from primitive linework.  In this exercise, you use linework in a common 

sketch to create a complex building grid.  The grid is used to create the 3D columns that support the roof. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Convert common AutoCAD lines into a custom building grid. 

§ Place columns on a building grid. 

§ Label a building grid. 
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  3. Create a Column on each node of the 

grid. 

§ On the Design tab of the Design tool 

palette, click the Column tool. 
 

 
 

§ Move the cursor over any one of the 

grid intersections until a column and a 

tooltip display. 

Note: Do Not Click. 

§ Press CTRL once to access the Add 

columns to all nodes option. A red 

circle displays wherever a column will 

be placed. 

 

§ Click to place the columns. 

§ Press Enter. 
 

Columns display at each node, 

however, some grid nodes do not 

require columns. For example, some 

columns block the entrance of the 

building. 

· Select the highlighted columns and 

press DELETE. 

 

 

 

 

Exercise: Creating a 

Layout from Linework 

In this exercise, you use linework in a 
sketch to create a more complex 
building grid than the grid that you 
created in the previous exercise. After 
you create the grid, you attach 
columns to the grid nodes. When the 
grid is complete, you manually label 
the grid lines. 

 

The completed exercise 

 

1. Open ACA_003_Gridwork_Custom.dwg. 

§ Zoom to the drawing extents. 

 

2. Convert linework to a grid. 

§ On the Design tab of the Design tool 

palette, right-click the Column Grid 

tool and click Apply Tool Properties to 

Linework. 
 

 
 

§ Using a selection window, select the 

drawing linework, and press ENTER. 

§ Sub Step 3. 

§ In the Command line, enter y, and 

press ENTER. 

§ Press ESC. 
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  § Select one of the Columns. In the 

Context Ribbon, click  (Select 

Similar). 
 

All columns are selected. 

 

§ On the Design tab of the Tool palette, 

right-click Column Cover 12 x 12, and 

click Apply Tool Properties to  

Column. 

§ Press ESC. 

 
 

6.  Use the grid bubble tool to label each 

line individually. 

§ Click View panel  View drop-down 

 View, Top. 

§ Right-click the Tool palette title bar, 

and select Document. 

§ On the Annotation tab of the 

Document tool palette, click the 

Column Bubble tool. 
 

 
 

§ Select the left endpoint of the top 

horizontal grid line. 

§ In the Create Grid Bubble dialog: 

o For the Label, enter A. 

o Clear Apply at both ends of 

gridline. 

o Click OK. 

4.  View the columns in 3D 

§ Click View panel  View drop-down 

 View, SW Isometric. 
 

Because the columns use the Standard 

style, a generic column displays at 

each grid intersection. 

 

 

5. Change the style of the columns using 

the Content Browser. 

§ Click Home tab  Build panel  Tools 

drop-down  Content Browser. 
 

 
§ In the right pane of the Content 

Browser, click the Design Tool Catalog 

- Imperial. 

§ In the left pane, click Structural  

Members. 

§ In the right pane, click Next until you 

locate the Column Cover 12 x 12 tool. 

§ On the lower-right corner of the 

Column Cover 12 x 12 icon click the i-

drop symbol . 

§ Drag the tool onto the tool palette, 

and when the dropper fills, release 

the mouse button. 

§ Close the Content Browser. 
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7.  View the columns in 3D. 

· Select the left endpoint of the grid 

line below the one that you just 

labeled. 

· In the Create Grid Bubble dialog: 

o For Label, verify that B 

displays. 

o Clear Apply at both ends of 

gridline. 

o Click Ok. 

· Continue to select grid line 

endpoints to label the remaining 

lines as shown. 
 

Use a letter sequence on the 

horizontal lines and a numeric 

sequence on the vertical lines. 

 

§ When you are finished, press ENTER. 

 

 

8. Close the drawing without saving. 
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Lesson: Creating a Curtain Wall 
 
 

 
 

 

 

 

 

 

 
 

 

 

 

 

 

Curtain Walls are often part of a factory building design.  As with all other architectural elements, curtain walls 

are easily created using dedicated commands.  Curtain walls can be created from scratch or applied to existing 

walls or AutoCAD linework.  This section will demonstrate the process of converting existing walls to 

architectural curtain wall elements. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Convert Existing Walls to Curtain Walls. 

§ Trim Curtain Walls. 

§ Modify Curtain Wall Styles. 
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  § On the Command line: 

Enter c and press ENTER. 

This option enables you to use the 

center of the wall to justify the curtain 

walls. 

 

§ Enter y and press ENTER. 
 

Use this option to erase the layout 

geometry (the walls used in the 

conversion). 

 

§ Press ESC, and zoom to the bumpout 

to view the curtain walls.  
 

The curtain walls may overlap or 

display with a gap at the corner.  

Trimming and Extending is often 

necessary when you convert linework 

or walls to curtain walls, or other 

objects. 

 
3.  Stretch the curtain walls. 

§ Extend the curtain walls, using the 

grips, until the walls overlay as shown.  

 

 

4. Trim the right curtain wall. 

§ Click Home tab  Modify panel  

AEC Trim drop-down  Trim. 

§ Select the left curtain wall segment, 

and press ENTER. 

§ Select the top portion of the right 

curtain wall segment. 

§ Press ENTER. 

§ The right segment is trimmed to the 

left segment. 

Exercise: Creating a 

Curtain Wall 

In this exercise, you convert some of the 

walls that you created in a previous 

exercise to curtain walls.  

 

The completed exercise 

 

1. Open ACAD_004_Curtain_Wall.dwg. 

 

2. Convert Walls to Curtain Walls. 

§ On the Design tab of the Design tool 

palette, right-click the Curtain Wall 

tool and click Apply Tool Properties to 

Walls. 
 

 
 

§ Select the walls in the bumpout on the 

north side of the building and in the 

corners of the left wing of the building 

as shown. 

 

§ Press ENTER. 
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  7. View the changes to the curtain wall in 

3D. 

§ Click View panel  View drop-down 

 View, NE Isometric. 

§ Click Visual Styles drop-down  

Visual Styles, Realistic. 

 

 

8. Optional:  Use same techniques to 

change the two corner conditions on the 

curtain walls in the left wing of the 

building. 

 

9.  Close the drawing without saving. 

 

5. Trim the left curtain wall. 

§ Click Home tab  Modify panel  

Trim.

§ Select the right curtain wall segment, 

and press ENTER. 

§ Select the top portion of the left 

curtain wall segment, and press 

ENTER  

 

 

6.  Modify the curtain wall style to match 

design requirements. 

§ Select the left curtain wall segment, 

right-click, and click Edit Curtain Wall 

Style. 

§ Modify the Orientation to Horizontal, 

shown by marker (1) in the following 

image. 

§ Modify the division type to Fixed 

Number of Cells, shown by marker (2) 

in the following image. 

§ Modify the Number of cells to 5, 

shown by marker (3) in the following 

image. 

 

§ Click OK. 
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Lesson: Creating an Entrance 
 
 

 
 

 

 

 

 

 

 
 
 

 

 

 

 

 

Interior and exterior entrances are a fundamental architectural element of any factory design.  Doors and 

door/window assemblies can be placed anywhere along existing walls.  The door/window assemblies 

command creates an access door nested in a window assembly.  Supporting styles for doors and 

door/windows assemblies allow designers to create any size and mullion combination desired for simple or 

complex access situations. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Place Door/Window assemblies in existing walls. 
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§ On the right panel, click  

(Design Tool Catalog – Imperial). 

 

§ On the left panel, click Doors and 

Windows, and then on the right 

panel, click Door and Window 

Assemblies as shown in the following 

image. 

 

§ Left Click and drag the Hinged Double 

4 Inch Head Door and Window 

Assembly from the right panel into the 

drawing. 

 

3. Place the door/window assembly. 

§ Select the wall shown in the following 

image  

 

Exercise: Creating an 

Entrance 

In this exercise, you create an entrance by 

adding two door and window assemblies 

to the building shell.

 

The completed exercise 

 

1. Open ACA_005_Creating_Entrance.dwg. 

 

2. Place two door/window assemblies. 

§ Zoom in to the highlighted area of the 

drawing shown in the following image. 

 

§ On the Home Ribbon, select Content 

Browser on the Build Panel. 
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  4. Modify the doors to swing outward. 

§ If required, select one of the doors, 

and click the flip grip. 

 

 

§ Press ESC to clear your selection. 

§ If required, repeat the previous steps 

to flip the swing of the other door. 

The doors should swing to the outside 

of the building as shown in the 

following image. 

 

 

5. View the door/window assemblies in 3D. 

§ Click View panel  View drop-down 

 View, SW Isometric. 

§ On the visual Style panel, set the 

Visual Style to Realistic. 

§ Zoom in to the door/window 

assemblies. 

 

§ Close the drawing without saving. 

§ Set the Door Dimension Width to 9’-

0” in the Properties pallete. 
 

 
 

§ Place the Door 2’ from the right hand 

wall as shown in the following image. 

Enter 2’ in the right hand input box 

and hit ENTER. 

 

§ Place a second Entrance Door 13’ 

from the right hand wall as shown in 

the following image. Enter 13’ in the 

right hand input box and hit ENTER. 
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Lesson: Creating a Foundation Slab 
 
 

 
 

 

 

 

 

 

 
 
 

 

 

 

 

 

 

In AutoCAD Architecture, a slab is a three-dimensional object with multiple edges. A slab style controls the 

appearance of the slab, while a slab edge style controls the appearance of the slab edges. 

To create the haunched edges of the foundation slab, a profile is applied to the slab edges in the slab edge style. 

When you create the slab, this profile is extruded along the slab edges, creating the haunched appearance. 

Objectives 

After completing this lesson, you will be able to: 

§ Locate the haunched slab in the Content Catalog. 

§ Create a haunched slab from existing AutoCAD linework. 
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3. Add the Haunch (6 inch slab) tool to the 

Design tool palette. 

§ In the lower right corner of the 

Haunch (6 inch slab) tool icon, click   

 (i-drop).   

§ Drag the tool onto the Design tool 

palette, and when the dropper icon 

fills, release the mouse button. 

§ Close the Content Browser  

 

4. Use the new slab tool to create the 

foundation slab. 

§ If necessary, on the application status 

bar: 

o Click Ortho Mode and Object 

Snap to turn them on. 

o Right-click Object Snap and 

select Endpoint. 

§ On the Design tab of the Design tool 

palette, click Haunch (6 inch slab). 
 

 
 

§ Trace the outer perimeter of the 

building: 

§ If necessary, turn off the all layers 

except the original slab layer. 

§ Move the cursor over the outer wall 

endpoint as shown, and when the 

endpoint displays, select it. 

 

§ Moving in a clockwise direction, 

continue to select the outer endpoints 

of each wall segment. 

§ When you select the final endpoint, 

on the command line, enter c and 

press ENTER  

Exercise: Creating a 

Foundation Slab 
 

In this exercise, you create a haunched 
foundation slab for the factory building.  
Because the Design tool palette does not 
contain a tool to create the haunched slab, you 
must import a haunched slab tool from the 
Content Browser 

 

The completed exercise 

 

1. Open ACA_006_Slab.dwg. 

 

2. Search for the haunched slab tool in the 

Content Browser. 

§ Click Home tab  Build panel  Tools 

Flyout  Content Browser. 
 

 
§ In the left pane, under Search, enter 

haunch slab, and click GO. The search 

results, which include a 6 inch haunch 

slab tool, displayed in the right pane. 
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5. View the Slab in 3D. 

§ Click View panel  View drop-down 

 View, SW Isometric. 

§ Click Visual Styles drop-down  

Visual Styles, Hidden. 

§ To view the slab edges, on the 

ViewCube, click  . 

 

 

§ Close the drawing without saving. 
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Chapter Summary 
 

This chapter presented special architectural commands dedicated to creating Walls, Doors, and 
Slabs.  These elements could be created from scratch or applied to existing linework.  This chapter 
focused on the process of creating the outer shell of the factory facility using the architectural 
specific commands. 
 

Having completed this chapter, you can: 

 

§ Create the shell walls from linework in a drawing. 

§ Use two different techniques to create the structural grid. 

§ Add curtain walls and an entrance to the shell. 

§ Add a Slab to the design. 
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Chapter 
 

4 
 

 
 
 

Creating Interior Features 
 

 
 

Interior features such as interior walls, doors, and fixtures, are created using architectural specific 
commands.  Some commands such as walls and windows are located on the Design palette.  Many 
interior features such as restrooms and furniture are available in the Content Browser.  This chapter 
will demonstrate the process of converting existing AutoCAD linework to interior walls, and installing 
interior access doors and restroom fixtures.  The process of installing windows will be reviewed as 
well. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

 

 

 

Objectives 
 

After completing this chapter, you will be able to: 

 Create interior partition walls. 

 Place doors and windows in interior partition walls. 

 Layout a restroom created by partition walls. 

 Place furniture in the layout. 
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Lesson: Creating Partition Walls 
 
 

 
 

 

 

 

 
 
 

 

 

 

 

 

  

As with all architectural elements created with AutoCAD Architecture, partition walls can be created from scratch 

or applied to existing AutoCAD linework.  This lesson will demonstrate the process of converting existing AutoCAD 

linework to interior partition walls. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Draw a partition wall. 

§ Convert existing AutoCAD linework to walls. 

§ Modify the wall justification. 
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  2.  Draw a wall. 

§ On the Design tab of the Design tool 

palette, click the Wall tool. 
 

 
 

§ On the Properties palette: 

o Under Dimensions, for Width, 

enter 6''. 

o For Justify, select Center. 
 

 
 

§ Move the cursor to the lowest 

horizontal interior wall in the image 

below, and select the right endpoint 

of the linework as shown. 

 

§ Move the cursor to the left, select the 

left endpoint of the linework, and 

press ENTER. 

 

Exercise: Creating 

Partition Walls 

In this exercise, you create interior 

partition walls on a building floor plan. 

 

The completed exercise 

 

1. Open ACA_007_Interior_Walls.dwg. 

§ Zoom in to the upper left corner of 

the floor plan. 
 

 

§ If necessary, on the application status 

bar: 

o Click Ortho Mode and Object 

Snap to turn them on. 

o Right-click Object Snap and 

select Endpoint. 
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  5. Select a different wall style. 

§ Select a single interior wall. 

§ On the context Wall ribbon, click 

(Select Similar). 

 

§ On the Properties palette, set the 

Style setting to Stud-3.5 GWB-0.625 

Each Side. 

 

 
 

§ Press ESC. 

 

6. Optional: View the interior walls in 3D. 

 

7. Close the file without saving. 

3. Add another partition wall. 

§ Right-click in the drawing, and click 

Repeat WallADD. 

§ Select the endpoint of the vertical line 

as shown. 

 
§ Move the cursor up, and select the 

endpoint of the line as shown. 

 

§ Press ENTER. 

Note: Another quick way to add an 

object to the drawing is to use the 

Add Selected from the right-click 

menu. This not only repeats the 

command, but also uses the same 

style and properties of the object that 

you selected. 

 

4.  Create the remaining walls from existing 

AutoCAD linework. 

§ On the Design tab of the Design tool 

palette, right-click the Wall tool and 

select Apply Tool Properties to  

Linework. 

§  Select the remaining interior walls. 

 

§ Press ENTER twice. 
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Lesson: Placing Doors and Windows 
 
 

 
 

 

 

 

 

 
 
 

 

 

 

 

 

 

Interior access doors are created with the architecturally specific Door command located on the design tool 

palette.  Exterior and Interior windows are created with the Window command also located on the design tool 

palette.  If a door encased in a window is needed, the Door/Window Assemblies command is used.  This lesson 

demonstrates the process of adding interior doors and windows to the factory facility. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Add interior doors to existing walls. 

§ Add interior windows to existing walls. 
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  2. Place the double doors. 

§ On the Design tab of the Design tool 

palette, click the Door tool. 
 

 
 

§ On the Properties palette: 

Under General, for Style select Hinged 

– Double – Metal Frame in Plan. 

§ Under Dimension, for Width, enter 6'. 

§ Under Location, for Position along 

wall, select Center. 
 

 
 

§ If necessary, on the application status 

bar, click Osnap to turn it off. 

§ Select the center of the wall as shown, 

and when a centered door displays, 

click to place it. 

 

§ Press ENTER. 

Exercise: Placing Doors 

and Windows 

In this exercise, you will place doors and 

windows in the interior partition walls on the 

floor plan. 

 

The completed exercise 

 

1. Open the exercise drawing 

ACA_008_Interior_Doors_Windows.dwg. 

§ Zoom to the upper left portion of the 

floor plan. 

§ If necessary, on the application status 

bar, click Dynamic Input to display 

temporary dimensions as you place 

doors and windows. 
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  5. Place two double doors accessing the 

conference room and the factory floor. 

§ On the Design tab of the Design tool 

palette, click the Door tool. 

§ On the Properties palette: 

o Under General, for Style, 

select Hinged – Double – Full 

Lite. 

o Under Dimensions, for Width, 

enter 6'. 

§ Under Location, for Position along 

wall, select Offset/Center (depending 

on the installation requirements). 

§ If necessary, for Automatic Offset, 

enter 1'. 

§ Place doors as shown, and press ESC. 

 

 

6.  Place windows. 

§ On the Design tab of the Design tool 

palette, click the Window tool. 
 

 
 

§ On the Properties palette: 

Under Dimensions, for Width, enter 

4'. 

For Height, enter 6'. 

Under Location, for Position along 

wall, select Unconstrained. 

For Vertical alignment, select Head. 

For Head height, enter 7'. 

3. Place another door. 

§ Using the same technique, place 

another door as shown. 

 

§ Adjust the door swing direction if 

necessary. 

 
 

§ Press ESC if necessary. 

 

4. Place single doors. 

§ On the Design tab of the Design tool 

palette, click the Door tool. 

§ On the Properties palette: 

o Under General, for Style, 

select Hinged – Single – 

Metal Frame in Plan. 

o Under Dimensions, for Width, 

enter 3'. 

o Under Position, select Offset. 

o For Automatic Offset, enter 

4”. 

§ Place the doors as shown in the 

following image. 

 
 

§ Press ESC. 
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§ Place three windows in the wall as 

shown, and press ESC. 

Exact placement is not necessary. 

 

 

7. View the floor plan in 3D. 

 

 

8. Change the display of the doors to open. 
 

Autodesk Factory Design Suite enables 

you to walk through the factory layout 

and experience the facility before it is 

constructed.  To make navigation easier, 

the doors should be displayed open 

instead of closed. 

 

§ Select a single door. 

§ On the Properties Palette, click the 

Display tab. 

§ On the Display tab, set the value of 

the Swing Angle to 90. 

§ Press ENTER. 

 
 

 

 

 

§ Close the Drawing without saving.  
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Lesson: Laying out a Restroom 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

The restroom fixtures that you place on the floor plan are contained in a single block. The block contains the fixtures 

in a pre-constructed restroom layout, including accessories and stall partitions. 

After you place the restroom layout, you modify it to better fit the floor plan. Because the restroom layout is a block, 

you can explode it to edit its individual components. 

Objectives 

After completing this lesson, you will be able to: 

§ Convert an existing wall to a chase wall. 

§ Insert a preset restroom from the Content Browser. 

§ Explode and modify the restroom design. 
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3. Add a restroom layout to the design. 

§ Open the Content Browser. 

§ In the left pane, under Search, enter 

rest room, and click GO. 

§ In the right pane, locate the Rest 

Room (Women) tool. You may have to 

click Next in the bottom right corner 

to view more of your search results. 

§ In the lower-right corner of the Rest 

Room (Women) tool icon,  

click  (i-drop). 

§ Drag the icon into the drawing 

window. 

§ On the Insert dialog box, place a 

checkmark for Insertion point and 

Rotation angle then click OK. 
 

 
 

§ Move the cursor over the endpoint of 

the wall as shown and click. 

 

Exercise: Laying out a 

Restroom 

In this exercise, you lay out a restroom. 

You create a chase wall on the floor plan, 

and then place fixtures, accessories, and 

stall partitions on the floor plan. 

 

The completed exercise 

 

1. Open ACA_009_Restrooms.dwg. 

 

2. Change a wall style to create a chase 

wall. 

§ Select the wall in the following image. 

 
 

§ On the Properties palette, under 

General, for Style, select 12in Chase 

Wall – Stud-3.5 GWB-0.625 Each Side, 

and press ESC.  

The chase wall divides the 2 rooms 

that are intended for use as 

restrooms. You want to lay out the 

lower restroom, which is the women’s 

restroom. 
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6. Replace the lavatories. 

§ Select the lavatories and counter top, 

and press DELETE. 

§ Open the Content Browser, search for 

the Lavs (3) tool, and use i-drop to 

drag it into the drawing window. 

§ On the Insert dialog box, click OK. 

§ Move the cursor over the endpoint of 

the stall wall as shown. 
 

 
 

§ Rotate the block into position and 

click. 

§ Explode the lavatory block and grip 

edit the counter to the proper 

position. 

 

7.  Optional: Using the techniques learned 

in this exercise, layout the men’s 

restroom.  

Tip:  Use the following tips to complete 

the restroom layouts. 

§ Use the Content Browser to locate a 

men’s restroom layout block. 

§ Before you explode the block, use the 

mirror command to create the 

necessary layout orientation. 

 

8. Close the drawing without saving. 

§ Rotate the block into the correct 

position as shown in the following 

image and click. 

 

 

4. Explode the restroom layout. 

§ Explode the restroom layout block. 

§ Select the restroom layout. 

§ Click Home tab  Modify panel  

Explode. 

 

5. Lengthen the stall wall: 

§ Select the wall to display its grips. 
 

 

§ On the application status bar, right-

click Object Snap. 

§ Click Wall Justification Line to turn it 

off, and click Perpendicular to turn it 

on. 
 

This allows you to snap to the face of 

the interior wall while lengthening the 

stall wall. 

 

§ Select the bottom triangular cyan 

lengthen grip. 

§ Click the face of the wall, and press 

ESC. 
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Lesson: Placing Furniture 
 
 

 
 

 

 

 

 

 

 The conference table in Plan view. 

 

 

The conference table in a 3D view. 
 

 

 

 

 

 

 

 

 

Thousands of furniture and accessories are available in the Content Browser.  You place furniture on the floor plan 

as a single multi-view block.  Like an AutoCAD block, a multi-view block is an object that can combine two or more 

objects to create a single object.  Unlike an AutoCAD block, a multi-view block can have different representations 

when viewed from alternate directions.  This lesson demonstrates the process of placing furniture into an existing 

floor plan. 

Objectives 

After completing this lesson, you will be able to: 

§ Place furniture from the Content Browser into an existing floor plan. 
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  3. Place the conference table. 

§ Zoom to the large conference room on 

the floor plan. 

 

§ Move the cursor over the center of 

the conference room and click to 

insert the conference table as shown 

in the following image. 

 

§ Rotate the conference table into the 

correct position and click to finish the 

operation. 

§ Press ESC. 

 

4. View the conference table in 3D. 

 

 

5.  Optional: Search the Content Browser 

for additional office furnishing and place 

them on the floor plan. 

 

6. Close the drawing without saving. 

 

Exercise: Placing 

Furniture 

In this exercise, you place a conference 

table and chairs on the floor plan as a 

single multi-view block. 

 

The completed exercise 

 

1. Open ACA_010_Furniture.dwg. 

 

2. Browse for the Conference table. 

§ Click Home tab  Build panel  Tools 

drop-down  Content Browser. 

§ In the right pane of the Content 

Browser, click Design Tool Catalog - 

Imperial. 

§ In the left pane, under Search, enter 

conference table, and click GO. 

§ In the right pane, locate the Conf 16ft 

- 16 Seat tool. 

§ In the lower right corner of the Conf 

16ft - 16 Seat tool, click  (i-drop). 

§ Drag the tool to the AutoCAD drawing 

window and release the mouse 

button. 

§ On the Insert dialog box, click OK. 
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  Exercise: Challenge  

Using the methods you have learned and 

the extra tips in this section, convert the 

linework in this drawing to a suitable 

building shell.   

 

1. Open ACA_013_Challenge.dwg. 

 

2. Use the tips below to complete the 

factory floor plan: 

§ Exterior Wall – Stud-5.5 Brick-LOWER 

FLOOR – 15’. Base Height – Right 

Justified. 

§ Interior Walls - Stud-3.5 GWB-0.625 

Each Side – Center Justified. 

§ Convert existing grid lines to custom 

grid. 

§ Columns - 8" Steel Column w/ 12"x12" 

Column Cover, available in the Content 

Catalog. 

§ Restroom - Use the 3 Lavs block from 

the Content Catalog for the men’s and 

women’s restrooms.  

§ Insert an Overhead – Coiling Industrial 

rolling overhead door from the Content 

Catalog. 

§ Rolling Door Centered in the Wall at 

each end of the facility - Door Size 12’ x 

12’. 

§ Doors to suit. 

§ Use the images below to aid in the 

completion of the challenge exercise. 
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This image shows the completed exercise viewed in 3D. 

 

This image shows the finished office and restroom spaces in plan view. 
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Chapter Summary 
 
 

This chapter presented the tools and recommended workflows for basic shape design. Using these 
techniques, you can now create more complex 2D sketches at different locations on your part, 
combine multiple 3D features to create various shapes, and modify those shapes at any time during 
the design process. 

Having completed this chapter, you can: 

 Create interior partition walls. 

 Place doors and windows in interior partition walls. 

 Layout a restroom created by partition walls. 

 Place furniture in the layout. 

 



 
 
 
 
 
 

Chapter 
 

5 
 

 
 

Autodesk Inventor  

Getting Started 

 
Autodesk® Inventor® has a context-sensitive user interface that provides you with the tools relevant 
to the tasks being performed. A comprehensive online help and tutorial system provides you with 
information to help you learn the application. This chapter introduces the tools and interface options 
that you use on a constant basis. 

 
This chapter also introduces fundamental of parametric part design concepts that enable you to 
capture design intent and build intelligence into your designs. 

 

 

Objectives 
 

After completing this chapter, you will be able to: 
 

 Identify the main user interface components that are common to all Autodesk Inventor design 
environments and describe how to access different tools. 

 View all aspects of your design by efficiently navigating around in 2D and 3D space. 

 Describe the characteristics and benefits of a parametric part model. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 
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Lesson: Autodesk Inventor User Interface 
 
 
 
 

This lesson describes the application interface. You are introduced to the different file types (part, 
assembly, presentation, and drawing) you work with as you create and document your designs, 
and you examine the common user interface elements and view management tools in these 
environments. 

 

As with all computer applications, the User Interface (UI) is what you use to interact with the program. 
While the Autodesk Inventor UI shares many common themes and elements with other Microsoft 
Windows applications, it also has some unique elements and functionalities that may be new to you, 
even as an experienced CAD user. 

 

In the following illustration, the Autodesk Inventor User Interface is shown. 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Describe the multiple environments within Autodesk Inventor. 

 Describe what project files are used for. 

 Describe the types of files Autodesk Inventor creates and the kinds of information they store. 

 Identify the major components of the Autodesk Inventor user interface. 

 Identify the browser and panel bar in the assembly, part, presentation, and drawing 
environments. 

 Identify and access various types of online help and tutorial resources. 
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About Multiple Environments 
 

In order to provide the greatest design flexibility and reuse, each part, assembly, and drawing is stored 
in a separate file. Each part file is a stand-alone entity that can be used in different assembly files and 
drawing files. When you make a change to a part, the change is evident in each assembly or drawing 
that references that part. Assembly files can be referenced by other assembly files, presentation files, 
and drawing files. IDW and DWG files are now interchangeable. Depending on your workflow and 
need for use in downstream applications, you can create your production drawings with either file 
format. 

 

The basic file references that exist in a typical 3D design are represented in the following illustration. 
 

 
 

    Assembly files: IAM files reference part files and are referenced by drawing files. 

    Part files: IPT files are referenced by assembly files and drawing files. 

    Drawing files: DWG files reference assembly files and part files. 
 

    Inventor Drawing files: IDW files are interchangeable with DWG files in Inventor and 
reference assembly and part files. 

 

Using Template Files 
 

Template files serve as the basis for all new files that you create. When you begin a file from a 
template file, you can control default settings such as units, snap spacing, and default tolerances in 
the new file. 

 

The application offers template files for each type of file. Template files are categorized into two 
main groups: English for English units (inches and feet), and Metric for metric units (millimeters and 
meters). 

 

The New File dialog box has three tabs: Default, English, and Metric. The Default tab presents 
templates based on the default unit that you select during installation, while the English and Metric 
tabs present template files in their respective units.  
 

Autodesk Factory Design Suite provides a special template for the creation of Factory Layouts  .  
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Part Modeling Environment 
 

In the part modeling environment: 

 You create and edit 3D part models. 

 The interface adjusts automatically to present tools for your current task, for example, tools for 
sketching or tools to create 3D features. 

 

The following illustration shows the user interface in the part modeling environment. 
 

 

 

Assembly Modeling Environment 
 

In the assembly modeling environment: 

 You build and edit 3D assembly models. The components displayed in the system are references to 
external parts and subassemblies. 

 You use assembly specific tools to position and build relationships between components. 

 A common set of viewing tools is available. 

The following illustration shows the user interface in the assembly modeling environment. 
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Presentation Environment 
 

In the presentation environment: 

 You create exploded assembly views. 

 You can record an animation of an exploded view to help document your assembly. 

 The presentation file references an existing assembly. 

 A common set of viewing tools is available. 

The following illustration shows the user interface in the presentation environment. 
 

 

Drawing Environment 
 

In the drawing environment: 

 You create 2D drawings of parts and assemblies. 

 A drawing file references one or more parts, assemblies, or presentation files. Changes to the part 
or assembly model update the associated drawing views and annotations. 

 

The following illustration shows the user interface in the drawing environment. 
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About Project Files 
 

As you create designs in Autodesk Inventor, file dependencies are created between files of different 
types. For example, when you create a 3D assembly, a file dependency between the assembly and its 
part models is created. As your designs grow in complexity, these dependencies can become more 
complicated. Autodesk Inventor utilizes project files to locate the required files as they are needed. 
As a result of using the information contained in the project file, when you open that 3D assembly, 
Autodesk Inventor can locate the 3D part files and display them properly. 

 

In the context of an introduction to the Autodesk Inventor user interface, all that is important to 
realize is that you must have an active project before you create any files. This is why the project file is 
listed in the New File dialog box. Autodesk Inventor installs several sample project files, but the default 
project is initially active. 

 

 

Inventor File Types 
 

To maximize performance, Autodesk Inventor uses different file types for each type of file. Assembly 
files are stored in a different type of file than the parts that are used to create them. 2D drawing 
information can be stored in either the IDW file type that is unique to Autodesk Inventor, or the DWG 
format that is native to AutoCAD® and is an accepted industry standard. 

 

In the following illustration, the New File dialog box illustrates the different types of files that you can 
create with Autodesk Inventor. 

 



7 Chapter 5: Autodesk Inventor Getting Started 

 
 

Part Files 
 

Part files (*.ipt) represent the foundation of all designs using Autodesk Inventor. You use the 
part file to describe the individual parts that make up an assembly. 

 

 

 
 
 

Assembly Files 
 

Assembly (*.iam) files consist of multiple part files assembled in a single file to represent your 
assembly. You use assembly constraints to constrain all the parts to each other. The assembly 
file contains references to all of its component files. 

 

 

Presentation Files 
 

You use presentation files (*.ipn) to create exploded views of the assembly. It is also possible 
to animate the exploded views to simulate how the assembly should be put together or taken 
apart. 
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Drawing Files 
 

You use drawing files (*.idw) to create the necessary 2D documentation of your design. 
Drawing files include dimensions, annotations, and views required for manufacturing. When 
you use a drawing file to create 2D views of an existing 3D model, the views are associative to 
the 3D model, and changes in model geometry are reflected in the drawing automatically. You 
can also use drawing files to create simple 2D drawings in much the same way that you use 
other 2D drawing programs. 

Inventor drawing files can also be stored in the standard DWG format. If you use this format 
for your 2D drawings, they can be opened and saved in AutoCAD. This is a very useful option 
for users who must share their design data with others who use AutoCAD. 
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User Interface 
 

All environments share a common layout for tabs on a single toolbar across the top of the 
application window called the ribbon. The ribbon contains tools and commands for specific 
tasks on separate tabs. Each environment, assembly, part, or drawing for example, displays tabs 
and tools specific to that environment. As you change tasks within a single environment, the 
ribbon adjusts to present the appropriate tabs and tools. 

 

The following illustration shows the major components of the Autodesk Inventor user 
interface. The ribbon and tabs are displayed at the top of the application window. 

 

 
 

    Application Menu 

    Quick Access Toolbar 

    Ribbon 

    Ribbon Tabs 

    ViewCube 

    Navigation Bar 

    Browser 

    3D Indicator 

Graphics Window 
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Interface Structure 
 

Autodesk Inventor uses a standard structure common in all Microsoft Windows applications. The 
structure is context-sensitive based on the environment and mode you are using. 

 
As you are learning the application more thoroughly, you should take the time to familiarize yourself 
with the different options that are displayed on the ribbon in different work environments. 

 

The following illustration shows the Assemble tab in the assembly modeling environment. 
 

 
 

The following illustration shows the Model tab in the part modeling environment. 
 

 
 

The following illustration shows the Place Views tab in the drawing environment. 
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Quick Access Toolbar 
 

By default, a single Inventor standard toolbar is displayed in all environments and is called the 
Quick Access toolbar. When you change between environments, the Quick Access toolbar 
updates to present valid tools for the environment. The toolbar contains tools for file 
handling, settings, view manipulation, and model or document appearance. 

 

A section of the Quick Access toolbar is displayed in the following illustration. It is organized 
into groups based on functionality. This area of the toolbar displays tools for standard file 
and modeling operations. 

 

 
 

    Standard file management tools 

    Undo and Redo 

    Environment navigation 

    Update document 

    Selection filters 

    Color List 

Design Doctor 
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Context-Sensitive Tools 
 
 

As you switch between environments or between tasks in a single environment, Autodesk Inventor 
displays the appropriate tools and information for the current task. The ribbon automatically 
presents tabs and tools for the current task. The browser displays information on the active 
environment. 

 

 

    The ribbon is your primary interface for accessing the tools available while you design. The 
context-sensitive design presents the relevant tools based on the current context of your design 
session. For example, when you switch from assembly modeling to part modeling, the ribbon 
switches automatically to display the correct tabs and tools for the context where you work. 

    The browser is one of the main interface components. It is context-sensitive with the environment 
you use. For example, when you work on an assembly you use the browser to present information 
specific to the assembly environment. While you use the part modeling environment, the browser 
displays information that is relevant to part modeling. 

 

 

Model Tab 
 

When you are in the part modeling environment, the Model tab is displayed while you create and edit 
part models. You use these tools to create parametric features on the part. 
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Sketch Tab 
 

You use the Sketch tab in the modeling environment to create 2D parametric sketches, dimensions, 
and constraints. You use the same set of tools on the Assemble tab when creating a sketch in the 
assembly environment. 

 
 
 

Part Modeling Browser 
 

The browser displays all features you use to create the part. The features are listed in the order 
in which they are created. The browser also displays the Origin folder at the top of the list which 
contains the default X, Y, and Z planes, axes, and center point. 

 
 
 

Assembly Modeling Environment 
 

When you are in the assembly modeling environment, the browser displays all the parts you use in 
the assembly. It also lists the Origin folder containing the default X, Y, and Z planes, axes, and center 
point of the assembly. 

 
If applied, nested under each part, you see the assembly constraints. If you select an assembly 
constraint, an edit box is displayed at the bottom of the browser, enabling you to edit the offset or 
angle value for the constraint. 
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In the assembly environment, you can use the Modeling View option in the Assembly 
View drop-down list to display the part features nested under the parts instead of the 
assembly constraints. This is useful when performing part modeling functions in the 
context of the assembly. 

 
In the following illustration, the Assemble tab is shown in the default Normal mode. In Normal mode, 
the tool icons and names are displayed. 

 

 
 
 

 
You can also choose to display tool icons without text by right-clicking anywhere on the 
ribbon and then clicking Ribbon Appearance > Text Off. 
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Design Accelerator 
 

Clicking on the ribbon, Design tab displays the Design Accelerator tools. 
 

 
 
 

Presentation Tab 
 

When you are in the presentation environment, you use the Presentation tab to create presentation 
views and tweaks, and to animate geometry in the presentation environment. 

 
 
 

Presentation Browser 
 

The browser displays the presentation views you create followed by the tweaks you use for the 
explosion. When you expand each tweak, you see the parts included in that tweak. You can also 
switch the browser mode from Tweak View to Sequence View or Assembly View. 
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Drawing Environment 
 

In the drawing environment, the browser displays the Drawing Resources folder containing sheet 
formats, borders, title blocks, and sketched symbols. It also displays each sheet in the drawing along 
with the views you create for each. 

 

 
 

You use the Place Views tab in the drawing environment to create drawing views on the sheet. 
 

 

 
You use the Annotate tab in the drawing environment to add reference dimensions and other 
annotation objects. 
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Keyboard Shortcuts 
 

You can use keyboard shortcuts to access and begin tools and commands. For example, you can enter 
P for Place Component, or N for Create Component. Entering the keyboard shortcut is the same as 
clicking the tool on the tabs. When you hover the mouse over a tool on the ribbon, the tooltip will 
expand to reveal information about the tool. The keyboard shortcut (1) will be listed as shown in the 
following illustration. 

 
 
 

Access Shortcut Keys List 
 

You can access a complete list of the default shortcut keys from the Help menu. 
 

In the Info Center, click the arrow next to the Help icon > Shortcut/Alias Quick 
Reference 

 

 
Condensed Ribbon 

 

As you become more familiar with the tools in each environment, you can condense the ribbon by 
choosing to display tool icons without text. To switch, right-click anywhere on the ribbon and click 
Ribbon Appearance > Text Off. Clear the check mark to display icon text. In this mode, tools are 
displayed with icons only resulting in more area for the browser and graphics windows. 
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Alternative Ribbon and Browser Positions 
 

In addition to the default positions, you can alter the location of the ribbon or browser by clicking and 
dragging the horizontal bars near the top of the element, or the title area when the element is floating. 
Both the ribbon and browser can be placed in a docked position on the left or right side of the screen, 
or in a floating position anywhere in the graphics window. 
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Online Help and Tutorials 
 

Autodesk Inventor offers several types of online help, tutorial references, and other resources to assist 
in building your skill level. Standard Help files, context-sensitive how-to presentations, Show Me 
animations, and tutorials are available. 
 
Autodesk Factory Design Suite also offers factory specific help, available on the Factory ribbon.  The 
Factory Design Help is shown in lower image. 
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Setting Your User Type 
 

The initial Help screen enables you to specify the user type that most closely matches your situation. 
The topics that are most relevant to the user type that you select are presented first on the initial 
help screen. By default, the option to Show Help on startup is enabled. This causes the Inventor Help 
system to launch each time you start Inventor and create a new file or open an existing file. 

To access the Inventor Help System, press F1 or click Help menu > Help Topics. 

 
 
 

Help for Returning and New Users 
 

Returning and new users can find links to Help information that is most relevant for them. 
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Help for AutoCAD Users 
 

AutoCAD users can use the Help topics designed specifically for them as they make the transition to 
Autodesk Inventor. 

 
 
 

Shortcut/Alias Quick Reference 
 

The Shortcut/Alias Quick Reference shows all of the default Shortcut/Alias keys along with the 
command names they execute. 

 

Click Help menu > Shortcut/Alias Quick Reference to access the reference. 
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Show Me Animations 
 

The Show Me animations present topic-specific information in animated presentations. 
 

To access the Show Me animations, on the Info Center, click Help > Help Topics and select the Show 
Me Animations link. In the Show Me Animations dialog box, navigate to the topic of choice and the 
animation begins automatically. 

 
 
 

Inventor Tutorials 
 

There are several tutorials available that cover a range of topics from Level 1 to Level 3. Click the tabs 
along the top of the page to view the tutorials for each level. On each tab, panels display tutorial titles 
and descriptions. From the main list of tutorials, select the topic of interest. The tutorials present step- 
by-step information on performing tasks in Autodesk Inventor. 

You access these tutorials by clicking Help menu > Learning Tools > Tutorials, or by clicking Try It 
Tutorials on the main Help screen. 

 

 

Factory Design Suite Tutorials 
 
There are several Factory Design tutorials available that cover the initial processes and practices of the 
Autodesk Factory Design Suite.  These tutorials are access on the Factory Ribbon > Learn About 
Factory Panel > First Experience Videos. 
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In the following illustration, the Introduction to the Ribbon Interface page of the Autodesk Inventor 
tutorial is displayed. 
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Exercise:  

Explore the Autodesk Inventor 

User Interface 

 
In this exercise, you explore the Autodesk Inventor 
user interface for assembly, part modeling, and 
drawing environments. 

 
 

The completed exercise 
 

Exercise Setup 
 

Before you can complete the exercises for the 
Autodesk Factory Design course, you must activate 
the Learning Autodesk Factory Design Suite project 
file. 

 

1. Start Autodesk Inventor. If Autodesk Inventor 
is already running, close all files. 

 

2. Click Get Started tab > Launch panel > Projects. 

 If Learning Autodesk Factory Design 
Suite is displayed in the project list, 
double-click to make it active. A check 
mark appears next to the active project. 

 If Learning Autodesk Factory Design is not 
in the list, click Browse. 

 Navigate to the installation folder of 
your student dataset files. By default, 
this location is C:\Autodesk 
Learning\Autodesk Factory Design 
Suite\Learning. 

 Double-click Learning Autodesk Factory 

Design Suite.ipj. A check mark appears next 

to the 
active project. 

 Click Done. 

 
 

3. End of exercise setup. Continue to the exercise. 
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Explore the Autodesk Inventor User Interface 

1. Open Inv-001_Getting_Started.iam. 

2. Because this is an assembly file, notice the 
specific assembly modeling tools on the 
ribbon. In the browser, notice the 
appearance of both assembly files (1) and 
part files (2). When assembly files are 
referenced in other assemblies, they are 
commonly referred to as subassemblies. 

 

 
 

3. In the browser, expand the 
INV_001_Conveyor_Line:1 subassembly to 
view its referenced parts (1) and assembly 
constraints (2). 

 

 

4. To activate a part in the context of 
the assembly: 

 In the browser, collapse the 
INV_001_Conveyor_Line:1 
subassembly node. 

 Double-click 
INV_001_Conveyor_Line:2   

 Notice the change in appearance in the 
browser, graphics window, and ribbon. 
In the browser, the area listing inactive 
components and subassemblies has a 
gray background. The ribbon changes to 
display tools specific to part modeling, 
and in the graphics window, all inactive 
components become transparent leaving 
only the active part opaque in color. 

 
 

5. To return to the assembly, on the ribbon, 
click Return. Note: You could also double-
click the assembly in the browser to return. 
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6. To open a part in its own window: 

 In the browser, expand 
INV_Conveyor_Line_001 assembly and 
right-click the Straight Belt Conveyor:1 
part. Click Open. The part opens in a 
separate window and any changes made 
to the part are reflected in the assembly.  

 
 
 
 
 

 

 

 

 

 

 

 

 

7. To activate the sketch environment: 

 In the browser, expand the Rail1 part 
feature. 

 Double-click Sketch1. 

The browser background color changes to 
indicate the active sketch, the part features are 
rolled-back and the graphics window displays 
the sketch geometry. 

 

 
 

8. To exit the sketch, on the ribbon, click Finish 
Sketch. 

9. Close the part file and return to the assembly. If 
you are prompted to save changes, click No. 

10. To open an Inventor drawing file: 

 On the Quick Access toolbar, click Open. 

 In the Open dialog box, select 
INV_001_Getting_Started.dwg and click 
Open. 

 The ribbon updates to show drawing 
related tasks and tools. 
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11. In the browser, expand the Drawing Resources 
node and View1: INV_Getting Started.iam 
node to reveal the nested resources, views, 
and assembly references. 

 
 

12. To explore the Help System resources: 

 Press F1. 

 If you are an experienced AutoCAD user, 
click the option for Users Transitioning from 
AutoCAD and explore the Help resources 
that are tailored for these users. 

 If you are new to Inventor and do not have 
AutoCAD experience, click the option for 
Returning / New Inventor Users and explore 
the Help resources that are tailored for 
these users. 

 Return to the Factory Assembly and review 
the Factory Specific Help available on the 
Factory Ribbon. 

13. Close the Help windows. 

14. Close all files. Do not save. 
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Lesson: View Manipulation 
 
 
 
 

This lesson describes the use of the various view manipulation tools in the modeling and drawing 
environments. 

 

You view all aspects of your 3D geometry by navigating around in 3D space. The view manipulation 
tools enable you to quickly perform these tasks in a manner that is intuitive and efficient. 

 

In the following illustration, a constrained orbit is used to rotate the assembly and change the view 
orientation. The ViewCube, in the upper right corner of the graphics window, is shown with the 
compass displayed. The ViewCube rotates with the model and aids in the orientation of the model. 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Identify the tools that are available in the graphics window. 

 Explain the behavior of the Free Orbit and Constrained Orbit tools. 

 Explain the ViewCube options and how to access them. 

 Describe how the ViewCube can be used to view part and assembly models and how to customize 
its appearance and behavior options. 

 Explain the steps to define and restore the home view. 

 Describe how to use various tools to restore previous views. 
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About the Graphics Window 
 

Your 3D part and assembly models, presentations, and drawings are displayed in the graphics window. 
Many tools are available to manipulate the view and appearance of your model in the graphics 
window. 

 
 
 

Viewing Tools 
 

View manipulation is a key 2D drawing and 3D modeling skill. You are often required to view different 
areas of a design, and changing your view can help you visualize solutions for the current task. Many 
of the view manipulation tools are common to all environments. 
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The following illustration shows the view manipulation tools that are available on the Navigation bar. 
 

 
 
 

Navigation Bar Zoom Options Orbit Options 
 

    ViewCube 

    SteeringWheel 

    Pan 

    View Face 

    Zoom All 

Free Orbit 
 

 

You have different view manipulation tools available to you depending on how you want to change 
where you are viewing and to what magnification. To efficiently change your view to see exactly what 
you want or need to see, you need to know what view manipulation tools are available to you and how 
to use them. 

 

 

Icon 
 

View Tool 

 

Description 

 

 
 

ViewCube 
 

In the 3D environment the ViewCube tool displays as a default 
in the graphics window, enabling you to reorient your view of 
the model. In the 2D environment the ViewCube enables the 
definition of view orientations for a drawing view. 

 

 
 

Free Orbit Enables you to freely rotate the view of your model on screen. 
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Icon 
 

View Tool 

 

Description 

 

 
 

Constrained 
Orbit 

 

Constrained Orbit enables you to rotate around the vertical axis of 
a model in a manner similar to the rotation of a turntable. 

 

 
 
 

SteeringWheel 
 

The SteeringWheel tool is designed to be a common tool for 
multiple Autodesk products. The SteeringWheel tool was 
implemented to provide many different levels and types of control 
over model and drawing navigation. 

 

 

You can use the mouse to accomplish most pan and zoom tasks. 

 Roll the mouse wheel to zoom at the cursor location. 

 Click and drag the mouse wheel to pan. 

 Shift+click and drag the mouse wheel to free orbit. 

 Double-click the mouse wheel to zoom all. 
 
 

Display Modes 
 

This area of the toolbar displays appearance-related tools for controlling the appearance of your 
model. Select a render style from the list to change the color and texture of your model. 

 

 
    Toggle the section views which graphically slice portions of an assembly so that you can visualize 

other features. 

    Toggle between Orthographic and Perspective display modes. 

    Toggle between Shaded, Shaded with Hidden Edge and Wireframe displays. 

    Toggle between No Shadow, Ground Shadow, and X-Ray Shadow display modes. 

    In an assembly file, toggle between Transparency On and Transparency Off display modes. 

Select a color/material to assign to a component. 
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3D Indicator 
 

While using the assembly, part modeling, and presentation environments, the 3D Indicator is displayed 
in the lower-left area of the graphics window. The Indicator displays your current view orientation in 
relation to the X, Y, and Z axes of the coordinate system. 

 
 

The 3D Indicator is positioned below and to the left of the assembly in this illustration. 

 Red: X-axis 

 Green: Y-axis 

 Blue: Z-axis 
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Orbit Tools 
 

You have two options to rotate the views of models and assemblies. The Free Orbit tool is used to 
rotate the model freely in screen space, while the Constrained Orbit tool is used to rotate the model 
about axes in model space. 

 

In the following illustration, the functionality of the Constrained Orbit tool is compared to that of a 
globe. As you rotate a globe about the north-south axis, the angle at which you view the globe does 
not change. The Constrained Orbit tool is similar in behavior. 

 
 
 

Access 
 

     Free Orbit 
 

 
Navigation Bar: Free Orbit 

 

Ribbon: View tab > Navigate panel 

Access 
 

     Constrained Orbit 
 

 
Navigation Bar: Constrained Orbit 

 

Ribbon: View tab > Navigate panel 
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Free Orbit 
 

The Free Orbit tool enables you to dynamically change your view of the model. It is important to 
remember that the model does not move, you change your viewing position with the Rotate tool. 

 
The following illustration outlines the rotation modes available. The cursor provides feedback on the 
rotation mode available. You click and drag to rotate the view and you can set the center of rotation by 
clicking a location on the model. 

 

 

    Click and drag here to rotate the view about all axes. 

    Click and drag here to rotate the view about a vertical axis. 

    Click and drag here to rotate the view about a horizontal axis. 

    Click and drag here to rotate the view about an axis normal to the screen. 

Position and click here to exit. 
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Axis Orbiting with Free Orbit 
 

The illustrations below display the behavior of the Free Orbit tool. When the model view is orbited 
using the horizontal cross hairs, the model rotates about an imaginary vertical axis based on the view. 
The model does not stay in the same view orientation. When the view is orbited without the use of the 
cross hairs, the rotation is about the center of the graphics area, or the center as assigned by the 
SteeringWheel. 

 
In the following example, using the Free Orbit enables you to view the top and bottom of the 
assembly as it is orbited. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Axis Orbiting with Constrained Orbit 
 

The Constrained Orbit tool places the axis of rotation on the vertical axis of the part or assembly. 
This functionality enables users to orbit around the vertical axis of their models as they would on a 
turntable. 

 
In the following illustrations, the Constrained Orbit tool is started. The orbit starts from the right 
horizontal cross hair. As the assembly is orbited, you can see the sides of the assembly, but your view 
orientation remains the same. 
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About the ViewCube 
 

The ViewCube tool displays by default in the graphics window. The ViewCube enables you 
to be more efficient because it is accessible at all times, and provides intuitive access to 
multiple view orientations. 

 

In the following illustration, the front view of the assembly is restored by clicking Front on the 
ViewCube. 

 
 
 

Definition of the ViewCube 
 

The ViewCube is a view manipulation tool that enables you to efficiently and intuitively change 
the viewing angle of your parts and assemblies. The ViewCube uses faces, edges, and corners 
as selection options to define viewing angles. 

 

 

ViewCube Example 
 

In the following illustration, the view of the monitor arm assembly is changed from the 
current isometric view (1) to an angle view between the top and front views (3). The new 
view orientation 
was obtained by selecting the ViewCube edge (2) between the Top and Front panels on the 
ViewCube. 
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Using the ViewCube 
 

You can access the ViewCube tools by selecting the face, edge, or corner of the ViewCube. Each face, 
edge, and corner of the ViewCube represents a different view orientation that corresponds to the 
model. The model rotates to the selected view orientation when the ViewCube is clicked. 

 

In the following illustration, the ViewCube is used to reorient the view of the assembly. 

 

Access 
 

     ViewCube 
 
 

Navigation Bar: ViewCube 

 
 

Ribbon: View tab > Windows panel > Toggle Visibility of the User Interface Elements > 
ViewCube 

 

 

Access 
 

     ViewCube Options 
 

Ribbon: Tools tab > Application Options > ViewCube > Options 

Shortcut: Right-click the ViewCube > Options 
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Introduction to ViewCube Options 
 

The ViewCube is displayed in the upper right corner of the graphics area of a new window by default. 
However, there are many options associated with the ViewCube that enable you to control both its 
appearance and behavior. 

 

 

ViewCube Display Options 
 

The following options control the display and appearance of the ViewCube. 

 

 

    Use this option to display the ViewCube. To hide the ViewCube, clear the check mark in the box 
next to the Show the ViewCube on Window Create option. When a check is in the box for the 
ViewCube option, you can choose to display the ViewCube in all 3D views or only in the current 
view window. 

    Use this option to place the ViewCube in a corner of the graphics area. Options include: Top Right, 
Bottom Right, Top Left, and Bottom Left. The default location is Top Right. 

    Use this option to set the ViewCube size. Options include: Small, Normal, or Large. The default 
setting is Normal. 

    Use this option to control the ViewCube opacity. When the cursor is near the ViewCube, the 
ViewCube is fully opaque. When the cursor is away from the ViewCube, the opacity of ViewCube 
is reduced. Options include: 0%, 25%, 50%, 75%, and 100%. The default setting is 50%. 
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ViewCube Behavior Options 
 

The following options control the behavior of the ViewCube. 

 

 
    Use this option to snap the ViewCube to a common view position when dragging the ViewCube 

through different view orientations. 

    When selecting a new view orientation using the ViewCube, use this option to fit the new view to 
the screen. 

    Use this option to create smooth transitions from the current view to the selected view. 

   Use this option to apply additional calculations for view orientation. 

    Use this option to set the default orientation of the ViewCube. 

Use this option to display a compass with the ViewCube. 
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Procedure: Using the ViewCube to View Models 
 

The following steps describe using the ViewCube to change the view orientation of your models and 
assemblies. 

 

1. Select the panel on the 
ViewCube to change the view 
orientation. 

 

 
 
 
 
 
 
 

2. Select the arrow to rotate the 
view orientation. 

 

 
 
 
 
 
 
 
 

3. Select a corner to change 
the view orientation to an 
isometric view of the panel 
view. In this example, the 
Bottom view is shown. 

 
 
 
 

 
4. An isometric view based on 

the Bottom view is displayed. 
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Procedure: Using the ViewCube to Orient Drawing Views 
 

The following steps describe using the ViewCube to set the view orientation of your models and 
assemblies for drawing views. 

1. Start the Base View tool. 
Click Place Views tab > Create 
panel > Base View. 

 

 
 
 
 
 
 
 

2. Select to change the view 
orientation. 

 

 
 
 
 
 
 
 
 

3. Select the desired ViewCube 
face. 

 

 
 
 
 
 
 

4. If necessary, rotate the model 
orientation. 

 

 
 
 
 
 
 

5. Accept the changes and place 
the view. 
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Procedure: Resetting the Current View as Front 
 

The following steps describe resetting the current view orientation to the Front view. 
 

1. Select the panel on the 
ViewCube to change the view 
orientation. 

 

 
 
 
 
 
 
 

2. Right-click the ViewCube, 
click Set Current View as 
Front. 

 

 
 
 
 
 
 
 

3. The ViewCube updates the 
orientation of the current 
view to Front. 
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Using Home View 
 

Using the Home View tool, you can manipulate your model to any orientation, then specify that view 
as the home view. In addition to being able to quickly return to that view, the home view is also the 
view that is shown each time you open the file. 

 
In the following illustrations, the view orientation of the assembly is restored to the home view when 
the Home View glyph next to the ViewCube is clicked. 

 

 
 

Orthographic View Home View 
 

 

Access 
 

     Home View 
 

 
 
 
 
 
 
 
 
 

The Home View glyph displays as you move your cursor to the ViewCube. 
 

 
In all modeling environments, you can quickly return to the home view using either of 
the following methods. 

 Right-click in the graphics window background. Click Home View. 

 Press the F6 function key. 
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Home View Options 
 

The following options control the model display when you use the Home View tool. 

 
 

    Use to define the direction of the view and the zoom magnification. 
 

    Use to define the direction of the view and automatically assign the zoom magnification as view 
all. 

 

 

Procedure: Setting the Home View 
 

The following steps describe how to set any view orientation to the home view. 
 

1. Use any view manipulation tools to orient 
the model. 
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2.      With the model in the desired orientation, 
right-click anywhere in the ViewCube. Click 
Set Current View as Home, and select Fixed 
Distance or Fit to View. 

 
 
 
 
 
 

 
3. With the model in a different orientation, 

click the Home View glyph. 
 

 
 
 
 
 
 
 
 

4. The view orientation returns to the specified 
home view. 
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Exercise: Manipulate Your Model 

Views 
 

In this exercise, you use the ViewCube and Home 
View tools to navigate through and restore different 
view orientations. 

 
 
 
 
 
 
 
 
 
 
 
 

 
The completed exercise 

 

 
1. Open INV_001_Getting Started.iam. 

2. To switch to an isometric view, click the top left 
corner of the ViewCube. 

 

Your view is displayed as shown. 

 

 

 

 

 

 

 

 

 

 

 
3. To view the current top view, on the ViewCube, click Top. 
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4. To rotate the view: 

 On the ViewCube, click and hold Top. 

 Drag the cursor toward the upper left 
corner of the ViewCube until the model is 
oriented as shown. 

 

5. To return the view orientation to the original 
Home view: 

 Move the cursor to the ViewCube. 

 When the house image is displayed (1), click 
the image. 

  

6. To redefine the current view as the Front view: 

 Move the cursor to the ViewCube. 

Select the Left Face. 

 Right-click the cube. Click Set Current View 
as Front. 

 
 

7. To view the model in an isometric view, click 
the upper left corner of the ViewCube. 

 

 

 

 

 

 

 

 

 

 

8. To redefine the Home view to the current view: 

 Right-click the ViewCube. 

 Click Set Current View as Home > Fit to 

View. 

 

9. To edit the options of the ViewCube: 

 Right-click the ViewCube. Click Options. 

 In the ViewCube Options dialog box, under 
Document Settings, place a check in the box 
next to the Show the Compass Below the 
ViewCube option. 

 Click OK. 
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10. To orbit the model: 

 Click View tab > Navigate panel > Free 
Orbit. 

 Click the right quadrant line and drag the 
cursor to the left until you can see the 
bottom view of the computer housing. 

 Right-click anywhere in the graphics 
window. Click Done. 

 
 

11. On the ViewCube, click Home View. 

12. To constrain orbit the model: 

 Start the Constrained Orbit tool. 

 Click the right quadrant line and drag the 
cursor to the left. 

 Right-click anywhere in the graphics 
window. Click Done. 

Notice that the orbit pivots about the axis. 
 

 

 

 

 

 

13. To turn off the display of the ViewCube: 

 Click View tab > Windows panel > Toggle 
Visibility drop-down > ViewCube. 

 Click the option again to turn the ViewCube 
on. 

 
 

14. To return to your previous view: 

 Press F5. 

 Your previous view is restored. 

 Press F5 again to return the view previous 
to the current view. 

 

15. To rewind to a specific view: 
 Press CTRL+W to activate the 

SteeringWheel. 
 Click Rewind and hold down the cursor. 

 Drag your cursor over the views filmstrip 
and release the mouse button over the 
specific view you want to restore. 

 Continue to use the Rewind tool to restore 
other views. 

 
 

16. Close the SteeringWheel tool. 

17. Close all files. Do not save. 
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Lesson: Designing Parametric Parts 
 
 
 
 

This lesson describes the characteristics of parametric part models and the overall process of their 
creation. 

 

Familiarity with the basic characteristics of parametric models simplifies the process of learning and 
applying the tools to create such models. 

 

A parametric part model is shown with dimensions displayed in the following illustration. 
 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Describe the characteristics of a parametric part model. 

 Identify guidelines for capturing design intent. 

 State the general workflow for creating parametric part models. 

 State the characteristics of the ribbon and browser when in the part environment. 

 Create a basic parametric part. 
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About Parametric Part Models 
 

You can create and edit 3D geometry using parametrics. Parametrics use geometric and dimensional 
constraints to precisely control the shape and size of a 3D model. 

 

A typical parametric part is shown in the following illustration, consisting of both 2D sketch geometry 
with dimensional constraints and the resulting 3D solid geometry. 

 

 
 
 

Parametric Part Models 
 

A parametric model is a 3D model that is controlled and driven by geometric relationships and 
dimensional values. You typically create parametric models from a combination of 2D sketches and 
3D features. With a parametric part model, you can change a value of a feature and the part model is 
adjusted according to that value and any existing geometric constraints. 

 

 

Sketched Features 
 

Sketched features are features that add or remove material and are typically based on a 2D closed 
loop sketch. The sketch can be composed of lines, circles, and arcs. 

 
Sketched features are shown in the following illustrations. After the sketch is used by a feature, it is 
considered consumed by the feature and is displayed nested below that feature in the browser. 
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Placed Features 
 

While sketched features start from a sketch, placed features have an internally defined shape for 
adding or removing material. You need to determine only where and at what size the feature should 
be created. Holes and fillets are two commonly used placed features. 

 

Placed features are shown in the following illustration by the Fillet4 and Chamfer2 highlights. 
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Base Features 
 

The first feature that you create is typically a sketched feature. This first feature is also referred to as 
the base feature. All subsequent features either add material to or remove material from the part 
model. 

 

Extrusion1 represents the base feature of the part in the following illustration. 
 

 
 

    Base sketch and base feature 
 

 
 

Progression of a Parametric Model 
 

A parametric model progresses through the stages of its creation in the following illustrations. The 
model is transformed after the size of the base feature is increased upon inclusion of sketched and 
placed features. 

 
 
 
 
 
 
 
 
 
 

 
Initial sketch is created Base feature is created 
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Secondary sketch is added Secondary feature is created from secondary sketch 
 
 
 
 
 
 
 
 
 
 
 

Fillets (placed features) are added Length is changed in initial sketch, causing part to update 
 
 

 

Capturing Design Intent 
 

Regardless of the type of design that you are creating, you should always aim to capture the intent 
of the design as early in the process as possible. It is common for a design to change as a result 
of inherent design problems or future revisions. The ability to capture design intent makes these 
potential changes much easier to implement. 

 

Design intent has been captured in the following illustration by using a simple formula (2) to calculate 
the outside diameter of the part based on the inside diameter (1). 
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About Capturing Design Intent 
 

When you capture your design intent, you add intelligence to your design. This intelligence can exist in 
several different forms. It can reside in a simple geometric constraint that forces two lines to be 
parallel or two circles to be concentric. Intelligence can also reside in dimensional constraints that 
force a feature's dimension to remain constant or enable the dimension to change based on a built-in 
formula. 

 

Just as each part design is unique, so is the design intent for each part. Capturing this intent is a 
process in which you match the design intent with a feature or capability that makes it possible to 
create the design in the most efficient way while enabling you the maximum flexibility in making 
changes. 

 

Different examples of design intent are shown in the following illustration being captured at the 
earliest stage of the design. The toolbars show constraint symbols (glyphs). 

 

 

 

    Toolbars displaying geometric constraints applied to the geometry. Each icon illustrates a specific 
type of geometric constraint that has been applied to the sketch, and as a result captures a 
portion of the design intent. For example, the right-most icon on the top toolbar indicates a 
tangent constraint between the top horizontal line and the arc on the right side of the sketch. 

    Coincident constraints are displayed by a yellow dot at the coincident point between two 
segments. 

    Dimensional constraints applied to the geometry. These types of constraints capture design 
intent by defining the size of objects in the sketch. 
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Guidelines for Capturing Design Intent 
 

Consider the following guidelines when you begin a new part design. Each of the following points 
indicates an area in which design intent can be captured. 

 Identify geometric relationships. For example, a feature's length may be directly related to its 
width, or the width or length of another feature. 

 Identify areas of the design that may be prone to change as a result of design problems or 
revisions. 

 Identify areas of symmetry or areas where features are duplicated or patterned. 

Once you have identified the potential ways to capture your design intent, you can then match that 
intent with a specific Inventor tool or capability. 

 

 

Example of a Part Design Capturing Design Intent 
 

A simple parametric design of a plastic indexer is shown in the following illustrations. Each one reflects 
how a specific guideline of the design intent is captured and implemented into the design with a 
parametric feature. 

 

 

Capturing Geometric Relationships in Design Intent 
 

Design intent for the indexer part dictates that the outside diameter should be equal to twice the 
inside diameter in the following illustration. The design intent has been captured with the use of a 
simple formula in the dimension parameter. 

 

 
 

    Inside diameter of the indexer part. 

Outside diameter is determined by a formula equal to twice the inside diameter. 
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Capturing Design Intent for Features That Are Prone to Change 
 

Design intent has been captured to allow for potential design changes in the following illustration. As 
the thickness of the part changes, so does the depth of the slots. This result is achieved by setting the 
depth parameter for the slot to All, ensuring the slot always extrudes completely through the part. 

 

 
 

    With a 3 mm part height, slot depth cuts though the entire part. 
 

    With a change in part height from 3 mm to 6 mm, the slot depth continues to cut through the 
entire part. 

 

 

Capturing Symmetry in Design Intent 
 

Design intent for symmetry has been captured in the part design in the following illustration by using 
a parametric pattern feature. By capturing the design intent in this manner, you can easily change the 
number or angled spacing of slots by editing the feature. 
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    Original slot feature. 
 

    Circular pattern being created to duplicate the slot feature in a precise and easily editable 
manner. 

 
 

 

Creating Parametric Part Models 
 

The overall process for creating parametric part models is very flexible. With this flexibility, you can 
concentrate on your design, design intent, and essential design features instead of being limited by a 
rigid modeling process. 

 

In the following illustration, what begins as a simple circle is transformed into fully parametric model. 
 

 
 
 

Process: Creating a Parametric Part 
 

The following steps provide an overview of the process for creating a parametric part. 

1. Create the initial sketch profile.  
 

2. Capture the design intent by applying 
constraints and dimensions. 
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3. Use the part feature tools to create 
the base feature. 

 

 
 
 
 
 
 
 
 

4. Continue to develop the design by 
creating additional sketched and 
placed features. 

 

 
 
 
 
 
 
 
 
 

Part Design Considerations 
 

When creating a parametric part model, try to determine the basic building blocks of the part; that 
is, how the part can be designed and built in stages. Also determine which aspects of the model are 
the critical aspects of the part. You create those aspects first in the order of their importance and 
relationship. 

 

 

Part Design Workflow 
 

The following steps represent the overall workflow for creating parts. 

 Use one of the part templates provided to create a new part. 

 All new parts you create have a blank sketch automatically placed. Create the profile of your 
geometry on the initial sketch. 

 Use sketched features such as Extrude and Revolve to create your base feature. 

 Create additional sketched and placed features as required to generate the necessary 3D 
geometry. 
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Part Design Environment 
 
 

When you are editing a part file and the part environment is active, the ribbon and browser are 
displayed with the tools and information relevant to this environment. 

 

The part design environment is shown in the following illustration. 
 

 
 

    Part Features on Ribbon Model Tab: Displays part modeling tools while in part modeling mode. 

Browser: Displays the feature history for the part or assembly. 
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Model Tab 
 

The Model tab is displayed when you are editing a part model. You use these tools to create sketched 
and placed features on the part. 

 

 
 
 

Browser 
 

When you use the browser in the part design environment, it displays the Origin folder containing the 
default X, Y, and Z planes, axes, and center point. It also lists all features you use to create the part. 
Features are listed in the order in which they are created. 
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Exercise: Create a Parametric Part 
 

In this exercise, you create a simple bracket by 
extruding the predefined sketch. You then edit the 
part by changing some of the parameters and add a 
fillet feature. 

 
 

The completed exercise 

  

 

 

1. Open INV_002_Parametric_Part.ipt. 

The initial sketch profile has been created and constrained.  
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2.  Right click sketch 1 in the browser > Select Edit          

Sketch. 

 

3.  Add the dimension that will control the length 

and height of the Simple Conveyor. 

§ Click the Dimension Command. 

 

 

§ Select the top line of the rectangle and then 

click to place the dimension.  If necessary, 

click the new dimension to edit the value. 

§ Type in the new parameter value as shown 

below.  Length=75 

§ Click the check mark to update the value. 

 

 

§ Repeat the Dimension process and add 

another dimension to a vertical. 

§ Type in the new parameter value as shown 

below.  Height=30 

 

§ Click the check mark to update the value. 

 

 

4.  Finish the Sketch. 

§ Click the Finish Sketch Button. 

 

 

5. Click Model tab > Create panel > Extrude. 

 For Distance, enter Width=30 (1). 

Click the Symmetric Extrusion Button (2). 

 Click OK. 

 

  



73 Chapter 5: Autodesk Inventor Getting Started 

 
 

6. In the browser, expand the Extrusion feature. 

 The initial sketch is consumed by the 3D 
extrusion feature. 

 

7. In the browser, double-click Sketch1. 

 Double-click the 30 mm vertical 
dimension. 

 In the Edit Dimension dialog box, enter 35. 

 Press ENTER. 

 On the Sketch tab, click Finish Sketch. 

The part is updated to reflect the new 
dimension value. 
 

 

 
 

8. In the browser, right-click the Extrusion1 
feature. Click Edit Feature. 

 For Distance, enter 40 mm. 

 Click OK. 

The parametric part updates to reflect the new 
parameter value.  
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9. Click Model tab > Modify panel > Fillet. 

 In the graphics window, select the 
outside edges as shown. 

 For Radius, enter 6. 

 Click OK. The fillet feature is updated. 

 
 

10. Close all files. Do not save. 
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Chapter Summary 
 
 
 
 

By using the context-sensitive user interface and the tools that are available, you can quickly create 
basic parametric geometry. This chapter introduced you to the Autodesk Inventor user interface and 
concepts supporting parametric part design and capturing design intent. 

Having completed this chapter, you can: 
 

 Identify the main user interface components that are common to all Autodesk Inventor design 
environments and describe how to access different tools. 

 View all aspects of your design by efficiently navigating around in 2D and 3D space. 

 Describe the characteristics and benefits of a parametric part model. 
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Chapter 
 

6 
 

 
 
 

Basic Sketching Techniques 
 

 
 

The majority of the features that you create on your parametric part models start with constrained 2D 
sketches. Intelligent and predictable part designs require a thorough understanding of how to create 
2D sketches and how to capture design intent by applying geometric and dimensional constraints. 

 
Objectives 

 

After completing this chapter, you will be able to: 

 Use sketch tools to create 2D sketch geometry. 

 Use geometric constraints to control sketch geometry. 

 Apply parametric dimensions to your sketch geometry. 
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Lesson: Creating 2D Sketches 
 
 

 
This lesson describes how to create 2D sketch geometry using sketch tools. 

 

Nearly every parametric part begins with a 2D sketch, and every sketch you create defines a 2D plane 
on which your sketch geometry is created. These sketches not only form the foundation of each part, 
but are also used throughout the design process. 

 

A basic parametric part for which several sketches were used to create its features is shown in the 
following illustration. 

 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

          Describe the differences between standard 2D sketching and 2D parametric sketches. 

          Explain the options for aligning geometry in 2D sketches. 

          Reorient the initial sketch to a different plane. 

          Use sketch tools to create sketch geometry. 

          Describe guidelines for creating successful sketches. 
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About Sketching 
 

The sketch environment is where all 2D sketching takes place. When you create a new 2D sketch or 
edit an existing sketch, the sketch environment is activated. 

 

The sketch environment is activated as the sketch is edited, as shown in the following illustration. 
 

 

 

 

    When the sketch environment is active, the Sketch tab is displayed. 

    The active sketch is highlighted in the browser while all other elements are dimmed. 
 

     When you activate the sketch environment, the grid lines and X and Y axes are displayed by 
default in the graphics window. 

 

 

Parametric Sketching 
 

A parametric sketch forms the base of each parametric part you create in Autodesk Inventor. Unlike 2D 
sketches that you can create in a nonparametric 2D application, when you create a sketch in Autodesk 
Inventor, you immediately begin to add intelligence to your part and capture design intent. 
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Constraints in Parametric Sketches 
 

A parametric sketch consists of 2D geometry on which constraints are applied to control the size 
and potential behavior of the 2D geometry. There are two different types of constraints, geometric 
constraints and dimensional constraints. As you create geometry in Autodesk Inventor, some 
geometric constraints are applied automatically. 

 

The symbols next to the geometry in the following illustrations are known as "glyphs" and represent 
2D constraints. Glyphs are displayed while a sketch tool is active and you are sketching. The use of 2D 
constraints is one way in which design intent is automatically captured as you are creating your sketch 
geometry. 

 

 
 

    Indicates a parallel constraint being applied to the bottom horizontal line. 

    Indicates a parallel constraint with the top horizontal currently being drawn. 

Indicates a tangent constraint between the arc and the horizontal line being drawn. 
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You must add dimensional constraints to each element of the sketch for which you need to specify 
a dimension. Both types of constraints applied to sketch geometry are shown in the following 
illustration. 

 

 
 

      

Geometric Constraints 

Geometric constraints, which are applied to geometry, are represented by the symbols on the 
following toolbar. Each type of constraint is represented with a unique symbol. 

 

 
 

From left to right: 

 Perpendicular constraint that forces the line to remain perpendicular to the left-side vertical 
line. 

 Tangent constraint, forcing the line to be tangent to the arc. 

 Parallel constraint indicating that the line must remain parallel to the lower horizontal line. 

 Horizontal constraint that forces the bottom line to be parallel the X-Axis of the sketch. 
 

         Coincident Constraints 
These constraints force the endpoints of lines to remain coincident or connected. 
 

    Dimensional Constraints 
These dimensions control the size of the objects. The diameter dimension controls the size of the 
circle, while the linear dimension controls the length of the horizontal line. 

 

 

Parametric Sketches Versus Precise Sketches 
 

Precise sketches created with AutoCAD®, by default have no parametric intelligence. A change in a 
dimension does not force the geometry to update to reflect the new dimension value. Parametric 
sketches in Inventor enable you to click and drag the geometry in directions allowed by the existing 
constraints while all conditions controlled by the constraints are maintained. For example, if you drag 
the outer arc to a different size, the horizontal lines remain tangent, horizontal, and one unit in length. 
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Example 
 

The effect of 2D geometric constraints is shown in the following illustration, where an element of the 
sketch is dragged to reshape the geometry. 

 

 
 

    Original position of line element being moved. 

    Centerline element used with symmetry constraints. 

   Cursor dragging line to a new location. 

    New location of the line as it is being moved. Notice the same movement on the opposite side of 
the sketch. 

    Dimensional constraint positioning the edge of the part. A change in this dimension would be 
reflected on both sides of the centerline. 

 
To achieve the same modifications in a nonparametric sketch, you would have to duplicate each edit 
on both sides of the centerline. 

 

 

Fully Constrained Sketch Geometry 
 

When you apply constraints to a sketch, each constraint removes degrees of freedom from the 
geometry. By removing degrees of freedom, you limit the direction or amount a given part of the 
sketch can be moved or resized. When a sketch has all degrees of freedom removed, it is considered 
to be fully constrained. 

 

While it is not necessary to fully constrain a sketch before creating 3D features, it is recommended. A 
fully constrained sketch is predictable in the manner in which it can change, and reduces the number 
of errors as changes are made to the parametric part. 
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Identifying the Constraint Conditions 
 

Once the sketch is fully constrained, the profile will be a single color. 
 

Inventor uses color differences and numerical feedback to identify fully constrained as opposed to 
under constrained geometry. Represented in the following illustration, the lighter colored geometry 
requires either geometric or dimensional constraints to fully constrain the sketch. You can use these 

colors to identify which elements still require constraints. At the bottom right of the interface, 
the application indicates "6 dimensions needed" to fully constrain the sketch geometry. 

 

 
 

Colors used to show constraint conditions vary depending on your color configuration for 
Inventor. Color differences occurring while using the Presentation configuration (white 
background) are the least noticeable. 

 
 

 
As your sketch increases in complexity, the number of constraints or 
dimensions required to fully constrain the sketch also increases. 

 
 
 

 

Point Alignment 
 

When you are creating sketch geometry and you want to align to a point projected from existing 
geometry, you have two different workflows you can follow depending on the current setting for point 
alignment. To utilize and benefit from automatic point alignment, you need to understand what point 
alignment is and where to toggle it on and off. 

The following illustrations show different point alignments automatically occurring during the creation 
of sketch geometry. 
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Point Alignment 
 

The automatic alignment of points during sketch creation is an option that you can toggle on and off. 

Point alignment during sketch geometry creation enables you to create your sketch geometry with the 
alignment you require as you create it. You can have the endpoints of the sketch geometry align to an 
extension, be perpendicular, or align to a virtual intersection of other sketch geometry. You achieve 
these point alignment locations by the position of the cursor. You do not need to scrub the cursor over 
the intended referencing geometry first. 

 

The automatic point alignment option is set globally for the installation of Autodesk Inventor. You 
toggle on and off point alignment by selecting or clearing the Point Alignment On check box on the 
Sketch tab in the Application Options dialog box. 
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Reorienting the Initial Sketch 
 

Each time you create a new part, the default configuration places a new sketch on the XY plane. In 
some cases you may want to begin sketching on a different plane. You can either delete the initial 
sketch and create a new one, or you can reorient the initial sketch including any geometry that might 
have been drawn. 

 

The initial sketch of concentric circles has been reoriented from the XY plane to the YZ plane in the 
following illustration. 

 

 
 
 

Procedure: Reorienting the Initial Sketch 
 

The following steps describe how to reorient the initial sketch to a different plane: 

1. If the sketch is active, exit the sketch environment. 

2. In the browser, right-click the initial sketch and select Redefine. 
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3. In the browser, expand the Origin node and select a plane to reorient the sketch. 

 

 
 

4. The sketch and any existing geometry are reoriented to the selected plane. 
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Basic Sketching Tools 
 

A profile or path sketch can consist of objects such as points, lines, arcs, circles, and dimensional 
geometry. When the environment of a sketch plane is active, the ribbon switches to display the 
available sketch tools. The Sketch panel contains all the tools for creating, manipulating, and controlling 
sketch geometry. 
 

 
 
 

Sketch Tool 
 

By default, the first sketch in a new part is automatically created on the XY plane. If you require 
additional sketches, you use the Sketch tool to create them manually or to activate existing ones. The 
Sketch tool prompts you to select a plane to create a sketch, or to select an existing sketch to edit. You 
can select planes or sketches in the graphics window or in the browser. You can create a new sketch on 
a part face, origin plane, or work plane. 

 

 

Access 
 

     Create 2D Sketch 
 
 

 
Ribbon: Model tab > Sketch panel 
 

 
 

Shortcut Menu: Right-click a selected face or plane 
 

 

Exiting a Sketch 
 

To exit the sketch, use one of the following methods: 

 On the ribbon, click Finish Sketch. 

 Right-click in the drawing area and click Finish Sketch. 



12 Chapter 6: Basic Sketching Techniques  

Procedure: Creating Lines 
 

The following steps describe how to create lines in your sketch: 

1. Start the Line tool. Select a start point for the line segment. 

2. Drag in the direction you want to draw the line. Note that the constraint glyph (1) is displayed. 
This glyph indicates the type of constraint being applied to the line segments. 

 

Select a point to end the line segment. 

3. Drag in the direction of the next line segment, again noticing the constraint glyph indicating the 
automatic constraint. 

 

Select a point to end the line segment. 

4. Continue drawing line segments as required. 

If the constraint glyph represents a constraint that you would like to change, brush the cursor 
against the geometry on the sketch for which you want to apply the constraint and then 
continue drawing the line segment. 

5. Continue drawing line segments as required. 

 
 

6. Right-click in the graphics window and select Done. 
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Procedure: Creating Circles 
 

 

The following steps describe how to create circles in your sketch. 
 

1. To create a center point circle, start the Center Point Circle tool. Select the center point of the 
circle. 

 
 

2. Drag to a location representing the outside perimeter of the circle. Select that point to create the 
circle. 

 
 

3. Right-click in the graphics window and select Done. 

4. To create a three-point tangent circle, start the Tangent Circle tool. 

5. Select three parts of the geometry for the circle to be tangent to. 

 
 

6. Right-click in the graphics window and select Done. 
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Procedure: Creating Perpendicular or Tangent Arcs 
 

The following steps describe how to create a perpendicular or tangent arc in your sketch using the 
Line tool: 

1. Start the Line tool. 

 
 

2. Click and drag the endpoint of an existing line or arc. Temporary tangent and 
perpendicular construction lines are displayed at the arc start point. 

 To create a perpendicular arc, click and drag in the direction of the perpendicular 
construction line. 

 

 To create a tangent arc, click and drag in the direction of the tangent construction  

line. 
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3. Continue to drag the endpoint to the final endpoint of the arc and release. 

 
 

4. Right-click in the graphics window and select Done. 
 

 

Procedure: Creating Three Point Arcs 
 

The following steps describe how to create three-point arcs in your sketch: 

1. Start the Three Point Arc tool. Select the start point of the arc. 

 

2. Select a point for the endpoint of the arc. 
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3. Drag to size the arc. Depending on existing geometry and arc size, constraint glyphs may be 
displayed. 

 
 

4. Right-click in the graphics window and select Done. 
 

 

Procedure: Creating a Two Point Rectangle 
 

The following steps describe how to create a two point rectangle in your sketch: 

1. Start the Two Point Rectangle tool. 

2. Select a point representing the first corner of the rectangle. 

3. Select a point representing the opposite corner of the rectangle. 

 
 

4. Right-click in the graphics window and select Done. 
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Guidelines for Successful Sketches 
 

You can use several methods to create closed shapes. You can use tools such as the rectangle, circle, 
or polygon, or you can constrain sketch geometry so that separate sketch elements come together 
to create a closed shape. At times you may need to create sketch geometry that is not closed, for 
example, a path for a sweep feature or to create a surface; however, these guidelines focus on creating 
closed profiles. 

 

 

Sketch Guidelines 
 

Follow these guidelines for successful sketching: 

 Keep the sketch simple. Do not fillet the corners of a sketch if you can apply a fillet to the edges of 
the finished 3D feature and achieve the same effect. Complex sketch geometry can be difficult to 
manage as designs evolve. 

 Repeat simple shapes to build more complex shapes. 

 Draw the profile sketch roughly to size and shape. 

 Use 2D constraints to stabilize sketch shape before setting size. 

 Use closed loops for profiles. 

 
Example of Sketching Guidelines 

 
In the following illustration, the same part results from two different sketches. In the image on the left, 
the sketch contains no fillets. The fillet features are created on the 3D part as placed features. 

 
In the image on the right, the fillet features were placed at the sketch level. While this results in the 
same part shape, this method complicates the sketch geometry. 
 

 

 
 

Correct: Sketch with no fillets Incorrect: Sketch with fillets 
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Exercise: Create 2D Sketches 
 

In this exercise, you create a simple Support Bracket 
extrusion using the basic sketching tools. 

 

The completed exercise 
 

 
Completing the Exercise 
To complete the exercise, follow the 

steps in this book or in the onscreen 

exercise. In the onscreen list of 

chapters and exercises, click Chapter 

2: Basic Sketching Techniques. Click 

Exercise: Create 2D Sketches. 
 
 

1. Create a new part using the Standard (mm).ipt 
template. 

 On the Quick Access toolbar, click New. 

 In the New File dialog box, click the Metric 
tab. 

 Select Standard (mm).ipt. 

 Click OK. 

2. Create a basic shape. 

 Start the Line tool. 

 Select a point near the origin. 

 Drag the cursor to the right, making 
certain the horizontal constraint glyph 
displays 
near the cursor. 

 Select the second point of the line 
approximately 25 mm from the start 
point. 

Note: The line length is displayed as it is 
drawn in the lower-right corner of the 
application window. 

 

 
 

 

3. With the Line tool still active, create an 
inline arc segment. 

 Drag the endpoint of the line segment to 
the right to define the direction of tangency 
for the arc. 

 Release the left mouse button when 
the endpoint of the arc is directly 
above the start point. Use the grid 
spacing in the following illustration to 
define the size of the arc. 
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4. With the Line tool still active, draw another line 
segment to the left. 

 Move the cursor to the left until it is 
positioned vertically above the start point 
of and parallel to the first line segment. 
Ensure that the constraint glyphs are 
displayed as shown in the following 
illustration. 

 Click to create the line segment. 
 

 
 

 

5. Complete the sketch by creating the last line 
segment as shown. 

 
 

6. On the ribbon, click Finish Sketch to exit the 
sketch. 

7. On the ViewCube, click the top-right corner to 
view the sketch in an isometric view. 

8. Extrude the shape 5 mm. 

 Click Model tab > Create panel > Extrude. 

 In the Extrude dialog box, for 
distance, enter 5 mm. 

 Click OK. 
 

 
 

9. To create a new sketch on the front face of 
the part. 

 Right-click the front face of the part. 

 Select New Sketch. 
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10. Draw a rectangle on the top surface. 

 Start the Two Point Rectangle tool. 

 Select point 1 as shown. 

 Select point 2 as shown. 

Note: When selecting the points for the 
rectangle, make sure the coincident constraint 
glyphs appear. Depending on how your Sketch 
Options are set, the edges on the face may not 
be projected and thus the coincident 
constraints will not appear. If this occurs, right-
click in the graphics window while sketching the 
rectangle and select the AutoProject option. 

 

 
 

 
11. On the ribbon, click Finish Sketch to exit the 

sketch. 

12. Extrude the new sketch a distance of 10 mm. 

 Start the Extrude tool. 

 Select a point inside the rectangle. 

 In the Extrude dialog box, enter 10 mm. 

 Click OK. 

 

 
 

 

13. Close all files. Do not save.
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Lesson: Geometric Constraints 
 
 

This lesson describes geometric constraints and how to apply them to sketch geometry. You use 
geometric constraints to control sketch geometry. For example, a vertical constraint applied to a line 
segment forces that line segment to be vertical. A tangent constraint added to an arc forces that arc to 
remain tangent to the geometry that has been constrained. 

 

 
Geometric constraints represent the foundation of all parametric design. Using these objects, you can 
capture your design intent and force the geometry to follow the rules set by each constraint. 

 

2D constraints on a part sketch are shown in the following illustration. 
 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Describe geometric constraints and their effects on geometry. 

 Explain how constraint inference and persistence provide complete control over when, where, and 
which constraints are created in a sketch. 

 Apply geometric constraints to sketch geometry. 

 View and delete constraints using the Show Constraints tool. 

 State key guidelines for successful constraining. 

 Explain how to display sketch degrees of freedom and how they can assist in creating fully 
constrained sketches. 
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About Geometric Constraints 
 

Several different types of constraints exist, each with a specific capability and purpose. The selection 
you choose depends largely on the design intent. 

 

As you create sketches, some constraints are inferred (applied automatically). In most cases the 
inferred constraints are sufficient for your initial constraints. As you continue to develop the sketch, 
you may need to add additional constraints to properly stabilize the sketch geometry. 

 

The effects of constraints on sketch geometry are shown in the following illustration. The sketch on 
the left was purposely drawn using only some of the inferred constraints. The sketch on the right is 
the result of adding additional constraints such as perpendicular, parallel, and collinear. 
 

 

 
 
 
 

    Initial inferred constraints only. 

After applying constraints. 
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Definition of Geometric Constraints 
 

Geometric constraints stabilize sketch geometry by placing limits on how the geometry can change 
when you attempt to drag or dimension it. For example, if a horizontal constraint is applied to a line, 
that line is forced to be horizontal at all times. 

 

In the following illustration, the circle on the right is being resized. Tangent constraints have been 
applied to the lines. As the circle is resized, the lines remain tangent to both circles. 

 

 
 
 

Constraint Types 
 

You can use the following constraint types to constrain your sketches: 

 
 

 

Constraint 
 

Description 

 

Before Constraint 

 

After Constraint 

 

 
 

 

 

Tangent: Use to make selected 
elements tangent to one 
another. 

 

 

 

 

 

 
 

 
 

 

 

Perpendicular: Use to make 
selected elements 
perpendicular to one another. 

 

 

 

 

 

 
 

 
 
 
 

 

Parallel: Use to make selected 
elements parallel to one 
another. 

 

 
 

 

 
 

 

 
 

 
 

 

Coincident: Use to make two 
points exist at the same point 
location. 

 

 
 

 

 
 

 

 
 
 

 

 

Concentric: Use to force two 
arcs, circles, or ellipses to 
share the same center point. 
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Constraint 
 

Description 

 

Before Constraint 

 

After Constraint 

 

 
 

 

 

Collinear: Use to force two 
lines or ellipse axes to lie on 
the same line. 

 

 
 

 

 

 
 
 

 

 
 
 

 

 

Horizontal: Use to force the 
element to be parallel to the 
X axis of the current sketch 
coordinate system. 

 

 
 
 
 

 

 
 
 
 

 

 
 
 

 

 

Vertical: Use to force the 
element to be parallel to the 
Y axis of the current sketch 
coordinate system. 

 

 
 

 

 

 
 

 
 

 
 

 
 
 
 

 

Equal: Use to force two 
elements to be of the same 
length. In the case of arcs or 
circles, the radius becomes 
equal. 

 

 
 

 

 

 
 

 
 

 

 
 
 
 
 
 
 

 

 

Fix: Use to cause an element 
to be fixed in location to the 
current sketch coordinate 
system. 

 

 
 

 

 
 
 

 
 

 
 

 
 

 

Symmetric: Use to cause the 
elements to be symmetrically 
constrained about a line. 

 

 

 

 

 
 

 

 
 

 
 
 
 

Smooth: Use to cause 
a curvature continuous 
condition (G2) between a 
spline and another curve, line, 
arc or spline. 
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Horizontal Constraint Example 
 

In the following illustration, the application of a horizontal constraint is shown. The two circles are 
constrained to the endpoints of the line. The design intent requires these two circles to remain 
aligned. After the horizontal constraint is applied to the line, the line updates and the circle on the 
right side moves with the line. 
 

 
 
 
 

About Constraint Inference and Persistence 
 

By default, when you create sketch geometry, that geometry can automatically have geometric 
constraints applied to it. To control when geometric constraints are automatically inferred and applied 
in a sketch, you must understand what it means to have constraints inferred and the meaning of 
persistence, and where and how to change their related settings. 

 

In the following illustration, a sketch is shown being created alongside the completed sketch with its 
geometric constraints displayed. As the sketch geometry was being created, the geometric constraints 
were automatically added to the geometry. 

 
 
 

Definition of Constraint Inference and Persistence 
 

As you are working in a sketch, several types of geometric constraints can be automatically applied to 
sketch geometry as it is created. This includes constraints such as perpendicular, parallel, coincident, 
horizontal, vertical, and tangent. The automatic application of geometric constraints is referred to as 
constraint inference and persistence. 

 

When you are sketching geometry and a valid geometric constraint to another sketch geometry is 
identified, that constraint is said to be inferred. When a constraint is inferred, the constraint symbol 
for that geometric type displays. If you click to create the sketch geometry when the constraint symbol 
is displayed, and if the inferred geometric constraint is automatically applied to the sketch geometry, 
then that constraint is said to be persistent. Depending on your settings, that inferred constraint may 
or may not be automatically added to the sketch geometry. 

 

The evaluation of sketch geometry for constraint inference occurs automatically based on the location 
and relationship of the geometry being sketched to the existing geometry around it. You can have 
aspecific piece of sketch geometry inferred by passing the cursor back and forth over the geometry. 
Passing the cursor back and forth over the sketch geometry is referred to as scrubbing the geometry. 
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You can control the automatic application of geometric constraints through the use of the Constraint 
Inference and Constraint Options settings or the CTRL key. 

 

By changing the Constraint Inference and Constraint Persistence options, you control whether 
constraints are automatically inferred and applied, only inferred but not applied, or neither inferred 
nor applied. When you press and hold CTRL as you create sketch geometry, no geometric constraints 
are inferred or applied. 

 

Having geometric constraints automatically applied to the sketch geometry as you create it means you 
decrease the number of constraints required later to control the sketch geometry's shape, size, and 
position. 

 

 

User-Controlled Constraint Inference and Persistence 
 

As you create sketch geometry, the automatic inference of constraints is dependent on the setting of 
the Constraint Inference option, and the settings for the Constraint Options, as set in the Constraint 
Options dialog box. The actual creation of an inferred constraint in the sketch is dependent on the 
Constraint Persistence option. 
 

 

 

Icon 
 

Option 

 

Description 

 

 

 

Constraint 
Inference 

This setting controls whether or not sketch constraints are inferred. 

 

 

 

Constraint 
Persistence 

 

This setting controls whether or not inferred sketch constraints are 
created. 

 

 

You change the settings for the Constraint Inference and Constraint Persistence options on the 
Constrain panel of the ribbon. There are three different combinations of settings you can set for 
constraint inference and persistence. You can have both settings off, only the inference setting on, or 
both on. As you are creating sketch geometry, you can change the settings for Constraint Inference 
and Constraint Persistence to match your requirements for the sketch geometry you are about to 
create. 

The following table illustrates the settings for Constraint Inference and Constraint Persistence and 
describes the various behaviors associated with these options. 

 
 

 

Option 
 

Description 

 

 
 

 
 

 

Both Off: As you create sketch geometry, you do not infer geometric constraints other 
than coincident constraints. Therefore, the sketch geometry does not automatically 
have geometric constraints like horizontal, parallel, or perpendicular applied to its 
geometry. Lines can still snap to horizontal and vertical, and point alignment can still 
occur if it is enabled. 

 

 
 

 
 

 

Inference Only: As you create sketch geometry, you can infer geometric constraints like 
parallel, perpendicular, and tangent. However, the only geometric constraints 
automatically applied to the sketch are coincident constraints. Use this setting to get 
the initial sketch geometry aligned and positioned as you require without adding initial 
geometric constraints. 

 

 
 

 

Both On: As you create sketch geometry, you can infer geometric constraints such as 
parallel, perpendicular, and tangent. Any inferred constraint is automatically added 
and applied to that sketch geometry. 
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Constraint Inference Options 
 

You access the Constraint Options dialog box by selecting Constraint Options in the shortcut menu 
when a sketch is active for editing. Within the Constraint Options dialog box, there are two areas for 
setting constraint inference: Selection for Constraint Inference and Scope of Constraint Inference. 

 

In the Selection for Constraint Inference area, you select which geometric constraints you want to infer 
as you are creating new sketch geometry. For these options to be selectable, the Constraint Inference 
option must already be on. 

 

In the Scope of Constraint Inference area, you set either to automatically evaluate all sketch geometry 
to infer constraints from, or to use only the sketch geometry you preselect. 
 

 

 

Example Settings and Uses for Constraint Inference and Persistence 
 

The way you set the Constraint Inference and Constraint Persistence options depends on the sketch 
geometry you are creating and the workflow you want to follow. For example: 

 If you are sketching geometry that needs to be at varying angles other than horizontal, vertical, 
parallel, and perpendicular to other geometry, you should have both settings off so the geometry 
does not align in that manner nor have geometric constraints applied. 

 If you want to create the sketch geometry and manually apply each geometric constraint so it has a 
specific constraint scheme, then you should have both settings off or have only the Constraint 
Inference option on. 

 If you want to infer constraints and apply the constraints to the sketch geometry as you create it, 
then you should have both settings on. 
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In the following illustration, the progressive steps used to create the sketch are shown along the top. 
The settings that were used for constraint inference and constraint persistence are shown at the 
bottom with their respective constraint results. 

 

 

 

 

 

 

 

 

 

 

 

 
 

  Applying Geometric Constraints 
 

Each type of constraint can be applied to certain types of geometry and in certain situations. Some 
constraints such as perpendicular are relational constraints and must be applied to two elements 
in the sketch. A relational constraint defines a geometric relationship between two objects. Other 
constraints such as vertical can be applied to a single object or two points. 

 

 

Accessing Constraint Tools 
 

2D constraints are available on the ribbon, Sketch tab > Constrain panel. 

 

Access 

     2D Constraints 
 
 
 
 
 
 

Ribbon: Sketch tab > Constrain panel 
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Procedure: Applying a Horizontal Constraint 
 

The following steps give an overview for applying a horizontal constraint. 

1. Click Sketch tab > Constrain panel > Horizontal. 

2. Select the geometry to be constrained. 
 

 
 

3. Add more horizontal constraints, or right-click and select Done. 

 

Procedure: Applying a Horizontal Constraint between Point and Midpoint 
 

The following steps give an overview for applying a horizontal constraint between two points. 

1. Start the Horizontal constraint tool. 

2. Select a point such as the endpoint of a line or center of a circle. 

 

 
 

3. Select the midpoint of an existing line. 
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The geometry is now constrained horizontally based upon the two points selected. 
 

 

 
 

Procedure: Applying an Equal Constraint 
 

The following steps give an overview for applying an equal constraint to two circles. 

1. Click Sketch tab > Constrain panel > Equal. 

2. Select a circle, line, or arc. 

 

 
 

3. Select the circle, line, or arc to which you want to apply the equal constraint. 
 

 
 

4. The selected geometry is now constrained to be equal in size. 
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Procedure: Applying a Symmetrical Constraint 
 

The following steps give an overview for applying a symmetrical constraint. 

1. Click Sketch tab > Constrain panel > Symmetric. 

2. Select the first sketch element for the constraint. 

 

 
 

3. Select the second sketch element for the constraint. 
 

 
 

4. Select a sketch element to be used for the symmetry line. 

Note: You only need to select the symmetry line once during the current session. 
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5. Continue selecting other sketch elements to apply the symmetric constraint. 
 

 
 

 

 
 

 
 
 

Showing and Deleting Constraints 
 

As you create and constrain your 2D sketches, you may need to view and possibly delete some 
constraints. Using the Show Constraints tool, you can view the constraints applied to the selected 
geometry and if necessary, select the constraint(s) and delete them. You can also use the Show All 
Constraints tool to display the constraints on all the elements in your sketch. 

 

The constraint glyphs for one piece of sketch geometry is shown in the following illustration. The 
illustration also shows that selecting a constraint glyph highlights the geometry it is associated with. 
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Showing Constraints on Multiple Objects 
 

In the following illustration, the Show Constraints tool has been started. A selection window is used to 
select multiple objects in the sketch. The constraints for each object selected are displayed. The cursor 
is then moved to a single object to review the constraints related to that object. 

 

 
 
 

Constraint Glyph Features 
 

You can use the Constraint Glyphs in the following ways. 

 

 

Option 
 

Method 

Viewing constraints 
 

Click the constraint glyph. The geometry referenced by the selected 
constraint glyph is highlighted. 

Hide constraints Right-click the constraint glyph, and click Hide. 

Deleting constraints 
 

Select the constraint glyph and press Delete, or right-click the selected 
constraint glyph and click Delete. 

 

 

Show All Constraints 
 

Using the Show All Constraints tool, you can see all constraints applied to the active sketch geometry. 
When you select the Show All Constraints tool, Show/Delete Constraint toolbars are displayed next 
to each sketch element. Pause over or select the constraint symbol to highlight the constrained 
geometry. Select the constraint symbol and press DELETE to delete the constraint. 
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Access 
 

You can use the following methods to access the Show All Constraints tool. 

 

 

Option 
 

Method 

Shortcut menu 
 

Right-click in the graphics window and select Show All Constraints (sketch 
must be active). 

 

Keyboard 
shortcut 

F8: Show all constraints. 

F9: Hide all constraints. 

 
The constraint toolbars are displayed next to each sketch element. Click and drag the bars on the 
toolbars to move them to another location. 

 

 
 
 
 

Guidelines for Successful Constraining 
 

As you create sketch geometry, constraints are automatically applied. However, those constraints do 
not always completely represent your design intent. Therefore, you must add constraints or delete 
existing constraints. 

 

 

Constraint Guidelines 
 

The following list represents some guidelines to consider when you are placing constraints. 

 Determine sketch dependencies: During the sketch creation process, determine how sketch 
elements relate to each other and apply the appropriate sketch constraints. 

 Analyze automatically applied constraints: As you create sketch geometry, some constraints are 
automatically applied. After the sketch is created, you should determine whether any degrees of 
freedom remain on the sketch. If required, delete the automatically applied constraints and apply 
constraints to remove the degrees of freedom. 

 Use only needed constraints: When you apply constraints to your sketch geometry, take into 
account the design intent and the degrees of freedom remaining on the sketch. It is not necessary 
to fully constrain sketch geometry in order to create 3D features. In some situations you may be 
required to leave sketch geometry under constrained. You can use the constraint-drag technique to 
see the remaining degrees of freedom on the sketch. 
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 Stabilize shape before size: Before you place dimensions on your sketch elements, you should 
constrain the sketch to prevent the geometry from distorting. As you place the parametric 
dimensions, the sketch elements update to reflect the correct size. By stabilizing the geometry 
with constraints, you are able to predict the effect the dimensions have on the sketch geometry. If 
necessary, use the fix constraint to fix portions of the sketch. 

 Identify sketch elements that might change size: When constraining sketches, take into account 
features that may change as the design evolves. When you identify sketch features that may 
change, leave those features under constrained. When a feature is left unconstrained, the feature 
can change as the design evolves. 

 

 

Guideline Examples 
 

The following list illustrates and describes some basic constraint guidelines. 
 

Determine sketch dependencies: In this 
illustration, the two short vertical line 
segments must remain perpendicular 
to the centerline, and the two diagonals 
must remain parallel to each other. 

 
 
 
 
 
 
 

 
Analyze automatically applied 
constraints: In this illustration, the 
automatically applied constraints on 
the right-side vertical line and the 
lower diagonal line are being analyzed. 
The symbols (glyphs) on the toolbars 
indicate the types of constraints that 
have been applied. In this illustration the 
perpendicular and parallel constraints 
are highlighted. 

 

 
 
 

 
Use only needed constraints: In this 
illustration, the horizontal line has been 
intentionally left under constrained. 
This enables the designer to adjust the 
position between the horizontal line and 
the centerline. 
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Stabilize shape before size: In this 
illustration, constraints are shown but no 
dimensions appear on this sketch. The 
constraints have been added to stabilize 
the sketch shape before dimensions are 
applied to control its size. 

 

 
 
 
 
 
 
 

 
Identify sketch elements that might 
change size: In this illustration, the 
dimensions complete the constraint 
requirements. Notice how the short 
horizontal line below the centerline is 
not dimensioned for its position away 
from the centerline. This line's position 
has been identified as an element 
that may need to change, and thus is 
intentionally not dimensioned. 

 
 
 
 
 
 
 
 
 
 
 

Toggling Sketch Degrees of Freedom Glyph Display 
 

When you are constraining a sketch, if you understand how sketch geometry is free to move and 
rotate, it makes it easier to figure out your strategy for applying geometry and dimensional constraints. 
By understanding the purpose of sketch degree of freedom glyphs and how to display them, you will 
find that it is much easier to constrain the sketch geometry as you require. 

 

In the following illustration, a sketch has all of its degrees of freedom glyphs being displayed for 
its sketch geometry. Based on these glyphs, you get a visual understanding of how each object or 
endpoint can move or rotate. 
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Sketch Degrees of Freedom 
 

To visually identify how sketch geometry is under constrained, you can have degrees of freedom (DOF) 
glyphs display for all or selected geometry in a sketch. As you constrain the sketch, the visible DOF 
glyphs dynamically update to reflect the open degrees of freedom. 

 

You toggle on and off the display of sketch geometry degrees of freedom glyphs in the active sketch by 
clicking the corresponding option in the shortcut menu. When there is no sketch geometry selected, 
the shortcut menu options are Hide All Degrees of Freedom and Show All Degrees of Freedom. 
These options toggle on and off the DOF glyph display for all geometry in the active sketch. If sketch 
geometry is selected when you right-click in the graphics window, you are then able to toggle on and 
off the display of the degrees of freedom glyph for just that geometry by clicking the Display Degrees 
of Freedom shortcut menu option. 

 
In the following illustration, the same sketch is shown with sketch degrees of freedom glyphs before 
and after adding three dimensions. After adding the three highlighted dimensions, much of the 
geometry in the sketch had its degrees of freedom locked down. Degrees of freedom glyphs display 
only for the geometry that still has open freedom. The degree of freedom glyphs that are displayed 
update to show just the open freedom for the geometry. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure: Toggling Sketch Degrees of Freedom Glyph Display 
 

The following steps give an overview of toggling on or off the display of all sketch degree of freedom 
glyphs in an active sketch. 

1. Right-click in an open area in the graphics window. 

2. In the shortcut menu, select Hide All Degrees of Freedom or Show All Degrees of Freedom. 
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Exercise: Constrain Sketches 
 

In this exercise, you create and constrain sketch 
geometry. Using the concepts and procedures 
learned in this lesson, you create the slots on the 
Pillow Block component. 

 

The completed exercise 

 

1. Open INV_003_Constrain_Sketches.ipt. 

 
 

2. In the Model tab, click Sketch panel > Create 
2D Sketch. Select the face on the part as 
shown. 

 
 

 
 
 

 
 
 
 
3. Start the Two Point Rectangle tool. Sketch a 

rectangle on the face as shown. Press ESC to 
exit the tool. 

Note: The XYZ Indicator has its text turned off in 
the following image. 

 

 
 

4. Start the Centerpoint Circle tool and create 
circles centered on the edge of the rectangle 
and coincident to the corners. Right-click in the 
graphics window and select Done when 
finished drawing. 
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5. Start the Vertical Constraint tool and select 
the midpoint of the left edge and the 
centerpoint on the circle. 

 
 

6. Start the Horizontal Constraint tool and 
select the midpoint of the face and the 
midpoint of the slot sketch.  

 

 

 

The slot sketch is now centered on the face. 

 

7. Press ESC to exit the Horizontal Constraint 

tool. 

 

8.     Right-click anywhere in the graphics window, 
select Show All Degrees of Freedom. 
Observe that while the slot is constrained 
centered on the face, there are many 
degrees of freedom remaining. 

Note: The material is set to glass in the 
following illustration to better display the 
DOF symbols. 

 

 

9. Right-click anywhere in the graphics window, 
select Hide All Degrees of Freedom. 

 
10.   Add dimension to constrain the size of the 

sketch geometry as shown.  
 Horizontal Dimension is Length-7. 
 Diameter Dimension is 6. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11. On the ribbon, click Finish Sketch to exit the 
sketch. 

 

12. Start the Extrude tool and select inside each 
circle and the rectangle area of the sketch. 
Adjust the options in the dialog box as shown. 

§ Change the Extents Option to To Next. 
 

§ Click the New Solid Command. 

 
 

 

13. On the ViewCube, select the Home icon as 
shown. 
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14. On the Browser, expand the Solid Bodies 
folder and right-click on Solid 2.  Select 
properties and set the Body Color Style to 
Black. 

 

 

 
 

15. Close all files and do not save. 
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   Lesson: Dimensioning Sketches 
 

This lesson describes how to create and use various types of dimensions for your 2D sketch geometry. 

Using dimensions for your sketches is a major aspect of constraining 2D geometry. While geometric 
constraints stabilize the sketch and make it predictable, dimensions size the sketch according to your 
design intent. 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Describe the function and properties of parametric dimensions. 

 Create linear, radial, angular, and aligned dimensional constraints. 

 Use additional options when applying dimensions. 

 Describe best practices for dimensioning your sketch. 
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About Dimensional Constraints 
 

You create dimensional constraints by adding parametric dimensions to your sketch. This is the final 
step in fully constraining your sketch geometry. When you apply a parametric dimension to a sketch 
element, the sketch element changes size to reflect the value of the dimension. 

 

Various types of dimensions that you can apply to sketch geometry are shown in the following 
illustration. 

 

Definition of Parametric Dimensions 
 

A parametric dimension is a dimension that, when placed on sketch geometry, determines the size, 
angle, or position of the geometry. Associative dimensions in nonparametric applications report the 
size, angle, or position of an object, whereas changes to parametric dimensions affect the object's size, 
angle, or position. 

In the following illustration, when the dimension is placed, the initial value is 47.232. When the value 
is changed to 50 in the Edit Dimension dialog box, the width of the shape updates to reflect the new 
value. Note the d0 text in the title area of the Edit Dimension dialog box. This is the parameter name. 
Each time you place a parametric dimension, a unique parameter name is automatically assigned. 

 
 

 
 

Unlike 2D CAD applications in which dimensions are simply numeric representations of the size of 
the geometry, in a parametric 3D modeling application, dimensions are used to drive the size of the 
geometry. With this technology, you can quickly change a dimension and immediately see how the 
change affects the geometry. 
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Example 
 

Several types of parametric dimensions are available, but only one dimension tool is used to create 
them. The application places the appropriate type of dimension based on the geometry that you 
select. When you are placing dimensions, the shortcut menu displays additional options for placing 
the dimension. 

 

Parametric Dimensions 
 

The following illustration displays horizontal and vertical parametric dimensions and the shortcut 
menu, which enables you to choose the type of dimension to place. 

 

 
 
 
 

Creating Dimensional Constraints 
 

You use the General Dimension tool to place dimensions on your sketch. You can produce linear, 
aligned, angular, radial, and diameter dimensions with this single tool. 
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Access 
 

     General Dimension 
 

 
 

Ribbon: Sketch tab > Constrain panel. 

 

Keyboard Shortcut: D 
 

 

Access 
 

     General Dimension 
 
 

 

Ribbon: Sketch tab > Constrain panel. 
 

 

Keyboard Shortcut: D 
 

 

Procedure: Applying Linear Dimensions 
 

The following steps describe how to apply a linear parametric dimension. 

1. Click Sketch tab > Constrain panel > General Dimension. 

2. Select the sketch element for the linear dimension and place the dimension. 

 

 

3. Select the dimension and enter a new value. 
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4. Press ENTER or click the green check mark on the Edit Dimension dialog box to have the 

geometry change to reflect the new dimension. 

 
 

5. Right-click in the graphics window and select Done on the shortcut menu or continue 
placing additional dimensions. 

 

 

Procedure: Applying Radial/Diameter Dimensions 
 

The following steps describe how to apply radial or diameter parametric dimensions. 

1. Start the General Dimension tool. 

2. Select the sketch element for the radial/diameter dimension and place the dimension. 

 
 

3. Select the dimension and enter a new value. 

 
 

 

4. Press ENTER or click the green check mark on the Edit Dimension dialog box to have the 
geometry change to reflect the new dimension. 

 

 
 

5. Right-click in the graphics window and select Done on the shortcut menu or continue 
placing additional dimensions. 
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Procedure: Applying Angular Dimensions 
 

The following steps describe how to apply an angular parametric dimension. 

1. Start the General Dimension tool. 

2. Select each element for the angular dimension and place the dimension. 

Note: Select each element at any location other than their endpoints. 
 

 

3. Select the dimension and enter a new value. 

 
 

 

4. Press ENTER or click the green check mark on the Edit Dimension dialog box to have the 
geometry change to reflect the new dimension. 

 

 
 

5. Right-click in the graphics window and select Done on the shortcut menu or continue 
placing additional dimensions. 
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Procedure: Creating Aligned Dimensions 
 

The following steps describe how to apply an aligned parametric dimension. 

1. Start the General Dimension tool. 

2. Select the sketch element for the aligned dimension. Position the cursor near the geometry. Click 
when the Aligned Dimension icon is displayed. 

 
 

3. Place the dimension. 

 
 

4. Select the dimension and enter a new value. 

 
 

5. Press ENTER or click the green check mark on the Edit Dimension dialog box to have the 
geometry change to reflect the new dimension. 

 

 
 

6. Right-click in the graphics window and select Done on the shortcut menu or continue 
placing additional dimensions. 

 

 
Instead of positioning your cursor near the geometry to cause the Aligned Dimension 
icon to be displayed, you can also select the element as you do when creating a linear 
dimension. Before positioning the dimension, right-click and set the dimension type as 
an aligned dimension by clicking Aligned on the shortcut menu. 
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Dimension Values and Units 
 

You click a dimension to define its value. If required, you can include specific units of measurement 
such as millimeter, centimeter, meter, inch, and foot. It is not necessary to enter the suffix of the 
default unit. 

 

If your part consists of multiple units of measurement you must enter the non-default unit suffixes. For 
example, if the default unit of measurement is millimeters, you would enter a value of 50 millimeters 
as 50 with no suffix. To specify a value of 50 centimeters in the same part, you would enter 50 cm. 

 

The application evaluates the values as you enter them. Values shown in red indicate an improper 
value or format, while values shown in black are considered to be valid. 

 

Unit suffixes and parameters are case-sensitive. When you enter a unit suffix, it must be entered in 
lowercase. For example, 50 cm would be evaluated correctly, while 50 CM is not valid. 

 

 

Edit Dimension Flyout Menu Options 
 

When applying parametric dimensions, the following options are available in the Edit Dimension 
flyout. 

 

 
 

 

  

Option 

 

Description 

 

 

 

Measure 
 

Use to measure another sketch element or 3D feature. The resulting value is 
placed in the Edit Dimension dialog box. 

 

 
 

 
 
 

Show 
Dimensions 

 

Use to select a feature on the 3D part to display the underlying dimensions. 
After the dimensions are displayed, you can select a dimension for use in the 
existing dimension. The dimension being referenced can be used alone or in a 
formula. 

 

 

 

Tolerance 
 

Displays the Tolerance dialog box, which you can use to assign a tolerance to 
the parametric dimension. 

 

 

 

Recently 
Used Values 

 

Displays a list of recently used values. Select any value for use in the current 
dimension. 
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Additional Dimension Options 
 

The following list represents additional options available on the shortcut menu when you place 
dimensions. 
 
 

Option 
 

Description 

Edit Dimension 
 

While placing a dimension, right-click in the graphics window, and on 
the shortcut menu click Edit Dimension. With this option set, the Edit 
Dimension dialog box is displayed automatically after each dimension is 
placed. 
 

  

Radial/Diameter 
Dimension Options 

 

When you place a dimension on an arc or circle, right-click in the graphics 
window and on the shortcut menu click Diameter or Radius to switch the 
default mode of the current dimension. When dimensioning an arc, the 
default mode is Radius. When dimensioning a circle, the default mode is 
Diameter. 
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Option 
 

Description 

Linear Dimension 
Options 

 

When you place a linear dimension to a line or two points at an angle, 
right-click in the graphics window, and on the shortcut menu click the 
desired dimension type. 

Dimensioning to 
Quadrants 

 

When you need to place a dimension to the quadrant of a circle, place 
the cursor near the quadrant and look for the quadrant dimension glyph. 
Select the arc or circle at the point where the glyph is displayed. 

 
 
 

About Dimension Display and Relationships 
 

When you apply dimensions to your sketch elements additional options are available that you can 
use to control the display of the dimensions. Also available are tools designed to assist you in creating 
dimensions referenced from other features and/or dimensions. 

 
Dimension Display 

 

After you apply dimensions to your geometry, you can control the visibility of all dimensions in the 
sketch and control the visual formatting of the displayed dimensions. 

 

Being able to turn on and off the display of dimensions in a sketch means you have the flexibility when 
working with complex sketch geometry to decide how much information you see. Turning off the 
display of dimensions makes it easier to select the sketch geometry and review its general shape. 
When dimensions are not displayed and you make a sketch invisible, the dimensions remain off when 
you make the sketch visible again. 
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Using the optional display formats of Value, Name, Expression, Tolerance, and Precise Value can 
help you evaluate the structure of equations in relational dimensions, toleranced dimensions, and 
dimensions that contain equations. 

 
 

 

Menu 
 

Description 

Value 
 

The default mode. Displays the current value of the dimension at the precision 
specified in the Document Settings dialog box. 

 

Name 
 

Displays dimension names only. Dimension names are assigned automatically, or 
you can specify them in the Parameters dialog box. 
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Menu 
 

Description 

Expression Displays the dimensions as expressions. An expression can be as simple as d0 = 
26.4375; or a formula can be used, such as d0 = d1/2. 

Tolerance 
 

Displays the dimensions in a format associated with the specific type of tolerance 
applied. If a tolerance has not been applied to the dimension, there is no effect on 
the dimension display. 

Precise Value 
 

Displays the dimension using its exact numeric value, regardless of the Precision 
setting in the Document Settings dialog box. 
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Procedure: Selecting the Dimension Display Mode 
 

The following steps describe how to select the mode for displaying model dimensions. 

1. With nothing selected, right-click in the browser or graphic window. 

2. On the shortcut menu, select Dimension Display and then click the required option in the 
cascading menu. 

 
 

 
 

Referencing Other Dimensions 
 

When you define the value of a dimension, you can reference an existing dimension by selecting the 
dimension in the graphics window. The dimension parameter name is automatically entered in the Edit 
Dimension dialog box. 

 
The illustration shows dimension d18 being created equal to dimension d17. When you want to 
reference other dimensions in a new dimension, with the Edit Dimension dialog box open, select an 
existing dimension to reference. Your cursor changes to indicate that you are referencing an existing 
dimension. When you select the existing dimension, the parameter name of the dimension you 
selected is entered in the Edit Dimension dialog box. A dimension that references another dimension 
has fx: preceding its value. 
 

 
 

    Dimension being created. 

Dimension being referenced. 
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Dimensions Stored as Parameters 
 

Each dimension you create is automatically named and stored as a parameter in the current part file. 
Selecting the Parameters tool on the ribbon, Manage tab, displays the Parameters dialog box which 
lists the model parameters. 

 

 
 

Note the parameter names d0 and d1. These names are generated each time a dimension is placed. If 
you delete a dimension, its parameter is also deleted and the original dimension name is not used again 
in the current part file. You can rename the default dimension names and modify their values in the 
Parameters dialog box. In the previous illustration the parameter d2 is renamed to SleeveDia. 

 

 

Quickly Change Parameters 
 

You can change parameters on the fly to improve your productivity. While creating 
dimensions, for example, you can enter Length=20 and the current parameter is 
renamed to Length and the value is set to 20. 

 

 

Guidelines for Dimensioning Sketches 
 

Applying parametric dimensions is straightforward because you use a single command. 
Following these guidelines assures that dimensions are properly applied to your sketch. 

 

 

Guidelines for Dimensioning Sketches 
 

Consider the following guidelines when adding dimensions to your sketch: 

 Use geometric constraints when possible. For example, place a perpendicular constraint instead of 
an angle dimension of 90 degrees. 

 Place large dimensions before small ones. 

 Incorporate relationships between dimensions. For example, if two dimensions are supposed to be 
the same value, reference one dimension to the other. With this relationship, if the first dimension 
changes, the other dimension changes as well. 

 Consider both dimensional and geometric constraints to meet the overall design intent. 
 

These guidelines are not presented in any particular order and you do not apply all of them on every 
sketch. 
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Example of Relationships Between Dimensions 
 

Building relationships between dimensions captures your design intent. In this illustration, the intent 
is for the circle to always remain centered on the part. Building this dimensional relationship ensures 
that if the sketch width or length changes, the hole also moves in order to remain centered on the 
sketch. The dimension display is set to expression for clarity. 

 

 
 

 
 

In the following illustration, the length is changed. Notice how the hole moved to maintain its 
centered position. 

 

 
 

 
Without a dimensional relationship, a hole that was originally centered does not adjust if the length is 
changed. 
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Exercise: Dimension Sketches 
In this exercise, you apply dimensions to a sketch. 

Using the techniques learned in this lesson, you 

apply a variety of parametric dimensions to the 

sketch geometry. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The completed exercise 

 
 

1. Open INV_004_Dimensions.ipt. 

 

 
 

 
 

 

 

 

 

 

 

 

 
 

2. To rotate the view: 

 On the ViewCube, click Front. 

 Click the arrow to rotate the 
view counterclockwise 90 degrees. 

 
 

3. Constrain drag the sketch on various 
elements to examine the constraint 
conditions. 

 
 

3. In the browser, double-click Sketch1 to activate 
the sketch. 

 

 4.   Place an overall parametric dimension. 

 Start the General Dimension tool. 

 Select the top left and right corners of the 
sketch. 

 Place the dimension and select it. 

 In the Edit Dimension dialog box, enter   

Length=75. 

 Click the green check mark. 

 

     5. Set the Edit Dimension dialog box to automatic. 

 With the General Dimension tool still 
active, right-click in the graphics window. 

 Click Edit Dimension. 

 The Edit Dimension dialog box is 
displayed automatically as you place 
dimensions. 
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6. Add a vertical dimension in relation to the 

overall dimension just created. 

 Select the lower-left and upper-left corners 
of the sketch. 

 In the Edit Dimension dialog box, enter 
Height=30. 

  Click the green check mark.  

 

 

  

 

 

 

 

 

 

 

 

 

 

7.    Add a horizontal dimension the controls 

the size of the legs. 

 Check to make sure that the General 
 Dimension tool is still active. 

 Select points as indicated. 

  In the Edit Dimension dialog box, enter     

Leg_W=4. 

 Click the green check mark. 

 
 

  
 
 
 
 
 
 

 
Add the horizontal dimension to the other leg.      
Instead of entering a numeric value, click the 
previous dimension value to create a 
parametric relationship.  

 

 
 

8. Add additional dimensions as shown. Create 
parametric relationships to ensure 
symmetrical design intent.  Do not be overly 
concerned with placement as you create the 
dimensions. You can drag the dimensions to 
locations after all of them have been created. 
Double-click each dimension and adjust its 
value to those in the following illustration if 
necessary. 

 

 

 

 

 

 

 

 
 

9. On the ribbon, click Finish Sketch to exit 
the sketch. 

10. On the ViewCube, click the Home icon. 

 
 

  11. Close all files. Do not save. 
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Chapter Summary 
 
 

 
Properly constrained 2D sketches are the fundamental building blocks of parametric parts. By being 
able to fully constrain the size and shape of your sketches, you can achieve the highest quality 
parametric part designs. 

Having completed this chapter, you can: 

 Use sketch tools to create 2D sketch geometry. 

 Use geometric constraints to control sketch geometry. 

 Apply parametric dimensions to your sketch geometry. 
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Chapter 
 

7 
 

 
 
 

Basic Shape Design 
 

 
 

In earlier lessons, you learned how to create and constrain 2D sketches. In this chapter, you are 
introduced to the fundamentals of basic shape design by learning how to extrude, revolve, and sweep 
2D sketches to create 3D features. This chapter also covers the proper techniques for adding multiple 
sketched features to your 3D design, creating more intelligent sketches by referencing existing part 
edges and using construction geometry, and modifying your parametric parts at any stage of the 
design process. 

 

 

Objectives 
 

After completing this chapter, you will be able to: 

 Create features using the Extrude and Revolve tools. 

 Use reference and construction geometry. 

 Use the browser and shortcut menus to edit parametric parts. 

 Create, locate, and utilize work features to perform modeling tasks. 
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Lesson: Creating Basic Sketched Features 
 

 
Two basic types of features exist: sketched features and placed features. The term sketched feature 
refers to a 3D feature that is based on a 2D sketch. The term placed feature refers to a 3D feature that 
you place on the existing faces and edges of the part, and which does not require a sketch. This lesson 
describes sketched features and how to create them using the Extrude and Revolve tools. 

 

Because most 3D models include some combination of extruded and revolved features, a basic 
understanding of how to create them is essential to successful model creation. 

 

The following illustration shows a 3D conveyor model that was created using multiple extrusion 

features. 
 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Define sketched features and their attributes. 

 Use the Extrude tool to create extruded features. 

 Use the Revolve tool to create revolved features. 

 Use the Operation and Extent termination options when adding 3D features. 

 Orient sketch planes based on other planes or faces. 
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About Sketched Features 
 

You create most 3D models by combining multiple extruded and revolved features. You start by creating a 

2D sketch that represents the basic shape of the part and then use different feature creation tools to turn 

that 2D sketch into a 3D feature. 

 
 
 

 

 

Definition of Sketched Features 
 

Sketched features are 3D features that are created from an existing 2D sketch. These features serve as 
the basis for most of your designs. When you create a sketched feature, you begin by first creating the 
sketch or profile for the 3D feature. For simple sketched features, this profile usually represents a 2D 
section of the 3D feature being created. For more complex sketched features, multiple sketches can be 
created and used within one sketched feature. 

 

The first sketch feature you create is considered the base feature. After you create the base feature, 
additional sketched and/or placed features are added to the 3D model. As you add the additional 
sketched features, options are available that control whether the secondary sketched features add or 
remove material from the existing 3D geometry. 

 

 

Sketched Feature Attributes 
 

The key attributes of sketched features include the following: 

 An unconsumed sketch is required (not used by another feature). 

 Sketches can be used for both base and secondary features. 

 The result of the sketched feature can add or remove mass from the 3D geometry. 

 
Consumed and Unconsumed Sketches 

 

When you create a new part, the initial sketch is used as the basis of your 3D geometry. After the 
sketch is created, you can create a sketched feature, an extrusion for example, to create 3D geometry 
from the initial sketch. When you create the 3D sketched feature, the sketch itself becomes consumed 
by the 3D sketched feature. Prior to this time, the sketch is considered unconsumed and can be used 
for any sketched feature. 
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Unconsumed Sketch 
 

The following illustration shows the initial sketch before it is consumed by the sketched feature. 
 

 
 
 

 

Consumed Sketches 
 

The following illustration shows sketches consumed by the sketched features. In the browser, the 
sketches are nested below the sketched feature in which they were used. 
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Typical Sketched Feature Creation 
 

This illustration represents a typical workflow for creating a 3D part based upon sketched features. The 
base sketch is created, which is used to create the base feature. Secondary sketches and features are 
then added to the 3D model. 
 

 
 
 
 

Creating Extruded Features 
 

You use the Extrude tool to create extruded features from existing sketch profiles. Considered sketched 
features, extruded features require an unconsumed and visible sketch to be available. If the sketch 
contains a single closed profile, that profile is selected automatically when you start the Extrude tool. If 
the sketch contains more than one profile, you are required to select the profiles to be included in the 
extruded feature. 
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Examples of Simple Extruded Profiles 
 

In this example, the sketch contains multiple closed loop profiles selected to form a single extruded 
feature. 

 

 

 
In this example, the sketch contains multiple closed loop profiles selected to form a single extruded 
feature with holes. 

 

 
 
 

Access 
 

Extrude 

 

 
 

Ribbon: Model tab > Create panel 

 

 
 

Toolbar: Part Features 

Keyboard Shortcut: E 
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Extrude Options 
 

The Extrude dialog box is displayed when you start the Extrude tool. 
 

 

 
The following features and options are available in the Extrude dialog box: 

 
 

 

Dialog Box 
Access 

 

Option 

 

Description 

 

 
 

Profile 
 

Use to select geometry to be included in the extrusion. A red arrow 
indicates that no profiles have been selected for the extrusion feature. 

 

 
 

 

Solids 
 

The Solids selection tool is only active when the part contains more 
than one solid body. Use to determine to which solid body the feature 
is going to be applied. 

 

 
 

Output Use to specify the desired output option, Solid or Surface. 

 

 
 

Direction 
 

Select the direction icon or click and drag the preview of the extrusion 
in the desired direction. 

 

 
 

Operation 
 

Use to create an initial feature or add volume to models with Join. 
Remove volume from models with Cut. Create a new feature from 
shared volume of two features with Intersect. 

 

 
 

 

New 
Solid 

 

Use to create the extruded feature as a new solid body instead of 
using boolean operations to join, cut, or intersect the feature with an 
existing solid body. 



8 Chapter 7: Basic Shape Design 
 

Procedure: Creating an Extruded Feature 
 

The following steps describe how to create an extruded feature. 

1. Create a new sketch. 

 

2. Click Model tab > Create panel > Extrude. 

3. In the Extrude dialog box, adjust the options as required. 

 

 
 

4. The extruded feature is created. 
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Creating Revolved Features 
 

You use the Revolve tool to create revolved features from existing sketch profiles. You can revolve the 
profile at a full 360 degrees or at a specified angle. The Revolve tool requires an unconsumed and 
visible sketch to be available. When you start the Revolve tool, if the sketch contains a single closed 
profile, that profile is selected automatically. 

 

 

Examples of Simple Revolved Profiles 
 

In the following illustration, the sketch contains a closed profile and one centerline. When you start 
the Revolve tool, the centerline is automatically selected as the axis of revolution. 

 

 

 
In the following illustration, the sketch contains a single closed loop profile, reference geometry, and 
one centerline. The profile is revolved with the Cut feature relationship. 
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Access 
 

     Revolve 
 

 
 

Ribbon: Model tab > Create panel 

 

 
 

Toolbar: Part Features 

Keyboard Shortcut: R 
 

 

Revolve Options 
 

The Revolve dialog box is displayed when you start the Revolve tool. 
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The following features and options are available in the Revolve dialog box: 

 
 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

 

Profile 
 

Use to select geometry to include in the revolved feature. A 
red arrow indicates that no profiles have been selected for 
the revolved feature. 

 

 
 
 

 

Axis 
 

Use to select the line segment to use as the axis for the 
revolve feature. 

 

Tip: If the sketch contains a centerline, it is selected 
automatically as the axis. 

 

 
 

 

Solids 
 

The Solids selection tool is only active when the part contains 
more than one solid body. Use to determine to which solid 
body the feature is going to be applied. 

 

 
 

Output Use to specify the desired output option, Solid or Surface. 

 

 
 

New 
Solid 

Use to create a new solid body from the revolved feature. 

 

 
 

Angle Use to specify an angle and direction for the revolution. 

 

 
 

Full Use to revolve the profile 360 degrees. 
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Facts About Revolved Features 
 If the sketch contains a centerline, it is selected automatically as the axis for the revolved feature. 

 If the sketch contains more than one profile, you are required to select the profiles to include in 
the feature. 

 If the profile being revolved is closed, you can choose between a solid or surface for the result of 
the revolution. 

 If the profile being revolved is open, the revolution results in a surface. 

 
Procedure: Creating a Revolved Feature 

 

The following steps describe how to create a revolved feature. 
 

1. Create a new sketch containing a profile to revolve. If the profile is being revolved about a 
centerline, consider using the Centerline style on the line segment. 

 

 

 
 

2. Click Model tab > Create panel > Revolve. In the Revolve dialog box, adjust the 
options as required. 
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3. Create additional sketch geometry as required. 

 

 
 

4. Start the Revolve tool. Select the geometry to be included in the revolved feature. Adjust the 
options as required. 

 

 
 

 
 
 

Specifying Operation and Extents 
 

You use the Join, Cut, and Intersect operations to control how the feature you are creating affects 
existing features or Solid Bodies. By default, the Cut and Intersect operations are not available with 
base features and the New Solid button is automatically activated since the base feature will by 
default create a New Solid. 

You use the Extents options to define the termination of a feature. For example, you can extrude a 2D 
sketch a specific distance or you can terminate the feature on an existing face of the model. 
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Example of Operation and Extents 
 

In the following example, multiple sketched features with different operations and extents were used 
to define the shape of the part. 

 

 
 
 

Specifying Operation: Join, Cut, and Intersect 
 

When you create sketched and placed features, you can adjust operation options to control the effect 
of the current feature on existing features. These operations are not available for the first feature of 
the part. 

 

The feature relationship options are available when using Extrude, Revolve, Loft, Sweep, and Coil. The 
following illustration shows an example of these options in the Extrude dialog box. 
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Use the following options with the Extrude tool. 

 
 

 
Dialog 
Box 
Access 

 

Option 

 

Description 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Join 
 

This option joins the result of the extruded feature being created to 
existing part geometry. Using this option results in material being added 
to the existing part. A green preview indicates material is being added. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Cut 
 

This option cuts the result of the extruded feature being created from the 
existing part. Using this option results in material being removed from the 
existing part. A red preview indicates material is being removed. 
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Dialog 
Box 
Access 

 

Option 

 

Description 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Intersect 
 

This option removes material from the existing part by comparing the 
volume of the existing features and the feature being created and leaving 
only the volume shared between the existing features and the new 
feature. A blue preview indicates an Intersect relationship. 

 
 

New Solid – Best Practice for Factory Assets. 
 

Using the New Solid option will create a new solid body from the feature definition. 
Solid Bodies allow designers to create a single part model that represents multiple 
components.  The Conveyor part model in the following image uses multiple solid 
bodies to represent the frame and belt of a conveyor in a single part file.  This 
practice will greatly reduce the overall number of parts in the final Factory 
Assembly. 
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Specifying Extents 
 

When you create extruded and revolved features, you can specify termination options for the feature 
in the dialog box. Depending on the option you choose, different interface options are available. By 
specifying termination options, you can control where the feature starts and ends. 

 

The following illustration shows the Extents options that are available in the Extrude dialog box. 
 

 

 
 

 

Option 
 

Description 

Distance This option extrudes the profile according to the distance specified. 

To Next 
 

This option extrudes the profile to the next possible face or plane. Use 
the Terminator icon to select a solid or surface on which to terminate the 
extrusion. 
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Option 
 

Description 

  

 
 

To 
 

This option extrudes the profile to terminate on the selected face, plane, or 
point. If the selected termination face does not completely enclose the 
extrusion profile, select the Extended Face option to terminate the feature 
on the extended face. 

From To 
 

This option extrudes the profile by starting the extrusion at the face selected 
with the From option and ending the extrusion at the second face selected. 
If necessary, use the extend face option. 
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Option 
 

Description 

All 
 

This option extrudes the profile all the way through the part. If the part 
changes, the extruded feature continues to go all the way through the part. 

Extended Face 
 

This option extends a selected face with the To and From To options. The 
extrude does not build the extrusion if the sketched feature extends beyond 
the termination face. With the Extend option selected, a termination face 
becomes infinite in size. 
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Additional Extents Options for Revolve 
 

The following options are available for the Revolve tool. 
 

 

Option 
 

Description 

Full 
 

This option revolves the profile a complete revolution around a specified 
axis. If the part changes, the revolved feature continues to go all the way 
around the part. 

Angle 
 

This option revolves the profile a specified number of degrees around an 
axis. 
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Procedure: Specifying Operations 
 

The following steps describe how to specify operations. 

1. Create additional sketch geometry on an existing feature. 

 

 
 

2. Start the Extrude tool. 

3. In the Extrude dialog box, adjust the operations as required. In this example, Join is selected. 

 

 

 

4. The additional extruded feature is added to the part. 
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Procedure: Specifying Extents 
 

The following steps describe how to specify extents. 

1. Create additional sketch geometry on existing features as required. 

 
 

2. Start the Extrude tool. 

3. In the Extrude dialog box, adjust the options as required. In this example, All is selected. 

 

 
 

4. The additional extruded feature is added to the part. 
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Orienting Sketches 
 

When you create the first sketch for the base feature of your part, you usually use the default XY 
origin plane. However, the sketches that you create to add new features to the part often need to be 
oriented to other part faces. 

 

The sketch plane has been oriented to the selected part face in the following illustration. 

 
 
 

Procedure: Creating Sketch Planes on a Part Face 
 

The following steps describe how to create a new sketch plane aligned to a selected face. 

1. Right-click in a face of the part and select New Sketch. 

 

2. The sketch plane is created on the selected face. 
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Procedure: Creating Sketch Planes Offset from a Part Face 
 

The following steps describe how to create a new sketch plane offset from a selected face. 

1. Start the Create 2D Sketch tool. 

2. Click in the face and drag the sketch plane away from the selected face. 

 
 

 

3. In the Offset dialog box, enter a value for the offset and click the green check mark. The sketch 
plane is created offset from the selected face at the distance you specified. 
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Exercise: Create Extruded 

Features 

In this exercise, you build an Index Slide part file 
using several extruded features. Some initial 
geometry has been created, but you are required to 
create other sketch geometry. 

The completed exercise 

 

Create Extruded Features Specific Distances 
 

In this portion of the exercise, you extrude an existing 
sketch to create a base feature. Then you create a 
new sketch and extrude it a specific distance to create 
another sketched feature. 

 

 
1. Open INV_005_Extrusion.ipt. 

 

 

 

 

 

 

2. Extrude the two top profiles. 

 Start the Extrude tool. 

 Select the two top profiles. 

 For Distance, enter Width=30 (1). 

Click the Symmetrical Option (2). 

 Click OK. 

 

3. Use the Shell command to remove the top and 

end faces, creating a 1” channel. 

 Start the Shell command. 

 Click the select the top and end faces 

 Enter 1” for the Thickness value. 

 Click OK.  
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4.  Sharing a sketch.   

In the Browser, expand Extrusion 1.  Right click 

on sketch 1 and select Share Sketch. 

 
 

 
5. Extrude the legs of the conveyor. 

 Start the Extrude tool. 

 Select the two log profiles. 

For the Distance, enter Width-2. 

Select the Symmetrical option. 

Click OK. 

 

 
 
  

 
 
 
 
 
 
 
 
 
 
 

 
 
 
6. Cut out the leg openings. 
 

 Start the Extrude tool. 

 Select the two leg profiles. 

  Enter Distance (Width-2)-Leg_W-Leg_W. 

   Click the Cut option. 

 Click the Symmetrical option. 

   Click OK. 
 

 
 

7. Extrude the Belt Feature as a secondary Solid 
Body. 

 Start the Extrude tool. 

 Select the Belt Profile 
Set the Extents option to Between (1). 
Select the two interior faces of the 
channel section. 
Click the New Solid option (2). 
Click OK. 
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8. Turn off the visibility of the Shared Sketch. 
 In the Browser, right click the shared 

sketch and select Visibility. 
 

 
 

 

 

 

9. Change the color of the belt feature. 
 

§ Expand the Solid Bodies folder and selectSolid2.   
§ Right click and select properties from the menu. 
 
§ Change the Body Color Style to Black (1). 

 

 

10. Close the file without saving. 
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Exercise: Create Revolved 

Features 
 

In this exercise, you create a simple curved 
conveyor part file using the Revolve tool. The 
initial sketch will be created to start the 
exercise.  The Frame and Belt will be 
constrained vertically in line with the origin of 
the file.  The axis of revolution is drawn to the 
right of the initial profiles. 

 

The completed exercise 

 
 

Create Revolved Features that Add 
Material to the Part 

 
In this portion of the exercise, you will create a 
sketch and revolve it into the base feature. You 
create another sketch and revolve it, creating 
another sketched feature that adds material to the 
part. 

 

 
 

1. Start a New English part. 

2. Draw the initial 2 point rectangle.   

 Constrain the midpoint of the lower horizontal 

line to the origin point of the file using a 

Coincident constraint.   

 

 

 

 

 

 

 

 

Note: If necessary, project the 0,0 center point 

into the current sketch plane. 

 Select the 4 lines that make up the rectangle 

and then click the Construction tool on the 

format panel. 

 Dimension the horizontal and vertical lines as 

shown in the following image. 

  Note: Dimensions are displayed as expressions 

in this image. 
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3. Create the 2 point rectangles shown in the 

following image. 

 Draw the outer rectangle constraining the 

two corners to the top of the construction 

outline. 

 Use the Offset command to create the inner 

rectangle. 

Dimension the rectangle as shown.  

 Note: A parametric relationship should be 

established between the dimensions that 

position the inner rectangle. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

4. Draw the revolution axis to the right of the 
existing profiles as shown below.  

  
 Dimension the axis line with the value     

Radius_Inside=36. 
 
 Finish the sketch. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

 
 
5. Use the Revolve tool to create the first revolve 

feature. 
 

§ Start the Revolve tool on the Create 

panel. 

§ Select the two rectangular profiles. 

§ Select the Axis selector in the dialog box 

(1) and then click the axis line. 

§ Set the Extents option to Angle (2) and 

set the value to Angle=90 (3). 

§ Change the direction option as shown in 

the image below (4). 
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6. Use the Shell tool on the modify panel to 

create the channel feature. 

§ Start the Shell tool and select the top 

and end faces. 

§ Enter a thickness value of 1” 

§ Click OK. 

 
 

7. Share the original sketch to create the 
secondary revolve feature. 

§ In the browser, expand the first 

revolve feature. 

§ Right-click on Sketch1 and select 

Share Sketch from the menu. 

 

  

 

8. Use the Revolve tool to create the Belt feature 

as a new solid body. 

§ Start the Revolve tool and select the inner 

rectangular profile. 

§ Use the Axis selector (1) and click the axis 

line. 

§ Set the Extents option to Angle (2). 

 

 

 

 

 

 

 

 

§ Set the Value to Angle (3). 

§ Change the direction option (4) as shown in 

the image below. 

§ Click the New Solid option (5) to create a 

separate solid body. 

§ Click OK. 

 

 

 
 

9.  Turn off the visibility of the shared sketch. 

§ In the browser, right click on the shared 

sketch and select Visibility from the menu. 
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10. Add full round fillets to the belt feature. 

§ Start the Fillet command on the modify 

panel. 

§ Select the Full Round option (1). 

§ Select the top, end, and bottom faces on 

one end of the belt feature. 

§ Click OK. 

§ Add the opposite fillet using the same 

process.  

 

 

 

11. Change the color of the Belt solid body. 

§ Expand the Solid Bodies folder in the 

browser. 

§ Right click on Solid2 and select 

Properties from the menu. 

§ Set the Body Color Style (1) to black. 

§ Click OK. 

 

 

 

12. Close the file without saving. 

Note: The legs of the curve conveyor will be 
created in another exercise.
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Lesson: Intermediate Sketching 
 

 
This lesson describes the use of reference and construction geometry to add design intelligence to 
sketches on your parts. As your part progresses, you add multiple sketched features. Each sketch may 
require the use of reference and construction geometry to fully constrain your sketches. 

 

In the following illustration, reference geometry and construction lines are used to constrain the 
rectangle geometry on the face of the part. 

 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Describe sketch linetypes and their behavior. 

 Use the 2D sketch tools to create construction geometry. 

 Project part edges onto a sketch plane. 
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About Sketch Linetypes 
 

As your part design progresses, you need additional sketching tools to capture design intent within 
your sketch and to establish parametric relationships to existing faces and edges on your 3D part. As 
you create 2D sketch geometry, such as lines, arcs, circles, and prismatic shapes, you can use different 
linetypes for different purposes. 

 

In the following example, several linetypes are used to define, position, and constrain geometry on 
the part. 

 

 
 

 

    Normal sketch geometry 

   Construction geometry 

   Reference geometry 

    Centerline geometry 
 

 
 

Definition of Sketch Linetypes 
 

The following illustration shows the appearance of the different linetypes. Different linetypes display 
in different colors in the sketch environment; however the exact color is based on the color scheme 
you have selected. In the following illustration, using the Presentation scheme, lines 2 and 3 are 
displayed orange, while the reference geometry (4) is green. The reference geometry consists of 
projected edges of the solid model (arrows). 
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Sketch Linetypes 
 

The following are the different linetypes and how they are used. 

 
  

Linetype 

 

Description 

 

 

 

Normal 
 

This is the default linetype in a sketch. Normal lines define the profile or 
path that is used to define the shape of a sketched feature. 

 

 
 

 
 
 

Construction 
 

Construction lines are used to aid in constructing and constraining 
normal geometry. You use construction lines when you need additional 
geometry to constrain a sketch but do not want that additional geometry 
to participate in defining the profile for the feature. 

 

 
 

 
 
 

Centerline 
 

The Centerline linetype is another type of Construction linetype. It can be 
used to define the centerline about which to revolve a profile to create 
a revolved feature. When you add dimensions between centerlines and 
other sketch geometry, they are treated as diameter dimensions. 

 

 
 

 
 
 
 
 

Reference 
 

Reference geometry is geometry that is projected onto your sketch from 
existing part vertices, edges, and faces. You use reference geometry 
to constrain normal sketch geometry to existing features on the part. 
Reference geometry remains associative to the original part vertices, 
edges, and faces. You can also use reference geometry to define the profile 
or path for a sketched feature. 
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Normal Linetype Example 
 

The notched rectangle sketch on the left, consumed in the block feature on the right, has been 
created with the Normal linetype. While sketching, normal lines are represented as solid lines. 
 

 

Construction Linetype Example 
 

In the following example, the diagonal dotted line in the left image is a construction line. The 
endpoints of the construction line are constrained to the opposite corners of the face. The midpoint of 
the construction line is used to orient the center of the circle, which is defined with a normal linetype. 
The circle is then extruded with the Cut option to define a shaft opening in this block. 
 

 
 

Reference Geometry Example 
 

The current sketch plane in this example is coplanar with the side of the base of the part. Reference 
geometry is projected to the sketch plane from the perimeter of the part, from the hole through the 
part, and from the spherical cutout on the top. 
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Centerline Linetype Example 
 

The dashdot line on the left is a centerline. The circle is revolved around the centerline to create the 
torus feature on the right. 

 
 
 

    Creating and Using Construction Geometry 
 

You can use construction geometry to help you control and define a sketch by using geometric 
construction techniques rather than complex dimensions and formulas. You can constrain and 
dimension construction geometry like any other 2D sketch geometry. You can use construction 
geometry as a reference for dimensions to other normal sketch geometry, as well as to constrain 
normal sketch geometry. 

 

In the following illustration, construction lines (1) are used to position the slot from the center of the 
circle and along the angled construction line. 
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Tools for Creating Construction and Centerline Geometry 
 

The ribbon contains two buttons for creating construction and centerline geometry. Unlike other 
toolbar buttons, these buttons also indicate the current status of the selected geometry or drawing 
mode. When you click a button, you activate that specific mode. The selected mode remains active 
until you click the button again. 

 

 

Access 
 

    Construction Geometry 
 
 

 
 

Ribbon: Sketch tab > Format panel 

 

 
 
 

You can use the following buttons to create or change existing geometry types. 

 

 

Icon 
 

Option 

 

Description 

 

 
 

 

Construction 
Geometry 

 

When this button is selected, all 2D geometry drawn is construction 
geometry. To change existing geometry to construction, select the 
geometry, then click this button. 

 

 
 

 

Centerline 
Geometry 

 

When this button is selected, all 2D geometry drawn is centerline 
geometry. To change existing geometry to centerline, select the geometry, 
then click this button. 

 

 
 
 

To convert normal geometry or dimensions, select the geometry or dimension and 
then click the appropriate button on the ribbon. 
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Procedure: Creating Construction Geometry 
 

The following steps outline the procedure for creating construction geometry. 

1. On the ribbon, click the Construction tool. 

2. Using standard sketching tools, create the required 2D geometry. 

In the following example, a construction line was sketched between the opposite corners of a 
rectangle. The lines defining the rectangle are normal sketch lines. 

 

 
 

3. Click the Construction tool again to return to creating normal sketch geometry. 
 

 

Procedure: Converting Existing Geometry to Construction Geometry 
 

The following steps outline the procedure for converting existing sketch geometry to construction 
geometry. 

 

1. To change existing geometry to construction geometry, select the geometry in the graphics 
window. 

In the following example, a circle was selected. 
 

 

 
 

2. On the ribbon, click the Construction button. The selected geometry is changed to construction 
geometry. 
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Procedure: Creating Centerline Geometry 
 

The following steps outline the procedure for creating centerline geometry. 

1. On the ribbon, click the Centerline tool. 

2. Using standard sketching tools, create the required 2D geometry. 

In the following example, a vertical centerline was sketched to the left of the normal sketch 
geometry. 

 

 
 

3. Click the Centerline tool again to return to creating normal sketch geometry. 

 

 

Procedure: Converting Existing Geometry to Centerline Geometry 
 

The following steps outline the procedure for converting existing sketch geometry to centerline 
geometry. 

 

1. To change existing geometry to centerline geometry, select the geometry in the graphics 
window. 

In the following example, a horizontal line that bisects the slot shape is selected. 

 
 

2. On the ribbon, click the Centerline tool. The selected geometry is changed to centerline 
geometry. 
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    Creating and Using Reference Geometry 
 

Reference geometry is geometry that is created when existing vertices and edges of the part are 
projected onto the active sketch plane. Reference geometry is not drawn; rather it is created when 
you define a new sketch plane on a planar face of the part or by using the Project Geometry tool. 
Without reference geometry, you cannot dimension or constrain sketch geometry to the existing 
features on the 3D part. 
 

 
 
 

New Sketches and Reference Geometry 
 

When you create new sketches on a planar face of the part, the edges of the selected face are 
automatically projected onto the sketch as reference geometry. You can use this reference geometry: 

 To dimension to other sketch geometry. 

 For relational constraints to other sketch geometry. 

 As the basis for defining the path or profile for a sketched feature. 
 

The following example demonstrates how reference geometry is created and used when defining a 
new sketch on an existing part face. 

 

 
 

 

A new sketch is created on an 
existing part face. The coplanar 
edges of the existing part face are 
automatically projected onto the 
new sketch. 

Create additional sketch geometry and use the 
projected reference geometry for dimensions or 
constraints. 
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Project Geometry Tool 
 

You use the Project Geometry tool to project additional part vertices and edges that are not coplanar 
to the sketch plane onto the sketch as reference geometry. When you use the Project Geometry 
tool, you are prompted to select geometry to project onto the current sketch plane. As you select the 
geometry, it is projected onto the current sketch plane as reference geometry and is always associative 
to the original source geometry. This means that if the source geometry changes, the reference 
geometry also changes. However, after a reference geometry linetype is changed to another linetype, it 
loses its associativity. 

 

 

Projecting Part Edges 
 

Following are some key attributes for projecting part edges: 

 Can be used as the basis for dimensions to new sketch geometry. 

 Can be used to apply relational constraints to new sketch geometry. 

 Cannot be dimensioned. 

 Cannot be trimmed. 

 Can be mirrored. 
 Cannot be drawn; can only be created by using Project Geometry tool or by selecting the 

Autoproject Edges option. 

 
Access 

 

     Project Geometry 
 

 

 

Ribbon: Sketch tab > Draw panel 

 

 

Toolbar: 2D Sketch Panel 
 

 

Autoproject Options 
 

You can use the Autoproject functionality to speed projection of geometry to the sketch plane. 
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Autoproject for Sketch Creation 
 

When you check the box next to the Autoproject Edges for Sketch Creation and Edit option on the 
Sketch tab in the Application Options dialog box, the edges of the selected planar face are 
automatically projected onto the new sketch when you create a new sketch plane on an existing face. 
 

 

Autoproject Edges 
 

When the Autoproject Edges During Curve Creation option is selected, you can autoproject geometry 
by hovering the pointer over the geometry to be projected while sketching. 
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Sketching Shortcut Menu 
 

While sketching, right-click in the drawing area and select AutoProject. This enables you to hover 
over geometry to automatically project onto the current sketch plane. 

 

 
 
 

Procedure: Referencing Model Edge Geometry 
 

The following steps outline how to create reference geometry during curve creation in a sketch by 
autoprojecting model edge geometry. 

1. Create a new sketch on the existing part. 

 
 

 

2. Begin sketching the required geometry. Right-click in the graphics window and select 
AutoProject in the shortcut menu. 
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3. Hover over the geometry to project. It is automatically projected to the current sketch plane. 

 
 

4. Continue sketching the required geometry as required. 

Tip: You may consider turning off the AutoProject option until it is needed again. This action 
prevents the accidental projection of geometry while sketching over existing part features. 
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Lesson: Editing Parametric Parts 
 
 

This lesson describes the various methods used to make changes to parametric part models. You can 
edit sketches, modify features, and create and use parameters while making modifications to your 
models. 

 

Statistics show that designers spend more time making part modification and engineering changes 
than they spend creating new parts. You need to be able to modify your existing part models 
accurately and efficiently. 

 

The following illustration shows a parametric part model before and after implementing changes to 
existing features. 

 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Edit features from the browser. 

 Edit sketches from the browser or toolbar. 

 Create and modify parameters and equations. 
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Editing Features 
 

After you create features on your parametric part, you can modify those features at any time. 
Sometimes all you need to change is the size of the feature. Other times you may need to make a more 
significant change. Autodesk Inventor provides multiple options for editing your designs. 

 

The following illustration shows a part model before, and then after the extrusion distance was 
modified. 

 
 

 

Options for Editing Features 
 

There are three basic ways to modify features on your parametric parts. With both sketched and 
placed features, you can display and modify the dimensions to simply change the size of the feature, 
or you can access the feature dialog box to make a more significant change, like changing an operation, 
extrusion direction, or the extents of the feature. For sketched features you also have the option to 
modify the sketch geometry. For example, you can add and delete dimensions or constraints, or you 
can even modify the shape of the sketch by changing the sketch geometry. 

In the following illustration, the left browser image shows the three options for editing a sketched 
feature. The browser image on the right shows the two options for editing placed features. 
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  Editing Features Using Show Dimensions 

If you want to change the size of a feature, you can use the Show Dimensions option to change the 
value of an existing dimension. All sketch dimensions are displayed as well as other dimensions that 
are used to define the feature size, such as extrusion depth, revolution angle, or taper value. 
 

 

 

Editing Features Using Edit Feature 
 

When you use the Edit Feature option to edit a feature, you are presented with the same dialog box 
that you used when you created the feature. You can change the parameters, such as distance, 
feature relationships, and termination options. You can also reselect geometry to be included in the 
feature. 
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Access 
 

     Show Dimensions 

 
Browser: Double-click the feature. (Note: Dimensions are only visible on the underlying 
sketch while the feature is being edited.) 

Browser: Right-click the feature > Show Dimensions. 
 

 

Access 
 

     Edit Feature 
 

Browser: Double-click the feature. 

Browser: Right-click the feature > Edit Feature. 

 

 

Procedure: Modifying a Feature Using Show Dimensions 
 

The following steps describe how to edit a feature using the Show Dimensions option. 
 

1. Right-click the feature in the browser and select Show Dimensions. All the controlling 
dimensions are displayed on the feature in the graphics window. 

2. Double-click the dimension to modify and enter a new value in the Edit Dimension dialog box. 

3. Click Update in the Standard toolbar to apply the changes to the part. 
 

 

Procedure: Modifying a Placed Feature Using Edit Feature 
 

The following steps describe how to edit a placed feature using the Edit Feature option. 
 

1. Right-click the feature in the browser and click Edit Feature. The dialog box used to create the 
feature is displayed. 

2. Change the settings or values in the dialog box, then click OK. The part automatically updates. 
 

 

Procedure: Editing Extruded Features 
 

The following steps describe how to edit extruded features. 

1. In the browser, right-click the feature. Click Edit Feature. 

2. In the Extrude dialog box, adjust the options as required to edit the feature. 
 

 

Procedure: Editing Revolved Features 
 

The following steps describe how to edit revolved features. 

1. In the browser, right-click the feature. Click Edit Feature. 

2. In the Revolve dialog box, adjust the options as required. 
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Editing Sketches 
 

As you build your parametric model, you create multiple sketches. When the sketch is used by a 
feature such as Extrude or Revolve, the sketch becomes consumed by the feature and is displayed 
under the feature in the browser. You can see each of the sketches in the browser by expanding the 
particular feature(s). Even though this sketch is consumed by the feature, it can still be modified. 

 

The following illustration shows how sketches are consumed by the feature for which they are used. 
 

 
 

    The Extrusion1 feature has consumed Sketch1 and Extrusion2 has consumed Sketch4. 

   Sketch2 and Sketch5 are unconsumed sketches. 

 

 

Editing Consumed Sketches 
 

One powerful way to modify a feature is to edit the sketch. Editing the sketch places the model in 
a rolled-back state, where only the features existing at the time this sketch was created are visible. 
When you edit sketches, you are returned to the sketch environment and the panel bar changes, 
providing you with access to all the sketch tools initially used in creating the sketch. You can add, 
replace, or delete dimensions or constraints and even modify the sketch geometry. To return to the 
part modeling environment, click Return on the Standard toolbar. 
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In the following illustration, Sketch1 has been consumed by Extrusion1 in the browser. You can expand 
the Extrusion1 feature to expose and edit the consumed sketch. Notice the browser background color 
changes to indicate the active sketch. 

 
 

 
 
 
 

Access 
 

     Edit Sketch 
 

Browser: Double-click the sketch. 

Browser: Right-click the feature > Edit Sketch. 

Toolbar: Standard > Sketch > Select the sketch in the browser. 
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Procedure: Editing Sketches 
 

The following steps describe how to edit sketches. 

1. In the browser, right-click the feature or sketch and select Edit Sketch. 

 

 

 
 

2. After the sketch has been activated for editing, you can make changes to geometry, dimensions, 
and constraints. 

 

 

 

 

3. Continue to make edits to the sketch as required. 
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4. When you have finished editing the sketch, on the ribbon, click Finish Sketch to exit the sketch 
and return to the part model. The changes in the sketch are applied to the 3D features of the 
part. 
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Lesson: Using Parameters 
 

When you establish a relationship between one dimension and another, you can incorporate basic 
design intent into your model and quickly modify a model. You can define and control complex 
relationships by creating mathematical equations in a dimension or user-defined parameter. 
Equations can range from simple equations to more complex equations that include complex internal 
parameters. 

 

The Parameters dialog box is shown here. The Key Parameters control specific design values.  These 
parameters are a crucial to the eventual publication of Autodesk Factory Design Suite assets. 
 

 
 
 

Access 
 

     Parameters 
 
 
 

 

Ribbon: Manage tab > Parameters panel 

 

 
 

 
 
 

To establish a valid relationship to a parameter name, the spelling and capitalization 
must exactly match the name displayed in the Parameters dialog box. Select a custom 
parameter name from the list to ensure that spelling and capitalization match. 
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Parameters Dialog Box 
 

The Parameters dialog box is displayed when you start the Parameters tool. 
 

The following illustration shows the Parameters dialog box with model, reference, and user 
parameters. Notice that some model parameters were renamed to clarify use and facilitate access. 
The equations in this example range from a single numeric value to more complex equations that use 
functions and parameters. 

 

 
 
 

Managing Parameters 
 

Every dimension that you add when you create or assemble parts is accessible in the Parameters 
dialog box. You can manage parameters in the Parameters dialog box to accomplish the following 
tasks: 

 Create new user parameters. 

 Change the name of model and user parameters to add meaning. For example, you can give 
model parameters a generic letter d and an incremental number (d0, d1, d2, and so on). 

 Change the unit of measure to match your design data. For example, you can create a user 
parameter to store a volume value and use it later in an equation to calculate the size of a part. 

 Establish a mathematical equation to calculate a value. 

 Add or adjust the tolerance or precision for a dimension. 

 Adjust a dimension with tolerances at the maximum, minimum, median, or nominal value. 

 Select a parameter to export to a custom iProperty value. 

Add a general comment to explain the function or purpose of a parameter.

  Mark Key Parameters for Factory Asset Publication.

 Add multiple values for specific key parameters. 
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List Parameters 
 

You can select an existing custom parameter name for any dimension value. Right-click the value 
or click the arrow button on the right side of the value and click List Parameters to display a list of 
available custom parameter names. 

 

 
 

 
 

In this image, you right-click the value 10 
or select List Parameters. 

This image shows the Parameters list that opens 
when you select List Parameters. 

 

 

Using Equations and Parameters 
 

You can use equations wherever you can enter a numeric value. For example, you can write equations 
in the Edit Dimension dialog box, feature dialog boxes, and the Parameters dialog box. Equations can 
vary in complexity, and you can use them to calculate feature sizes, calculate assembly constraint 
offsets or angles, or simulate motion among several components. 

 

Equations can be simple or contain many algebraic operators, prefixes, and functions. For example, 
here is a simple equation: 

2 ul * (6 + 3) 

The following complex equation uses internal parameters such as pi: 

( PI rad /5 ul + (25 deg * PI rad / 180 deg ) ) 

 
Supported Algebraic Operators 

 

The following table lists the algebraic operators supported by Autodesk Inventor. 

 
 

 

Operator 
 

Meaning 

+ addition 

- subtraction 

% floating point modulo 
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Operator 
 

Meaning 

* multiplication 

/ division 

^ power 

( expression delimiter 

) expression delimiter 

; delimiter for multiargument functions. 

 
 

Supported Unit Prefixes 
 

The following table lists the unit prefixes supported by Autodesk Inventor. 

 
 

 

Prefix 
 

Symbol 

 

Value 

 

exa 
 

E 
 

1.0e18 

peta P 1.0e15 

tera T 1.0e12 

giga G 1.0e9 

mega M 1.0e6 

kilo k 1.0e3 

hecto h 1.0e2 

deca da 1.0e1 

deci d 1.0e-1 

centi c 1.0e-2 

milli m 1.0e-3 

micro micro 1.0e-6 

nano n 1.0e-9 
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Prefix 
 

Symbol 

 

Value 

pico p 1.0e-12 

femto f 1.0e-15 

atto a 1.0e-18 

 

 
When you use unit prefixes in an equation, enter the prefix symbol. Do not enter the prefix itself. For 
example, an equation that includes the unit nanometer might look like this: 3.5 ul * 2.6 nm. 

 
When you add the unit prefix for nano to the meter unit, your equation is calculated based on the 
length of 2.6 nanometers. 

 

 
 

Prefix symbols are case sensitive. You must enter them exactly as they appear in the 
previous table. 

 
 

 

Supported Functions 
 

The following table lists the supported functions. 

 
 

 

Syntax 
 

Returns Unit Type 

 

Expected Unit Type 

cos(expr) unitless angle 

sin(expr) unitless angle 

tan(expr) unitless angle 

acos(expr) angle unitless 

asin(expr) angle unitless 

atan(expr) angle unitless 

cosh(expr) unitless angle 

tanh(expr) unitless angle 

acosh(expr) angle unitless 

asinh(expr) angle unitless 

sqrt(expr) unit^1/2 any 



58 Chapter 7: Basic Shape Design 
 

 

 

Syntax 
 

Returns Unit Type 

 

Expected Unit Type 

sign(expr) unitless any (Return 0 if negative, 1 if positive.) 

exp(expr) unitless 
 

any (Return exponential power of expression; for 
example, return 2 for 100, 3 for 1000, and so on.) 

floor(expr) unitless unitless (Next lowest whole number.) 

ceil(expr) unitless unitless (Next highest whole number.) 

round(expr) unitless unitless (Closest whole number.) 

abs(expr) any any 

max(expr1;expr2) any any 

min(expr1;expr2) any any 

ln(expr) unitless unitless 

log(expr) unitless unitless 

pow(expr1;expr2) unit^expr2 any and unitless, respectively 

random(expr) unitless unitless 

isolate(expr;unit;unit) any any 

 
 

 

Function names are case sensitive. You must enter them exactly as they appear in 
the previous table. 
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Unit Types 
 

The unit type that you use with an equation depends on the type of data that you are evaluating. For 
example, to evaluate a linear or angular value, you typically use a unit type of millimeters, inches, or 
degrees (mm, in, or deg). 

 

Some equations must return a unitless value, for example, an equation to solve the number of 
occurrences in a pattern. You designate a unitless value with the characters ul. For example, 5 ul 
means that the equation has been evaluated and returned the number 5, as in the number of 
occurrences in a pattern. 
 

 
Unit Types: Keep Them Consistent 

 

Keep units consistent within equations containing parameters that represent different 
unit types. You can do this using the Isolate function. For example, to calculate the 
number of occurrences for a pattern that is based on one occurrence for each unit of a 
parameter named Width, your linear equation would be: 

 

isolate(Width;mm;ul) 
 

The Number of Occurrences value in a dialog box requires a unitless (ul) result, but 
you are referencing the unit width, which is a linear value. Therefore, you must 
convert the Width parameter to a unitless value. 

 

The following illustration shows how to break down the equation. 
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Order of Algebraic Operations 
 

Equations are evaluated from the inside out, and evaluation precedence is given to functions. For 
example, in the equation (15 * (25 + 3)), 25+3 is evaluated first, and the sum is multiplied by 15. The 
result is 420. 

 

The following table shows the algebraic operations in descending order. 

 

 

Operation 
 

Symbol 

 

Example 

parentheses ( ) (abs( 5 * -2)) 

exponentiation ^ Length^2 

negation - (-4.00 + Width) 

multiplication or division * or / (Length * Width) or (Length / Width) 

addition or subtraction + or - (-5.00 + Length - 0.50 * Width) 

 

 

Equation Color 
 

When you create equations, the equation text is displayed in red until it is considered 
valid. At that point, the equation text turns black. 

 

 
Procedure: Using Equations in Dimensions 

 

The following steps outline how to use equations in dimensions. 

1. On the ribbon, click the General Dimension tool. 

2. Select the geometry that you want to dimension. 

3. Place the dimension. 

4. In the Edit Dimension dialog box, enter the equation. 

 

 
 

5. Click the check mark icon to accept the value. 
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Procedure: Using Equations in a Dialog Box 
 

The following steps outline how to use equations in a dialog box. 

1. On the ribbon, click the feature type that you want to create. 

2. Select the geometry required for the feature. 

3. Enter the equation in any text box that requires a numerical value. 

 

 
 

4. Click OK to create the feature and close the dialog box. 
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Exercise: Edit Parametric Parts 
 

In this exercise, you implement changes to the clutch 
ever by editing sketches and features. You discover 
that changing one feature may create problems with 
other features that you will then need to edit as 
well. 

 

 

The completed exercise 

 
 
 

1. Open INV_007_Edit Feature.ipt. 

 
 

 
2. Display the dimensions on the original base 

sketch for editing: 

 In the browser, right-click Extrusion1. 

 Click Show Dimensions. 

 

 

 

 

 

 

 

 

3. Modify the 75 in dimension: 

 Double-click the 75 in dimension and 
change it to 80 mm and click the green 
checkmark. 

 On the Quick Access toolbar, click Update. 

 
 

4. Edit a sketch. 

 In the browser, right-click Extrusion7. 

 Select Edit Sketch. 
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5. Change the Dimension that controls the 
motor extrusion location: 

 Change the Value of the locating 
dimension from 10 to 15 and click the 
green check mark. 

 Click the Finish Sketch button on the 
Sketch ribbon. 

 

 
 
 
 

6. Change the counterbore holes to 
countersink clearance holes: 

 

 In the browser, right-click Hole1. Click Edit 
Feature. 

 In the Hole dialog box, set hole type to 
Countersink (1) and Clearance (2) by 
clicking the option button as shown. 

 Under Fastener, for Standard, select Ansi 
Metric M Profile (3). 

 For Fastener Type, select Flat Head 
Machine Screw (4). 

 For Size, select M2.5 (5). Click OK. 

 

 

Note:  The holes are shown in this exercise for 

instructional purposes only.  Small holes are 

usually not included on factory assets.  Factory 

assets should be modeled with a minimal or 

simplistic form to save computing time. 

7. Modify the depth of the main extrusion: 

 In the browser, double-click Extrusion1. The 
Extrude dialog box is displayed. 

 Change the 30 in to 36 in. 

 Click OK. 

 

8. Modify the motor size of Extrusion7: 

 In the browser, expand Extrusion7. 

 Double-click Sketch7 to display its 
dimensions on the model. 

 Double-click the 10 in dimension and 
change it to 12 in as shown. 

 On the Sketch Ribbon, click Finish Sketch. 
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9. Change the size of the chamfer on the 
Channel: 

 In the browser, right-click Chamfer1. Click 
Edit Feature. 

 

 
 

 Change the Distance value to 2 in to 1 in  

and click OK to implement the change. 

 

 

 

 

 

 

 

 

 

 

10. Close all files. Do not save. 
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2.   

   In the Parameters dialog box, select the 

  model parameter d0. Change its name to 

  Length. Press ENTER. 
 Note: In previous exercises you already 

established  the name of d0 as Length.  

This step simply demonstrates an 

alternative method of naming parameters. 

Exercise: Create Parameters 

and Multi-Value Parameters 
  Parameters dialog box: 

In this exercise you add additional values to the 
named parameters you created in the earlier 
exercises.  These values will be available when 
placing the asset component on the factory layout. 

  

 

 

 

 

 

 

 

The completed exercise 
 

 
 

 

1. Open INV_008_Parameters.ipt. 

 

 

 

In the Parameters dialog box, review the 
existing model, reference, and user parameters. 
Notice any custom parameter names or 
parameters with an existing equation instead of 
a single numeric value. 

 

 Click Done. 

3. Mark your Key Parameters. 

 Place a checkmark in the Key column for the 
parameters you wish to modify when 
placing the asset on the factory floor. 

§ Place checkmarks in the Key column for 
the Length, Height, and Width. 
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4. Add Multiple values to a parameter. 

For this asset, the Length and Height might be 

altered to any custom value.  The Width of the 

Conveyor must be one of three explicit values 

28 in, 30 in, or 36 in.  

 Right-click on the Value cell for Width and   

select Make Multi-value. 

 

 
 

 

6. Enter the alternative values. 

 In the Value List Editor, add 28 in, and 36 
in in the Add New Items window (1). 

 Click Add (2) and then OK. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
7. Test the functionality of the available 

parameters 

Modify the values for Length, Height, and 
Width, and notice the effect on the model.  
Notice that the Width Value displays as a 
drop down window with the alternative 
values listed for selection while the Length 
and Height values allow any custom value 
to be applied. 

 

 

 

 

 

 

 

 

 

 

 

8.  Return the Parameters to the original values 

and close the file without saving. 
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Lesson: Creating Work Features 
 

 
In this lesson, you learn to create and use work planes, work axes, and work points. You use these 
work features to assist in creating geometry, placing constraints, and completing other modeling tasks. 

 

The construction of most part models requires the use of work features to complete. The more 
complex your parts, the more work features you will likely use while creating it. 

 

The following illustration shows how work planes, axes, and points are displayed in your parts.  Work 

features help define the connector point that will be added to the asset during publication. 
 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Locate, display, and use the default work features and create new work features on a part. 

 Use the Work Plane tool to create work planes on a part. 

 Use the Work Axis tool to create work axes on a part. 

 Use the Work Point tool to create work points on a part. 
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About Work Features 
 

Every part contains a default set of work planes, work axes, and a center point. These default work 
features are located in the Origin folder of the Part browser. You use these default work features to 
define the initial orientation of your part design. You can use these default objects for the basis of 
new sketches, for feature termination options, and as the basis for creating new work features. As 
your part design progresses, you may need to create additional work plane, work axis, and work point 
features that are based on faces, edges, and vertices of your part. 

 

The following illustration shows the default work planes, axes, and center point located in the Origin 
folder of the browser. 

 

 
 
 

Definition of Default Work Features 
 

There are three default work planes, each representing a different coordinate plane. The three 
planes represented are the YZ plane, XZ plane, and XY plane. There are three default work axes, each 
representing a different coordinate axis. The three axes represented are the X axis, Y axis, and Z axis. 
There is a single Center Point work point, it represents the 0,0,0 coordinate. Work planes and work 
axes extend outward from this point. 

 

When you create a new part file, the initial sketch is created on one of these default planes. You can 
create additional sketches or features using the model or the default work planes. 
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The following illustration shows the three default work planes and the center point. 
 

 
 

The following illustration shows the three default work axes and the center point. 
 

 

 
The default planes are not visible when starting a new part file. You can control their visibility in the 
browser. The following illustration shows all of the default work features selected in the browser. By 
clicking on Visibility, they will all become visible in the drawing. 
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Parametric Work Features 

 

You create and use work features when physical geometry does not exist on the part for a specific task. 
For example, as you develop your part design, you typically orient sketches for your features on 
existing planar faces of the part. When a planar face does not exist, you can create one or more work 
features to define and orient a plane for that sketch. 

 

 

Example of Parametric Work Features 
 

In the following illustration, two work axes were used to create a centerline work plane. This work 
plane is then used to create a sketched feature on the end of the part. 

 

 
 

Browser Appearance of Parametric Work Features 
 

The following illustration shows how work features are displayed in the browser. 
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Work Feature Appearance 
 

The appearance of work features is controlled in several different ways. You can turn on or turn off the 
appearance of work features individually or globally. To turn off the visibility of a single work feature, 
right-click in the browser and click Visibility. 

 

 

 
 
 

Controlling Global Visibility 
 

On the ribbon, click View tab > Object Visibility to turn the visibility of work features and sketches on 
and off, as shown in the following image. Select the appropriate option. You can also use the keyboard 
shortcuts. 
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Creating Work Planes 
 

You use the Work Plane tool to create work planes in the current part. Work planes are used to 
define planar surfaces when the existing geometry does not represent the required plane. When you 
create work planes, you select geometry and/or other work features. Each selection defines either 
orientation or position for the new work plane. Work planes are parametrically attached to the model 
geometry or default work planes. When you create a work plane using features of existing geometry, 
if the geometry changes, the work plane also changes. For example, if you create a work plane that is 
tangent to a cylindrical surface with a radius of 2 mm, and that radius later changes to 5 mm, the work 
plane moves to retain the tangent relationship with the cylinder. 

 
Uses for Work Planes 

 

The following list summarizes some potential uses for work planes: 

 Basis for new sketches 

 Feature termination options 

 Basis for new work features 

 

In the following illustration, the work plane (1) is created at a 30-degree angle from a part face. The 
circular extrusion (2) is created from the work plane extruding to meet the part face. As the angle 
of the part face changes, the work plane updates to maintain the 30-degree angle, and the circular 
feature changes with the work plane. 

 

 
 
 

Access 
 

     Work Plane 
 

 
 

Ribbon: Model tab > Work Features panel 

 

Keyboard Shortcut: ] 
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Creating Work Planes: Process Overview 
 

When you create work planes, the type of work plane is based completely on the geometry you select. 
For example, there is no dialog box to create a planar offset work plane. All work planes are created 
based on two or three selections. Each selection represents either an orientation or position. 

 
Follow these steps to create a work plane that is aligned with the Origin XY plane and tangent to the 
outside of the cylinder. 

1. Select the feature or plane. 

 

2. Select the second feature or plane. 

 
 

The resulting work plane is created. 
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Procedures: Creating Work Planes 
 

When you create work planes, the type of work plane is based completely on the geometry you select. 
For example, there is no dialog box to create a planar offset work plane. All work planes are created 
based on two or three selections. Each selection represents either an orientation or position. 

Use the following approaches to create work planes. 

 
Aligned to Origin Plane/Tangent to Cylindrical Surface 

Selection 1 - Origin Work 
Plane 

Selection 2 - Cylindrical 
Feature 

Result 

 

 
 

 
 

Aligned to Face/Midpoint Between Two Faces 

 

Selection 1 - Part Face Selection 2 - Part Face Result 
 

 
 

 
 

Offset from Plane or Surface 
 

Selection 1 - Click and drag 
from plane or surface 

Selection 2 - Release the 
mouse and enter an 
offset distance 

Result 
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Angle from Face/Along an Edge 

Selection 1 - Edge on Part  Selection 2 - Planar Surface         Result 
on Part, Enter Angle 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Work Plane on Three Points 

 

Selection 1 - Vertex on Geometry Selection 2 - Vertex on Geometry 

 
 

 

 

Selection 3 - Vertex on Geometry Result 
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Parallel to Face/Midpoint of Edge 

Selection 1 - Plane/Face Selection 2 - Midpoint of 
Edge 

 

 
Result 

 
 
 
 

Procedure: Resizing Work Planes 
 

Place your cursor over the corner of the work plane. When the resize indicator appears, click and drag 
the corner of the work plane to resize it. 

 

 
 
 

Procedure: Moving Work Planes 
 

Place your cursor over an edge of the work plane. When the move indicator appears, click and drag the 
work plane to a new location within that same plane. In the following illustration, the move indicator is 
displayed (1) and the work plane is moved to a new location (2). 
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Creating Work Axes 
 

The Work Axis tool is used to create work axes in the current part. Work axes are used to define an 
axis when the existing geometry does not represent the required axis. Work axes are parametrically 
attached to the model geometry and/or default work features. When you create a work axis using 
features of existing geometry, if the geometry changes, the work axis updates to reflect those 
changes. 

 

 

Uses for Work Axes 
 

The following are some potential uses for work axes: 

 Axis of revolution for circular pattern 

 Basis for new work features 

 Representation of centerlines on sketches 

 

Access 
 

     Work Axis 
 

 
 

Ribbon: Model tab > Work Features panel 

 

Keyboard Shortcut: / 
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Procedure: Creating Work Axes 
 

When you create a work axis, the type of work axis is based completely on the geometry you select. 
For example, there is no dialog box to create an axis at the intersection of two planes. All work axes are 
created by selecting existing geometric features or other work features. Follow these steps to create a 
work axis. 

 
Procedures: Creating Work Axes 

 

Use the following approaches to create work axes. 

 
Work Axis at Center of Circular Feature 

Selection 1 - Circular Feature Result 

 

 

 

 

 

Work Axis at Intersection of Two Planes 

Selection 1 - Plane or 
Planar Surface 

Selection 2 - Plane or 
Planar Surface 

Result 
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Work Axis Through Point/Normal to Plane 

Selection 1 - Plane or 
Planar Surface 

Selection 2 - Point Result 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Work Axis Through Two Points 

Selection 1 - Point or 
Midpoint 

Selection 2 - Point or 
Midpoint 

Result 
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Creating Work Points 
 

You use the Work Point tool to create parametric construction points on part features. Several 
methods are available for creating these work points. Each method creates a work point that is 
parametrically attached to the geometry or other work features. If this geometry changes, the work 
point changes accordingly. 

 
Work points are used as construction geometry to assist in the creation of other geometry and 
features. 

 

Grounded Work Points are fixed in space and have no association to other geometry. In part files, you 
place grounded work points at vertex points on the part. Once placed, you can modify the point using 
options found on the short cut menu. 

 

 

Uses for Work Points 
 

The following are some potential uses for work points: 

 Projection onto sketches. 

 Basis for new work features. 

 Creation of 3D sketches by drawing lines between work points. 

 

Access 
 

     Work Point 
 

 
 

 

Ribbon: Model tab > Work Features panel 

 

Keyboard Shortcut: . 
 

 

Access 
 

     Grounded Work Point 
 

 
 

Ribbon: Model tab > Work Features panel 

 

 

Keyboard Shortcut: ; 

es panel
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Procedures: Creating Work Points 
 

Use the following approaches to create work points. 

 
Creating a Work Point on a Vertex 

1. On the panel bar, click the Work Point tool and select a vertex on the part. 

 

2. The work point is created on the selected vertex. 

 

 

Creating a Work Point at the Midpoint of an Edge 

1. On the panel bar, click the Work Point tool and select the midpoint of an edge. 

 

2. The work point is created on the midpoint of the selected edge. 
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Creating a Work Point at the Intersection of an Edge and Plane 

1. On the panel bar, click the Work Point tool and select an edge or axis. 

 

2. Select a plane or surface. 

 

3. The work point is created at the intersection of the edge and plane. 
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Work Point at the Intersection of a Line or Axis and a Surface 

Selection 1: Line or Axis Selection 2: Surface Result 

 
 

 
 

Work Point at the Intersection of a Plane and a Curve 

Selection 1: Plane or Face Selection 2: Curve Result 
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Exercise: Create Work Features 
 

In this exercise, you create work features that 

will define the connection points for the 

conveyor asset. 

 

The completed exercise 
 
 

1. Open INV_008A_Work_Features.ipt. 

2. Turn on the visibility of the default XY plane. 

 
 In the browser, expand the Origin folder. 

 Right-click XY Plane. 

 Click Visibility. 

 

 
 

 

 

 

 

 

 

 

 

 

3. Mirror the Motor feature to the other side. 

 On the ribbon, click the Mirror tool. 

 Select the motor feature (Extrusion5). 

 Click the Mirror Plane button. 

 Select the XY origin plane as shown here. 
Click OK. 

 
 
 

4. Create an Axis that runs along the center of 
the conveyor belt. 

 On the ribbon, click the Work Axis tool. 

 In the browser, select XY Plane. 

 Select the top face of the belt as shown 
in the following image. 
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5. Create a workpoints at the intersection of the 

Axis and the end faces. 

    On the ribbon, click the Work Point tool. 

 Click axis and then the right end face as 

shown in the following image. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Repeat the process creating a workpoint on 

the left face. 

 

6.      In the graphics window, right click the work 

plane.  Click Visibility on the shortcut menu to 

turn off the work plane visibility. 

 
§ Repeat this process for the work axis and 

work points. 

 

7.  Close the file without saving.
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Chapter Summary 
 
 
 
 

This chapter presented the tools and recommended workflows for basic shape design. Using these 
techniques, you can now create more complex 2D sketches at different locations on your part, 
combine multiple 3D features to create various shapes, and modify those shapes at any time during 
the design process. 

Having completed this chapter, you can: 

 Create features using the Extrude and Revolve tools. 

 Use reference and construction geometry. 

 Use the browser and shortcut menus to edit parametric parts. 

 Use the 3D Grips tool to edit part geometry in the context of an assembly and in a stand-alone 
part. 

 Create, locate, and utilize work features to perform modeling tasks. 
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Chapter 
 

8 
 

 
 
 

Detailed Shape Design 
 

 
 

This chapter enhances your basic part modeling skills by providing additional tools and recommended 
workflows for detailed shape design. Common industry practice dictates the use of chamfers and 
fillets to break sharp corners and relieve stress. Holes and threaded features often must be added 
for fasteners. Some parts, such as stampings or molds, must be designed as thin-walled shapes. 
Additionally, most parts include some shapes or features that are patterned or mirrored. 
 
Highly detailed models are usually not used during the Factory Layout Process.  Factory assets 
are created to be a simplified representation of the finished product.  As a result the use of the 
detailed features demonstrated in this section is generally discouraged as a best practice.  The 
placed features outlined and demonstrated in this chapter are provided in case they are 
required during the simplified asset creation process. 
  

The lessons in this chapter cover the tools required to meet each of these design requirements. 

 
Objectives 

 

After completing this chapter, you will be able to: 

 Create both chamfers and fillets on a part. 

 Use the Hole tool to place hole features on your part model. 

 Create rectangular and patterns and mirror existing features. 
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Lesson: Creating Chamfers and Fillets 
 
 

 
This lesson describes how to create both chamfers and fillets on your part. Fillets are commonly used 
on a part to reduce the potential of stress cracking, and for aesthetic reasons. Chamfers are used for 
angled faces, relief clearance, and also for aesthetic purposes. 

 

Chamfer and fillet features are standard on most manufactured components and are among the most 
widely used placed features on any 3D part. 

 

The following illustration shows a part where all sharp edges have been replaced with fillet or chamfer 
features. 

 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Describe the difference between chamfers and fillets and give an example of how they are used. 

 Use the Chamfer tool to create chamfers. 

 Use the Fillet tool to create constant radius fillets. 

 State the guidelines for creating chamfers and fillets. 
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About Chamfers and Fillets 
 

A fillet creates a radius edge on an interior or exterior corner of your part, whereas a chamfer bevels 
an edge. Cast and molded parts rarely have true sharp edges. Chamfer and fillet features are applied 
to almost all the edges of your part designs. When completing a machined part on the shop floor, you 
always remove all sharp edges. You also apply this same principle to your parametric part designs. 

 

The following illustration shows a cast part with fillets and rounds on edges and then chamfers placed 
on the holes to represent the machining process. 

 

 
 
 

Definition of Fillets 
 

A fillet is defined by a single constant radius, or in the case of a variable radius fillet, by more than one 
radius. Consider a fillet to be an interior shape, placed between faces of less than 180 degrees, which 
adds material to your part. A round is an exterior shape placed between faces of any angle, which 
removes material from your part when created. 
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    Fillet 

    Round 

Full round 
 
 
 

Definition of Chamfers 
 

A chamfer is defined using equal distances, a distance and an angle, or two different distance values. 
Chamfers are used to break sharp edges and as lead-ins on holes or bosses. Most angles faces in 
parametric parts are created using chamfers. 
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    Distance 

    Distance and Angle 

Two Distances 
 
 
 

Example of Using Chamfer for a Lead-in 
 

In most circumstances, placing a fastener into a hole is aided through the use of a chamfer. In the 
following illustration, it is easier to assemble the parts on the right that have a chamfer used as a lead- 
in. 

 

 
 

 
 
 
 

Creating Chamfers 
 

You use the Chamfer tool to add chamfer features to edges on your part. These features, like other 
features, are fully parametric and easily editable after you create them. When you create chamfer 
features, you can choose from three different methods which determine how the chamfer is specified. 
With any of the methods, the end result is the replacement of the selected edge(s) with a face(s) at an 
angle specified either directly or indirectly through the use of distances. 
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The following illustration shows a part before and after adding chamfer features. 
 

 
 
 

Access 
 

     Chamfer 
 

 
 

Ribbon: Model tab > Modify panel 

 

Keyboard Shortcut: CTRL+SHIFT+K 
 

 

Chamfer Dialog Box 
 

The Chamfer dialog box is displayed when you start the Chamfer tool. 
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Option

 

Description 

 

 

 

Distance 
 

Specify a distance for the chamfer. The distance is applied to both sides of the 
selected edge, resulting in a 45-degree chamfer. 

 

 
 

 
 
 
 
 

 

Distance 
and 
Angle 

 

Select a face adjacent to the edge you are chamfering. The angle is measured from 
this face. Select the edge(s) to be chamfered. This option is disabled until you 
select a face. The edge(s) selected must be adjacent to the selected face. Specify a 
distance for the chamfer. The distance is measured from the selected edge along 
the selected face. Enter an angle for the chamfer. The angle is measured from the 
selected face. 

 

 
 

 
 
 

Two 
Distances 

 

Select the edge to be chamfered. When you use this method, only one edge can 
be chamfered at a time. Specify the first distance of the chamfer. This distance 
is measured along one of the adjacent faces. Specify the second distance of the 
chamfer. This distance is measured along the opposite adjacent face. 

 
 

Procedure: Creating Chamfers 
 

The following steps describe how to create chamfer features. 

1. On the ribbon, click the Chamfer tool. 

2. In the Chamfer dialog box, select the desired method to create the chamfer. 
 

 For a single distance chamfer, select the edge(s) to be chamfered. Enter a distance for the chamfer. 
 

 
 

The resulting chamfer is created. 
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 For the distance and angle method, select the Distance and Angle option. Select the face, and then 
select the edge(s) to be chamfered. Enter a distance and angle for the chamfer. 

 

 
 

The resulting chamfer is created. 
 

 

 For the two distances method, select the Two Distances option. Select the edge to be chamfered. 
Enter distance values in the Distance1 and Distance2 fields. 

 

 
 

Click OK to create the chamfer. 

The resulting chamfer is created. 
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Creating Fillets 
 

You use the Fillet tool to create fillets and rounds on existing 3D geometry. You can create both 
constant radius and variable radius fillets with the Fillet tool. 

 

The following illustration shows a block before and after adding fillet features. 
 

 
 
 

Access 
 

     Fillet 
 

 

Ribbon: Model tab > Modify panel 

 

Keyboard Shortcut: F 
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Constant Radius Fillet Options 
 

The Fillet dialog box is displayed when you start the Fillet tool. 
 

 

 
The following creation methods and options are available in the Fillet dialog box. 

 

  

Option 

 

Description 

 

 

 

Edge 
 

Adds fillets or rounds to one or more edges of a part. All fillets and rounds created 
in a single operation become a single feature. 

 

 

 

Face 
 

Adds fillets or rounds between two selected face sets. The face sets do not need to 
share an edge. 

 

 

 

Full 
Round 

 

Adds fillets or rounds that are tangent to three adjacent faces. The center face is 
replaced by the fillet. 

 

 
 

 
 

Select 
Mode 

 

Mode selection enables easy selection of objects to fillet. Select Edge for edge 
selection priority; Loop for face selection priority; and Feature for feature priority 
selection. 

 

 
 

 
 

Solids 
 

This button is only available when multiple solid bodies exist in the part file. When 
this is the case, the user can click the solids button to select one or more solid 
bodies to use with the All Fillets and All Rounds selection options. 

 

 

 

Options 
 

Use the All Fillets or All Rounds check boxes to quickly select all fillet edges or all 
round edges on the part. Select them both to have all edges on the part selected. 
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Procedure: Creating Constant Radius Fillets 
 

Follow these steps to create constant radius fillet features. 

1. On the ribbon, click the Fillet tool. 

2.      With the Fillet dialog box displayed, in the graphics window, select the edges to be filleted and 
specify a radius for each edge set. Create an edge set for each different radius. In the following 
illustration, two edge sets have been created. The first edge set contains two edges to receive a 
2 mm fillet and the second set contains three edges to receive a 1 mm fillet. 

 
 

3.      Click OK to create the fillet feature. Notice that in the browser only one fillet feature is displayed 
even though five edges were filleted in this example. 
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Guidelines for Creating Chamfers and Fillets 
 

Although both fillets and chamfers are relatively simple shapes, they are often a challenge to create 
with consistency where multiple edges intersect. Following the guidelines presented here can improve 
your success in creating these features. 

 

 

Chamfer and Fillet Creation Guidelines 
 Avoid creating all of your fillets and chamfers with a single feature. You will have greater success 

creating and changing features with less edges selected. 

 Create these features on parallel edges of a part first. When you create additional features, you can 
select the resulting face to complete the remaining edges at the same time. 

 Remember that using the Two Distances option with the Chamfer tool limits you to creating the 
feature on one edge at a time. 

 Pressing CTRL while clicking removes geometry from the selection. 

 Because fillets and chamfers are considered finish features, consider creating them toward the end 
of the design process after all other features have been defined. 

 Avoid including fillets and chamfers in your sketch geometry and instead create them as part 
features. 

 

 

Example of Creating Separate Features 
 

In the following example, by creating your side fillets first, you can select the continuously tangent 
edge as a single selection rather than having to select all the edges individually. Creating your fillet 
features in this way gives you more flexibility for possible changes to the part later. 

 



13 Chapter 8:  Detailed Shape Design  

Exercise: Create Chamfers 
 

In this exercise, you add chamfer features to an 

existing part. 

 

 

 

 

 
 

The completed exercise 

 
 

 

1. Open Inv_009_Chamfer.ipt. 

 

 
 
 
2. Create a chamfer on 4 sharp corners as 

shown in the following image. 

 On the ribbon, click the Chamfer tool. 

 Select the 4 corner edges shown. 

 For Distance, enter 2 in . Click OK. 

 

 

 
 

 

3. Create a .5 in chamfer on the outside edge of 
the motor housing. 

 Restart the Chamfer tool. 

 Select the outside edge of the motor 

housing. 

 For Distance, enter .5 in. Click OK. 

 
 

4. Close the file without saving. 
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Exercise: Create Fillets 
 

 

 

In this exercise, you create constant radius fillets on 

an existing part. 
 

 

 

 
 

The completed exercise 

 
 

1. Open INV_010_Fillet.ipt. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

2. Create fillets on the 4 sharp corners as shown 
in the following image. 

 

 On the ribbon, click the Fillet tool. 

 Select the 4 corner edges shown. 

 For Distance, enter 4 in . Click OK. 

 

 

 
 

3. Create a .5 in fillet on the outside edge of the 
motor housing 

 Restart the Fillet tool. 

 Select the outside edge of the motor 
housing. 
For the distance, enter .5 in.  Click OK. 

 

 

 

4. Close all files without saving. 
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Lesson: Creating Holes and Threads 
 
 

 
This lesson describes how to use the Hole tool to create parametric hole features and the Thread tool 
to create threads on existing model features. You use hole features to create parametric holes on 
parts. Although hole features are considered to be placed features, you can use unconsumed sketch 
geometry to represent the center point locations for the holes. 

 

The most common method of joining two or more components together is with threaded fasteners. 
You should master the use of both the hole and thread features to produce the best models possible. 

 

The following illustration shows a part that contains a combination of hole and thread features. 

 
 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Define a hole feature. 

 Use the Hole tool to create holes on your part. 

 Use the Thread tool to create external thread features. 
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About Hole Features 
 

Hole features are parametrically created features that are placed on existing part geometry. You can 
create hole features with a number of different options, such as counterbore, countersink, flat bottom, 
spotface, threads, tapered threads, and fastener clearances. 

 

The following illustration shows a part with various types of holes. The enlarged view (1) shows the 
bitmap thread representation. 

 

 
 
 

Definition of Parametric Holes 
 

There are many different ways to fasten parts together and most require a hole. Although you can 
create holes by extruding a circle with a cut operation, the Hole tool provides greater flexibility in 
the variations and types of holes that you can create, such as counterbore, countersink, and threads. 
Using the Hole tool, you can create the various hole types in a single dialog box, rather than having to 
manually edit or create geometry. 

A primary benefit of using the Hole tool is the ability to annotate holes in the drawing environment 
with the Hole Note and Hole Chart tools. A sample of the automatic hole note callout is shown in the 
following illustration. 
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Example of Fastening Parts 
 

Two metal components are often fastened together using a socket head cap screw. The following 
illustration shows the clearance hole for the screw in one part and the threaded hole in the mating 
part. 
 

 

 
 

 

 

 

Benefits of the Hole Tool 
 

Benefits of using the Hole tool include the following: 

 You use a single tool to create holes with various options. 

 You can annotate holes created with the Hole tool in the drawing with the Hole Note and Hole 
Chart tools. 

 You can determine hole size by specifying the fastener thread type or clearance. 

 Options such as the counterbore, countersink, and spotface enable you to add features in a single 
operation. 
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Creating Holes 
 

When you use the Hole tool, different options are available for defining the location of the hole as 
well as for the type of hole to be created. You can define hole locations based on sketch geometry or 
existing planes, points, and edges on the part. You can create standard drilled holes, counterbored 
holes, and countersunk holes. Additional options are available for the drill point and thread options. 

 
 
 

Access 
 

     Hole 
 

 
 

Ribbon: Model tab > Modify panel 

 

 

Keyboard Shortcut: H 
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Hole Dialog Box 
 

The Hole dialog box is displayed when you start the Hole tool. 
 

 
 
 

Hole Placement Options 
 

You can use any of the following options in the Hole dialog box for placing a hole feature. 

 
From Sketch 

 

Select this option to create holes based on locations on a sketch. Hole locations can consist of Point/ 
Hole Center objects, endpoints of lines or curves, or centers of projected circular geometry. 
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The following option is available when you select From Sketch placement. 

 

 

Dialog Box 
Access 

 

Option 

 

Description 

 

 
 

Centers 
 

Select the center points for the holes. Use this option to create a 
series of identical holes with one feature. 

 

 
 
 

Solids 
 

This option is only available when the part contains multiple solid 
bodies. When available, you can use this option to select the solid 
body that the hole feature will apply to. 

 

 

Linear 
 

Select this option to position the hole relative to two selected edges. 
 

 

 
The following options are available when you select Linear placement. 

 
 

 

Dialog Box 
Access 

 

Option 

 

Description 

 

 
 

Face Select a face on the part to orient the hole. 

 

 
 
 

Solids 
 

This option is only available when the part contains multiple solid 
bodies. When available, you can use this option to select the solid 
body that the hole feature will apply to. 

 

 
 
 

Reference 1 
 

Select a part edge as the first reference. A dimension is placed 
from the selected edge to the center of the hole. The dimension 
can be edited as a standard parametric dimension. 

 

 
 

Reference 2 
 

Select a part edge as the second reference. A dimension is placed 
from the selected edge to the center of the hole. 

 

 
 

Flip Side 
 

Select this option to position the hole on the opposite side of the 
selected edge. 
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Concentric 
 

Select this option to position the hole concentric to another circular part edge. 
 

 

 
The following options are available when you select Concentric placement. 

 

 

Dialog Box 
Access 

 

Option 

 

Description 

 

 
 

Plane Select a part face to orient the hole. 

 

 
 
 

 

Solids 
 

This option is only available when the part contains multiple solid 
bodies. When available, you can use this option to select the solid 
body that the hole feature will apply to. 

 

 
 

Concentric 
Reference 

Select a circular edge or face to position the hole concentrically. 

 

 

On Point 
 

Select this option to position the hole on a work point. 
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The following options are available when you select On Point placement. 

 

 

Dialog Box 
Access 

 

Option 

 

Description 

 

 
 

Point Select a work point to position the hole. 

 

 
 
 

Solids 
 

This option is only available when the part contains multiple solid 
bodies. When available, you can use this option to select the solid 
body that the hole feature will apply to. 

 

 
 
 

Direction 
 

Select a plane, face, edge, or work axis to define the direction of 
the hole. If you select a plane, the hole direction is normal to the 
face or plane. 

 

 

Hole Type and Size Options 
 

You can use any of the following options in the Hole dialog box to define the type and size of the hole. 

 
Hole Type 

 

Use the following options to define a standard drilled hole, counterbore hole, spotface, or countersink 
hole. 

 

 
 
 

Hole Parameters 

Depending on the hole type selected, enter the hole parameters in each available field. 
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Drill Point 
 

Select flat or angled drill point. If you select angled, either enter an angle for the drill point or accept 
the default value. 

 

 
 

 
 

 

Termination 
 

Select the termination option for the hole from the drop-down list. 

 

 

Option 
 

Description 

Distance 
 

The depth of the hole is based on the distance that you entered in the hole 
parameters area. 

Through All 
 

The hole is created through the entire part, even if the part depth at the location 
of the hole changes. 

To Select a face or plane to calculate the depth of the hole. 

 

Additional Hole Type Options 
 

Use the additional hole type options to define a simple hole, tapped hole, or clearance hole. 
 

 

Option 
 

Description 

 

 
 

Creates a simple hole with no thread features. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Creates a tapped hole based on the thread designation and options entered in the 
Threads area of the dialog box. The Threads area appears only when this option is 
selected. 
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Option 
 

Description 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Creates a clearance hole based on the fastener selected. Available clearance options 
are Close, Normal, and Loose. The Fastener area appears only when this option is 
selected. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Creates an NPT tapped or Taper threaded hole based on the thread designation and 
options entered in the Threads area of the dialog box. 
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Procedure: Creating Hole Features Using the Linear Option 
 

Follow these steps to create hole features using the Linear placement option of the Hole tool. 

1. On the ribbon, click Hole and select Linear from the Placement list. 

 
 

2. Select the face to orient the top of the hole, then select two reference edges to locate the 

hole. The edges that you select do not need to be on the same plane as the face that you 

select. 

 

 

3. Select each dimension and enter its precise value in the Edit Dimension dialog box. 

 

           
 
 
 

 4. Adjust the options in the Hole dialog box. Click Apply to create the hole and continue 
placing other holes. 
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Procedure: Creating Hole Features Using the Concentric Option 
 

 

Follow these steps to create hole features by using the Concentric placement option of the Hole tool. 

1. On the ribbon, click Hole and select Concentric from the Placement list. 

 

   
 

 

2. Select the plane or face (1) to orient the hole, then select a curved surface (2) as the concentric 
reference. 
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3. Adjust the options in the Hole dialog box. Click Apply to create the hole and continue placing 
other hole features. 
 

 
 

 
 

Procedure: Creating Hole Features Using the From Sketch Option 
 

Follow these steps to create and edit holes using sketch geometry for the hole locations. 

1. Create a new sketch that contains the center point location for the hole features. 

 
 

 

2. On the ribbon, click Finish Sketch to exit the sketch. 
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4. On the ribbon, click Hole and select the From Sketch placement option. If you use the Point/Hole 
Center sketch object, the hole centers are automatically selected. Adjust the options in the dialog 
box depending on the type of hole you need to create. Click OK to create the hole. 
 

 
 

 
 

Procedure: Creating Hole Features Using the On Point Option 
 

Follow these steps to create hole features using the On Point placement option of the Hole tool. 

1. Create a work point (1) at the location of the hole. 
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2. On the ribbon, click Hole. Select On Point from the Placement list and then select the work 
point. 

 
 

2. Select a face, edge, or axis to define the direction of the hole. If you select a face or plane, the 
direction is normal to the face or plane. 
 

 

 

3. Adjust the options in the Hole dialog box. Click Apply to create the hole and continue placing 
other holes, or click OK to create the hole and end the process. 
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Exercise: Create Holes and 

Threads 
 

In this exercise, you use the Hole tool with 
multiple placement options to create tapped, 
countersink, counterbore, and clearance 
holes. You also use the Thread tool to create 
an internal and external thread. 

 

 

The completed exercise 
 
 

Create Holes 
 

In this portion of the exercise, you use the Hole tool 
To create simple holes on the conveyor asset 
model. 

 

 
1. Open INV_011_Holes.ipt. 

 

 
 

 

 

 

 

 

 

 

 

 

 

2. Create a Concentric Hole thru the conveyor 

end. 

 On the ribbon, click the Hole tool. 

 In the Hole dialog box, select Concentric 
from the Placement list. 

 Click Face. 
 

 

 
 

3. Select the outside face of the channel near the 
right end of the conveyor. 
 

 

 

 

4. Select the circular edge of the channel as a 
concentric reference. 
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5. Select the settings for the hole feature: 

 Enter a diameter value of 2 in (1). 

 Set the termination (2) to Through All. 

  To include the Belt body in the hole feature, 

click the Solids selector (3) and click the Belt 

body. 

 Click OK. 

 

 

 

6. Repeat the process to create the concentric 
hole at the opposite end of the conveyor. 
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Lesson: Patterning and Mirroring Features 
 

This lesson describes how to mirror features, and how to reuse existing features in rectangular and 
circular patterns. Mirroring and patterning can save you time in creating the geometry, as well as in 
editing the features when the design changes. 

 

When you create patterns or mirror existing geometry, you reduce the need to manually draw and 
edit these duplicate features. 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 
 

 Identify situations in which you should pattern or mirror part features instead of creating new 
ones. 

          Use the Rectangular Pattern tool to create rectangular patterns. 

          Use the Circular Pattern tool to create circular patterns. 

          Use the Mirror tool to create symmetric features. 
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About Feature Reuse 
 

Many designs require patterns of features or geometry that consist of features that are symmetric 
about a given plane. Instead of creating these features independently, you can use the Pattern and 
Mirror tools to populate your parts with existing features. 

 
 
 

Definition of Patterns 
 

You use patterns to duplicate existing geometry according to parameters that you specify. When you 
create patterns, occurrences of the original features are created. You can create these occurrences in 
a circular or a rectangular pattern. When you create these patterns, the occurrences are associative to 
the original feature, so any changes in the original feature are automatically reflected in the pattern 
occurrences. 

 

Definition of Mirroring Part Features 
 

Parts often include features that can be considered symmetric about a plane of symmetry to other 
features on the part. You can use the Mirror tool to mirror this geometry. 

 

In the following illustration, Rectangular (1) and Circular (2) patterns have been created based on 
individual features. 
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Features That Can Be Reused 
 

The following features can be patterned or mirrored: 

 Most sketched and placed features 

 Entire solids 

 Work features 

 
Benefits of Reusing Features 

 

Benefits associated with patterning and mirroring features include the following: 

 You need to create only one of the patterned or symmetric features. 

 Changes that you make to the original feature are automatically applied to the patterned or 
mirrored features. 

 

Appearance of Rectangular and Circular Patterns in the Browser 
 

The way that patterns are displayed in the browser is different from the way that other features are 
displayed. When you expand a rectangular or circular pattern, the difference is immediately apparent. 
Any sketches used as a path, along with a folder containing the features used in the pattern, are 
displayed under the pattern feature. Beneath that is an Occurrence item for each occurrence in the 
pattern. The first Occurrence item represents the initial feature used in the pattern, followed by an 
Occurrence item for each occurrence created. 

 

 
 

Right-click an occurrence and click Suppress on the shortcut menu to suppress the selected 
occurrence. This option is not available on the first occurrence. 
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Example of Mirrored Features 
 

In the following illustration, the part consists of several features that are symmetric about a plane of 
symmetry. The symmetry planes are identified, along with the features that have been mirrored about 
them. 

 

    Symmetry Plane A 

    Features mirrored about Plane A 

   Symmetry Plane B 

Features mirrored about Plane B 

 

Creating Rectangular Patterns 
 

You use the Rectangular Pattern tool to duplicate one or more features in a rectangular pattern. 
You can pattern a feature along one or two directions and/or paths, with options to control feature 
spacing. 
 

 
 
 

Access 
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     Rectangular Pattern 

 
 

 
 

Ribbon: Model tab > Pattern panel 

 

Keyboard Shortcut: CTRL + SHIFT + R 

 

 

Rectangular Pattern Dialog Box 
 

The Rectangular Pattern dialog box is displayed when you start the Rectangular Pattern tool. 
 

 
 
 

Pattern Type Options 
 

The following pattern types are available in the Rectangular Pattern dialog box. 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

Individual 
Feature 

Click this button to pattern individual features. 

 

 
 

Entire 
Solid 

Click this button to pattern the entire solid. 
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When the Pattern Individual Features button is selected, you have the following selection option. 

 
 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

Features Select one or more features to be patterned. 

 

 
 
 

Solid 
 

This button is only available when multiple solid bodies exist. You 
use this button to determine to which solid body the feature is 
going to be applied. 

 

When the Pattern Entire Solid button is selected, you have the following selection option. 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 
 
 

 

Include 
Work/ 
Surface 
Features 

Select the work features to include in the pattern. 

 

 
 
 

Solid 
 

This button is only available when multiple solid bodies exist. You 
use this button to determine to which solid body the feature is 
going to be applied. 

 

 

Direction Pattern Options 
 

The following options are available in the Direction 1 and Direction 2 areas of the Rectangular Pattern 
dialog box. 
 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

 
 

Path Select the path for Direction 1. This can be the edge of a part or a 
2D sketch that represents the path for the pattern. Valid selections 
include 2D and 3D lines, arcs, splines, part edges, axes, and 
trimmed ellipses. Click the Flip button to flip the path direction. 

 

 
 

Mid 
Plane 

 

Creates a pattern where the occurrences are distributed on both 
sides of the original feature. 

 

 
 

Count 
 

Enter the number of occurrences for the pattern. This number 
includes the original feature. 

 

 
 

 

Length 
 

Enter a value for the pattern distance. This value represents either 
the total distance of the pattern or the spacing between the 
features. 

 

 
 

Method 
 

Specifies the total distance and direction of the pattern, the 
spacing between occurrences, or if the pattern is equally fitted to 
the length of the selected curve. 
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Compute Options 
 

The following options are available in the Compute area of the Rectangular Pattern dialog box. 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

 

Optimized 
 

For pattern occurrences of 50 or more, increases pattern 
performance. 

 

 
 

 

Identical 
 

With this method, each occurrence uses an identical termination 
method, regardless of where it intersects other features. 

 

 
 

 
 

Adjust 
 

Enables each occurrence termination to be calculated. 
This method requires more processing and can increase 
computational time on large patterns. 

 

 

Orientation Pattern Options 
 

The following options are available in the Orientation area of the Rectangular Pattern dialog box. 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

Identical Occurrence orientation is identical to that of the first feature. 

 

 
 

Adjust 
Direction 

 

Specifies which direction controls the position of patterned 
features. Rotates each occurrence so that it maintains its 
orientation to the 2D tangent vector of the path. 

 

 

 

Procedure: Creating an Optimized Rectangular Pattern 
 

Follow these steps to create an optimized rectangular pattern. 

1. Create a part with one or more features to be patterned. 
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2. On the ribbon, click the Rectangular Pattern tool and select the feature to be patterned. Click the 
Path button under Direction 1 and select a path, part edge, or origin axis for the pattern. Enter 
the number of occurrences and distance values and adjust the spacing method as necessary. 
Optionally include information for Direction 2 and then click OK. 

 

 
 

3. As soon as the total number of occurrences is equal to or greater than 50, you are prompted to 
consider using the Optimized Compute option. Click OK to close the message box. 
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4. In the Rectangular Pattern dialog box, click the More button to expand the dialog box, and then 
select Optimized. 

 

 

 

5. Click OK to create the optimized pattern. 
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Creating Circular Patterns 
 

You use the Circular Pattern tool to duplicate one or more features in a circular pattern. When you 
start the Circular Pattern tool, you first choose to pattern individual features or the entire solid. 
You then select a rotation axis, which serves as the center of the pattern. Next you set the pattern 
properties, such as number of occurrences and angle. There are also options for controlling the 
creation method and positioning method. 

 

The following illustration demonstrates a circular hole pattern being created. 

 

 
 
 

Access 
 

     Circular Pattern 
 

 
 

 

Ribbon: Model tab > Pattern panel 

 

Keyboard Shortcut: CTRL + SHIFT + O 
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Circular Pattern Dialog Box 
 

The Circular Pattern dialog box is displayed when you start the Circular Pattern tool. 
 

 
 
 

Pattern Type Options 
 

The following pattern types are available in the Circular Pattern dialog box: 

 
 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

Individual 
Feature 

Click this button to pattern individual features. 

 

 
 

Entire 
Solid 

Click this button to pattern the entire solid. 

 

Feature-Axis Selection 
 

When the Pattern Individual Features button is selected, you have the following selection options. 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

Features Select one or more features to be patterned. 

 

 
 

Rotation 
Axis 

 

Specifies the axis, or pivot point, about which features are rotated. 
Click Flip to reverse the direction of the pattern. 

 

 
 
 

Solid 
 

This button is only available when multiple solid bodies exist. You 
use this button to determine to which solid body the feature is 
going to be applied. 
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When the Pattern Entire Solid button is selected, you have the following selection option. 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 
 
 

 

Include 
Work/ 
Surface 
Features 

Select the work features to include in the pattern. 

 

 
 
 

Solid 
 

This button is only available when multiple solid bodies exist. You 
use this button to determine to which solid body the feature is 
going to be applied. 

 

 

Pattern Placement Options 
 

The following placement options are available in the Circular Pattern dialog box: 

 
 

 

Dialog Box Access 
 

Option 

 

Description 

 

 

 

Count 
 

Specify the number of occurrences for the pattern. This number 
includes the original feature. 

 

 
 

Angle 
 

Specify the angle for the pattern. The result of this angle is based 
on the positioning method you select. 

 

 
 

Mid 
Plane 

 

Creates a pattern where the occurrences are distributed on both 
sides of the original feature. 

 

Creation Method Options 
 

The following options are available in the Creation Method area of the Circular Pattern dialog box: 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 

 

Optimized 
 

For pattern occurrences of 50 or more, increases pattern 
performance. 

 

 

 

Identical 
 

With this method, each occurrence uses an identical termination 
method, regardless of where it intersects other features. 

 

 
 
 

Adjust 
 

Enables each occurrence termination to be calculated. 
This method requires more processing and can increase 
computational time on large patterns. 
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Positioning Method Options 
 

The following options are available in the Positioning Method area of the Circular Pattern dialog 
box. 
 

 

 

Dialog Box 
Access 

 

Option 

 

Description 

 

 
 

Incremental Sets the angle value to represent the angle between occurrences. 

 

 

 

Fitted 
 

Sets the angle value to represent the total rotational angle of the 
pattern. 

 
 

 

 Mirroring Features 

 
When you mirror part features, you must first have the features to be mirrored and a plane to use as 
the symmetry plane. The symmetry plane can be any of the following: 

 An existing face on the part. 

 Any one of the origin work planes. 

 A new work plane. 
 

With these conditions met, click the Mirror tool, select the features to be mirrored, then select the 
face or work plane to use as the mirror plane. The features are mirrored about the selected plane and 
displayed in the browser, with the included features and occurrences nested underneath the mirror 
feature. 

 

The features to be mirrored are highlighted in the browser. 
 

 
 
 

Access 
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     Mirror 
 

 
 

 

Ribbon: Model tab > Pattern panel 

 

Keyboard Shortcut: CTRL + SHIFT + M 

 

Mirror Dialog Box 
 

The Mirror dialog box is displayed when you start the Mirror tool. 
 

 
 
 

Mirror Type Options 
 

The following mirror types are available in the Mirror dialog box. 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

Individual 
Feature 

Click this button to mirror individual features. 

 

 
 

Entire 
Solid 

Click this button to mirror the entire solid. 
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When the Mirror Individual Features button is selected, you have the following selection options. 
 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

Features Select one or more features to be patterned. 

 

 
 

Mirror 
Plane 

Select a face or work plane to be used as the plane of symmetry. 

 

 
 
 

Solid 
 

This button is only available when multiple solid bodies exist. You 
use this button to determine to which solid body the feature is 
going to be applied. 

 

When the Mirror Entire Solid button is selected, you have the following selection option. 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 
 

Solid 
 

This button is only available when multiple solid bodies exist. You 
use this button to determine to which solid body the feature is 
going to be applied. 

 

 
 
 
 

 

Include 
Work/ 
Surface 
Features 

Select the work features to be included in the mirror. 

 

 
 

Mirror 
Plane 

Select a face or work point to be used as the plane of symmetry 

 

 

 

Remove 
Original 

 

Placing a check in the box next to this option will delete the 
original solid that was originally used to pattern the feature. 

 

Creation Method Options 
 

The following options are available in the Creation Method area of the Mirror dialog box. 
 

 

 

Dialog Box Access 
 

Option 

 

Description 

 

 
 

Optimized Optimizes pattern performance. 

 

 
 

 

Identical 
 

The default; creates the mirrored occurrences identical to the 
original features. 

 

 
 

 
 
 
 
 
 
 
 

Adjust to 
Model 

 

Enables the new mirrored occurrences to adjust to changes in 
model geometry. For example if you are mirroring a cut feature 
that extrudes through the part, using this option enables that cut 
feature to extrude the part on the opposite side, even if the part's 
thickness changes. 

 

Note: Use this option only when necessary, because additional 
processing resources are required to calculate the new 
occurrences. 
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Example: Creation Method = Identical 

 

 
 

 

    Original hole features with through all termination option. 

   Mirrored hole features. 

 

 

Example: Creation Method = Adjust to Model 

 

 
 

 

    Original hole features with through all termination option. 

Mirrored hole features. 
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Procedure: Mirroring Part Features 
 

The following steps give an overview of mirroring part features. 

1. Open or create a part that contains the geometry intended to be symmetric. 

 

2. On the ribbon, click the Mirror Feature tool and select the features to be mirrored. 
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3. In the Mirror Pattern dialog box, click the Mirror Plane button and select a plane or face that 
represents the plane of symmetry for the mirrored features. Click OK. 

 

 

 

4. The mirrored features are created. 
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Exercise: Create Mirror and 

Pattern Features 
 

In this exercise, mirror the motor housing 
to the opposite side and end of the 
conveyor.  You also pattern the legs and link 
the number of legs to the overall length of 
the conveyor. 

 
 

The completed exercise 

 
 

 

1. Open INV_012_Mirror_Pattern. 

 

 

 
 

 

2. Turn on the Visibility of the XY and YZ workplanes. 
 

  

  

3. Mirror the motor feature to the opposite side of 

the conveyor. 

 On the Pattern panel start the Mirror tool. 

 Select the motor feature (1) and then click 
the Mirror Plane selector (2). 

Click the XY Plane (3) and then click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



51 Chapter 8:  Detailed Shape Design 

 
 

4. Mirror the motor features to the opposite 

end of the conveyor. 

 On the Pattern panel start the Mirror tool. 

 Select the Mirror feature from the browser 

(1) and then click the Mirror Plane selector 

(2). 

 Click the YZ Plane (3) and then click 
OK. 
Turn off the visibility of the work 
planes. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

5. Change the value of the Length 
parameter. 

 On the Quick Access toolbar, click the 
Parameters tool (1). 

 Change the value of the Length parameter (2) 

to 200 in and then click Done. 

 

 
 

6. Pattern the left set of legs. 
Note: In this example, the legs were 
created with separate extrusion features. 

 On the Pattern Panel, click the     
Rectangular pattern tool. 

 Select Extrusion 2 and Extrusion 3 
from the Browser. 

 

 

 

 

 

 Click the Direction 1 selector and then 
select a horizontal edge of the channel. 

 Enter 2 for the number of legs and 60 in 
for the spacing. Click OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Modify the Number of Legs. 

 On the Quick Access toolbar start the 

Parameters tool. 

 Find the parameter that controls the 
number of legs (d33). 
Change the value to the following 
formula. 
floor(( isolate(Length;in;ul))/60) 
Click Done. 

 

 

 
 

8.  Modify the value of the Length parameter and 
notice the legs update to suit. 
Note:  This example assumes that a valid length 
of 120” between legs is allowed but a leg every 
60” is preferred.  If you want a leg every 60”, 
change the floor function to ceil. 
 
Optional 
Change the floor function in the formula to ceil 
and notice the difference. 
 

Close the file without saving. 
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Exercise: Create a Work Plane 

and Mirror Feature 
 
In this exercise, you create the legs on the 
curved conveyor section and then mirror 
them to the opposite end of the curve 
conveyor. 

 
 

             The completed exercise 

 
 

1.  Open INV_013_Workplane_Mirror.ipt. 

 
 

2.   Turn on the Visibility of Sketch 2 and reorient 

the model to view Sketch 2. 
 

 
Note: the image below shows the constraints 

that were applied to the 2 rectangular profiles 

that will be used to create the legs.

 

 

 

 

 

 

3.    Extrude the leg profiles to the XZ plane. 

 On the Pattern panel start the Mirror tool. 

 Select the motor feature (1) and then click 
the Mirror Plane selector (2). 

Click the XY Plane (3) and then click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Create a Work Axis at the center of the 

conveyor arc. 

 On the Work Features panel, start the 
Work Axis tool. 

 Select the inside curved face of the 

conveyor. 

 Click the Axis selector. 
Select the inside curved edge of the 
conveyor channel. 
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5. Create a work plane with that bisects 

the conveyor. 

      On the Work Features panel, start the 
Work Plane tool 

  Select the Axis created in the previous step   

(1). 

Select the left end face of the conveyor (2). 

Enter Angle/2 in the heads-up display. 

Click the green checkmark on the heads up 

display. 

 
 

6.  Mirror the leg feature to the opposite end of 
the conveyor. 

 On the Pattern Panel, start the Mirror 
tool. 

 Select the leg extrusion feature. 
 Click the Mirror Plane selector and then 

select the work plane created in the 
previous step. 

 Click Ok. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 

7. Open the Parameters tool and modify the Angle 

parameter. 

Note:  Use values between 90 and 20 degrees.   

Notice how the second set of legs are tied to the 

angle parameter. 

Close the file without saving. 
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Chapter Summary 
 
 
 
 

This chapter enhanced your basic part modeling skills by providing additional tools and recommended 
workflows for detailed shape design. Understanding how to create chamfers and fillets, place hole and 
thread features, pattern and mirror features, and create thin-walled parts greatly extends your 3D part 
modeling capabilities to cover most part design requirements. 

Having completed this chapter, you can: 

          Create both chamfers and fillets on a part. 

          Use the Hole and Thread tools to place hole and thread features on your part model. 

          Create rectangular and circular patterns and mirror existing features. 

          Create thin-walled parts using the Shell tool. 
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Chapter 
 

9 
 

 
 

Autodesk Factory Design Utilities 

Creating Layouts and Placing 

Assets 
 

 
 

Autodesk Factory Design Utilities are integrated with the standard Inventor environment.  This 
means that the interface you will be working with is the same as the Inventor interface.  Some 
additional tools have been added to incorporate Factory Layout functionality.  The Autodesk® 
Factory Design Utilities gives Inventor users a factory – specific work environment that helps factory 
layout designers spend more time innovating rather than drafting.  This chapter introduces the tools 
and interface options you will use as you start laying out your initial factory design. 

 

Objectives 
 

After completing this chapter, you will be able to: 

 Review the Factory Specific Ribbons 

Create a New Factory Layout. 

 Add a DWG Overlay to the Factory Floor. 

 Place Assets on the Factory Floor using the Asset Browser 
 Insert Existing Models onto the Factory Floor. 

 Modify Factory assets with the Factory Properties Browser 
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Lesson: Factory User Interface 

Getting Started 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

  

This lesson describes the application interface. You are introduced to the Layout Assembly 
Template you work with as you create and document your factory designs.  As you start Autodesk 
Inventor with the Autodesk Factory Design Suite Utilities loaded, you will notice a different 
Getting Started Ribbon.  This ribbon is specifically designed to work with and support the factory 
layout users.  Several commands are familiar to veteran Inventor users while some are new and 
offer access to support and community features. 
 
 

As with all computer applications, the User Interface (UI) is what you use to interact with the program. 
While the Autodesk Inventor UI shares many common themes and elements with other Microsoft 
Windows applications, it also has some unique elements and functionalities that may be new to you, 
even as an experienced CAD user. 
 

In the following illustrations, the Autodesk Factory Design User Interface is shown.  The first illustration 

shows the default Getting Started ribbon that is displayed when you start the program.  The second 

illustration is the default Factory ribbon used to create and develop your factory design. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Review the Factory Specific Ribbons. 

§ Create a New Factory Layout. 

§ Add a DWG Overlay to the Factory Floor. 
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The Factory User Interface – Getting Started Ribbon 
 

The Getting Started Ribbon is the first ribbon you encounter when you start the application.  The 
contents of the getting started ribbon are documented below. 

 
 
 

 
 
 
 
 
 
 
  
 
 
 
 
Item Command Function 

1 New Layout Starts a new Factory Layout document based on the 
default template. 
 

2 Create Asset The Autodesk Inventor Factory Design Utility 
provides users with predefined system content that 
is included with the product. The Create Asset 
command enables you to create new, or use, 
existing data. The data is authored and published 
into a User Assets library, with the provided system 
content. 

3 Projects Provides access to existing or new project 
workspaces. 

4 Factory Options Drawing layer visibility for DWG overlays, selection 
of template files, and snap settings are all managed 
using the Factory Options dialog box. 

5 Factory Help A specific help system supplied that supports the 
Autodesk Factory Design Utilities. 

6 First Experience 
Videos 

Provides access to online content reviewing the 
basic operations and commands unique to the 
Factory Design Suite. 

7 Community Access Provides access to popular online communities 
when additional content, communications, and 
discussions, are available. 
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The Factory User Interface – Factory Ribbon 
 

The Factory Ribbon is the primary ribbon you use while designing your factory layout.  Several 
commands from the Getting Started ribbon are also included on this ribbon.  The contents of the 
Factory Ribbon are documented below. 

 
  

 
 
 
 
 
 
 

Item Command / Panel Function 

1 Insert Model Inserts and external model into the factory.  A Factory Layout can be 
populated with component data from multiple sources. You can insert 
components from the System Assets and User Assets content libraries, 
or you can insert external content. External content represents any 
data that has not been customized and placed in the Factory Assets 
library. This data includes standard Inventor part and assembly files, or 
files from other CAD products. 

2 Create Asset The Autodesk Inventor Factory Design Utility provides users with 
predefined system content that is included with the product. The 
Create Asset command enables you to create new, or use, existing 
data. The data is authored and published into a User Assets library, 
with the provided system content. 

3 Set Landing 
Surface 

Allow users to define a different landing surface other than the default.  

The default landing surface is usually defined when an asset is authored. 

The component is oriented so the landing surface is positioned against 

the floor. If the component has not been authored, define a landing 

surface so the component snaps to the floor. Also, some assets can be 

placed in more than one orientation. Although the primary orientation is 

defined, you might have to rotate it for certain applications.  
 

4 Add DWG Overlay Allows users to paint 2D lines on the factory floor for reference.  A 2D 

drawing of a factory floor layout showing all factory components and 

personnel in their proper locations can be created in AutoCAD. The 

drawing can also be created in another CAD program capable of 

outputting a file in DWG format. Using the Add DWG Overlay command, 

the drawing can then be overlaid onto the factory floor in Inventor 

Factory to serve as a snap-to guide in the precise placement of 3D factory 

assets. 
 

5 Layout Tools Panel Contains various tools that aid in the specific placement and 
orientation of Factory Assets. 

6 Options Panel Provides access to Floor settings and default Snap options.   

7 Learn about 
Factory Panel 

Provides access to a specific help system supplied that supports the 
Autodesk Factory Design Utilities and also provides access to online 
content reviewing the basic operations and commands unique to the 
Factory Design Suite. 

8 Community Panel Provides access to popular online communities when additional 
content, communications, and discussions, are available. 
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The Factory User Interface – Factory Options 
 

The Factory Options dialog box contains four tabs. The DWG tab lets you display a layer dialog box listing 

all the layers present in a DWG overlay. Using this dialog box, layer visibility may be toggled on or off as 

required. It also includes a setting to enable a drawing preview of the DWG overlay. The Templates tab 

lets you specify the template file to be used for new factory layouts and for the creation of both part and 

assembly assets. The Snap tab controls whether snaps are enabled and sets the active distance for snaps. 

The Assets tab contains the default locations for assets download from the Autodesk Cloud.  These assets 

are not locally available unless the user chooses to download them from the Cloud via the Asset Browser.  

 

 

The DWG tab lets you display a Layer dialog box 

listing all the layers present in a DWG overlay. Using 

this dialog box, layer visibility may be toggled on or 

off as required. It also includes a setting to enable a 

drawing preview of the DWG overlay. 

 

The Templates tab lets you specify the template file 

to be used for new factory layouts and for the 

creation of both part and assembly assets. 

 

The Snap tab controls whether snaps are enabled 

and sets the active distance for snaps. 

 

The Assets tab contains the default locations for 

assets download from the Autodesk Cloud. These 

assets are not locally available unless the users 

chooses to download them from the Asset Browser. 
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The Factory User Interface – Floor/Grid Settings 
 

You can manage floor and grid settings using the Floor/Grid Settings dialog box. The settings enable you 

to customize the floor size and style, as well as the grid that appears on the floor. 

 

The preference settings only affect the current document. Settings such as floor size and grid spacing can 

vary depending on whether you are designing a work cell or an entire factory. For example, you would 

want a small section of floor for designing a work cell. The floor size usually matches the building for 

laying out an entire factory. If you change the settings in the template, all new documents use those 

settings. For existing documents, you have to change the settings in each document if you want the new 

behavior. 

 

 

In the Floor Settings area, uncheck Visible to 

turn off the floor display. Select Auto Size to 

have the floor dynamically change size based on 

component placement, or User Defined to 

specify a fixed size for the floor.  

Note: To change the minimum floor size for 

Auto Size, select User Defined and enter the 

floor dimensions, then select Auto Size again. 

 

In the Floor Style area, uncheck Floor Border to 

turn off the display. To change the Floor Color, 

click the drop-down arrow to display the color 

palette. You can select one of the basic colors or 

click Select Color… to display the Color dialog 

box, where you can define a custom color. 

 

In the Grid Settings area, uncheck Visibility to 

turn off the grid display. You can individually 

control whether Major Grids, Minor Grids, XY 

Axes, and the Coordinate System Triad are 

displayed.  

The Minor Grid Spacing controls the distance 

between grid lines. By default, every other grid 

line is displayed as a major grid line. You can 

enter an integer from 1 through 512 to change 

the frequency of the Major grid lines.  

 

 

In the Grid Style area, you can set the Major 

Grid Color and the Minor Grid Color. Click the 

drop-down arrow to display the color palette. 

You can select one of the basic colors or click 

Select Color… to display the Color dialog box, 

where you can define a custom color. 
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The Factory User Interface – Resize Floor 
 

You can use Resize Floor to change the floor size by manually dragging the borders. When you click 

Resize Floor, grips display at the corners and midpoints of the floor edges. When you drag a grip, a value 

input box displays the floor dimension.  

 

  
 

The new floor size is saved in the Floor/Grid Settings dialog box. If Auto Resize is enabled, Resize Floor 

also changes the minimum floor size settings. 

 

A spherical grip also appears at the 0,0 factory floor origin. You can drag this grip up or down to change 

the Z-axis elevation of the factory floor (Shown in the image below). 
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The Factory User Interface – Snap Types 
 

You can quickly enable or disable snap types by using the Snap Types drop-down menu on the Options 

panel of the Factory tab. The snap options are synchronized with the settings in the Factory Options 

dialog box. 

 

Snap to Floor Snaps to the floor plane. 

Snap to Grid Snaps to the intersection of any major or 

minor grid lines. 

Snap to Sketch Snaps to endpoints, midpoints, or along any 

Inventor sketched entity. 

Snap to Connector Snaps to predefined connection points that 

have been defined in assets. 

Snap to DWG Overlay Snaps to endpoints, midpoints, or along any 

drawing entity on the DWG overlay. 

Note:  If the Snap Types drop-down list is 

disabled, open the Factory Options dialog 

box, click the Snap tab, and activate the 

Enable check box. 
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Getting Started – DWG Overlay 
 

A 2D drawing of a factory floor layout showing all factory components and personnel in their proper 

locations can be created in AutoCAD. The drawing can also be created in another CAD program capable 

of outputting a file in DWG format. Using the Add DWG Overlay command, the drawing can then be 

overlaid onto the factory floor in Inventor Factory to serve as a snap-to guide in the precise placement of 

3D factory assets. 

 

After placement, right-clicking the DWG overlay node in the assembly browser displays a pop-up context 

menu with various options. The drawing may be repositioned, scaled, rotated, or deleted. The visibility of 

drawing layers may also be toggled on and off. 

 
 

  

 

On the ribbon, click Factory tab >Layout Tools panel>Add DWG Overlay to 

display the Select DWG file dialog box. 

Reposition DWG 

Overlays 

 
 

You can reposition a DWG overlay after placing it onto the factory floor. 

Using a 3-axis triad, you can move the overlay in the X and/or Y directions. 

The Z-axis of the triad lets you rotate the overlay into a new orientation. The 

translations or rotations are performed from the 0, 0 origin of the DWG 

overlay.  To access the reposition option, right-click over the DWG overlay 

node and select Reposition from the shortcut menu. 

Transform DWG 

Overlays 

 

A DWG overlay can also be repositioned, as well as scaled, using the 

Transform command. Unlike the Reposition command which moves the 

overlay relative to the 0,0 origin of the drawing, the Transform command 

moves the overlay relative to the 0,0 origin of the factory floor. 
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Control Layer 

Visibility 

Upon initial placement of a DWG overlay, you have the option to toggle on or off 

the visibility of any layers defined in the 2D drawing. This capability, as well as a 

drawing preview in the Layer Settings dialog box (if both are enabled using the 

Factory Options command) updates to reflect any changes you make to layer 

visibility.   To access the Layer Control, Right-click over the DWG overlay node and 

select Layer Settings from the pop-up context menu. 

You can return to the Layer Settings dialog box at any time if you wish to change the 

on/off visibility status of any of the layers. 

 

Update DWG 

Overlays 

There is associativity between the 2D drawing from which the DWG overlay 

originated and the 3D factory layout. If any revisions occur to the original drawing 

file, you can read the changes back into Inventor Factory using the Update 

command.  Right-click over the DWG overlay browser node and select Update from 

the pop-up context menu. 

Delete DWG 

Overlays 

A drawing overlay may be deleted at anytime.  Right-click over the DWG overlay 

node and select Delete from the shortcut menu. 
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Getting Started – Make Layout 
 

You can create an Inventor based layout sketch for the floor of the Factory Layout assembly that 

provides a 2D representation of the factory floor design. The layout uses 2D, Inventor based, sketch 

geometry to represent design components and their locations. The geometry can be created using 

standard Inventor sketch tools or you can import data from an existing DWG file.  

 

 

 

On the ribbon, click Factory tab > Layout Tools panel > 

Make Layout. 

 

In the Make Layout dialog box, enter a name for the layout 

file, select its template file, and define its storage location. 

Click OK. The Sketch tab becomes the active tab. 

 

Use the standard Inventor sketching tools to define the 

layout or click ACAD in the Insert panel and import an 

existing AutoCAD DWG file.  

 

As an alternative, you might consider using the Add DWG 

Overlay command if you have an existing 2D layout of a 

factory floor. 

 

 

Click Finish Sketch to complete the layout and exit the 

sketch environment. The layout is automatically placed on 

the floor of the Factory Layout assembly. Multiple layouts 

can be created. 
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  2.  Start a New Factory Layout. 

§ On the Factory Launch panel, click the 

New Layout tool. 

 
§ Note the presence of the Floor object 

(Unique to the Factory Design Suite).   

§ Notice the Factory Ribbon active by 

default in this environment. 

 

3.  Review the Factory Floor Settings. 

§ On the Options Panel, click the Resize 

Floor command.  

 

 
 

§ Drag the Grips at the edge of the floor 

to resize the floor manually.   

Note: Numeric values may also be 

entered. 

 
 

§ Right-click and select Done from the 

menu. 

 

 

 

Exercise: Creating a 

Factory Layout. 
 
In this exercise, you set your default 
factory options and start a new factory 
layout.  Once the Layout is created, 
Floor and Snap settings are adjusted 
and a DWG Overlay is placed on the 
Factory Floor. 

 

 

The completed exercise 

 

1.  Set your factory options 

§ On the getting started ribbon click the 

Factory Options tool. 

 
§ Set the DWG Overlay Options as 

shown below. 

 

 
§ Review the other tabs available in the 

dialog box and then click close. 
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  6.  Click OK on the Warning that some 

graphical elements are not supported. 

 

 

7.  Set the Layer Settings for the DWG 

Overlay. 

§ In the Browser Right click on the DWG 

node and select Layer settings from 

the menu. 

 

§ Set the Layer settings according to the 

following image and Click OK. 

 

 

8.  Close the file without Saving 

 

 

 

4.   Review the Floor Display Options 

§ On the Options Panel, click the Floor 

and Grid Settings tool. 

 

 
§ Toggle the visibility option in the Floor 

Settings area off, then click Apply.   

Toggle the visibility option in the Floor 

Settings area back on, then click 

Apply. 

 
§ Repeat the previous step toggling the 

visibility of the Grid Settings Area On 

and Off.   

 
§ Return the Floor settings to the 

default settings and click OK. 

 

5.  Add a DWG Overlay to the Factory 

Floor. 

10. On the Layout Tools Panel, Start the 

ADD DWG Overlay tool. 

 
11. In the Select DWG Dialog box, navigate 

to the exercise files and select 

ACA_012_Complete.dwg and Click OK. 
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Lesson: Placing Factory Assets 
 
 

 
 

 

 

 

 

 

 

 

 

  
 

 

 

 

 

 

 

A factory design can be populated with component data from multiple sources. You can insert 
components that exist in the Factory Assets library or you can insert external content. The 
Factory Assets library contains part and assembly models for use in a Factory Layout assembly. 
The System Assets directory contains content provided with the Inventor Factory Design Utility 
and the User Assets directory is for content that you publish. You access the Factory Assets 
library from the Assets Browser. 

Objectives 

After completing this lesson, you will be able to: 

§ Review the Contents of the Factory Asset Browser. 

§ Place Assets on the Factory Floor. 

§ Connect Assets together to form a conveyor line. 
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Placing Factory Assets - The Asset Browser 
 

The System Assets directory contains content provided with the Inventor Factory Design Utility and the User 

Assets directory is for content that you publish. You access the Factory Assets library from the Assets 

Browser. 

 

 

1.  The main pane of the Factory Asset 

Browser displays a folder structure of 

common and custom factory assets.  This 

pane allows the users to manually 

navigate thru the directory structure to 

locate the desired factory asset. 

2.  The Search window allows users to easily 

find a factory asset by entering the full or 

partial name of the asset.  A list of valid 

search terms is dynamically displayed.  

You can click one of the terms to 

populate the search field. 

3. Common Directory Navigation tools are 

available at the top of the asset browser.   

To return to the top level to access the User 

Assets content library, click the Folder up 

button  . From this location, you can 

double-click folders to move lower or use the 

Folder up button to move higher in the tree 

structure.  

At the top of the Assets Browser, you can 

switch to display contents in a Tree View. You 

can then navigate through the Factory Assets 

library by expanding directories  

The refresh button offers a manual method of 

updating the Asset Browser display after 

custom assets have been published. 

4.  The Cloud Asset Enabled/Disabled icon 

displays the whether the ability to download 

Cloud based assets is Enabled or Disabled.   

This functionality is controlled by the Factory 

Options. 
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Placing Factory Assets – Factory  
 

Once a component from the Assets Browser is placed, you can select it and change the available Model 

parameters or Miscellaneous parameters. 

 

 

Once an asset is selected, any of the values 

displayed in the Factory Properties 

Browser can be edited. Only the Model 

parameters that were specified as Key 

parameters when it was published are 

listed in the Properties Browser. Only a 

select few iProperty parameters are also 

listed in the Properties Browser. These 

iProperty parameters include Name, Title, 

Author, Company, Catalog, Keywords, and 

Comments. 

 

 

 

At the top of the Factory Properties 

browser there are several tools that assist 

in the organization and updating of the 

asset parameters.   

 

The first icon on the left is the Alphabetical 

tools, it allows you to sort the properties 

alphabetically.  

 

The Refresh Tool allows you to restore a 

modified value.  

 

The Update button allows you to finalize a 

change and update the model at the same 

time.  You can also use the enter key on 

the keyboard to update the component 

after modifying a parameter value. 

 

The Update Other Instances button allows 

you to modify multiple instances of the 

same asset at one time. 
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Placing Factory Assets – Factory Asset Preview 
 

After locating the content you want in the Assets Browser, you can right-click over the asset to display a pop-

up context menu. The context menu for a System Asset offers two options - Explore and Preview. 

 
Clicking Explore opens Windows Explorer and navigates to the Factory Library folder location so you can 

verify where the asset resides. 

 
The Preview option launches a separate preview window displaying the selected asset.  The preview window 

allows the users to zoom and rotate the asset prior to placement. 

 
 

 



18 Chapter 9: Autodesk Factory Design Utilities 

  

  3.   Preview the Factory Asset 

§ Right Click on the Straight Belt 

Conveyor and select Preview from the 

menu. 

 
§ Using the Left Mouse Button, Drag 

and orbit the asset preview. 

§ Using the Scroll Wheel, Zoom in and 

Out of the asset preview. 

§ Close the Preview Window. 

 
 

4.  Place the first asset. 

§ Using the Left Mouse Button, Drag from 

the Straight Belt Icon into the model 

pane. 

§ Release the Left Mouse Button and 

notice that the conveyor moves freely 

across the factory floor. 

§ Zoom into the DWG overlay and Left 

Click to place the conveyor at the snap 

point shown in the following image. 

 

 

Exercise: Place Factory 

Assets 
 
In this exercise, you place various 
factory assets as you complete a 
conveyor line. 

 

The Completed Exercise 

 

1.   Open the Exercise file. 

AFDS_001_Place_Assets.iam. 

§ Right Click on the DWG overlay 

node and click update if necessary. 

 

2.  Navigate to an Asset using the Asset 

Browser. 

§ Activate the Asset browser if 

necessary 

View ribbon / User Interface. 

 

§ Manually navigate thru the 

default directory structure to 

the Straight Belt Conveyor 

§ System Assets / Conveyor / Belt 

/ Straight Belt. 
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  7.  Continue placing the second asset with 

the connection points. 

§ Move the new asset closer to the 

previous conveyor and the green 

connectors will snap together. 

 
§ Left Click to place the second 

conveyor asset as shown in the 

following image. 

 

§ Right Click and select Done from the 

menu. 

 

5.  Specify the rotation angle. 

§ Move the mouse around to specify 

the rotation angle Sub Step 2 

 

§ Lock the rotation angle by moving the 

cursor over another line in the DWG 

Overlay as shown in the following 

image. 

§ Left Click to Place the define the 

rotation angle at 0.00. 

 

 

6.  Add another instance of the conveyor 

using the connection points. 

§ Another instance of the conveyor asset 

is automatically available for placement. 

§ Slowly move the new asset near the 

conveyor that was placed previously. 

Notice the green connector dots at the 

end of each conveyor.  When the assets 

come close to one another, a yellow line 

signifies that they are being drawn 

together. 
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8.  Using the process described above 

place the rest of the conveyor assets in 

the line. 

Note:  All Assets use default lengths and 

widths. 

Note:  The height of the legs will 

automatically adjust on the high end of 

the incline conveyor. 

§ Use the image below to determine the 

proper asset. 

§ When the line is complete, close the 

file without saving. 

§ Left Click to Place the define the 

rotation angle at 0.00. 

 

 

 

TIP 

Disassembling Factory Assets 

During the course of this exercise, it may be 

necessary to disconnect a factory asset after 

placing it.   

To disconnect a factory asset: 

§ Hold the F7 button down 

§ Drag the desired asset away from the 

connected asset. 

§ Release the mouse button. 

§ Release the F7 Key. 
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Lesson: Inserting a Model 
 

The Factory Assets library will not contain all the required components for Factory Layout assembly. For 

example, infrequently used components are not usually published into the library. For these situations, 

you can add a model directly to the layout 

A Factory Layout can be populated with component data from multiple sources. You can insert 

components from the System Assets and User Assets content libraries, or you can insert external content. 

External content represents any data that has not been customized and placed in the Factory Assets 

library. This data includes standard Inventor part and assembly files, or files from other CAD products. 

    

 

1.  In the Insert Model dialog box, browse to the folder location, select the file to 

insert into the layout, and select Open. 

Drag the selected component to the required location in the layout and press the 

left mouse button to insert the component. The component is displayed inside a 

bounding box. The sides of the bounding box are parallel to the component origin 

planes. The insertion point is the corner of the bounding box that aligns with the 

origin coordinate system. 

2.  When locating the component in the Factory Layout assembly you can snap to the 

following: 

§ Grids:  Drag the component to the intersection of two gridlines on the 

factory floor and select once using the left mouse button. The Snap to Grid 

Snap Type must be enabled to allow grid snapping.  

§ Sketch:  Drag the component to a sketch entity on the layout and select 

once using the left mouse button. Components can be snapped to 

endpoints, midpoints, and along an entity. The Snap to Sketch Snap Type 

must be enabled to allow sketch snapping. 

§ DWG Overlay:  Drag the component to a 2D entity on the drawing overlay 

and select once using the left mouse button. Components can be snapped 

to endpoints, midpoints, and along an entity. The Snap to DWG Overlay 

Snap Type must be enabled to allow overlay snapping. 

3.  The component is placed in a default orientation in the XY plane. To adjust the 

orientation, select the XY, ZX, or YZ, mini-toolbar options that appear below the 

component.  

 

 

 

 



22 Chapter 9: Autodesk Factory Design Utilities 

  

Lesson:  Reposition Components 
 

The Reposition command helps you accurately position single or multiple components on a factory floor. 

A triad is provided for selecting axes or planes to reposition components by translation or rotation.  

 

1.  On the ribbon, click Factory tab >Layout Tools panel >Reposition 

2. Select the component you want to reposition. A triad appears next to the 

component. The triad position and orientation vary depending on where 

you click on the component.  

To select additional components, click the triad and then click a 

component. The triad moves to a position between the components. You 

can repeat the process to add additional components to the selection set. 

The triad position updates after each component is added. 

3.  Use the triad to move or rotate the components. Depending on where 

you click on the triad, you can make planar (2D) translations, axial 

translations, or axial rotations. 

 

o On the Triad, select a plane for 2D repositioning of the 

component. 

o   

To dynamically reposition the component, click and drag the 

plane.  

 

To manually reposition the component, click the plane once and 

enter the translation values in the Heads-Up Display. Press Enter 

to move the component and close the HUD. 

 

o On the Triad, select the shaft of an axis for linear repositioning of 

the component.  

To dynamically reposition the component, click and drag the shaft 

of the axis to move the component.  

To manually reposition the component, click the shaft of the axis 

and enter the translation value in the Heads Up Display. Press 

Enter to move the component and close the HUD. 

 

o On the Triad, select the end of an axis to rotate the component.  

 

To dynamically rotate the component, click and drag the end of 

the axis to move the component. 

 

To manually rotate the component, click the end of the axis and 

enter the translation value in the Heads Up Display. Press Enter to 

rotate the component and close the HUD. 

 

 4. Right-click and select Done to accept the changes and exit the Reposition 

command. Right-click and select Cancel to exit the Reposition command 

without moving the components. 

 Note:  The Reposition command can position the component off the floor, 

regardless of whether the Snap to Floor Snap Type is on 
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  3. Modify the Landing face. 

§ Move the model around the floor 

noticing the bounding box that 

surrounds the component. 

§ Place the model close to the outline of 

the DWG Overlay shown below. 

 
§ Left Click to Place the model. 

§ Select the XY, ZX, or YZ buttons on the 

heads up display to change the default 

landing position. 

 
§ When the correct landing position is 

displayed, click the green checkmark. 

 

 

 

 

 

 

 

 

 

 

Exercise: Insert Model 
 
In this exercise, you insert an existing 
model onto the factory floor. 

 

 

The Completed Exercise 

 

1.  Open the exercise file 

AFDS_002_Insert_Model.iam 

 

2. Fourth Objective 

§ On the Factory Asset Panel, start the 

Insert Model tool. 

§ On the Insert Model Dialog, expand 

the Files of Type drop down and 

review the possible file types 

supported by the Factory Design Suite. 

 
§ Navigate to the Components directory 

and select Blower.ipt.  

§ Click Open 
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  6. Use the methods demonstrated in this 

exercise to position the Robot_Table.ipt 

on the second Conveyor Line, as shown 

in the following image. 

 

 

 

End of Exercise 

 

 

 

 

 

 

 

4. Reposition the inserted model. 

§ On the Layout Tools Panel, start the 

Reposition tool. 

§ If necessary, select the inserted 

model. 

§ Click on the vertical Blue (Z) axis as 

shown in the following image. 

 
§ Enter the value -90 in the heads up 

display. 

 
§ Press the Enter button. 

§ Right Click and select Done from the 

menu. 

 

5. Move the Model into position. 

§ Use the View Cube to reorient the 

assembly to the Top View as shown. 

 
§ Drag the model to the desired position. 

Note: for this exercise the asset location 

will not be fully defined.  Autodesk 

Inventor offers several methods for 

positioning components accurately. 
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Lesson: Aligning Components 
 

Using the Align dialog box, you can align multiple components in various directions and orientations based on 

a selected reference component. The dialog box consists of two tabs - one for aligning components and the 

other for distributing components. 

§ Selection: Assigns a reference component and components to align to it.  

§ Align Position: Moves selected components to a location defined by another component without 

changing their orientation. The components can be aligned horizontally or vertically based on the left, 

right, top, or bottom edges of their respective bounding boxes relative to the reference component. They 

may also be aligned horizontally or vertically based on the centers of their respective bounding boxes.  

§ Align Orientation: Aligns selected components to a reference component without changing their position. 

Orients the X or Y axes of the selected component to the X or Y axes of the reference component.  

§ Distribute: The Distribute tab lets you align components horizontally or vertically based on their left 

edges, center points, or right edges. The alignment occurs between the selected components, and does 

not use a reference component. Distribute also aligns components so that they can be equally spaced 

along horizontal or vertical intervals. 
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On the ribbon, click Factory tab > Layout Tools panel  > Align. The Align 

dialog box opens with the Align tab active. 

 

Use the Align dialog box to orient the X or Y axis of selected components to 

the X or Y axis of a reference component. 

You can choose from among the following: 

§ Align Position Horizontal Left  

§ Align Position Horizontal Center  

§ Align Position Horizontal Right  

§ Align Position Vertical Top  

§ Align Position Vertical Center  

§ Align Position Vertical Bottom 

 

 

Click the Distribute tab and using the Components selection tool in the 

Selection section, select the components you want to distribute. 

You can choose from among the following: 

§ Align Distribution Horizontal Left  

§ Align Distribution Horizontal Center  

§ Align Distribution Horizontal Right  

§ Align Distribution Horizontal Interval  

§ Align Distribution Vertical Top  

§ Align Distribution Vertical Center  

§ Align Distribution Vertical Bottom  

§ Align Distribution Vertical Interval 
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3. Align the 4 Crates. 

§ Start the Align command again. 

§ Select the 3 crates on the right as 

shown in the following image. 

 
§ Click the Reference selector in the 

dialog box and select the left Crate. 

§ Select Align Position Vertical Top. 

 
§ Click Apply  

 

 

 

 

 

 

 

Exercise: Align Components 
 
In this exercise, use the Align 
command to align components and 
distribute components across the 
factory floor. 

 

The Completed Exercise 

 

1. Open the exercise file 

AFDS_003_Align.iam. 

2. Align the Forklift and Crate with the 

Roller Conveyor. 

§ On the Factory Tools Panel, start the 

Align tool. 

 
§ Select the Crate and the Forklift as 

shown in the following image. 

 
§ In the Align Dialog box, click the 

Reference selector 

§ Select the Straight Roller Conveyor 

nearest the Crate. 

§ Click the Align X button at the bottom 

of the Align Dialog Box. 

 
§ Click OK. 

§ Drag the Crate and Forklift into 

position as shown in the following 

image. 
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  4. Distribute the Crates evenly. 

§ Start the Align command if necessary 

§ Click the Distribution tab. 

§ Select the 4 crates as shown in the 

following image. 

§ Click the Align Distribution Horizontal 

Left option. 

 
§ Click OK. 

 

End of Exercise 
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Lesson: Modify Asset Properties 
 

Values for any of the parameters listed in the Factory Properties browser can be selected and edited to 

change the properties of the component. Any changes made to the selected component only reflect in 

that specific instance of the component. Changes do not affect the Factory Assets library. 

The Properties Browser becomes populated with component Model and Miscellaneous parameter data 

when a parameterized component is selected in the Factory Layout assembly. Model parameters 

represent the modeling parameters that have been specified as Key Parameters within a component. The 

Miscellaneous parameters represent specific iProperty parameters that can be modified. 

     

 

 

 

 

At the top of the Factory Properties browser there are several tools 

that assist in the organization and updating of the asset parameters.   

 

The first icon on the left is the Alphabetical tools, it allows you to sort 

the properties alphabetically.  

 

The Refresh Tool allows you to restore a modified value.  

 

The Update button allows you to finalize a change and update the 

model at the same time.  You can also use the enter key on the 

keyboard to update the component after modifying a parameter value. 

 

The Update Other Instances button allows you to modify multiple 

instances of the same asset at one time. 

 

The Model section of the Factory Properties browser provides access 

to the modeling parameters that have been specified as Key 

Parameters within the asset. 

 

Only a select few iProperty parameters are listed in the Factory 

Properties browser. These iProperty parameters include Name, Title, 

Author, Company, Catalog, Keywords, and Comments. 
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  § Modify the Length Parameter with the 

Value of 19’6”. 

 
§ Press Enter or click the Update tool at 

the top of the Factory Properties 

browser. 

 
§ Drag the updated asset into the 

proper position as shown in the 

following image. 

 

 

4. Add a Y Merge Belt Conveyor (Left) as 

shown in the following image. 

 

Exercise: Modify Asset 

Properties 
 
In this exercise, place and modify assets 
using the Factory Properties browser. 

 

The Completed Exercise 

 

1. Open the exercise file 

AFDS_004_Modify_Asset_Properties.iam 

 

2. Place a Straight Belt Conveyor on the DWG 

Overlay as shown in the following image. 

 

 

 

3. Modify the Length Parameter of the new 

asset. 

§ Activate the Factory Properties browser 

if necessary.  The option is accessed on 

the View Tab under the User Interface 

tool. 
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  5. Add and modify a Curved Belt Conveyor. 

§ Add a Horizontal Curve Belt Conveyor 

as shown in the following image. 

 
 

§ Select the new asset and modify the 

angle value in the Factory Properties 

browser.  Change the Angle value to 

45. 

§ Click the Update tool on the Factory 

Properties browser. 

 

 

End of Exercise 
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Exercise: Challenge 
 
In this exercise, you practice the 
processes learned in this chapter. 

 

The Completed Exercise 

 

1. Open the exercise file 

AFDS_005_Challenge.iam 

 

2. Place and modify the necessary assets to 

complete the second conveyor line. 

 

§ Use the diagram provided below to 

determine the correct asset or model to 

place on the factory floor. 

Note:  Unless otherwise noted, use the 

default Parameters. 

 

Tips to complete the Challenge Exercise 

§ Use the Copy / Paste method to quickly 

create copies of assets.  After pasting the 

asset into the factory layout, drag it into 

position as normal. 

§ Copy multiple assets by holding the shift 

button down while selecting. 

§ All Long Conveyors are 19’6” in Length. 

§ The Storage Rack assets are located in the 

System Asset folder, in the Material 

Handling directory. 

§ When Placing the Storage Racks, modify 

the ColumnNumber value to 2, and the 

RowNumber value to 1. 
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Chapter Summary 
 
 
 
 

This chapter presented the tools and recommended workflows for basic shape design. Using these 
techniques, you can now create more complex 2D sketches at different locations on your part, 
combine multiple 3D features to create various shapes, and modify those shapes at any time during 
the design process. 

Having completed this chapter, you can: 

 

 Use the Factory Specific Ribbons 

Create a New Factory Layout. 

 Add a DWG Overlay to the Factory Floor. 

 Place Assets on the Factory Floor using the Asset Browser 
 Insert Existing Models onto the Factory Floor. 

 Modify Factory assets with the Factory Properties Browser 
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Chapter 
 

  10 
 

 
 
 

Factory Asset Publishing 
 

 
 

One of the main keys to success and productivity with the Autodesk Factory Design Suite, is the 
ability for each users to establish and maintain a custom library of factory assets unique to the 
products and processes of individual customers.  In previous chapters, we have demonstrated the 
process of creating Inventor components that will be used as factory assets.  In this chapter we will 
demonstrate the process of establishing Landing Surfaces and connection point.  We will also 
explore the process of publishing these assets to a user library that is accessible from the Factory 
Asset browser. 

 

 

Objectives 
 

After completing this chapter, you will be able to: 

 Use the Asset Builder to Create Factory assets. 

Establish a Landing Surface for a new factory assets. 

 Establish Connection Points for new factory assets. 

 Identify Key Parameters for use during factory asset placement. 

 Publish Assets to a custom user library. 

 Test new Factory Assets. 
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Lesson: Asset Creation 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  
 
 

 

 

 

 

 

  

The Autodesk Inventor Factory Design Utility provides users with predefined system content that is 

included with the product. The Create Asset command enables you to create new, or use, existing 

data. The data is authored and published into a User Assets library, with the provided system 

content.  Standard Inventor parts and assemblies can be created and used as content for a factory 

library, or you can import existing Inventor part and assembly files.   

Content in the Factory Assets library can be parameterized to capture its intent in the Factory Layout 

assembly. Therefore, the data that drives it must contain the necessary parameters. The import 

process creates base features in Inventor that are representative of the geometry and topology in 

the source file. You can use Inventor commands to adjust the base features and add new features; 

however, you cannot modify or parameterize the base feature. If secondary Inventor features 

contain all required parameters necessary, you can use the imported data. 

Objectives 

After completing this lesson, you will be able to: 

§ Establish a Landing Surface for a new factory assets. 

§ Establish Connection Points for new factory assets. 

§ Identify Key Parameters for use during factory asset placement. 
§ Publish Assets to a custom user library. 

§ Test new Factory Assets. 
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Asset Creation 
 

The Autodesk Factory Design Utility provides a content library of System Assets that you can use to 
create factory layouts. You can author and publish additional assets into the library. You can create the 
models in Inventor, or you can use models from other CAD systems.  
The Asset Builder environment provides tools to author and publishes the models into the library. The 
authoring tools define the interface geometry and the key parameters. The publishing tool saves the 
file to the library. 
 

 

The Create Asset tool is located in multiple locations.  It is available 

in the following locations. 

§ Getting Started ribbon > Factory Launch panel 

§ Factory ribbon > Factory Asset Panel 

§ With an Inventor Part Open, The Environments ribbon 

 

The Model as part option allows the users to create a factory asset 

from scratch using a new Inventor part file. 

 

The Model as Assembly option allows the user to create a factory 

asset from scratch using a new Inventor assembly file. 

 

The Import Asset option allows the user to create a factory asset 

from an existing model file.  The user can choose to use an existing 

Inventor model or select from various model formats for import. 

 

This image shows the various file types available for import as 

factory assets. 
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Asset Builder 
 

After all model features and parameters are created, the Asset Builder is used to convert the model to 
an asset.  The Asset Builder environment provides tools to author and publish the models into the asset 
library. The authoring tools define the interface geometry and the key parameters. The publishing tool 
saves the file to the asset library. 
 

 
 
 
 
 
 
 
 
 
 
 
 

The Asset Builder tool is available on the Factory ribbon in the Inventor 
part and assembly environments.  Click this tool to launch the Asset 
Builder environment. 

 
 
 
 
 
 
 
 
 
 
  
 
 
 

1.  Set Landing Surface Defines a landing surface and insertion points on a Factory Asset. 

2.  Define Connector Defines Connection points on a Factory Asset. 

3.  Measure Panel The Measure tools are provided for the asset authoring process. 

4.  Work Features Panel The Work Features are provided for the asset authoring process. 

5.  Parameters Panel Provides access to the Parameter table. 

6.  Publish Asset Starts the Publish Asset process. 
7.  Finish Asset Builder Exits the Asset Builder Environment. 

 
 

 
 

  



5 Chapter 10: Factory Asset Publishing  

Asset Creation 

 

Setting a Landing Surface  
 

Components in a Factory Layout assembly design are usually placed onto the floor. For the component 
to orient itself properly relative to the floor, it requires a defined landing surface. The landing surface 
defines the plane on the component that is positioned relative to the floor. When authoring content, it 
is important to use the Landing Surface command to establish how the component is located relative to 
the factory floor. 
 
Note: Establishing a landing surface on a component is not required for publishing to the Factory Assets 
library. 
 
All components provided in the System Assets content of the Factory Assets library have predefined 
landing surfaces. 

    

 

 

The Landing Surface tool is the first Icon of the 

Asset Builder ribbon. 

 

The Placement section of the Landing surface 

dialog box helps define the position and direction 

of the landing plane. 

 

 

Click this button to select the landing plane in the 

model. You can select a planar face, a work plane, 

or a 3D sketch plane. 

 

Click the Flip direction button to flip the positive 

side of the current landing plane. 

 

Click the Insertion point button to select one or 

more insertion points for the model. You can select 

a vertex, work point, or sketch point. 

 

Enter a value to place an offset for the landing 

plane. 
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The Options section of the Landing Surface dialog 

box provides options for visual feedback for the 

landing surface. 

 

 

Click the Show coordinates button to display or 

hide the coordinate system. 

 

Click the Preview button to view a preview of the 

landing surface. 

 

 

Asset Creation - Defining Connector Points 
 

Connectors can be used to help assemble components on the factory floor. Connectors allow snapping 

between specific points on each component and aligning them based on the axes of the connector 

points. 

  

The Define Connector tool is located on the Author 

panel of the Asset Builder. 

 

Connector Points may be created on the following: 

· A planar face 

· A vertex 

· A midpoint 

· An endpoint 

· A hole center 

A work point 

· A work plane   

 

After you select the Connector location, the 

connector point triad appears at the point 

you selected. 

 

· The red axis on the triad represents the X 

direction for the object as seen from the 

plan view (Looking down from the top).  

This is the direction in which the 

connection is to be made. 

· The green axis indicates the side of the 

connection 

· The blue axis indicated the top, or “up”, 

side of the connection. 

· The origin ball of the triad may be selected 

and moved to a different location. 
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  3. Define the Landing Surface. 

§ On the Asset Builder ribbon, Click 

the Set Landing Surface tool. 

 
§ Select the planar face as shown in the 

following image as the landing 

surface. 

 
§ In the Landing Surface dialog box, 

click the Insertion Point selector and 

select the 4 bottom outside corners of 

the conveyor legs. 

 
§ Click OK. 

 

 

 

 

 

 

 

Exercise: Create Asset 

Landing Surface and 

Connector Points. 
 
In this exercise, you begin the process 
of authoring a factory asset.  You will 
import an existing Inventor model 
and define a Landing Surface, 
Insertion points, and Connector 
points. 

 

The Completed Exercise 

 

1. Close all Inventor Files. 

§ On the Getting Started ribbon, click 

the Create Asset > Import Model tool. 

 
§ In the Import Asset dialog, select the 

AFDS_006_Conveyor_Straight.ipt 

part file. 

§ Click Open. 

 

2. On the Factory ribbon, click the Asset 

Builder tool. 
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  § To define the Z direction (UP) select 

the Blue axis of the triad. 

 
§ Select the top face of the belt as 

shown in the following image. 

 
§ Right Click and select OK from the 

menu. 

 
§ The Green sphere indicates the 

connector point. 

 

4. Define the Connector Points 

§ On the Author panel, start the Define 

Connector tool. 

 
§ Click the work point at the top end of 

the conveyor as shown in the 

following image. 

 
§ To define the X direction of the 

connector, click the red arrow of the 

triad. 

 
§ Select the left end face of the 

conveyor channel. 
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5.  Define the opposite Connector Point. 

§ Repeat the Connector Point process 

to define the connector point at the 

opposite end of the conveyor. 

Note: If the Blue Z (UP) axis points 

down after selection a vertical edge, 

select it again and use another vertical 

edge. 

 
§ Click the Finish Asset Builder tool and 

Save the file. 

End of Exercise 

NOTE:  Please save the file for future use. 
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Lesson: Defining Key Parameters. 
 

Various parameters can be created during the model creation process.  Only specific parameters, marked 

as Key parameters are available for edit during asset placement.  The Properties Browser becomes 

populated with component Model and Miscellaneous parameter data when a parameterized component 

is selected in the Factory Layout assembly.  Named model parameters that have been specified as Key 

Parameters within a component and miscellaneous parameters representing specific iProperty 

parameters can be modified. 

Note:  Parameters can be marked as Key at any point in the modeling process. 

 

 

In the Asset Builder environment, the Key 

Parameters browser is displayed.  The Key 

Parameters Browser displays all named 

parameters.  Check marks are placed by 

parameters that will be available for modification 

when the asset is selected in the factory layout. 

 

 

The Parameters command on the Asset Builder 

ribbon provides access to the model parameter 

table.   

  

Parameters in the table can be marked as key by 

placing a check mark in the Key column. 
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Lesson: Publishing Assets 
 

Publishing the asset adds the model to the User Assets Folder of the Factory Asset library.  Once an asset 

is published it can be inserted from the Asset Browser into the factory layout. 

 

 

 

 

The Publish Asset tool is located on the Asset 

Builder ribbon.  This command launches the 

Publish Asset dialog.  

Note:  A model or assembly cannot be published if 

it has a pending save. 

 

 

  

1. The upper left portion of the Publish Asset 

dialog allows the designer to select an 

existing destination folder from the tree 

list or create a new sub-folder. 

2. Specific iProperty values are available to 

modify in the upper right portion of the 

Publish Asset dialog. 

3. The Preview portion of the Publish Asset 

dialog allows the designer to view the icon 

that will represent the asset in the Asset 

Browser.  

The Replace Preview button allows users 

to substitute the automatic image with 

another image file.   

Note:  Supported Image Files include 

.PNG, .BMP, and .JPG. 
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  3. Publish the Asset. 

§ On the Asset Builder ribbon, start the 

Publish Asset tool. 

 
§ In the Publish Asset Dialog, select the 

User Assets folder as shown in the 

following image. 

 
§ Fill out the iProperty information 

similar the following image. 

 
§ Click OK to Publish the Asset. 

§ Close the file without saving. 

 

4. Locate the Published Asset in the Asset 

Browser. 

§ Start a new Factory Layout. 

§ Click Refresh on the Asset Browser. 

§ In the Search window type AFDS and 

click the search button. 

 

 

Exercise: Select Key 

Parameters and Publish 

Asset 
 
In this exercise, you verify that the 
desired parameters are marked as 
Key and then publish the conveyor 
asset to the Factory Asset library. 

 

The Completed Exercise 

 

1. Continue using the file from the 

previous exercise or open the exercise 

file AFDS_006_Conveyor_Straight_.ipt. 

§ If necessary, click the Asset Builder 

tool to activate the Asset Builder 

environment. 

 

2. Review the Key Parameters 

§ Review the contents of the Key 

Parameters browser. 

§ Notice the available parameters.  All 

Named parameters are listed in the 

Key Parameters dialog. 

§ Place a check mark beside the 

following parameters. 
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  5. Test the Factory Asset. 

§ Place the new asset on the factory 

floor. 

§ Place a second instance of the asset 

and connect it to the first. 

§ Select one of the assets and modify 

the Length parameter in the Factory 

Properties browser.  Change the 

Length value to 200. 

§ Click the Update button on the 

Factory Properties browser. 

§ Close all files without saving. 

 

 

 

End of Exercise 

 

Challenge Exercise 
 
Using the processes described in this 
chapter, complete the Asset 
Authoring process for the Curved Belt 
Conveyor. 

 

The Completed Exercise 

 

1. Open the exercise file 

AFDS_007_Conveyor_Curved.ipt 

2. Using the processes from the previous 

exercises, Author and Publish the 

Curved Conveyor Asset. 

 

3. Hints for this exercise. 

§ Define the Landing surface 

§ Use the supplied work points to 

define the connectors. 

§ Make sure to mark the Key 

Parameters as shown in the following 

image. 

 
§ Publish the Asset to the User Asset 

Folder. 

§ Start a new Layout and test the both 

assets created in this chapter. 
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Chapter Summary 
 
 
 
 

This chapter presented the tools and recommended workflows for asset authoring and publishing. 
Using these techniques, you can now create factory assets and publish them to the factory asset 
library. 

Having completed this chapter, you can: 

 

 Use the Asset Builder to Create Factory assets. 

Establish a Landing Surface for a new factory assets. 

 Establish Connection Points for new factory assets. 

 Identify Key Parameters for use during factory asset placement. 

 Publish Assets to a custom user library. 

 Test new Factory Assets. 
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Chapter 
 

11 
 

 
 
 

Workflow and Best Practices 
 

 
 

Designing a complete factory layout with all architectural elements and thousands for factory assets 
is quite a lot for a single computer program to handle.  Autodesk Factory Design Suite allows factory 
designers and system integrators to work with factory that are beyond the capability of most 
computer applications.  In order to work with so many components efficiently, it is important to 
understand the Project settings, Workflows, and Best Practices for using the Autodesk Factory Design 
Suite. 

 

 

Objectives 
 

After completing this chapter, you will be able to: 

 Create a Project file for a typical factory design. 

 Understand the supporting file directories for Autodesk Factory Design Suite. 

 Understand the Best Practice for dividing a factory design into sub-layout. 

 Understand the Best Practice for modeling a Simplified form for factory assets.  
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Lesson: Using Project Files for Factory Design. 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This lesson describes the characteristics and implementation of Autodesk Inventor project 

files.  You use project files to resolve path locations.  When an assembly file is loaded, the 

location of the part files must be resolved.  The same is true when loading a drawing or 

presentation file. 

 

It is important to understand how Autodesk Inventor accesses and stored files used to design the 

factory layout.  It is also important to develop and utilize libraries of custom data to support the 

common components to all designs.  This section will outline the process of creating an Inventor 

project file for factory design.  It will also explore the supporting directories used by the project file.   

Objectives 

After completing this lesson, you will be able to: 

§ Create an Inventor Project file for factory layout design. 

§ Understand the supporting settings and directories used by the project file and the 

application. 
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About Project Files 
 

Before you start any layout, you will want to create a project for your parts/layouts to be saved in.  This 
will help you to keep your files organized, and help prevent incorrectly saving over your parts with 
modifications for another project.  Not only will each project be able to help you clarify what job you are 
working on, but models provided from different vendors, or created for a specific line, can be placed in 
libraries specific for each project. 
 
If you are a veteran Inventor user, you will notice that the typical Inventor project practices are used to 
work for factory layouts.  The Autodesk Factory Utilities provide additional options for the following. 

§ Asset Creation Templates 
§ Factory Asset Library Location 
§ Factory Asset Storage Directories 

 

 File Relationships 
 

When you use Autodesk Inventor software to create designs, each one consists of multiple files and 
file types. The design and documentation of a single part file require at least two separate files: (a) a 
part file and (b) a drawing file. The design and documentation of assembly models require a minimum 
of three different file types: (a) assembly files, (b) part files, and (c) drawing files. 

 

Using separate files for each file type is critical for performance and is common among most 
parametric modeling systems. By storing path information for each project, the application can search 
for the required files when opening an assembly, presentation, or drawing file. The need to search in 
different path locations for files is the primary purpose of project files. 

 

The following illustration shows file dependencies in a typical assembly design. 
 

 
 

    Assemblies reference parts. 

   Drawings reference parts. 

    Drawings reference assemblies. 

    Drawings reference presentations. 

   Presentations reference assemblies. 

 
When you open an assembly, drawing, or presentation file, the active project file is used to resolve 
path locations to the referenced files. 
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Definition of Project Files 
 

A project file is an ASCII text file that is stored with an *.ipj file extension. The file contains information 
about paths and other options that enable Inventor to resolve the file references of other files when 
you open an assembly, presentation, or drawing file. 

 

When you create designs you probably organize them in different folder locations. The same is true 
for Autodesk Inventor project files. You generally create one project file for each design you create. 
While there is no limit to the number of project files you can create, only one project can be active at 
a time. 

 

In the following illustration, the active project is identified by the check mark. 
 

 
 
 

Example of a Project File 
 

It is recommended that you store your project file in the upper level folder of your project design 
folders. This keeps your project file organized with your designs and simplifies portability issues. 

 

The following illustration shows the folder structure for a project and where the project file is located. 
 

 

 
A typical project might have assets and assemblies unique to the project, standard assets unique to 
your company, and purchased components such as fixtures, fittings, or electrical components. 

 

To reduce the possibility of file resolution problems, set up a folder structure before you create a 
project and start saving files. To help organize your design files, it is a good idea to set up subfolders 
under your project workspace or workgroup folder. You can keep all your design files for a project 
in the subfolders, making it a logical way to organize the files used in a design project. Because 
references are stored as relative paths from project folders, if you change the folder structure, move, 
or rename files, you are likely to break file references. 

Always save new files in the workspace or workgroup defined for your project or one of its subfolders. 
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Projects Folder Option 
 

Because you can store your project files in several different locations, you need an efficient way of 
locating them. Rather than search every folder on your computer or network, Autodesk Inventor uses 
Microsoft Windows shortcuts to point to the project files that have been accessed on your computer. 

 
Click Tools tab > Application Options, then click the Files tab in the Application Options dialog box. The 
default Projects Folder option is set to your Documents\Inventor folder. If you want to use a different 
path for your project files, enter or browse to a new location. 
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In the following illustration, the Documents\Inventor folder is selected to list all files. The Project file 
shortcuts in the right pane of the Explorer window are not the actual project files. They are Microsoft 
Windows shortcuts to the actual project files. 

 

 
 
 
 

Project File Configuration 
 

Each project file contains a series of categories and options. To successfully design a project file, you 
must understand how to use these categories and options, to ensure proper file referencing when you 
design assemblies. 

 

 

Projects Dialog Box 
 

You use the Projects dialog box to create, edit, or set a project file to current. The dialog box is divided 
into two panes. The top pane lists the currently available projects, while the lower pane shows the 
settings and configured options for the selected project. 
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Option 

 

Description 

 

 
 

 
 
 

Select Project 
Pane 

Select a project to edit it, or double-click a project to make it active. 
 

Note: You cannot edit the active project or activate a different project if there 
are files open in Autodesk Inventor. 

 

 
 

 
 

Edit Project 
Pane 

 

Select the category or right-click the option you want to change. When you 
edit search paths they are divided into two sections: (a) Named Shortcut and 
(b) Category Search Path. 

 

 

 

Named 
Shortcut 

 

Enter the shortcut name as you would like it to appear in the Open dialog box. 
This enables you to navigate easily to the search path. 

 

 

 

Category 
Search Path 

Enter the path name or click the browse button to define the path location. 
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Open Dialog Box: Location Shortcuts 
 

When you open files, the Locations area of the dialog box displays all of the named shortcuts 
contained in the active project. 

 

 
 
 

Project File Categories 
 

Each project file is divided into separate categories in which you define different paths. A typical 
design makes use of some or all of these categories depending on the structure of your assembly and 
the environment in which you are working. 

 

 
 

 

Category 
 

Description 

Type 
 

Defines the type of project. Unless you also have Autodesk Vault installed, 
you only create single-user project files. 

Location Displays the physical location of the project file. 

Use Style Libraries 
 

Defines whether or not the project uses a style library. Options are Yes, 
Read Only, and No. 



9 Chapter 11:  Workflow and Best Practices  

 

 

Category 
 

Description 

Workspace 
 

A personal location where you edit your personal copy of design files. Only 
one designer should have access to the files in the folder called out in the 
workspace. 

Workgroup Search 
Paths 

 

Within this group you can define multiple search paths for accessing files. 
You do this when you want to add levels of organization to your design 
files or access files from another designer. 

Libraries 
 

You use this category to define search paths for part libraries. Part libraries 
can consist of standard off-the-shelf components that you use in your 
designs or can also include common parts that you design. Common 
factors in all libraries include that the path is considered by the application 
to be read-only, and parts stored within a library search path rarely, if ever, 
change. If library folders are defined, each needs a descriptive name that 
should not change. Because the library name is stored in the reference, 
changing the library name later breaks library references. 

Frequently Used 
Subfolders 

 

This group is used to define paths of frequently used subfolders within the 
project folder structure. 

Folder Options 
 

This group contains options for setting the folder locations of style 
libraries, templates, and Content Center files. 

Options You use these properties to set specific options for the project file. 

 
 

Project Categories: Search Order 
 

Knowing and remembering the category search order is critical to properly implementing and 
managing project files. The following illustration represents a typical project file with path locations 
defined in each category. When the application needs to locate referenced files, it searches for files 
using paths contained in each category using the following order. 

1.   Libraries 

2.   Workspace 

3.   Workgroup Search Paths 
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A simple way to remember the search order is to remember libraries first, and then the order that 
each category is displayed in the project window. 

 

 
 
 
 
 

Relative Paths in Your Project Files 
 

When you add paths to each category, the application stores only the relative path. The relative path 
is created by removing the project file location from the path text and leaving only the remaining path 
information. Using relative paths enables greater portability of your project files and data sets. When 
you view the paths under each category, the path settings begin with . followed by the folder location 
relative to the physical location of the project file. In the following example, the Robot-Assembly.ipj 
file is stored in the folder C:\Designs\Robot Assembly. 

 
By storing only relative paths in your project file, it is possible to physically move the entire folder 
structure to another location or storage device. As long as the folders maintain their relative location 
to the storage location of the project file, the application can resolve the files as required. 

 
 

    Location of project file 

    Relative path 

    Full path 

Full path 
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Project File Folder Options 
 

Folder options identify where project level files such as templates and styles are stored. 

 
 

 

Option 
 

Description 

Design Data Identifies where the project-specific style definitions are stored. 

Templates 
 

Specifies the location of the Autodesk Inventor document templates for 
the project. 

Content Center Files Specifies the location of the Content Center files used in the project. 
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Project Options 
 

The following options can be set for each project. 
 

 
 

 

Option 
 

Description 

 

Old Versions to Keep 
on Save 

 

Specifies the number of versions to keep when you save changes. Older 
versions of each file are stored in an Old Versions subfolder of the file 
location. 

Using Unique File 
Names 

 

Specifies whether all files in the project have unique file names. Not 
applicable for library locations. 

 

Yes: Indicates that no duplicate file names are used in the project. The 
application searches through all editable project locations to find the file 
name, even if it was last accessed from a different folder. 

 

No: Indicates that duplicate file names exist in the project. If duplicate file 
names are found when resolving files, the Resolve Files dialog box opens 
so you can browse to the correct file to manually reestablish the link. 

Name Indicates the name of the project file. 

Shortcut Indicates the name of the project file shortcut. 

Owner Identifies the project owner, typically the lead engineer or CAD 
administrator. 

Release ID 
 

Identifies the version of the released project data. If a project is used as 
a library by another project, the release ID may be useful in identifying 
which project to use. 

 

Imported 
Components Folder 
Name 

Identifies the name of the folder where imported components are stored. 

 

Imported Top Level 
Assemblies Folder 
Name 

 

Identifies the name of the folder where imported top level assembly data 
is stored. 
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Creating a Project File 
 

You begin to create project files through a wizard. You are prompted to fill in relevant information 
such as project name, workspace folder, and libraries to import from other projects. After the initial 
creation is complete, you proceed to add the required paths to the categories you will use. 

 

 
 
 

Access 
 

     Create or Edit Projects 
 
 

 
Ribbon: Get Started tab > Launch panel 

 

Open or New Dialog Boxes: Projects 

Procedure: Creating a Single-User Project File 
 

The following steps describe how to create a single-user project. 

 1.  Access the Projects dialog box by clicking File menu > Projects. 

 2.  Select the New Single User Project type and click Next. 
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3. In the Name field, enter a name for the project. In the Project (Workspace) Folder field, enter a 
path location for storing the files for this project. Click Next. 

 
 

4. If you have any projects with libraries defined, they are displayed in this list. You can use this 
information to copy library paths from other project files. 

 Click Finish to create the project. 

 If you are prompted to create the path, click OK. 
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Lesson: Factory Templates 
 

It is important for you to define which templates you want to use as defaults when starting a new 
project.  This will keep you from accidently working in different unit systems when working with 
multiple vendors.  The Factory Design Utilities determine the default template for asset creation in the 
Factory Options dialog. 
 
 
 
 
 
 
 
 

You access the Factory Options on the Getting Started 
ribbon and the Factory ribbon. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Default Layout Temple setting determines the 
default assembly template used to create new factory 
layouts.   
Note:  A factory layout template is different than a 
typical Inventor Assembly template.  Special settings 
and parameters are in place to support factory layout 
processes. 
 
The Default Part Asset Template setting determines 
the default part template used to create new factory 
assets. 
Note:  The default setting uses a typical Inventor part 
template. 
 
The Default Assembly Asset Template setting 
determines the default assembly template used to 
create new factory assets.   
Note: The default setting uses a typical Inventor 
assembly template. 
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Lesson: Supporting Directories 
 

Each time a factory asset is added from the Asset Browser, an independent instance of it is created in 
the local workspace.  A Factory Asset directory is added to the local workspace when the first asset is 
placed into the factory layout.  All factory assets placed from the Asset Browser are stored in this 
location.  Each asset is stored in a unique sub folder with a unique file name. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Supporting Library Directories 
 

The supporting System Asset Library that ships with Autodesk Factory Design Suite is stored in the 
following location. 
 
C:\Program Files\Autodesk\Inventor 2011 
 
 
 
 
 
 
 
 
 
 
 
 
 

Supporting User Library Directories 
 

The supporting User Asset Library for Autodesk Factory Design Suite is stored in the following location. 
 
C:\Users\username\Documents\Factory Library 
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  § In the Inventor Project Wizard enter 

R&D as the name of the new Project. 

 
§ Set the Project Workspace by clicking 

the button and navigating to the 

directory created in the first step. 

 
§ Select the Workspace directory and 

click OK. 

§ In the Inventor Project Wizard dialog, 

Click Finish 

 

 

3. Set your active Project File 

§ In the Projects Dialog, double click the 

R&D Project File listed in the upper 

pane. 

Note: The check mark denotes the 

active project file. 

 
§ Click Done. 

Exercise: Project File and 

Supporting Directories 
 
In this exercise, you create an 
Inventor Project file and review the 
supporting directories used by 
Autodesk Factory Design Suite. 

 

 

The Completed Exercise 

 

1. Create the Workspace. 

§ In Windows, create a directory called 

C:\R&D. 

Note: In this example, this directory 

will be used as the Workspace. 

 

2. Create the Project File. 

§ In Inventor, make sure all files are 

closed. 

§ Click the Projects Tool on the Getting 

started ribbon. 

 
§ On the Projects Dialog, click the New 

Button. 

 
 

§ In the Inventor Project Wizard, select 

the New Single User Option. 

 
§ Click Next 
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  7.  Review the location of assets placed in 

the factory layout. 

§ Select a system asset. 

 
§ Right Click and select iProperties 

Notice the default storage location for 

assets placed on the factory floor. 

 
§ Close the iProperties dialog. 

 

8. Review the contents of the Factory 

Asset folder in the Workspace. 

§ Use the file open command and 

review the contents of the Factory 

Asset folder now located in the 

Workspace. 

§ Close the File Open dialog without 

opening any files. 

 

9. Review other supporting directories. 

§ To easily navigate to the location of a 

system asset, Right Click on a system 

asset in the Asset Browser and click 

Explore from the menu.  Notice the 

supporting directory for System 

Assets. 

§ To easily navigate to the location of a 

user asset, Right click on a user asset 

in the Asset Browser and click Explore 

from the menu.  Notice the 

supporting directory for the User 

Assets. 

 

 

 

 

 

4. Create and Save New Layout. 

§ Create a New Layout. 

§ Save the Layout in the default 

workspace.  During the Save 

operation notice that the file is saved 

to the workspace by default. 

Note: Please note that there are no 

other directories located in the 

workspace at this time. 

 

 

5.  Add Several System Assets from the 

Asset Browser. 

§ Using the System Assets create a 

small conveyor line as shown in the 

image below. 

 

 

6. Add several User Assets from the Asset 

Browser. 

§ Using the User Assets create a small 

conveyor line as shown in the 

following image. 

 
§ Save the File. 
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13. Reset the Project File. 

§ Close all files. 

§ Set the Active Project back to 

Learning Autodesk Factory Design 

Suite. 

 

End of Exercise. 

 

10. Copy custom assets to the User Asset 

Library. 

§ Navigate to the Components folder in 

the AFDS_Training_Files directory. 

§ Copy the AFDS_Sample_Assets folder. 

§ Right Click on a User Asset in the 

Asset Browser and select explorer. 

§ In Windows Explorer, navigate up one 

level to the Factory Library. 

§ Paste the AFDS_Sample_Assets folder 

into the Factory Library folder. 

 

§ Close Windows Explorer. 

 

11. Refresh the Asset Browser. 

§ On the Asset Browser Click the 

Refresh tool. 

 

 

12. Review and Place some sample factory 

assets. 

§ In the Asset Browser, navigate to the 

User Assets. 

§ Review the new assets available in the 

directory. 

§ Place several of the sample assets in 

combination with the conveyor assets 

placed earlier as demonstrated in the 

image to the right. 
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Lesson: Workflow – Divide and Conquer 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 
 

 

 

 

Designing a complete factory layout with all architectural elements and thousands for factory 
assets is quite a lot for a single computer program to handle.  Autodesk Factory Design Suite 
allows factory designers and system integrators to work with factory designs that are beyond the 
capability of most computer applications.  In order to work with so many components efficiently, 
it is important to divide the layout into logical sections and reference each section back into the 
overall factory design. 
 
There are various reasons to store your factory lines in separate files instead of a single layout.  
By dividing the lines into multiple assemblies, you increase your computer resource efficiency.  
Dividing the layouts also offers the ability to reuse the asset configuration in other factory 
layouts.  This workflow allows multiple designers to work together on a single project.  The final 
reason is very straight forward; factory layouts often require thousands of assets to make up the 
overall design.  Loading all these assets into a single file will require more computer resources 
than are available in most computers.  
 
For all these reasons, the best practice recommendation for handling large factory layouts is to 
break up the layout into logical spaces.  Each space becomes a separate sub-assembly in the 
overall design.   

 

Objectives 

After completing this lesson, you will be able to: 

§ Understand the basic process of dividing an entire Factory Layout into logical 

subassemblies. 

§ Place the subassemblies into the overall Factory Layout at the proper location. 



21 Chapter 11:  Workflow and Best Practices 

  

Workflow – Divide and Conquer 
 

A factory layout is normally divided into logical sections or subassemblies.  Each section usually performs 
a specific task essential to the overall mission of the facility.  Each section is created as a separate layout 
using the practices outlined in previous chapters.  The layout subassemblies are then placed into the 
overall Factory Layout assembly. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
DWG Overlay – Common Reference Lines 
The first step in creating a Sub-Layout is to place the DWG Overlay in the proper position.  Each Layout 
will utilize the DWG Overlay of the overall facility.  These reference lines are crucial to the placement of 
the factory lines in the final overall assembly.   
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Placing Factory Line Sub-Layouts into the Final Factory Layout 
 

The final factory layout will reference all the individual Factory Lines or Subassemblies.  Each Sub-
Layout is placed into the overall Factory Layout at the original coordinates established by the DWG 
Overlay.   
 
The first Sub-Layout will report to it designed coordinated automatically but the following 
subassemblies will need to be moved into position manually.  There are several simple methods of 
placing components into an assembly based on their design coordinates.  The simplest is to set the 
occurrence location in the iProperties to 0 for the X, Y, and Z values. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
                                                 

To access the iProperties for a part or assembly, 
select the desired component and Right Click.  
Select iProperties from the menu. 

 
 
 
 
 
 
 
 

On the iProperties dialog, select the Occurrence 
tab. 

 
 

On the Occurrence Tab, Set the Values for X 
Offset, Y Offset, and Z Offset to 0 (Zero). 

 Click Close to finish the process. 
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  3. Place the Second Sub-Layout. 

§ On the Assembly ribbon, click the 

Place Component tool. 

§ Select AFDS_008_Robot_Line.iam 

§ Click Open. 

§ The second component placed into an 

assembly does NOT report to any 

location.  Left Click to place the 

component anywhere. 

§ Right Click and select Done from the 

menu. 

 
4.  Set the location of the second Sub-

Layout. 

§ Right Click on the second Sub-Layout 

and select iProperties from the menu. 

 
§ On the iProperties dialog, click the 

Occurrence Tab. 

§ On the Occurrence Tab, set the values 

for X Offset, Y Offset, and Z Offset to 0 

(Zero). 

 
§ Click OK. 

 

 

Exercise: Build the Main 

Factory Assembly 
 
In this exercise, you create The main 
Factory Assembly and place the 
subassemblies for each factory line 
into the overall design. 

 

 

The Completed Exercise 

 

1. Start a New Factory Layout. 

§ Add the DWG Overlay 

AFDS_008_2D_Factory.dwg 

 

2. Place the first Sub-Layout. 

§ On the Assemble ribbon, click the 

Place Component tool. 

 
§ Select AFDS_008_Conveyor_1.iam 

§ Click Open 

§ The first component in an assembly 

automatically reports to its original 

location 

§ Right Click and select done from the 

menu. 
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  5. Place the remaining subassemblies. 

§ Repeat the previous 2 steps for the 

following subassemblies. 

§ AFDS_008_Inspection_Line.iam 

§ AFDS_008_Packaging_Line.iam 

§ AFDS_008_Machining_Line.iam 

 

3. Close All Files without Saving. 

End of Exercise 
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Lesson: Best Practices 
 
 

 
 

 

 

 

 

 

 

 

 

Clearance Zones 

 
 

 

 

 

 

 

 

 

The Autodesk Factory Design Suite simplifies the factory layout process using a simple, easy to understand 

workflow.  This section covers several recommendations for maximizing your design productivity while using the 

Factory Design Suite. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Understand the Simplified Model practice. 

§ Create Access and Maintenance zones with separate solid bodies. 

§ Use the Shrinkwrap tool to convert an assembly into a single part. 

§ Understand how to handle multi-level designs. 

§ Objective 4 
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Simplified Model Design 
 

The more features your assets contain, the more graphic resources they require.  In addition, your factory 
design could contain hundreds or thousands of assets.  For this reason, it is a recommended practice to 
generate assets in a simplified form with a minimal amount of detail.  Assets should represent the design 
envelope of the actual component and deliver the necessary design information for the layout drawing. 
 
Several general practices should be followed to simplify the design representation and reduce the model file 
size.  Please note these practices are general guidelines and may need to be adjusted or ignored in certain 
situations.  The best practices for modeling simplified representations are as follows. 
 
§ Fit, Form, and Function – Asset components must be modeled as accurately as possible.  They must also 

be modeled to the simplest representation possible.  The general guideline of Fit, Form, and Function 
should be followed.  This term is sometimes referred to as F3.  In manufacturing and design industries the 
term refers to the description of an item’s identifying characteristics.  If the specifications and criteria of 
an item’s Fit, Form and Function are met; all other attributes are extraneous. 

§ Eliminate Fillets, Chamfers, and Tapers whenever possible. 
§ Eliminate Holes whenever possible.  Some holes are necessary for proper attachment and location in the 

final factory design.   
§ Eliminate Shells – Remove all inner features that are not necessary. 
§ All Contact faces and edges should be modeled to the simplest form possible. 
§ Clearance and Maintenance spaces can be modeled as separate solids bodies using a transparent color. 
§ Assemblies should be modeled or converted to single components if possible. 
§ All Adaptive features should be removed from equipment models. 
§ Do not include fasteners in assembly designs 
 
The following examples illustrate the realistic view of a component or assembly, and the recommended 
simplified form that should be modeled for the Factory Asset Library. 
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Create Clearance Zones as Separate Solid Bodies 
 

Clearance and maintenance spaces can be modeled as separate solid bodies and displayed with a 
transparent color.  The appearance of the clearance zones can be controlled by establishing a simple 
on / off parameter.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

Creating a simple On / Off 
Parameter 

Define A User Parameter 
§ Create a Numeric 

Parameter setting the unit 
to unitless and the number 
to one.   

§ Make the value a Multi-
Value and add 0 as an 
alternative. 

 
 
 
 
 

 
 
 
 

Set Suppression for a Feature by 
Parameter. 
§ In the Browser, Right Click 

the desired feature and 
select Properties from the 
menu. 

§ In the Feature Properties 
dialog, set the Suppress 
option to IF. 

§ Select the On / Off 
Parameter from the drop 
down list. 

§ Set the argument to Not 
Equal. 

§ Enter the value of 1. 
§ Click Ok. 

 

 



28 Chapter 11:  Workflow and Best Practices 

 
 

Converting an Assembly into a Single Part - Shrinkwrap 
 

One of the primary methods of saving computer resources is to minimize the number of files 
referenced into the main assembly.  Subassemblies can be converted to a single part saving many file 
references in the overall factory layout.  The Shrinkwrap command can be used to convert an 
assembly into a single component.  Holes and interior features can be removed simplifying the form 
of the component. 
 
Note:  The single part representation of multiple bodies is critical to reducing the overall part count in 
the overall factory assembly.   The Pump shown below is a good examples of converting (Shrinkwrap) 
an assembly into a single component. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Shrinkwrap an Assembly to a Single Component. 

 

Open the desired Assembly. 
 
From the Assembly ribbon, click the Shrinkwrap 
tool. 
 

 

In the Create Shrinkwrap Part dialog… 
§ Enter a name for the new component (1).   
§ Specify the New File Location (2).   
§ Click Ok. 
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Assembly Shrinkwrap Options 
 

1.  Style - Specify how multiple bodies are to be 
handled during the shrinkwrap operation. 

§ Single solid body merging out seams 
between planar faces Select to 
produce a single solid body without 
seams between planar faces. When 
you merge seams between faces, the 
face assumes a single color. 

§ Solid body keep seams between planar 
faces Select to produce a single solid 
body with seams between planar faces 
retained. 

§ Maintain each solid as a solid body 
Select to produce a multi-body part 
that contains a unique body for each 
part in the assembly. 

§ Single composite feature This is the 
default selection. Select to produce a 
single surface composite feature. This 
selection produces the smallest file. 
Colors and seams of the original 
components are retained. The mass 
properties of the original assembly are 
cached. and retained. 

2. Remove geometry by visibility Select the 
check box to enable the options to remove 
geometry based on visibility. The check box is 
selected by default. 

3. Hole Patching –  
None  - Does not remove any holes. 
All  - Removes all holes that do not cross 
surface boundaries. Holes do not need to be 
round to be included. It is the default setting. 
Range - Specifies the circumference or 
perimeter of the holes to include or exclude. 
Holes do not need to be round to be included. 
 

4. Break Link - Permanently disables any updates 
from the source component. 
 

 Click OK. 
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Creating a Multi-Level Factory Design 
 

Multi-Level factory designs require a separate layout assembly for each floor.  As described in the 
Divide and Conquer Workflow section, a separate assembly will be created for each level of the 
factory design.  Unlike the previous examples, the new factory layouts are created in context of the 
main factory using the Create command located on the Assemble ribbon. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   
 

 
 
 
 
 
 

To Add a Second Level to the Factory Layout… 

On the Assembly ribbon, Start the Create tool. 

 
 
 
 
 
 
 
 
 

In the Create In-Place Component dialog… 
1. Enter a name for the new layout. 
2. Select the StandardFactoryLayout.iam template 

from the template dropdown list. 
 
Click OK. 

 
 
 
 
 
 
 
 
 
 
 

Select the face or work plane that represents the landing 
surface of the second level. 
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Use the Resize floor command to alter the size of the 
new floor.   
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Chapter Summary 
 
 
 
 

This chapter presented the recommended best practices for working with Autodesk Factory Design 
Suite.  The Project settings and supporting directory structure was also discussed.  Knowing the 
supporting directories and following the best practice workflow will allow you to successfully design 
your factory layout. 

Having completed this chapter, you can: 

 Create a Project file for a typical factory design. 

 Understand the supporting file directories for Autodesk Factory Design Suite. 

 Understand the Best Practice for dividing a factory design into subassemblies. 

 Understand the Best Practice for modeling a Simplified form for factory assets.  
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Chapter 
 

12 
 

 
 
 

Basic View Creation 
 
 
 

Now that you understand the basics of factory design, you need to learn how to create production-
ready drawings of those designs. Basic view creation with Autodesk® Inventor® is quite simple when 
you understand tools and recommended workflows. Within only a few minutes, you can easily create 
plan, elevation, section, detail, and even isometric views of your 3D factory Layouts. 

 

 

Objectives 
 

After completing this chapter, you will be able to: 

 Navigate the Autodesk Inventor user interface when creating and editing drawing sheets. 

 Create base and projected views of 3D parts and assemblies. 

 Create and edit section views. 

 Create and edit detail views. 

 Create and edit cropped views. 

 Add Annotations to Drawings. 

 Review the AutoCAD Interoperability with Inventor DWGs. 
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Lesson: Drawing Creation Environment 
 
 

 
This lesson describes the main interface components in the drawing environment related to creating 
production-ready drawings. When you create, annotate, and edit a drawing sheet, you have the same 
tools that you have when working on an assembly or part. However, the tools and information that 
display on the ribbon and browser may vary. 

 

Being able to navigate the user interface when creating and editing drawing sheets has a direct impact 
on your ability to complete your work efficiently. 

 

The following illustration shows the drawing creation environment. 
 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Describe a production-ready drawing and its purpose. 

 Describe the process for creating production-ready drawings. 

 Recognize the different areas of the drawing creation environment. 

 Navigate the drawing creation environment.
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About Creating Drawings 
 

A drawing that can be used to produce a factory assembly as specified is referred to as a production- 
ready drawing. When creating a production-ready drawing, you work in the drawing environment. 
Within this environment you create the drawing views of the factory assemblies and add annotations 
to fully communicate your design requirements and intent. 

 

The following illustration shows a production-ready factory drawing. 
 

 
 
 

Definition of Production-Ready Drawings 
 

A production-ready drawing contains all the necessary views, annotations, notes, revisions, and title 
block information, required to manufacture the objects displayed in the drawing. 

 

In the following illustration, the final view, an isometric view, provides additional information for 
collaborators who cannot read conventional 2D drawings. 
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Example of Drawing Views 
 

Production-ready drawings communicate design requirements for manufacturing. To communicate 
these requirements, a production-ready drawing contains the required combination of views and 
annotations. A drawing can contain any of the following views: 

1. Base views 

2. First or third angle projection views 

3. Isometric views 

4. Section views 

5. Detail views 

6. Draft views 
 

 

Example of Annotations 
 

A drawing can also contain the following annotations: 

1. Dimensions 

2. Hole notes 

3. Chamfer notes 

4. Centerlines and center marks 

5. Notes 

6. Parts list 

7. Balloons 
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Creating Drawings 
 

You create drawings to convey information. Depending on the type of parts or assemblies required 
for production, you create different views and add annotations to define every aspect of the design. 
A production-ready drawing contains all the necessary views, annotations, and notes to complete the 
manufacturing or assembly process. 

 

In the following illustration, a detail view is created to simplify the annotation process. 
 

 
 
 

Process: Creating Drawings 
 

The following steps outline the process for creating drawings. 

1. Determine the critical aspects of the design. 

2. Determine the views required to show the 
aspects of the design. 

3. Create the drawing views. 

4. Add drawing annotations. 

5. Add any notes or other information needed 
to manufacture the design. 

6. Enter title block data. 
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About the Drawing Creation Environment 
 

The drawing creation environment enables you to create production-ready drawings by creating the 
necessary views, annotations, notes, and other information needed to produce a part or assembly. 
The drawing creation environment has four main areas that you use in the creation of a drawing: 
drawing sheets, standard tools, panel bars, and the browser. 

 

The following illustration shows the drawing creation environment. 
 

 
 

  

Option 

 

Description 

 

 

 

Ribbon 
 

The ribbon contain the tools that you use to create views and annotations 
and the standard tools. 

 

 
 

 
 

Drawing 
Sheet 

The primary, and typically largest, area of the drawing environment is 
the drawing sheet. The drawing sheet represents the paper on which the 
drawing is created. 

 

 

 

Browser 
 

The browser tracks the history of the drawing file and has access to 
drawing resources such as title blocks, borders, and sheet sizes. 
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Project Files 
 

When you create designs, each one consists of multiple files and file types. The design and 
documentation of a single part file require at least two separate files: (a) a part file and (b) a drawing 
file. The design and documentation of assembly models require a minimum of three different file 
types: (a) assembly files, (b) part files, and (c) drawing files. 

 

Using separate files for each file type is critical for performance and is common among most 
parametric modeling systems. By storing path information for each project, the application can search 
for the required files when opening an assembly, presentation, or drawing file. The need to search in 
different path locations for files is the primary purpose of project files. 

 

The following illustration represents file dependencies in a typical assembly design. 
 

 
 

When you open an assembly, drawing, or presentation file, the active project file is used to resolve 
path locations to the referenced files. 
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Definition of the Drawing Creation Environment 
 

You use the drawing creation environment to create 2D representations of your 3D models and 
assemblies. 

 

In the following illustration, the drawing creation environment is used to create the necessary views 
and annotations for a conveyor line. 

 

 
 
 
 

Using the Drawing Environment 
 

The drawing environment contains a number of tools that you can use to create drawing views and 
add annotations to the view or drawing sheet. The tools on the ribbon are split between the Place 
Views tab, the Annotate tab, and the browser. 

 

In the following illustration, the ribbon is being switched to the Place Views tab for the addition of 
drawing views to the sheet. 
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Drawing Tabs 
 

In the drawing environment, on the ribbon, two tabs are available for creating production-ready 
drawings. You use the Place Views tab to create the various drawing views required to document your 
parts and assemblies. 

 

 

 
You use the Annotate tab to add dimensions, notes, and symbol annotations to the drawing views. 
You can switch between the tabs by clicking the tab name on the ribbon. 

 

 
 
 

Drawing Environment Browser 
 

In the drawing environment the browser displays the Drawing Resources folder, which contains sheet 
formats, borders, title blocks, and sketched symbols. It also displays each sheet in the drawing, along 
with the views that you create for each. 

 

In the following illustration, the cursor is moved to the browser and a new title block is being inserted. 
 

 

Process: Navigating the Tabs 
 

Navigating the drawing environment is an iterative process. When a drawing has been started, and a 
base view placed, annotations can be added. Subsequent views can be placed as needed, making 
additional annotation or even a different sheet size necessary. The following steps outline the general 
process when navigating the drawing environment. 

1. Start or open a drawing file. 

2. Select the expected drawing size. 

3. Create a base view. 

4. Create projected views. 

5. Click the Annotate tab. 

6. Add drawing annotations. 

7. Enter title block data. 
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Exercise: Use the Drawing 

Creation Environment 
In this exercise you navigate the drawing creation 
environment to create projected views and change 
the sheet size. 

 

The completed exercise 
 

 
 
 

1. Start a New ANSI(in).dwg 

§ On the Quick Access toolbar, click File New. 

§ Click the English Tab. 

§ Select the ANSI (in).dwg drawing template. 

 
 

2. Place the Base View: 

§ On the Place Views ribbon, click the 

Base View tool. 

 
§ On the Drawing View dialog, click 

the browse button and select: 

INV_014_Create_Views.iam 

 

 
 

§ Click OK 

 

3. Left click on the drawing sheet to place the 
base view. 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Place the Top and Right Side View. 
§ Left click directly above, and directly right 

of the base view to create the Top and 
Right side views. 

 

 

 

 

 

 

 

 

 

 

5. To create an isometric view, click above and to 
the right of the view that you just placed.  

 Click Create. 
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6. Change the size of the Sheet: 

§ In the browser, Right Click on the Sheet node 
and select Edit Sheet from the menu. 

 
§ In the edit sheet dialog, change the sheet 

size to D size. 

 
§ Click OK 

 
 
7. Click and drag the border of each drawing view 

to position them as shown. 

 
 

8. To access annotation tools, click the Annotate 
tab. 

 

 
 

 

9. Click Annotate tab > Dimension panel 

> Dimension: 

§ Click the largest radius on the main 

machine. 

§ On the right end of the Annotate 

ribbon select the Architectural (ANSI) 

style form the style drop down list. 

 
§ Click next to the radius to place the 

dimension. 

§ Right-click above the dimension.  

§ Click Done. 

§ If the Edit Dimension dialog box 

appears, click OK. 

 

 

10. Close All Files 

End of Exercise. 
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Lesson: Base and Projected Views 
 
 

 
This lesson describes creating projected views of your part or assembly files. 

 

After you complete the 3D design of your factory layout, manufacturing requires dimensioned 
drawings in order to build your design. The first step in creating production drawings is to create the 
required orthographic and isometric views. 

 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Create base views of 3D factory assemblies. 

 Create and edit exploded drawing views. 

 Create projected views. 

 Edit orthographic views and describe how other projected views may be affected. 
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Creating Base Views 
 

You create a base view to begin creating orthographic views. The base view establishes the original 
view orientation and scale upon which projected views are based. When you create the base view, 
you specify the file to be used for the view, the view orientation, scale, and style. After you specify this 
information, the view is placed onto the sheet and an associative link between the drawing and the 
part, assembly, or presentation file is established. If the part geometry changes, those changes are 
reflected in the drawing. 

 
 
 

Access 
 

     Base Views 
 

 
 

Ribbon: Place Views tab > Create panel > Base 

 

Toolbar: Drawing Views Panel 

Shortcut Menu: Base View 
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Drawing View Dialog Box 
 

The following options are available in the Drawing View dialog box. 
 

 
 

 

Option 

 

Description 

File 
 

Determines the part or assembly file to create its view. If you have a part, 
assembly, or presentation file open, it is the default file listed. If multiple 
files are open, you select them from the drop-down list. 

Orientation 
 

Determines orientation for the base view. Move your cursor away from the 
dialog box to see a preview of the view before it is created. The standard 
view orientations are based upon the origin planes of the file you select. 

Change View 
Orientation 

 
Opens the model's 3D viewing window. You use standard view tools 

to define a custom view orientation. 

View / Scale Label 
 

Enables you toggle the display of the view and scale label, select a preset 
scale value, or enter a custom value for the view. Additionally, you can 
enter a label for the view or accept the default view label. 

 Scale from Base: Not available when you create a base view. You use it 
when you edit projected views. 

 Visible: Displays the scale and view label on the sheet under the view. 

 Edit View Label: Displays the Format Text dialog box. 
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Option 

 

Description 

Style Rendering style for the view: 

 Hidden Line: Hidden lines are displayed. 

 Hidden Line Removed: Hidden lines are removed. 

 Shaded: View is shaded using the same colors used in the assembly or 
part file. 

 
 

Procedure: Creating Base Views 
 

The following steps describe how to create base views. 

1. Create a new drawing file. 

2. On the ribbon, click the Base View tool. 

3. Enter or browse for the Autodesk Inventor file to create the view, and adjust the options as 
desired for orientation, scale, and style. Click the sheet to place the view. 

 

4. The base view is placed on the sheet according to the options specified. 
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Creating Projected Views 
 

The Projected View tool enables you to create projected views from any existing view on the sheet. If 
you select the Projected View tool you must select a parent view, then position each projected view. 
All view positions are previewed by a bounding box prior to the views being created. 

 

When you create projected views, the view orientation is automatically determined based on its 
position on the sheet relative to the base view. If you place the projected view to the right of the base 
view, it generates a right-side projection of the parent view. If you place the projected view at an angle 
to the parent view, it generates an isometric view based on the relative position to the parent view. 

By default, the following view properties are carried over from the base view: 

 Scale 

 Style (Orthographic Only) 
 

In the following illustration, the right, top, and isometric views are projected from the lower left base 
view. 

 

 
 
 

Drafting Standards Projection Setting 
 

The description above is based on a Third Angle projection setting in the Drafting 
Standards dialog box. The First Angle projection method is also available. 
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Access 
 

     Projected View 
 

 
 

Ribbon: Place Views tab > Create panel > Projected 

 

Toolbar: Drawing Views Panel 

Shortcut Menu: Create View > Projected View 
 

 

Procedure: Creating Projected Views 
 

The following steps describe how to create projected views. 

1. On the ribbon, click Projected View. 

2. Select the parent view. 

 

3. Click in the drawing to define the first projected view. Repeat until all views are defined. 
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4. Right-click in the drawing. Select Create. 

 
 

 
 
 

Properties of Editing Base and Projected Views 
 

After you create base and projected views, you can edit the view properties using the Drawing View 
dialog box. Depending on the type of view, base or projected, different options are available for 
editing. 

 
When you edit a base view, you can change the scale and style properties. However, while editing a 
projected view, you can change these properties only if you clear the Scale from Base or Style from 
Base options. In a projected view, these properties are linked to the base view to ensure the same 
scale and the same rendering style across views. 
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Editing a Base View 
 

When you edit a base view, you can edit any option that is not grayed out. If you change the scale 
factor on the base view, all projected views with the Scale from Base option selected are updated to 
reflect the new scale factor. 

 

 
 

When you edit a projected view, you can edit any option that is not grayed out. Clear the Scale and 
Style from Base check boxes to change the view scale or rendering style. 
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Exercise: Create and Edit Base 

and Projected Views 
In this exercise, you create a new drawing and place 

a base view and three projected views of a rotor 

assembly as the base for a production-ready 

drawing. 

 

 

 

The completed exercise 
 

 
 
 
 
 
 
 
 
 

 

1. Open INV_015_Create_Edit_Views.iam 

 

3. On the Quick Access toolbar, click New. 

4. In the New File dialog box, select the English tab. 
Double-click the ANSI (in).dwg template. 

5. In the drawing environment, Click Place Views 
tab > Create panel Base. Because the assembly is 
already open, it is automatically selected as the 
file for the drawing view. 

 

6. In the Drawing View dialog box, adjust the 
options as shown: 

 Set the Scale value to 1/16”=1” (1). 

 Turn on the Scale Value (2). 

§ Enter Elevation in the View Identifier field (3). 
§ Click the lower-left area of the sheet to 

place the view. 
§ Right Click and select Done from the 

menu. 

 
 

7. On the Place Views ribbon, Click the Projected 
view tool. 
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8. Select points on the sheet to position the 
views as indicated by the bounding box 
preview and isometric preview in the 
following illustration. 

 
 

9. Right-click in the graphics window. Click 
Create to create the projected views. 

10. The drawing views are displayed as shown in the 

following image. 

 

 
 

 

 

 

 

 

 

 

11.  Edit the Sheet Size and Arrange the views. 

§ In the browser, Right Click on the Sheet node 

and select edit sheet from the menu. 

§ In the Edit Sheet dialog, set the sheet size to D. 

§ Arrange the views as shown in the following 

image. 

 
 

12.  Right-click in the isometric view. Click Edit View. 

 In the Drawing View dialog box, under 
Scale, enter 3/32”=1’ 

 Click OK. 
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13. The projected isometric view updates to 
reflect the new scale as shown in the 
following image 

 
 

14. Right Click in the Top View and Click Edit 
View from the menu. 
§ Turn on the View Label (1) and enter Plan 

in the View Identifier window (2). 
§ Repeat this process for the right side 

view.  For this view enter Right Elevation 
for the View Identifier 

 

 

15. Right-click in the isometric view. Click Edit View. 

 Turn on the View Label (1) and enter 

Isometric View for the View Identifier (2). 

 Under Style, click Shaded (3). 

 Click OK. 

 
 

16. The isometric view updates to the shaded 
representation. 

Note: You may need to reposition the isometric 
view. 

 

 
 

17. Close all files. Do not save. 
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Lesson: Section Views 
 
 
 
 

This lesson describes creating section views of factory layout drawings. When you create drawings of 
factory layouts, important internal details are sometimes obscured by other features or assets. 

 

Section views enable you to better visualize these important details by removing the assets or 
features that are obstructing the view. Features that were obstructed or displayed as hidden lines are 
drawn with continuous lines with hatch patterns representing the section plane. 

 

In the following illustration, a half section view was created based on the initial view. Then an 
isometric projection was created from the offset section. 

 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Create section views. 

 Edit section views. 

 Control hatch and sectioning in section views. 
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Creating Section Views 
 

In order to create a section view, you must have at least one view on the sheet on which the section 
line is drawn. After drawing the section line, you choose a side of the current view for the section 
view. The section view is generated based on the direction of sight relative to the view being 
sectioned. 

 
 
 

Access 
 

     Section View 
 

 
 

Ribbon: Place Views tab > Create panel 

 

Toolbar: Drawing Views Panel 

Shortcut Menu: Create View > Section View 
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Section View Dialog Box 
 

The following options are available in the Section View dialog box. 
 

 
 

  

Option 

 

Description 

 

 

 

View 
Identifier 

Use to specify a view label or accept the default value. 

 

 
 

 
 

 

Toggle 
Label 
Visibility 

Displays the label and view scale on the sheet. 

 

 
 

Scale Scale factor for the section view. 

 

 

 

Format 
Text 

Access the Format Text dialog box. 

 

 
 

 
 
 
 

Style Rendering style for the view. 
 

 Hidden Line 

 Hidden Line Removed 

 Shaded 
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Option 

 

Description 

 

 
 

 
 
 
 
 

Section 
Depth 

Section depth for the view. 
 

 Full: Section depth is calculated through the entire part or assembly. 

 Distance: Measured from the section line to calculate the section view. All 
geometry outside of the calculated distance is ignored and is not displayed in 
the view. 

 

 

 

Slice 
 

Depending on browser settings, when checked, some parts are sliced, and some 
sectioned. 

 

 
 

 
 

Slice All 
Parts 

 

Browser settings are overridden and all parts in the view are sliced according to the 
section line geometry. Parts not crossed by the section line are not included in the 
view. Section Depth fields are disabled. 

 

 
 

 
 
 

Method 
 

Use the Projected method to project the lines orthogonally to the section views 
position. The Aligned method projects section geometry perpendicular to each 
segment of the section line. This option only appears if the section line contains 
more than one segment. 
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Procedure: Creating Section Views 
 

The following steps describe how to create section views. 
 

1. With at least one view on the sheet, 
on the ribbon, click Section View. 

2. Select the parent view.  
 

3. Enter the endpoints of the section 
line. 

 Select the first point of the 
section line. If necessary, use 
tracking to align the section line 
to a feature in the parent view. 

■ Click additional endpoints to 
define the section line. The 
number of endpoints defined, 
and their directions, determine 
the type of section view created. 
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4. Right-click in the graphics window, 
select Continue.  

 

 
 
 
 
 
 
 
 
 

5. In the Section View dialog box, 
enter the desired values. Note: The 
projected method is used in this 
step. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
6. Move the preview to the desired 

location and click to place the 
section view. 
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Exercise: Create and Edit 

Section Views 
 

In this exercise, you create section views of factory 
layout.  

 

 

 

 

 

 

 

 

The completed exercise 
 

 
 
 
 
 
 
 

 

1. Open INV_016_Section_View.dwg 

 

 

2. Click Place Views tab > Create tab > Section. 

 

 

 

 

 
§ Select the view on the sheet as 

shown. 

 
 

3. Click outside of the building on the left hand 
side and draw a line thru the building to the 
right hand side as shown in the image below.  
Click a second point on the right side of the 
building. 

 
 

4. Right Click and select Create from the menu. 
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5. In the Section View dialog, select the shaded 
option for Style. 

 
 

6. Move the section view to the desired location 
and left click to place the view. 

 
 

7. The Section View is shown in the following 

image. 

 

 

 

 

 

 

 

 

 

 

 

8. Edit the Hatch Pattern 

 Zoom into the section view and review 

the current hatch pattern. 

 

 

 

 

 

 

 

 

 

 Right Click on the Hatch Pattern and select 
Edit from the menu. 

§ In the Edit Hatch Pattern dialog, change 
the scale of the hatch to.5. 

§ Click OK. 

 
 

9. Close all Files without saving. 
End of Exercise. 
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Lesson: Detail Views 
 
 

 
This lesson describes creating detail views. As you create 2D drawings for manufacturing, it may be 
necessary to magnify areas of the drawing. A detail view shows congested areas of a drawing clearly. 

 

In the following illustration, detail views have been created to magnify congested areas of the main 
view. 

 

 
 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Describe the purpose of detail views. 

 Create detail views in drawings. 

 Edit the size and location of detail views. 
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Creating Detail Views 
 

You use the Detail View tool to create detail views of an existing view in the drawing. When you use 
Detail Views, you define the detailed area by specifying a center point and a rectangular or circular 
fence. All geometry contained within the detail view rectangle or circle is included in the detail view. 

 

When you create a detail view, you magnify an area of the drawing while creating an associative link 
between the original view and the detail view. If the geometry being magnified changes in the original 
view, those changes are reflected in the detail view. Also, the placement and readability of dimensions 
in these areas of the drawing are simplified. 

 

A detailed view is associated with the main view, and any changes that affect geometry within the 
main view are reflected in the detail view automatically. Although the view is scaled, as is true of 
other scaled views, when you place dimensions on geometry within the view, the dimensions reflect 
the actual geometry size. 

 

 
 

    Detail view circle 

Scale detail view with dimensions 
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Access 
 

     Detail View 
 

 
 

Ribbon: Place Views tab > Create panel 

 

Toolbar: Drawing Views Panel 

Shortcut Menu: Create View > Detail View 
 

 

Detail View Dialog Box 
 

The following illustration shows the Detail View dialog box. 
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The following options are available in the Detail View dialog box. 

  

Option 

 

Description 

 

 

 

View 
Identifier 

Use to specify a view label or accept the default value. 

 

 

 

Scale 
 

Use to specify the scale factor for the detail view. Select from the list or 
manually enter a custom value. 

 

 
 

 
 
 
 

Style Determines a rendering style for the view. 
 

 Hidden Line 

 Hidden Line Removed 

 Shaded 

 

 

 

Toggle Label 
Visibility 

When selected, the view scale label is visible on the sheet. 

 

 

 

Edit View 
Label 

Use to access the Format Text dialog box. 

 

 
 

 
 
 

Fence Shape Determines a fence shape for the view. 
 

 Circular 

 Rectangular 

 

 
 

Cutout Shape Specify the cut line as Jagged or Smooth. 

 

 
 

 
 

 

Display 
Full Detail 
Boundary 

 

If Smooth cutout shape is selected, select this option to have a boundary 
drawn around the detail view. 

 

 
 

 
 

 

Display 
Connection 
Line 

 

If the Display Full Detail Boundary option is selected, select this option to 
have a line drawn between the detail view boundary in the parent view 
and the boundary around the detail view. 
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Exercise: Create and Edit 

Detail Views 
 

In this exercise, you create and edit detail views to 
magnify critical features of the factory layout. 

 
 

The completed exercise 
 

 
 
 
 
 
 
 
 
 

1. Open INV_017_Detail_View.dwg. 

2. Zoom in on the section view. 

 
 

3. To begin to create a detail view from the parent 
view. 

 Click Place Views tab > Create panel > Detail 
View. 

 Select the section view. 

4. In the Detail View dialog box, verify the 
following values: 

§ For Label, Enter B (1). 

§ For Scale, Enter 3/16”=1’ (2). 

§ For Style, Click Hidden Line Removed (3). 

§ For the Fence Shape select Circular (4). 

§ For the Cutout Shape select Smooth (5). 

§ Check the option to Display Full Detail 

Boundary (6) 

§ Check the option to Display Connection Line 

(7) 
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5.      For the center point of the fence, select a point 
near (1). For the endpoint of the fence, select a 
point near (2). 

 
 

6. When prompted to select a location for the 
view, select a point as shown in the following 
illustration. 

 

7. Activate the Detail View tool again. Create 
another detail view (shown in the 
following image) using the process 
demonstrated in the previous steps.   

 
 

8. Close all files.  Do not Save. 
 End of Exercise.
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Lesson: Crop Views 
 
 
 
 

As you create complex drawings, the need to crop view geometry to show only certain areas arises. 
To display only an area of a drawing view, you need to understand the process for using different 
boundary shapes to crop drawing views. 

 

The Crop tool provides a straightforward method to show only the area of information that you 
require. 

 
In the following illustration, the initial view before cropping is shown on the left. The middle image 
shows the view cropped using a circular default boundary, while the right image shows the view 
cropped using a closed loop sketch. 

 

  
 

 
 

Objectives 
 

After completing this lesson, you will be able to: 

 Describe the types of views that can be cropped and the supported display options. 

 Crop a drawing view using a circular or rectangular boundary shape. 

 Crop a drawing view using a sketched boundary shape. 
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Creating Quick Cropped Views 
 

To create a quick cropped view, you must first have a view on the drawing sheet that supports 
cropped views. After starting the Crop tool, you select the view to crop and choose a rectangular or 
circular boundary. You then define the location and size of the boundary. 

 
In the following illustration, the isometric section view is in the process of being cropped on the left. 
The results of cropping this view with a rectangular boundary is shown on the right. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Access 
 

     Crop 
 

 
 

Ribbon: Place Views tab > Modify panel 

 

Toolbar: Drawing Views Panel > Crop 

Shortcut Menu: Create View > Crop 
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Process: Cropping a View Using a Default Boundary Shape 
 

The following steps give an overview and example of cropping a drawing view using a default 
boundary shape of circular or rectangular. 

1. Start the Crop tool.  

2. Select the view to crop.  
 

3. If the default boundary type (circular or 
rectangular) is not what you want, 
select another crop boundary type. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Draw the cropping boundary at the location 
and size that you require. Use opposite 
corners for a rectangular boundary or the 
center and radius for a circular boundary. 
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Creating Cropped Views with Sketches 
 

To create a cropped view using a sketch, you must first have a view on the drawing sheet that supports 
cropped views. You then create a closed loop sketch associated to the drawing view to be cropped. 
After starting the Crop tool, you select the sketch and the view is cropped. 

 

In the following illustration, a sketch is created in an isometric view. That sketch is then selected using 
the Crop tool to create the resulting view on the right. 

 
 
 

Process: Cropping a View Using a Sketch 
 

The following steps give an overview and example of cropping a drawing view using a closed loop 
sketch. 

 

1. Click inside the drawing view that you want 
to crop. Click > Place Views tab > Sketch panel 
> Sketch to create a sketch associated to the 
drawing view. 
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2. In the sketch, create a single closed loop 
shape using line, arc, or spline segments. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click Place Views tab > Modify panel > Crop.    

4. Select the associated sketch. 
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Exercise: Create and Edit 

Cropped Views 
 

In this exercise, you create cropped views using 
default and sketch boundaries.  

 

The completed exercise 
 

 
 
 
 
 
 
 
 
 

 

1. Open INV_018_Cropped View.dwg 

2. To create a rectangular cropped view: 

 Click Place Views tab > Modify panel > Crop. 

 Click the Top view. 

 Click and drag a rectangle over the right 
section of the drawing, as shown. 

 
 

3. The view is cropped to show only the objects 
inside the defined boundary. 
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4. Activate the second sheet in the drawing. 

§ In the browser, double click the sheet 2 to 

activate it. 

 

5. To create a sketch based on the view: 

 Select the isometric view. 

 On the Place Views ribbon, click the Create 

Sketch tool 

 Using the line command, draw a 
the simple sketch shown in the 
following image. 

 Note:  Make sure the sketch 
creates a closed loop. 

 

 

 

 

 

 

 

 

 

 

 

 

 On the Sketch ribbon, click Finish. 

 
 

5. On the Place Views ribbon, click the Crop tool. 

§ Select the sketch drawn in the previous 

step. 

 
 

 6.  Close all files.  Do not save. 

  End of Exercise.
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Lesson: Dimensions, Annotations,  

and Parts Lists 
 
 

 
 

 

 

 

 

 

 

 
 
 

 

 

 

 

 

 

 

After creating drawing views, you can annotate those views with dimensions, centerlines, and 

symbols. Production-ready drawings also typically include parts lists and balloons. While traditional 

annotation methods can be quite tedious, you can quickly and easily include these elements in 

your drawings using the annotation tools available in Autodesk® Inventor®. 

Objectives 

After completing this lesson, you will be able to: 

§ Dimension drawings with manual techniques. 

§ Add centerlines, center marks and symbols to your drawings. 

§ Add a Parts List and Balloons to the drawing. 
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Adding Dimensions 
 

This lesson describes the manual application of dimensions. Dimensions define the size and location of 
the objects being designed. They are the most important annotation applied to a drawing. Therefore, 
the application of dimensions is critical to the success of the project. 

 

Dimensions manually applied to drawing views are associated with the object that defines them. 
Manually placed dimensions provide documentation of the model in the drawing environment. The 
application of manual dimensions uses general, baseline, and ordinate dimensions. 

 

In the following illustration, the dimensions have been added manually to define the size of the factory 

facility. 

  
 
 
 

Creating General Dimensions 
 

The General Dimension tool can place many different types of dimensions, depending on the 
geometry selected. Selecting two parallel lines results in horizontal, vertical, or aligned dimensions; 
selecting two nonparallel lines results in angle dimensions; and selecting an arc or circle results in 
radial or diameter dimensions. To obtain a horizontal or vertical dimension between two nonparallel 
lines, you select one line and the endpoint of the other line, or select two endpoints. 

 

In the following illustration, general dimensions are placed on the drawing to define the location of a 

factory asset. 
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Access 
 

     General Dimension 
 

 
 

Ribbon: Annotate tab > Dimension panel 

 

Toolbar: Drawing Annotation Panel 

Keyboard: D 

 

Term 

 

Definition 

Horizontal Creates a horizontal dimension based on the points or segments selected. 

Vertical Creates a vertical dimension based on the points or segments selected. 

Aligned Creates a linear dimension perpendicular to the points or segments selected. 

 
 

Procedure: Placing General Dimensions 
 

The following steps describe how to place general dimensions on a drawing. 

1. Start the General Dimension tool. 

2. Select two points or line segments in the drawing view. 

 

3.     Place the dimension. 
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Adding Centerlines 
 

This lesson describes how to add centerlines and leaders to your drawings. These tools help define 
asset locations on production-ready factory drawings. 

 

The use of centerlines and center marks is critical in the interpretation of symmetrical and cylindrical 
features in drawings. Symbols aid in defining the manufacturing processes used in creating parts and 
assemblies. Leaders provide information about the text, symbol, or dimension attached to specific areas 
on a feature or object. 

 

In the following illustration, centerlines define the location of factory assets. 

  
 
 
 

Procedure: Adding Centerlines Manually 
 

The following steps describe how to manually add centerlines to drawings. 

1. Start the Centerline tool.  In the graphics window, click to place the start point of the centerline. 

 

2. Click to place the end point of the centerline. 

 

3. Right-click on the centerline and click Create. 

 

4. Right-click in the graphics window. Click Done. 
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Adding Parts List and Balloons 
 

This lesson describes how to create and customize parts lists to document the assets in your 

Factory assembly.   The parts list is generated from the assembly bill of materials (BOM) and shows all or 

only certain parts and subassemblies in the BOM database. 

 

Parts lists play a vital role in the factory documentation process by displaying the assets that 

make up the lines, and their quantities, parameters, and any other properties that you wish to convey. 

 

 In the following illustration, a factory drawing is shown with the associated parts list. 

 
About Parts Lists 

 
The parts list is generated from the bill of materials database and can be customized to show the 
columns and information needed to complete the assembly. Formatting such as table layout, column 
width, and heading names can be customized to give the parts list the exact look that you want. 

Parts lists can display four types of information: 

 Structured 

 Parts only 

 
The following illustration provides a comparison between the parts list and bill of materials database 
for an assembly. 
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Creating Parts Lists 
 

You create parts lists by clicking the Annotate tab > Table panel > Parts List. The Parts List dialog box is 
displayed to reveal the following controls for creating your parts list. 

 
 

  

Option 

 

Description 

 

 

 

Source 
 

This area specifies where to pull the parts list data from, an existing view or 
a file (IPT, IPN, IAM). 

 

 
 

 
 
 
 

 

BOM Settings 
and Properties 

 

The options in this area dictate how to represent subassemblies and their 
parts. When the selected view is Structured, the subassemblies show 
as line items. When the selected view is Parts Only, the parts within the 
subassemblies show as line items with their Item value containing the 
delimiter character specified. 

 

 
 

 
 

Table Wrapping 
 

In Table Wrapping, set the wrap direction. If you select Enable Automatic 
Wrap, you can set the maximum number of parts list rows, or number of 
parts list sections. 

 
 

Access 
 

     Parts List 
 

 
 

Ribbon: Annotate tab > Table panel 

 

Toolbar: Drawing Annotation Panel 

 

Procedure: Creating a Parts List 
 

The following steps describe how to create a parts list in a drawing file. 

1. In a drawing file, click Annotate tab > Table panel > Parts List. 

2. Select a drawing view and make the appropriate settings in the Parts List dialog box. 

3. Position the parts list on the sheet. The parts list is displayed. 
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  3. Add Centerlines to the Conveyor Lines. 

§ On the Annotation ribbon, click the 

Centerline tool 

 
§ Click the two midpoints shown in the 

following image. 

 
§ Right Click and select Create from the 

menu. 

§ Repeat the process adding centerlines to 

all straight conveyors in the line. 

 

 

4. Change the color of the Centerline layer. 

§ On the Annotate ribbon, click Edit 

Layers. 

 
§ In the Style and Standards Editor dialog, 

click the color swatch for Centerline 

(ANSI) and set the color to blue. 

§ Click OK 

 

§ Click Done 

§ Click Yes 

 

 

Exercise: Adding 

Annotations 
 
In this exercise, you add centerlines, 
dimensions, leaders and a parts list to a 
factory drawing. 

 

The Completed Exercise 

 

1. Open INV_019_Annotations.dwg. 

 

2. Zoom into the Plane view as shown in the 

following image. 
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  7. Add a Parts List to the Drawing. 

§ On the Annotate ribbon, click the 

Parts List command. 

 
§ Select the Plan View. 

 

§ Click OK and place the parts list as 

shown below. 

 

Note: If you Right Click on the Pars 

list, you can choose the Edit Parts 

List…  The Edit Parts List Dialog offers 

many options for modifying the parts 

list.  This functionality is not covered 

in this course. 

 

8. Change the Color of the Symbol Layer. 

§ Click Edit Layers. 

§ Set the color of the Symbol (ANSI) 

layer to blue. 

 

§ Click OK 

§ Click Done 

§ Click Yes 

 

 

 

5. Add Dimensions documenting the 

length and width of the Robot Line. 

§ On the Annotate ribbon, click the 

Dimension tool. 

 
§ In the Style window, at the right end 

of the ribbon, select Architecture 

(ANSI). 

 
§ Add Dimensions documenting the 

length and width of the Robot Line.   

Note: You can select centerlines while 

adding dimensions 

Note:  The Dimension command, for 

drawings, works the same way it does 

in model sketches. 

 

 

6.  Change the Color of the Dimension 

Layer. 

§ Click Edit Layers. 

§ Click the color swatch for Dimension 

(ANSI) and set the color to dark green. 

 

§ Click OK 

§ Click Done 

§ Click Yes 
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10. Add Additional Balloons to the Drawing 

View. 

§ Using the previous process, add the 

additional balloons as shown in the 

following image. 

 

§ Close the drawing without saving 

§ End of Exercise. 

 

 

 

 

 

 

 

 

9. Add a Balloon to the Drawing View. 

§ Click the Balloon tool. 

 
§ Click the curved conveyor as shown in 

the following image.  This places the 

arrow head of the Balloon. 

 

§ Move the cursor away and click to 

place the balloon as shown. 

 

§ Press ENTER to finish the Balloon 

Command. 
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Lesson: 2D Drawings and AutoCAD 

Interoperability 
 

The common practice for factory designers currently centers on the use of AutoCAD.  Currently most 
factory layout drawings are created as simple 2D drawings using the AutoCAD application.  Many 
factory designers will incorporate the Factory Design Suite into current design practices and still 
maintain an AutoCAD centric approach to factory layout.   
 
This lesson will outline the process of creating a factory layout in AutoCAD, bringing it into Inventor 
(Autodesk Factory Design Suite), building the 3D layout, creating the Inventor drawings, and 
referencing them back into the original AutoCAD design.  This process creates a “round trip” 
maintaining reference links so drawings can update if changes occur. 
 
The following flow chart depicts the “Round Trip” process, starting in AutoCAD, moving to Inventor 
Factory Design, and linking back to the original AutoCAD drawing. 
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Round Tripping Settings 
In order to have a seamless roundtrip without user interaction, we need to set up Inventor in a 
certain way. Open the Applications Options, on the Manage ribbon, and adjust the options as shown 
for: 

§ View justification  = Fixed 
§ View Block insert point = Model Origin 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



55 Lesson: Managing Views  

Process for Round Tripping 
The process starts in 
AutoCAD with the original 
2D layout of the facility. 

 

This drawing is used as the 
DWG Overlay in the 
Inventor Factory Layout. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The 3D Factory Layout is 
Created, based on the DWG 
Overlay. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

An Inventor Drawing is 
created from the 3D Factory 
Layout. 
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The Inventor Drawing is 
opened in AutoCAD and the 
Block created for the 
drawing view is placed in 
Model space at 0,0. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
` 
 

The Inventor Drawing is 
then inserted into the 
Original AutoCAD drawing 
as an External Reference, 
completing the Round Trip. 
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Chapter Summary 
 
 
 
 

In this chapter, you learned how to quickly and easily create drawing views of your 3D factory designs. 
Learning how to create and edit drawing views is the first step in creating production-ready drawings. 
In the next chapter, you learn how to annotate your drawing views with dimensions, , centerlines and 
symbols, and even add bill of material tables to your drawings. 

Having completed this chapter, you can: 

 Navigate the Autodesk Inventor user interface when creating and editing drawing sheets. 

 Create base and projected views of 3D parts and assemblies. 

 Create and edit section views. 

 Create and edit detail views. 

 Create and edit cropped views. 

 Add Annotations to Drawings. 

 Review the AutoCAD Interoperability with Inventor DWGs. 
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  13 
 

 
 
 

Navisworks – Getting Started 
 

 

Validating your Factory Layout requires the comparison and analysis of multiple designs from various 
stakeholders.  Your Factory Layout must interface with the Architectural Facility and the Manufacturing 
designs supplied by the System Integrators or Factory Owners.  Putting all this information into a single 
environment is often beyond the capabilities of most software programs. 

 
Navisworks enables Factory Layout Designers to visualize large complex Layouts with thousands of 
components such as complete manufacturing facilities, factory floor layouts, production lines & industrial 
machinery, all in a single digital model by means of real time flythrough and walk through. Customers can 
combine together CAD data from various design systems regardless of file format or size, for complete 
Factory visualization and analysis. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Objectives 
 

After completing this chapter you will: 

 Focus on the Navisworks product overview. 

 Review the Navisworks user Interface and Workflow. 

 Aggregate an entire Factory design from various CAD files. 

 Review the file types used by Navisworks. 

 Publish an NWD file. 
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Product Overview 
 

Navisworks revolutionizes design review. Navisworks provides interactive visualization and real-time 
walkthrough of even the largest and most complex 3D models.  Navigating and exploring the design to 
improve quality and compress the review process is effortless with Navisworks. The post-production 
value of 3D models is significantly increased by the wide-ranging access that Navisworks offers for 
investigating and examining a design. 
Publisher 
The Navisworks Publisher tool provides a way of communicating design intent.  
Publisher creates NWD files in which everyone can view and walk through the 3D models in real time, 
without specialist skills and free from the limitation of pre-programmed animation.  
Compressed and secure for distribution, Navisworks review files are faithful to the original native 3D data 
from which they are created. 
 

TimeLiner 
Embracing a fourth dimension of time, the Navisworks TimeLiner tool available in the Autodesk® 
Navisworks® Simulate and Manage products is aimed at satisfying the growing interest in affordable 4D 
construction simulation for building and site planning, as well as presentation of time-based modeling. 
TimeLiner makes it easy to produce time simulations and “what-if” scenarios. While these can be set up 
solely in Navisworks, you can also link to some major project software, such as Microsoft Project, 
Primavera (Sure Track/Power Project), Excel (CSV files), and Asta Power Project. TimeLiner also supports 
any project scheduling software that can export the common MPX format. 
 

Animator and Scripter 
With the Navisworks Animator and Scripter tools available in the Autodesk Navisworks Simulate and 
Manage products, you can animate your model and interact with it. For example, you could animate how 
a crane moves around a site, or how a car is assembled or dismantled. You can also create interactive 
scripts, which link your animations to specific events, such as On Key Press or On Collision. For example, 
the doors will open as you approach them in your model.  
You can also link Clash Detective, TimeLiner, and Object Animation together to enable clash testing of 
fully animated TimeLiner schedules. So, instead of visually inspecting a TimeLiner sequence to make sure, 
for example, that the moving crane did not collide with a work group, you can run a Clash Detective test.  
 

Presenter 
The Navisworks Presenter tool available in the Autodesk Navisworks Simulate and Manage products, is an 
original visualization solution dedicated to enhancing the real-time experience and the creation of 
compelling rendered output to communicate design intent.  
With Presenter, you can apply textures, materials, and lights quickly to 3D models, and is ideal for fast-
moving collaborative review at every stage of the creative process.  
With Presenter, everyone can enhance the realism of the interactive environment, and create both still 
and animated photorealistic rendered output to share a vision of a project and improve understanding 
and design quality. 
 

Clash Detective 
The Navisworks Clash Detective tool available in the Autodesk Navisworks Manage product enables the 
effective identification, inspection, comment tracking, and reporting of interference in a 3D project 
model. Clash Detective can eliminate a tedious manual task, with the accompanying risk of human error, 
to significantly reduce the expensive consequences of incomplete, inaccurate, and poorly coordinated 
production information. 
 Project Coordination is simplified with the use of Clash Detective by easily coordinating with the 
responsible parties to track the clash through the project lifecycle. 
For those who seek to complete design projects on time and within budget, the business case for Clash 
Detective is clear and unequivocal. 
 

Freedom Viewer 
Freedom is a separate Navisworks software that provides users with a free 3D viewer to look at 
Navisworks NWD files. It is the answer for those without design software or specialist skills who want to 
explore a 3D project model. 
 Easily open, view, and walk through NWD files, even those streamed across the Internet. 
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Lesson: User Interface 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This lesson describes the Navisworks workspace layout. It also introduces you to basic workflow of 

aggregating 3D data from various sources into a single digital environment. 

Objectives 

After completing this lesson, you will be able to: 

§ Review the Navisworks User Interface 
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Workspace 
 

The Navisworks interface is intuitive and easy to learn and use. It contains a number of traditional 

Windows ribbon elements, such as the Application Menu, ribbon, Quick Access toolbars, and so on. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Application Menu The Application Menu provides access to commonly accessed 
tools. 

2. Ribbon The ribbon is a palette at the top of the application window 
that displays task-based tools and controls. 

3. Quick Access Toolbar The Quick Access toolbar displays frequently used commands. 

4. Scene View The Scene View window is used to interact with 3D models. 

5. View Cube ViewCube is used to reorient the current view of a model. 

6. Navigation Bar The Navigation bar is a user interface element where you can 
access both unified and product-specific navigation tools. 

7. Dockable Windows - Open Dockable Window allow access to model and system 
information.  Window can be pinned open as shown here. 

8. Dockable Windows - Closed Dockable Windows automatically collapse to maximize the 
scene window size. 

9. Status Bar The Status bar displays command instructions, model status, 
and system performance. 

10. InfoCenter  The InfoCenter is located in the top right-hand corner of 
Navisworks and provides a number of useful tools for getting 
to know and searching for help in Navisworks. 
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Application Menu (1) 

The Application Menu provides access to commonly accessed tools. To access its commands, click  

in the top left-hand corner of Navisworks. The commands available in this menu include: file actions 

(Open, Save, and Save As), Import and Export commands, the Publish command, and the option to the 

print or distribute it to other users by email. Within this menu, the  button provides access to the 

Options Editor dialog box to customize your global settings. 

 

Ribbon (2) 

The ribbon is a palette at the top of the application window that displays task-based tools and controls. 

The ribbon is divided into tabs, with each tab supporting a specific activity. Within each tab, tools are 

grouped together into a task-based series of panels. 

 

To activate a command on the ribbon, simply navigate to the tab and panel and select the command. 

Every command on a toolbar includes a tooltip, which describes the function the button activates. Placing 

the mouse over a button displays a brief instruction on how to use this feature in the Status bar. When 

some commands are activated, context-sensitive tabs may be added to the ribbon. When active, the 

context-sensitive tab is highlighted in green to show tools that will only be applied to the selected items. 

Once the objects are deselected, the context-sensitive tab is removed. 

 

You can customize the ribbon depending on your needs in the following ways: 

§ To specify which ribbon tabs and panels are displayed, right-click the ribbon and on the shortcut 

menu, click or clear the names of the tabs or panels. 

§ You can change the order of ribbon tabs. Click the tab you want to move, drag it to the desired 

position, and release. 

§ You can change the order of ribbon panels in a tab. Click the panel you want to move, drag it to 

the desired position, and release. 

§ You can control the amount of space the ribbon takes in the application window. There are two 

buttons to the right of the ribbon tabs, that allow you to choose the ribbon toggle and ribbon 

minimize states. 

 

Select  to cycle between the minimized ribbon states. Once fully compressed, select  to resume 

the full ribbon display state. The minimize ribbon states enable you to minimize to tabs only, minimize to 

Panel titles only, and minimize to Panel buttons only. The  pull-down enables you to control which of 

the states can be accessed as you are cycling. 
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Quick Access Toolbar (3) 

At the top of the application window, the Quick Access toolbar displays frequently used commands. 

   

§ A default set of commands have been included on the ribbon, to enable/disable these defaults 

select  at the end of the Quick Access toolbar, and select the commands that are to be 

included. 

§ You can add an unlimited number of buttons to the Quick Access toolbar by selecting the 

command on its tab, right-clicking, and selecting Add to Quick Access Toolbar. New buttons are 

added to the right of the default commands.  

§ You can add separators between the buttons to subdivide the commands. To add a separator, 

right-click on the Quick Access toolbar in the location where the separator is required, and select 

Add Separator. Separators can be removed by right-clicking on the separator and selecting 

Remove from Quick Access Toolbar. 

§ You can position the Quick Access toolbar either above or below the ribbon. To move its position, 

select  at the end of the Quick Access toolbar and select either Show Below the Ribbon or 

Show Above the Ribbon. 

 

Only ribbon commands can be added to the Quick Access toolbar. Commands 

that extend past the maximum length of the toolbar are displayed as flyouts. 

 

Scene View (4)  

The Scene View window is used to interact with 3D models. You can control how much space the Scene 

View window uses compared to the dockable windows by dragging the edges of the windows as required. 

Alternatively, you could auto hide  the dockable windows, or switch on full screen mode (F11).  
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§ To split your current view horizontally, expand the Split View command in the Scene View panel 

on the View tab and click Split Horizontal. 

§ To split your current view vertically, expand the Split View command in the Scene View panel on 

the View tab and click Split Vertical. 

§ Resize a view by dragging the view borders or select Window Size  in the View tab and enter 

the required values. 

§ Views can be subdivided so that there are horizontal and vertical Scene View windows. This is 

done by selecting within a Scene View window to activate it and then splitting it again. 

§ Any of the sub-divided Scene Views have title bar headings. To float a Scene View, select its title 

bar heading and drag it away from its current location. To redock a floating Scene View, double-

click on the title bar heading. 

§ Split Scene View windows can be set to Auto Hide by selecting the Auto Hide  icon on the 

Scene View’s title bar heading. Once auto hidden, it is listed above the Status bar. 

 

ViewCube (5) 

ViewCube is used to reorient the current view of a model. You can reorient the view of a model with the 

ViewCube tool by clicking pre-defined areas on the ViewCube to assign preset views, click and drag on the 

ViewCube to freely change the view angle of the model, and define and restore the Home view. 

 

§ The ViewCube tool provides twenty-six defined parts to click and change the current view of a 

model. The twenty-six defined parts are categorized into three groups: corner, edge, and face. Of 

the twenty-six defined parts, six of the parts represent standard orthogonal views of a model: 

top, bottom, front, back, left, and right. Orthogonal views are set by clicking one of the faces on 

the ViewCube tool. You use the other twenty defined parts to access angled views of a model. 

Clicking one of the corners on the ViewCube tool reorients the current view of the model to a 

three-quarter view, based on a viewpoint defined by three sides of the model. Clicking one of the 

edges reorients the view of the model to a half view based on two sides of the model. 

 

When the cursor is over one of the clickable areas of the ViewCube tool, the clickable face, 

corner, or edge highlights and the cursor changes to an arrow with a small cube to indicate that it 

is over the ViewCube tool. A tooltip is also displayed. The tooltip describes the action that you can 

perform based on the location of the cursor over the ViewCube tool. 

 

§ You can also click and drag the ViewCube tool to reorient the view of a model to a custom view 

other than one of the twenty-six predefined parts. As you drag, the cursor changes to indicate 

that you are reorienting the current view of the model. If you drag the ViewCube tool close to one 

of the preset orientations, and it is set to snap to the closest view, the ViewCube tool rotates to 

the closest preset orientation. 
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The outline of the ViewCube tool helps you to identify the form of orientation it is in: 

standard or fixed. When the ViewCube tool is in standard orientation (i.e., not 

orientated to one of the twenty-six predefined parts) its outline is displayed as dashed. 

The ViewCube tool is outlined in a solid continuous line when it is constrained to one of 

the predefined views. 

 

§ When you view a model from one of the face views, two roll arrow  buttons are displayed 

near the ViewCube tool. Use the roll arrows to rotate the current view 90 degrees clockwise or 

counterclockwise around the center of the view. 

§ When the ViewCube tool is active while viewing a model from one of the face views, four 

orthogonal triangles  are displayed near the ViewCube tool. You use these triangles to switch 

to one of the adjacent face views. 

§ Selecting  in the top right-hand corner of the ViewCube reorients the Scene View to its default 

orientation and zoom level. 

 

Additional ViewCube options can be accessed by selecting  in the bottom left-hand corner of the 

ViewCube. These options enable you to define the view setting, define the Home and Front orientations, 

and access its settings in the Options Editor. 

The display of the ViewCube can be set in the Navigation Aids panel on the View tab by enabling/disabling 

the View Cube  command in the Navigation Aids panel.  

 

Navigation Bar (6) 

The Navigation bar is a user interface element where you can access both unified and product-specific 

navigation tools. Unified navigation tools (such as Autodesk® ViewCube® and SteeringWheels®) are those 

that can be found across many Autodesk products. Product-specific navigation tools are unique to a 

product. The navigation bar floats over and along one of the sides of the Scene View. 

You start navigation tools by clicking one of the buttons on the navigation bar. Many of the tools have 

varying commands that are compressed. To expand a command, press and hold its  icon and select 

an alternate command. 

The top-level Navigation bar commands are as follows. The full suite of commands that are available on 

the Navigation Bar are discussed in Chapter 2. 

 

Full Navigation Wheel  
Collection of wheels that offer rapid switching between 

specialized navigation tools. 

Pan  
Activates the pan tool and moves the view parallel to the 

screen. 

Zoom Tools  
Set of navigation tools for increasing or decreasing the 

magnification of the current view of the model. 

Orbit Tools  
Set of navigation tools for rotating the model around a 

pivot point while the view remains fixed. 

Look Tools  
Set of navigation tools for rotating the current view 

vertically and horizontally. 
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Walk  / Fly  
Set of navigation tools for moving around the model and 

controlling realism settings. 

 

The Navigation bar can be customized by selecting  at the bottom of the bar. You can enable/disable 

which commands are displayed, define where the Navigation bar is located in the Scene View window, 

and access its settings in the Options Editor. 

The display of the Navigation bar can be set in the View tab by enabling/disabling the Navigation Bar  

command in the Navigation Aids panel.  

Dockable Windows (7) 

Most features are accessible from the dockable windows. To display a dockable window, expand the 

Windows command in the View tab and choose from the list of available dockable windows. Alternatively, 

some of the windows can be enabled/disabled directly on tabs. For example, the Selection Tree and 

Properties windows are available on the Home tab.  

 
                                                                          

 

 

 

 

 

 

All windows are dockable and resizable, and will automatically lock to specific locations near to where 

they are moved.  

 

Holding down the CTRL key when moving a window prevents it from auto docking. 

Using the Docking Tool  

When you drag a window from its current location towards a new destination on the interface, a docking 

tool is displayed. The docking icons point towards the four edges of the interface. The options that are 

available are dependent on the permittable locations for docking. 
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NOTE: These inner docking locations do not allow for pinning/unpinning workspaces. Only the outside 

docking locations allow pinning. 

When the window you are dragging is close to the place where you want it to dock, move the mouse over 

the corresponding area of the docking tool. You will see an outline of the window appear on the interface. 

To dock the window, release the mouse button.  

Tiling Windows  

You can tile windows on the interface. To do this, drag the window you want to tile over the window 

where you want it to be placed. When a rectangular outline appears, release the mouse button.  

Auto Hiding Windows  

You can auto hide windows; this keeps them active while maximizing the amount of available screen 

space. If auto-hide is active, the body of the window disappears when you move the cursor out of it, 

leaving only the title bar visible. Move the cursor over the title bar to display the entire window again.  

 To turn auto-hide on, click         on the title bar. To turn auto-hide off, click         on the title bar. 

Status Bar (8)  

The Status bar is displayed at the bottom of the Navisworks screen.  

The left-hand corner of the Status bar displays short instructions for using the Navisworks features.  

The right-hand corner of the Status bar contains four performance indicators that provide constant 

feedback as to how Navisworks is performing on your computer.  

Performance Indicators 

The four performance indicators are Scene Drawing, Disk to Memory, Web Server Download, and 

Memory Usage.  
 

Scene Drawing Indicator Bar 

The Pencil                       progress bar indicates how much of the current view is drawn (for example, how 

much drop-out there is in the current viewpoint). When the progress bar is at 100%, the view is 

completely drawn, with no drop-out.  

While the view is being drawn, the pencil icon will change to yellow. If there is too much data to handle 

and the computer cannot process this quickly enough for Navisworks, then the pencil icon will change to 

red, indicating a bottleneck. 

Disk to Memory Indicator Bar 

The Disk                  progress bar indicates how much of the current model is loaded from disk (for example, 

how much is loaded into memory). When the progress bar is at 100%, the entire model, including 

geometry and property information, is loaded into memory.  

While data is being read, the disk icon will change to yellow. If there is too much data to handle and the 

computer cannot process this quickly enough for Navisworks, then the disk icon will change to red, 

indicating a bottleneck. 

  



11 Chapter13: Navisworks – Getting Started  

Web Server Download Indicator Bar 

The Web Server  progress bar indicates how much of the current model is downloaded when 

opening a file via a URL (for example, how much has been downloaded from a Web server). When the 

progress bar is at 100%, the entire model has been downloaded.  

While data is being downloaded, the Web Server icon will change to yellow. If there is too much data to 

handle and your computer cannot process this quickly enough for Navisworks, then the Web Server icon 

will change to red, indicating a bottleneck. 

Memory Usage Indicator 

The field to the right of the icons                 displays the amount of memory currently being used by 

Navisworks. 

InfoCenter (9) 

The InfoCenter is located in the top right-hand corner of Navisworks and provides a number of useful 

tools for getting to know and searching for help in Navisworks.  

 

  

The InfoCenter can be used to search for keywords by typing directly in the entry field. The additional 

tools enable you to access subscription services, product updates and announcements, and to access the 

Navisworks Help tool. The Favorites command also provides a convenient way of saving searched topics 

for future review. 
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Lesson: Workflow 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

  
 
 

 

 

 

 

 

 

 

Navisworks enables Factory Layout Designers to visualize large complex Layouts with thousands of 

components such as complete manufacturing facilities, factory floor layouts, production lines & industrial 

machinery, all in a single digital model by means of real time flythrough and walk through. Customers can 

combine together CAD data from various design systems regardless of file format or size, for complete 

Factory visualization and analysis. 

 

Navisworks is compatible with all major native design and laser scan file formats.  This means that 3D design 

data from various CAD systems can be combined together to create a single digital model.   

Objectives 

After completing this lesson, you will be able to: 

§ Understand the Navisworks Multi-CAD Data Aggregation Workflow. 

§ Assemble a Navisworks environment by aggregating 3D designs from various sources.  
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About File Types 
 

When you open a model file or files in Navisworks, you can save the file as either an NWF file or an  

NWD file.  

 

NWC File 
By default, when Autodesk Navisworks opens a native CAD file (for example, AutoCAD or MicroStation), 

it first checks in the same directory whether there is a cache file present with the same name as the 

CAD file but with an .NWC extension. If there is, and this cache file is newer than the native CAD file, 

then Autodesk Navisworks opens this file instead as it has already been converted to Autodesk 

Navisworks format and, therefore, opens much quicker. 

NWF File 
An NWF file contains the review markups, but no geometry. Instead, it includes links (acts as a pointer) 

to the original native CAD drawing files (as listed in the Selection Tree). This means an NWF is 

considerably smaller in file size than an NWD. 

 

 

Generally, you should use NWF files whenever multiple files are brought together to create the scene, 

such as xrefs in AutoCAD®. This way, whenever one file changes, the whole model does not have to be 

re-published, only the file that has changed needs to be re-read. 

NWF files can also be used as the design review “buffer” for NWD files. Comments, views, redlining, 

animations, material overrides, and clash tests can all be saved and added to an NWF file. The NWD 

files may need to be re-published due to changes throughout the design process. 

 

NWD File 
An NWD file is a fully published Navisworks file containing all geometry and review markups. An NWD 

file can be thought of as a “snapshot” of the current state of the model and can be viewed in both 

Navisworks and Freedom (the Navisworks free viewer). An NWD file is created with the Publish 

command, which is accessed by clicking Application Menu  > Publish, or by selecting the Output 

tab and clicking NWD  on the Publish panel. The file can also include features such as password 

access and file expiration dates.  
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Procedure: To Save as an NWF or NWD File 
 

An NWD file can be saved using the normal Save As procedure. However, there are 

additional features available if you use the Publish command. For more information, see 

Publish.  
 

1.   
Click Application Menu  > Save As. 

2. In the Save As dialog box, in the Save as type drop-down list, select NWD or NWF.  

3. Browse to the required directory then add an appropriate file name and click Save. 

Tip: If a file will need to be read using an earlier version (2009 or 2010) of 

Navisworks, it should be saved as that version type. 

 

 

Merging NWF Files 
An NWD file may be sent by a project coordinator to multiple parties for review. Each party will add 

review markups and data to the model, which may include any combination of viewpoints, comments, 

redlines, Clash Detective results, TimeLiner schedules, Presenter materials, and so on. 

Each party can save their review session as an NWF file that references the original NWD file. The 

project coordinator can then merge all of the NWF files into a single file, duplicating neither the NWD 

file (referenced by all NWFs) nor any other review markup that is common to all NWFs. 

 

Typical Navisworks Data Workflow 
The following illustration maps the typical Navisworks Data Workflow.   

§ Original data is created in various CAD applications. 

§ Navisworks is used to open the designs creating a NWC cache file.  The cache files are 

automatically created and stored alongside the original work.  As long as the NWC file is newer 

than the original data, it is used for upstream design.  If the original data is modified, a new 

NWC file will be created during the next reference operation. 

§ Once the original data is translated into Navisworks, it can be saved as an NWF file.  The NWF 

file simply references the original data (NWC).  The NWF file only contains unique information 

like user viewpoints, redline markups, animations, and simulations. 

§ If necessary, a standalone NWD file can be created embedding all necessary geometry, 

viewpoint, and markup information into a single highly compressed file. 

 
  



15 Chapter13: Navisworks – Getting Started 

 
 

  2. View the entire model using Zoom All, 

and the View Cube. 

§ On the View Cube, click the Upper Left 

corner on the Front face. 

 
§ On the Navigation Bar, expand the 

zoom tool and select Zoom All. 

 
§ The Scene should appear as shown in 

the following image. 

 

 

3. Append another file to the Navisworks 

environment. 

§ On the Home ribbon, click the Append 

tool. 

 
§ Select NAV_001_Conveyor_1.iam and 

click Open. 

§ Once the new model is displayed, Click 

the Zoom All tool again. 

§ Click in the background to deselect. 

 

Exercise: Data Aggregation 
 
In this exercise, you create a Navisworks 
model by combining original data from 
various CAD files or sources.    

 

 

The Completed Exercise 

 

1. Open a file with Navisworks. 

§ On the Navisworks application menu, 

click Open. 

 
§ Select NAV_001_Factory_Lines.iam and 

click open. 

§ When the model appears, Left-Click in the 

background to deselect. 
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  6. Open the previous file. 

§ On the application menu, click the 

Open tool. 

 
§ Note the existence of .nwc files just 

below each of the original cad files 

used in the previous step.  These files 

contain the translation information 

created during the initial import. 

 
§ Select NAV_001_Factory.nwf and 

click open. 

§ Notice how fast the file opens.  At this 

point, the NWC cache files 

(automatically generated in the 

previous steps) are newer than the 

original CAD files.  If the NWC files are 

newer than the supporting CAD files 

they are used during file open to 

speed up performance. 

§ If necessary, click in the background 

to deselect. 

 

§ Click File New and do not save. 

§ End of Exercise. 

4. Repeat the previous step appending the 

following files. 

Note:  Multiple files may be appended 

at the same time. 

§ NAV_001_Robot_Line.iam 

§ NAV_001_Packaging_Line.iam 

§ NAV_001_Machining_Line.iam 

§ NAV_001_Inspection_Line.iam 

§ NAV_001_Factory_Out_Building.iam 

§ NAV_001_Factory_Building.iam 

§ NAV_001_Robot_Line.iam 

§ NAV_001_Civil_Design 

§ Click in the background to deselect. 

§ Click Zoom All 

§ The Scene should appear as shown in 

the following image. 

 

 

5. Save the entire design as an NWF file. 

§ On the Application menu, click the 

Save tool. 

 
§ In the Save As dialog, save the file as 

NAV_001_Factory.nwf. 

Note: NWF is the default file format 

for work in progress designs. 

§ Start a New Navisworks file by clicking 

the New tool on the application 

menu. 
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Lesson: Publishing an NWD File 
 

With Navisworks Publisher, you can take a “snapshot” of the model at any time. This can then be issued to 

other members of the design team, who may not be CAD users, but who need to view the 3D model. NWD 

files can be viewed in Navisworks for full design review, or with the Navisworks Freedom free viewer for a 

simple real-time walkthrough.  There is also the option for entering publication information that is saved 

with the file. This includes password protection and file expiration options. 

Procedure: To Publish an NWD File 
 

1. In Navisworks, open the file that is to be published. 

2. 

Click Application Menu  > Publish or select the Output tab and click NWD  on the 

Publish panel. 

3. In the Publish dialog box (shown below), enter information in the Title, Subject, Author, 

Publisher, Published For, Copyright, Keywords, and Comments fields, as needed. The additional 

commands described below can also be set, as needed. 

4. Click OK.  

5. In the Save As window, browse to the required location, and enter a file name. (The name must 

be different if saved in the same folder as the original.) Click Save. The published file can be 

viewed in Navisworks or Freedom. 
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Publish Dialog Box Options 

Option Description 

Password Sets up a password if the file is to be protected and only accessed by certain 

personnel. (The password will need to be passed to those people.) 

 By default, this dialog box, including the entered information, will not be 

displayed until after the password has been entered and accepted. (See also 

Display on open option.) 

Display at 

password 
Specifies that the Publish dialog box, including the entered information, is to be 

displayed with the Password field. 

Expires Specifies an expiration date for the file. This can prevent the old files being used. 

After the expiration date is passed, the file cannot be opened. 

May be re-

saved 
Allows further changes to be made to a file. By default, a published file cannot be 

re-saved. This prevents changes being added to this publication. 

Display on 

open 
Specifies that the Publish dialog box is displayed when the file is opened. By 

default, the Publish dialog box, with entered information, is not displayed unless 

the Display at Password box or the Display on open box is checked. 

Embed 

Textures 
Enables textures to be embedded in the one project file. If textures have been 

added to the model, these can be embedded in the file or it will be saved as a 

separate file (in the same folder). The benefits of using the Embed Textures option 

is that there is only one published project file and the textures, including any 

custom or imported textures, will benefit from the security features of Publisher.  

Embed 

Database 

Properties 

Enables all the linked database properties to be embedded in the project file. This 

feature enables any object properties accessed via an external database to be 

embedded in the NWD as normal properties. 

 This adds value to database linkage as well as NWD publishing, giving a quick and 

easy way of getting a large amount of database data into the model, which is then 

viewable by all. 

Prevent Object 

Property 

Export 

Prevents inclusion of the object properties from any native CAD package in the 

published file. This is intended primarily for protection of intellectual property. 
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  3. In the Publish Dialog, do the following... 

§ For Title, enter Factory Site. 

§ For Subject, enter Sample Factory. 

§ For Author, enter your name. 

§ For Publisher, enter your company. 

§ For Published For, enter your customer 

name. 

§ Review all other fields, but leave them 

blank. 

§ Click OK. 

 

 

4. In the Save As dialog, save the NWD file in 

the Training Files directory as 

NAV_002_Factory.nwd. 

§ Optional: check the file size of the NWD 

file created in this exercise. 

§ Start a New file without saving. 

§ End of Exercise.  

 

 

 

 

 

Exercise: Publishing an 

NWD File. 
 
In this exercise, you publish a stand-alone 
NWD file containing all referenced 
geometry.  The NWD file may be e-
mailed to other members of your 
collaborative design team. 
Note:  The NWD file does not maintain a 
relationship to the original CAD files and 
must be treated as a “Snap Shot” of the 
design at a specific time. 

 

 

 

 

The Completed Exercise 

 

1. First Objective 

§ Open NAV_002_Factory.nwf. 

 

2. Start the Publish Command. 

§ On the application menu, click the Publish 

Command. 
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Chapter Summary 
 
 
 
 

This chapter presented the Navisworks user interface and demonstrated basic workflows for loading 
CAD models from various sources into the Navisworks environment.   The supporting file types 
used by Navisworks were also discussed.    

Having completed this chapter, you can: 

 Focus on the Navisworks product overview. 

 Review the Navisworks user Interface and Workflow. 

 Aggregate an entire Factory design from various CAD files. 

 Review the file types used by Navisworks. 

 Publish an NWD file. 
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14 
 

 
 

Visualization / Digital Mockup 
 

 
 

Navisworks enables Factory Layout Designers to visualize large complex Layouts with thousands of 

components such as complete manufacturing facilities, factory floor layouts, production lines & 

industrial machinery, all in a single digital model.  The ability to navigate the entire digital model is 

extremely important for quality assurance and the design review process.  We can visualize complete 3D 

layouts of manufacturing plants and factories consisting of the products, tooling, fixtures, machines, and 

plant layouts. 

The ability to walk through an extensive digital design is just the beginning of the Navisworks interactive 

experience.  The Measuring tools enable detailed measurement of distance, area, and angles.  User 

defined Cross Sections and section planes, enable close inspection of all details. 

 

The construction process is a constant challenge for designers.  The Factory design will change every day 

during the construction cycle.  Navisworks allow Factory designers to display the construction process in 

the context of time, with the Timeliner.  Designers can simulate the real-life experience and appearance 

of manufacturing plants and factory layouts at any time in the installation process, so things go according 

to schedule. 

 

Objectives 
 

After completing this chapter, you will be able to: 

 Use the various Navigation tools available in Navisworks. 

 Establish Viewpoints and Animations 

 Use the Measuring tools to add dimensions to a Viewpoint. 

 Create user defined Cross Sections. 

 Create, locate, and utilize work features to perform modeling tasks. 

 Review a Timeliner example. 
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Lesson: Navigation 
 
 

 
 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 

 

 

 

 

 

 

 

Using Navigation Tools 
 

The Navigation bar and various tabs on the Ribbon include tools that help you navigate a model in a 

variety of ways. When using a navigation tool, additional navigation functions may be available by using 

the CTRL or SHIFT keys. 
 
 

Navigation Bar 
 

The Navigation bar is located on the right-hand side of the Scene view. You can control the display of 

the Navigation bar on the View tab, in the Navigation Aids panel, by selecting/deselecting the 

Navigation Bar option. 

 

Icon Name Description 

 

Pan Drag in any direction to move the camera correspondingly. Press SHIFT 

or CTRL to temporarily switch to Zoom. 

This lesson describes how the Navisworks navigation tools work. It also introduces you to 

additional key actions and other tools to aid and enhance model navigation. 

Objectives 

After completing this lesson, you will be able to: 

§ Use the various navigation tools available in the Navisworks environment. 
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Zoom Drag up or down to move the camera in and out along the axis of the 

focal point. 

 

Zoom Window Click and drag a box over an area on the scene to zoom into the 

bounding area. 

 

Zoom Selected Zoom in to selected items in the scene window. 

 

Zoom All Fit the complete model into the scene window. 

TIP: This can be useful if lost, in or outside the model. 

 

Orbit Orbit the camera around the focal point; drag in any direction to orbit 

correspondingly. Orbit mode resets the world up vector. Press SHIFT to 

temporarily change to Zoom and press CTRL to temporarily change to 

Pan. 

 

Free Orbit Rotate the model around the focal point (similar to having the model 

in the palm of the hand). Drag in any direction to move the model 

correspondingly. Press and hold CTRL and select a new pivot location 

with the left mouse button. To temporarily change to Pan, 

 press and hold the middle mouse button. 

 

Constrained 

Orbit 
Spin the model on a turntable. Turntable mode resets the world up 

vector. Once started, the model continues to rotate; click again in the 

scene to stop rotation. Press SHIFT to temporarily switch to Zoom, or 

press CTRL to temporarily switch to Pan to adjust the camera height. 

 

Look Around Turn the camera about the viewpoint (similar to moving your head 

around). Press CTRL to rotate the model. 

 

Look At Looks at a particular face in the scene. The camera orients so that the 

selected face is centered and parallel with the screen. 

 

Focus Focus an item to the center of the scene window. Select, then click on 

an item to center it. 

 
Fly Fly the camera through the scene. Move up or down to ascend or 

descend and left or right to move correspondingly. If you find yourself 

flying too quickly, adjust linear and angular speeds by clicking 

Viewpoint menu > Edit Current Viewpoints. 

TIP: The Fly tool can be set to a speed that is suitable for the model 

size, and so on. Select a viewpoint to navigate from, then click Tools 

menu > Global Options > Interface > Viewpoint Defaults. Add a check 

mark to Override Linear Speed and then set the speed as required. 

 

Walk Walk around and through the model scene. Walk mode resets the 

model to an upright position. Press SHIFT to increase walking speed or 

press CTRL to temporarily switch to Pan to adjust the camera height. 

Press SPACEBAR to temporarily crouch under an obstacle. 

TIP: The Walk tool can be set to a speed that is most suitable for the 

model size, and so on. Select a viewpoint to navigate from, then click 

Tools menu > Global Options > Interface > Viewpoint Defaults. Click 

Override Linear Speed, then set the speed as required. 
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The Viewpoint Tab 
 
Additional viewing tools are available in Viewpoint tab on the ribbon, as described below. 
 

Icon Name Description 

 

Perspective 

(camera panel) 
View the model with a perspective camera (selected by default). 

 

Orthographic 

(camera panel) 
View the model with an orthographic camera. 

 

Collision (Motion 

Settings panel> 

Realism) 

Prevent navigation through objects. You can walk or climb over objects 

in the scene up to half the height of the collision volume (viewer). This 

way, you can climb stairs.  

NOTE: Collision detection is only available in Walk or Fly modes. 

TIP: The collision volume (viewer) can be adjusted in height and 

radius. Click Application Menu  > Options > Interface > Viewpoint 

Defaults > Settings (Default Collision Detection), and set the viewer 

radius and height as required. 

 

Gravity (Motion 

Settings panel> 

Realism) 

Enable gravitational effect when walking (for example, being pulled 

downwards). You can ascend and descend stairs and slopes. Enabling 

the gravity tool automatically enables collision. This ensures that 

gravity stops moving downward once the viewpoint collides with the 

ground.  

 

Crouch (Motion 

Settings panel> 

Realism) 

Enable automatic crouching while walking. (This function only works 

with Collision Detection switched on.) 

 

Third Person 

(Motion Settings 

panel>Realism) 

 

 

 

 

Tip: The Third 

Person, Collision, 

Gravity, and 

Crouch 

commands are 

also available on 

the Walk/Fly pull-

down menu on 

the Navigation 

bar. 

View from a third person’s perspective. When activated, an avatar 

(which is a representation of yourself) is visible in front of the camera 

within the 3D model. Navigating tools control the avatar’s interaction 

with the current scene. 

NOTE: With Auto Zoom enabled, the camera temporarily zooms closer 

to the third person, if separated by an object during navigation. To 

disable, go to Tools > Global Options > Interface > Viewpoint Defaults > 

Settings > and remove the check mark from Auto Zoom. 

TIP:  

§ Collision Detection and Crouch, Gravity, and Third Person can all 

be switched on and off by pressing the shortcut keys, CTRL+C, 

CTRL+G, and CTRL+T, respectively. 

§ Using Third Person in connection with Collision Detection and 

Gravity makes this a very powerful function, giving an exact 

visualization of how a person would interact with the intended 

design. 

§ The Third Person settings can be adjusted. To change the settings 

for the current session, select the Viewpoint tab, and on the Save, 

Load & Playback panel, click  (Edit Current Viewpoint) and click 

Settings in the Collision area. Under Third Person, select Enable, 

then select Avatar (type), and the Angle and Distance if required. 
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Align X (Camera 

panel>Align 

Camera) 

Aligns the camera along the X-axis. 

 

Align Y (Camera 

panel>Align 

Camera) 

Aligns the camera along the Y-axis. 

 

 

Align Z (Camera 

panel>Align 

Camera) 

Aligns the camera along the Z-axis. 

 

 

Straighten 

(Camera panel> 

Align Camera) 

You can straighten the camera to align it with the viewpoint up vector.  

When the camera position is close to the viewpoint up vector (within 

13 degrees), you can use this function to snap the camera to an axis. 

Tip: As an alternative, type 0 at the base of the Tilt window. 

N/A Tilt Camera Use the scroll bar to tilt the camera up and down. To display the scroll 

bar in the Scene view, click  Show Tilt Bar on the Viewpoint tab. 

 

 

  

 

 

Navisworks global settings for the default use of the Realism commands are set in the 

Application Menu  > Options > Viewpoint Default > Settings. When the user 

assigns settings from this location they become the default for every model that is 

opened from this point on. To set and store the use of the Realism commands at the 

model level, click Edit Current Viewpoint  on the Viewpoint tab and click Settings.  
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  3. Use Zoom Window. 

§ Activate the Zoom Window tool. 

 
§ In the Scene View, draw a box around 

the area of the model shown below. 

 

 

4. Walk Thru the Model. 

§ On the Navigation Bar, click the Walk 

Tool. 

  
§ On the Viewpoint ribbon, set the realism 

settings as shown in the following 

image, then set the Lighting option to 

use Scene Lights. 

   
§ Left Click and drag the mouse fwd to 

walk in that direction.  After you land on 

the ground proceed into the main 

factory building entrance. 

 

 

 

Exercise: Using the 

Navigation Tools 
 
In this exercise, you explore the Factory 
Layout using various navigation 
commands available on the Navigation 
Bar. 

 

The Completed Exercise 

 

1. Open NAV_003_Navigation.nwf 

§ Click in the background to deselect. 

 

2. Use the Zoom Commands. 

§ On the Navigation bar, select the  

associated with the zoom command. 

§ Click Zoom All to obtain an overall view of 

the model. 

 
Note:  The button on the Navigation bar 

changes to Zoom All and stays active until 

another tool is selected. 

 

 



7 Chapter14: Visualization / Digital Mockup 
 

  7. Use the View Cube. 

§ Click the Home button on the View 

Cube. 

 
§ Click the Front Face of the View Cube. 

 
§ On the Navigation Bar, click Zoom All. 

§ Use the View Cube to set the view to 

Right, Left, and Top.  

§ Return to the Home View. 

 

8. Use the Orbit Command. 

§ On the Navigation Bar, click the Orbit 

command. 

 
§ Place the cursor at the desired Pivot 

point and scroll up and back.  This sets 

the pivot point for the orbit command. 

 

§ Left click and drag to adjust the 

orientation of the model. 

§ Using the View Cube, return to the 

Home View 

§ On the Navigation Bar, select the  

associated with the Orbit command. 

§ Click the Constrained Orbit tool. 

§ Drag left and right to spin the model like 

a turntable. 

Note: Release the mouse button while 

dragging for a continuous spin. 

 

§  Start a New file without saving. 

§ End of Exercise. 

5. Explore the factory building using the walk 

tool. 

§ Drag the mouse Left and Right to look 

side to side. 

§ Use the scroll wheel to look up and down. 

§ Use the Walk Tool to explore the factory 

buildings. 

Note:  The collision setting in the realism 

panel allows you to walk up stairs. 

 

6.  Explore the Factory grounds using the Fly 

tool 

§ Exit the building and stand in front of the 

factory building. 

§ Clear all options on the Realism tool as 

shown in the following image. 

 
§ In the Navigation bar select the  

associated with the Walk command and 

click the Fly fool. 

 
§ Hold the Left button down to start flying 

thru the grounds.   

§ Move the mouse fwd and back to change 

elevation. 

§ Move the mouse right and left to bank in 

that direction. 

§ Explore the factory grounds using the fly 

command 

Note: Hold the scroll wheel down to 

adjust the yaw while flying. 
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Lesson: Viewpoints 
 
 

 
 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

This lesson describes how to create, organize, edit, and export viewpoints. It also introduces you to setting 

navigation commands in viewpoints. 

Objectives 

After completing this lesson, you will be able to: 

§ Create, organize, edit, and export viewpoints. 
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About Viewpoints 
 

Viewpoints are snapshots taken of the model as it is displayed in the scene.  The model can be navigated 
to a required view, items of the model can be hidden, and other items can be rendered with different 
materials and lighting. Then the finished scene can be saved as a viewpoint for further reference. 
 
In addition, you can add a variety of comments and Redline tags to a saved viewpoint. 
 
When a viewpoint is saved it contains information about the following: 

§ Camera position and focus point 
§ Section planes 
§ Navigation modes 
§ Speeds 
§ Rendering conditions 
§ Perspective/orthogonal modes 

 
 

Procedure: to Display and Add a Viewpoint 
 

1. To display the Saved Viewpoints window, if it is not visible, select the Viewpoint tab and click 

the  icon on the Save, Load & Playback panel’s title bar. As an alternative, select the View 

tab, expand the Windows option, and enable Saved Viewpoints. The Saved Viewpoints 

window displays a list of the previously saved viewpoints. 

 

2. Click a viewpoint to display it. 

3. To quickly view the whole model, click Zoom All on the Navigation Bar on the right-hand side 

of the Scene View. 

NOTE: Saved animations  are also located in the Viewpoints window. See “Animate 

Objects” for more information. 

4. Navigate to the required position in the model.  

5. Prepare the view (for example, apply rendering, lighting, comments, redlines, navigation 

modes, and tools). 

6. Right-click in the Viewpoints window, and click Save Viewpoint. 

7. Enter a new name and press ENTER. 

Tip: To rename a Viewpoint to an alternate name, right-click the viewpoint in the Viewpoints 

window and click Rename. 
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Organizing Viewpoints 

Viewpoints (and animations) can be moved, reordered, or organized in folders as follows: 

§ To move a viewpoint to a different position, drag it to the new position. 

§ To sort the list of viewpoints alphanumerically, right-click in the Viewpoints window, and then  

click Sort. 

§ To create a folder, right-click in the Viewpoints window, then click New Folder. 

§ To rename the folder, right-click the folder in the Viewpoints window, and click Rename. In 

the folder name field, enter a new name for the folder. 

§ To move viewpoints to a folder, in the Viewpoints window, select all viewpoints to be moved 

and drag to the folder.  

§ To sort the list of folders (and viewpoints) alphanumerically, right-click in the Viewpoints 

window, and then click Sort. 
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Editing Viewpoints 
Viewpoint settings can be changed in Application Menu          >                 > Interface > Viewpoint Defaults, 
which will be effective on all new viewpoints. Each viewpoint can also be edited individually. 
 

Procedure: To Open the Viewpoint Editor 

1. In the Viewpoints window, select the viewpoint to be edited.  

2. Right-click the selected viewpoint, and then click Edit. 

IMPORTANT: To save the changes after editing, click OK. Then right-click the viewpoint in the 

Viewpoint window, and click Update. 

 

 

Camera Positions 

§ Position – X Y Z coordinates of the viewing position. 

§ Look At – X Y Z coordinates of the focal point. 

§ Vertical Field of View – Viewing perspective of the camera. 

o Enter a value between 1 and 90. (This is not editable when in orthographic mode.) 

§ Horizontal Field of View – Viewing perspective of the camera. 

o Enter a value between 1 and 90. (This is not editable when in orthographic mode.) 

§ Roll – Roll of the camera about its viewing axis. (This value is not editable when the world up 
vector remains upright (in Walk, Orbit, and Turntable modes.) 
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Motion Speeds 

Editing the following motion settings takes effect when navigating from this viewpoint. When a 
different viewpoint is selected, the motion settings revert to the Global Option settings unless 
overridden in that viewpoint. 

§ Linear Speed – Navigation speed in a straight line. 

§ Angular Speed – Turning speed of a viewpoint (value in degrees per second). 

Saved Attributes 

§ Hide/Required – Saves objects set in the scene as hidden or required. 

§ Override Material – Saves overridden colors and transparencies of an object in a viewpoint. 

Collision 

§ Click Settings in the Edit Viewpoint dialog box to open the Collision dialog box. 

 

 

§ Collision – Add a check mark to switch collision detection on with this viewpoint. 

§ Gravity – Add a check mark to incorporate gravity on with this viewpoint. 

§ Auto Crouch – Add a check mark to enable crouching in this viewpoint. 
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Lesson: Animations 
 
 

 
 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

This lesson describes how to record animations and create animations between two or viewpoints. 

Objectives 

After completing this lesson, you will be able to: 

§ Record a Walking or Flying Animation 

§ Create an Animation between two Viewpoints. 
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Creating Animations. 
 

Animations can be created, edited, and played back in Navisworks, and also played back in the Freedom 
viewer. Animations can also be exported in AVI format to be played back in a variety of software including 
Windows Media Player. 
 
There are two ways to produce an animation, either by recording interactive navigation, or by animated 
transitions between saved viewpoints. In addition, an animation can be created in the form of a slide 
show. 

Animation Tab 

 

Procedure: To View a Saved Animation 

1. In the Saved Viewpoints window, select the animation. 

2. Select the Animation tab. 

 
3. 

On the Playback panel, click Play  to view the animation. 

 
4. 

Click Stop  or Pause  to stop play at any time. 

 
5. 

Click Step Forward  or Step Backward  to advance or reverse by one frame in the 

animation. 

 
6. 

Click Rewind  or Forward  to move to the beginning or end of the animation. 

7. Drag the Animation Slider  or the Time field  

to view a specific point in the animation. 

NOTE: Animations can also be played back using the controls on the Viewpoint tab. The only 

difference is that the Animation Slider and the Time field are not available on this tab. 
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Procedure: To Record an Interactive Animation 

 

Procedure: To Create an Animation from Viewpoint Transitions 

 

 

 

 

 

 

 

 

 

  

1. Select the viewpoint where the animation will begin. 

2. Select the Animation tab. 

3. 
On the Create panel, click Record  to start recording movements in the Navisworks scene. 

4. Navigate around the model as required. 

5. 
In the Recording panel, click Stop  to end the recording. Navisworks automatically saves the 

animation to the Viewpoints window and names it Animation1. 

6. In the Viewpoints window, right-click Animation 1, and click Rename. In the animation name 

field, enter a new descriptive name, and press ENTER. 

NOTE: Any delay in navigation or delay due to switching navigation tools will cause a cut frame 

to be added to the animation. This cut frame will add a controlled pause to the animation, or be 

an identifier of where frames may need to be removed to make a more smooth video 

movement.  

1. Select the Animation tab. 

2. Right-click in the Viewpoints window, and then click Add Animation. 

3. To rename the new animation, in the Viewpoints window, right-click the animation, and click 

Rename. In the animation name field, enter a new name and press ENTER. 

4. Create all the viewpoints required for the animation and rename each if required. 

5. Drag the viewpoints into the empty animation. 

The animation is ready for viewing. 
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  3. Review the Existing Viewpoints. 

§ Some Viewpoints have already been 

created for this exercise. 

§ In the Saved Viewpoints window, click 

the Main Entrance viewpoint. 

 
§ Notice that the viewpoint can be set to 

behave a predetermined manner.  In this 

case the 3
rd

 Person Avatar is active and 

the navigation mode is set to walk. 

§ In the Saved Viewpoints window, click 

the Conference Room Viewpoint. 

§ Review the other existing Viewpoints. 

 

4.  Create a Viewpoint. 

§ In the Saved Viewpoints window, click 

the R&D Floor viewpoint. 

§ On the Viewpoint ribbon, clear the Third 

Person option for Realism. 

 
§ Position yourself in front of the Robot 

Arm as shown in the following image. 

 

 

 

Exercise: Create Viewports 

and Animations 
 
In this exercise, you create Viewpoints at 
specific points in the factory layout.  
These viewpoints are then used to create 
animations moving from one viewpoint to 
another.   

 

The Completed Exercise 

 

1. Open NAV_004_Viewpoints.nwf 

§ Click in the Background to deselect. 

 

2. Review existing Viewpoints. 

§ On the View tab, under Window, Activate 

the Saved Viewpoints window. 

 
§ Pin the Window open by clicking the pin 

button shown below. 
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  § Left Click and Drag the Robot Arm 

Viewpoint on top of the animation 

node and release the mouse button. 

 
§ Repeat the previous process dragging 

the Blower Viewpoint into the 

animation. 

§ After adding the Viewpoints to the 

animation the animation node should 

look like the following image. 

 
 

6. Set the Timing for the Animation. 

§ Right Click on the Animation and 

select Edit. 

§ In the Edit Animation dialog, set the 

duration to 30 seconds. 

 
§ Click OK. 

 

7. Viewing the Animation. 

§ On the Viewpoint ribbon, on the Save, 

Load & Playback panel, click the play 

button. 

 
Note:  The Animation must be 

selected in the Saved Viewpoint 

window. 

 

§ Start and New file without saving. 

§ End of Exercise. 

 

 

 

 

 

§ Right Click in the Saved Viewpoint 

window and select Save Viewpoint. 

 
§ Name the new Viewpoint, Robot Arm. 

§ Change your position to view the 

Blower as shown in the following 

image. 

 

§ Right Click in the Saved Viewpoint 

window and select Save Viewpoint.  

Name the new Viewpoint, Blower. 

 

8.  Create an Animation between two 

Viewpoints. 

§ Right Click in the Saved Viewpoint 

window and select Add Animation. 

 
§ Name the Animation Robot to 

Blower. 
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3. Set the timing for the Animation. 

§ Right Click on the Walkthru animation 

and select Edit. 

§ In the Edit Animation dialog, set the 

duration to 30 seconds. 

 
§ Click OK. 

 

4. View the Animation. 

§ On the Animation ribbon, Playback 

panel, click the Play button. 

 

 

Challenge:  Create a Recorded 

Animation of a flight around the factory 

grounds. 

Hints: 

§ Turn off the Third Person Avatar. 

§ Turn off Collision. 

§ Select a starting position outside the 

buildings. 

 

 

 

 

 

 

 

 

 

 

Exercise: Record an 

Animation. 
 
In this exercise, you create an 
animation by recording a 
walkthrough. 
 

 

The Completed Exercise 

 

1. Open NAV_005_Record_Walkthru. 

§ Click in the Background to deselect. 

§ Activate the R&D Floor Viewpoint. 

 

2. Record a Walkthru. 

§ Click the Animation Tab. 

§ Note:  Please read the following step 

entirely before proceeding. 

§ Click the Record button and quickly 

begin walking.  Walk out the rear of 

the factory building and into the 

factory out building next door.  When 

you reach your destination, click the 

Record button to stop the recording. 

 
§ In the Saved Viewpoint window, name 

the new animation Walkthru. 
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Lesson: Digital Mockup 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Combining a digital prototype of a factory building with another digital prototype of a packaging or machining line 

can create several challenges.  Navisworks allows designers to easily compare multiple digital prototypes in a digital 

mockup of the entire design.  Experiencing the factory building, factory lines, and supporting infrastructure before 

construction allows design refinement and the opportunity to fix critical errors.  This section will focus on 

Navisworks tools that aid in the analysis and manipulation of the Digital Mockup. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Utilize the Factory Layout and Item Tools to manipulate model geometry. 

§ Use the Measuring Tools to make linear, angular, and area measurements. 

§ Use the Cross Section tools to expose interior detail. 

§ Review a Timeliner sample file. 
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Lesson: Factory Layout Tools 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

The version of Navisworks that ships with the Autodesk Factory Suite has special tools built in to 

aid in the Factory Layout process.  The floor concept, introduced in the Inventor Factory Design 

Utilities, is present in Navisworks as well.  Users can insert geometry from various CAD sources 

and specify a landing surface, so components land upright.  Special Grip Snap options make 

placing model geometry extremely easy.  This lesson will focus on the Factory Layout Tools 

available in Autodesk Navisworks. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Familiarize yourself with the Factory Layout Tools available in Navisworks. 

§ Append Model geometry from various CAD sources into the Navisworks model. 

§ Use the Item Tools to move and rotate model geometry. 
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Factory Layout Ribbon 
 

The Factory ribbon contains the Factory Layout Tools unique to the Factory version of Navisworks.  An 
outline of the commands and general functionality are included in the table below. 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Utilities 

 

You can use Resize Floor to manually change the floor size by 

dragging the borders. When you click Resize Floor, grips display at 

the corners and midpoints of the floor edges. 

 

The new floor size is saved in the Options Editor dialog box. If Auto 

Resize is enabled, Resize Floor updates the minimum floor size. 

 

  



22 Chapter14: Visualization / Digital Mockup 

  

2. Position 

 

The Grip Snap tool provides several methods for moving and rotating models. 

When you select a point or an edge on a model, a mini-toolbar displays with 

options for moving the model. 

 
Grip Snap options for an edge selection 

 
Grip Snap options for a point selection 

Each mini-toolbar provides three options for moving the model. Once you 

select an edge or a vertex on the model, the mini-toolbar appears. You can 

press Tab to cycle through each of the mini-toolbar options. Click the Back 

option on the far right of the mini-toolbar to cancel the edge or vertex you 

selected, and then you can select a different edge or vertex on the model 

again.  

Once you start to move the model, you can press Esc to cancel the move, and 

then press Esc a second time to cancel the command. 

· Free Drag is available for both Edge and Point selections. The model 

is attached to the pointer, and you can manually move the model to 

a different location. The model snaps to the floor grid and other 

model geometry.  

· Move Using Reference Geometry is available for both Edge and Point 

selections. It repositions the model based on selections on another 

model. The orientation of the model does not change.  

· Drag Along Ray is only available for Edge selections. You can 

dynamically drag the model along the infinite line defined by the 

selected edge. Or, you can enter a specific value in the Heads-Up 

Display.  

 
· Rotate About Point is only available for Point selections. You can 

dynamically rotate the model around the selected point. The rotation 

is restricted to the XY plane. You can also enter a specific angular 

value in the Heads-Up Display.  

 

 
· The Back button cancels the current selection and keeps the Grip 

Snap command active so you can select other geometry. 

 

You can move one or several models with the Grip Snap command. The 

model with the selected geometry always moves. To move multiple models, 

press and hold the CTRL key while selecting them in the graphics window 

before you start the command. Or, you can select the models from the 

Selection Tree after starting the command. If you start the command without 

preselecting models, you can only move the model with the selected 

geometry. If multiple models are preselected, and you select geometry on a 

different model, the preselection set is cleared and only the last model 

moves.  
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2. Position 

 

Most components in a factory are placed relative to the floor. 

Conveyors and other equipment sit on the floor, but items like hoppers 

and ductwork are usually positioned at a specific height above the floor. 

 

The landing surface of a model defines how it sits on the factory floor. 

Models are initially placed so the model coordinate system aligns with 

the factory coordinate system. You can set the landing surface by 

selecting three points on the model to define a plane. You can also 

change the landing surface of a model if it requires a different 

orientation. For example, a strut channel can be mounted on the ceiling 

or on a wall, so the landing surface depends on the location. 

 

For machinery, you simply pick points on the mounting feet and it will 

sit on the floor. For objects like pipe hangers, you pick the points where 

you want to set the height. The model is placed on the floor, and you 

can use Grip Snap to move it to the correct height. 

 
 

3. Learn 
About 
Factory 

 

Activates the Factory Specific Help system. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Activates a web link to the Autodesk Manufacturing Channel on 
YouTube.  There you will find various instructional videos to help you get 
started using the application. 
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4. Community  Activates the Autodesk Wiki Help page. 

 Activates the Autodesk Factory Design YouTube Channel. 

 Activates the Autodesk Factory Design Facebook page. 

 

Activates the Autodesk Twitter, Flicker, and Autodesk 
Discussion  Forum pages. 

 
 
 

 
 

Lesson: Item Tools 
 

When you select model geometry, the context sensitive Item Tools tab appears on the ribbon.  This 
ribbon, allows you to manipulate the selected geometry in a number of ways.  This lesson outlines the 
commands located on the Item Tools ribbon. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Switchback  
 
 
 
 

You can use the SwitchBack functionality to send the current view of the 

currently loaded file back to Inventor.  

 

Note: SwitchBack supports all versions of Inventor 2011, but Inventor must 

be installed on the same machine as Navisworks Factory for SwitchBack to 

work. 

Additional Switch Back information is available in this chapter. 
 

2. Hold  
 
 
 
 

When you navigate around a model in Autodesk Navisworks, it is possible to 

“pick up” or hold selected items and move around with them in the model. 

 

For example you may be viewing a plan for a factory and would like to see 

different configurations of machine layouts. 
 

  



25 Chapter14: Visualization / Digital Mockup 

  

3. Look At 

 

When you are in focus mode, clicking on an item swivels the camera 
so that the point clicked is in the center of the view. This point 
becomes the focal point for the Orbit tools (SteeringWheels and 
navigation bar). 

 
 
 
 
 

Zooms to the extents of the selected item. 

4. Visibility  
 
 
 
 

Hides the selected items.  You can hide the objects in the current 
selection so that they are not drawn in the Scene View. This is useful 
when you want to remove specific parts of the model. For example, 
when you walk down the corridor of building, you may want to hide a 
wall that occludes your view of the next room. 
 

 
 
 
 
 
 

Forces the selected items to remain visible during interactive 
navigation, regardless of any performance settings.  Although 
Autodesk Navisworks intelligently prioritizes objects for culling in the 
scene, sometimes it drops out geometry that needs to remain visible 
while navigating. 

5. Transform  
 
 
 
 

Moves the selected item with the translation Gizmo.    
Note: Additional information on the Move command is available in 
this chapter. 

 
 
 
 
 

Rotates the selected item with the translation Gizmo. 
Note:  Additional information on the Rotate command is available in 
this chapter. 

 
 
 
 
 

Resizes the selected item with the translation Gizmo.   
Note: Additional information on the Scale command is available in this 
chapter. 

 
 
 
 
 

Resets the position, rotation, and scale of the selected objects back to 
the original values. 

6. Appearance 

 

Sets the Transparency level and Color of the Selected objects. 
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 The SwitchBack Feature 

SwitchBack is designed to improve the workflow of design review by significantly reducing the time 
taken finding and altering original designs. 
 
When reviewing a model, the SwitchBack feature enables an instant switch back from Navisworks, to 
the CAD application that the model was created in. Furthermore, when an object is selected in 
Navisworks and then SwitchBack is selected, the same object is displayed in the CAD application, in the 
same camera position. 
 
This means that when reviewing an object in the model that then requires changes, by using 
SwitchBack, you can access the object easily in the CAD application and make changes. When the file is 
saved in the CAD application, and the model in Navisworks refreshed, the effect of the altered object 
can be reviewed 
 

To use SwitchBack with Inventor. 

1. Start Inventor so that both it and Navisworks Factory are running simultaneously.  

2. Select an object in the Scene View, and click Item Tools tab SwitchBack panel 

SwitchBack.  

3. The current Navisworks Factory camera view is taken back to Inventor, and the same object is 

selected.  

Note: Alternatively, you can right-click over the object in the Scene View and select SwitchBack 

from the pop-up context menu. You can also right-click over the object node in the Selection 

Tree and select SwitchBack. Additionally, in the Clash Detective window, on the Results tab, you 

can click the SwitchBack button. 

4. Make the changes in Inventor, then save the changes.  

5. Return to Navisworks Factory, and click Refresh on the Quick Access toolbar to view the 

modified object. 
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 Move an Object with the Gizmo 

To move an object with gizmo 

1. Select the object you want to move in the Scene View.  

2. Click Item Tools tab Transform panel Move .  

3. Use the move gizmo to adjust the position of the currently selected object:  

o To move all currently selected objects, place the mouse over the square at the end of the 

desired axis. When the cursor changes to , drag the square on the screen to 

increase/decrease the translation along that axis.  

o To move the objects along several axes at the same time, drag the square frame between 

the desired axes.  

Dragging the yellow square in the middle of the move gizmo enables you to snap this 

center point to other geometry in the model. 

o To move the gizmo itself rather than the selected objects, hold down the CTRL key while 

dragging the square at the end of the desired axis.  

o To snap the move gizmo to other objects, hold down the CTRL key while dragging the 

yellow square in the middle of the gizmo. 

o For the point-to-point translation, hold down the CTRL key, and use the center square 

to drag the gizmo to the start point. Then, with CTRL released, drag the square again to 

move the objects to the end point. 
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 Rotate an Object with the Gizmo 

To rotate an object with gizmo 

1. Select the object you want to rotate in the Scene View.  

2. Click Item Tools tab  Transform panel  Rotate .  

3. Use the gizmo to rotate the currently selected object:  

o Before you can rotate the currently selected objects, you need to position the origin 

(center point) of the rotation. To do this, place the mouse over the square at the end of 

the desired axis. When the cursor changes to , drag the square on the screen to 

increase/decrease the translation along that axis. This will move the gizmo itself. 

Dragging the yellow square in the middle of the rotate gizmo enables you to move it 

around, and snap it to points on other geometry objects. 

o Once the rotate gizmo is positioned correctly, place the mouse over one of the curves 

in the middle, and drag it on the screen to rotate the selected objects. The curves are 

color-coded, and match the color of the axis used to rotate the object around. So, for 

example, dragging the blue curve between the X and Y axes, rotates the objects around 

the blue Z axis.  

o To rotate the orientation of the gizmo to an arbitrary position, hold down the CTRL key 

while dragging one of the three curves in the middle.  

o To snap the gizmo to other objects, hold the CTRL key while dragging the yellow square 

in the middle of the gizmo. 
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 Resize an Object with the Gizmo 

To resize an object with the gizmo 

1. Select the object you want to resize in the Scene View.  

2. Click Item Tools tab  Transform panel  Scale .  

3. Use the scale gizmo to resize the currently selected object:  

o To resize all currently selected objects, place the mouse over one of seven squares. 

When the cursor changes to , drag the square on the screen to modify the size of 

the objects. Typically, dragging a square up or right increases the size, dragging it down 

or left decreases the size.  

o To resize the objects across a single axis only, use colored squares at the end of the 

axes. To resize the objects across two axes at the same time, use yellow squares in the 

middle of the axes. Finally, to resize the objects across all three axes at the same time, 

use the square in the center of the gizmo.  

o You can modify the center of scaling. To do this, place the mouse over the square in the 

middle of the gizmo, and hold down the CTRL key while dragging the square on the 

screen. 
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  3. Set the Landing Surface for the Container 

§ The Container was originally modeled in 

a different X,Y,Z orientation.  The Set 

Landing Surface command located on 

the Factory ribbon, allows users to 

specify a landing surface by selecting 3 

points. 

§ On the Factory ribbon, click the Set 

Landing Surface tool. 

§ Click the 3 corner points shown in the 

following image. 

Note: Each point is located on the 

bottom (currently side) of the shipping 

container. 

 

§ The Container flips to the underside of 

the floor grid.  Click the Inverse button 

in the heads up display as shown. 

 
§ The Container flips to the proper 

orientation.  Click the Confirm button in 

the heads up display as shown. 

 
§ Press the Esc key to deselect the 

component. 

 

Exercise: Factory Layout 

Tools and Item Tools 
 
In this exercise, you add a Skylift and 
shipping container to the overall factory 
design.  The Factory Tools are used to set 
the landing surface for one of the 
components, and the Item Tools are used 
to place the objects in the desired 
location. 

 

 

 

The Completed Exercise 

 

1. Open NAV_005A_Factory_Item_Tools.nwf. 

§ Click in the background to deselect. 

§ Activate the Factory Layout Tools 

Viewpoint. 

 

2. Add a shipping container to the layout. 

§ On the Home ribbon, use the Append 

command and add Container.skp from the 

Components / Google Sketchup folder. 

§ Navisworks automatically zooms to and 

highlights the appended file, as shown in 

the following view. 

 



31 Chapter14: Visualization / Digital Mockup 

 

 

  § The Shipping Container should be 

positioned similar the following 

image. 

 

 

5. Use the Item Tools to place the Shipping 

Container in the final position. 

§ When any object is selected, the Item 

Tools tab appears at the top of the 

ribbon (Shown Below). 

 

§ On the Item Tools ribbon. Click the 

Move tool. 

 
§ The Move Gizmo appears at the 

center of the selected geometry. 

 

 

 

 

 

 

 

4. Place the Container on the Flatbed Truck 

at the rear of the factory using Grip 

Snaps. 

§ On the Factory ribbon, click the Grip 

Snap tool. 

 
§ Select the lower corner of the 

Shipping Container as shown in the 

following image. 

 

§ Select Free Drag from the Heads Up 

Display as shown. 

 
§ Activate the Loading Area Viewpoint. 

§ Click the horizontal edge of the 

flatbed as shown in the following 

image. 
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Challenge – Using the processes 

demonstrated in this exercise, do the 

following. 

§ Append Skylift.skp to the layout.  The 

file is located in the Components / 

Google Sketchup folder. 

§ Use the Item Tools to Move the Skylift 

to the rear of the facility. 

§ Hint: The Top Viewpoint is preset 

looking down on the overall factory 

grounds.  Using this viewpoint allows 

you to drag the Skylift and easily cover 

the distance. 

§ Use the Rotate Gizmo to spin the 

Skylift into position. 

§ The following image shows the 

desired position of the Skylift. 

 

 

§ Place the cursor at the end of the 

Green (Y) axis.  When the Hand 

symbol appears, Left Click and drag 

the Shipping Container to the front of 

the flatbed. 

 

§ The final position of the Shipping 

Container is shown below. 

 

§ Press ESC to Clear the selection. 

 

6.  Activate the Factory Layout Tools 

Viewpoint for the Challenge portion of 

this exercise. 
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 Lesson: Measuring Tools 

 
Navisworks provides designers with a set of measuring tools.  Measurements can be made from any 
edge, vertex, or surface.  The Measurement tools are located on the Review ribbon. 
 
 
 
 
 
 
 
 
 

Snapping 
Snapping controls can be set in the Options Editor to precisely select vertices and edges while making 
measurements. These settings are in the Snapping group of the Options Editor dialog box. You can also 
specify the Tolerance for picking in this window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enable Snap to Vertex, Snap to Edge, or Snap to Line Vertex, as necessary, to aid in making 
measurements. Snap settings can also help when moving, rotating, or scaling in Navisworks.  
 

Cursor Name Description 

 

No 

Snap 
All Snap options are cleared. No snap function, but a point on a surface  

is found. 

 

Vertex 
Cursor changes to  when a point, snap point, or line end is moved over 

(found to snap to). 

 

Edge 
Cursor changes to  when moved over an edge (found to snap to). 

 

 

 

The geometry in Navisworks is constructed with triangles, and therefore the cursor 

will snap to edges that may appear to be in the middle of a face.  

Viewing the model in Hidden Line  mode clarifies which vertex or edge the cursor 

is snapping to 

. 
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Procedure: How to Use Measuring Tools 

1. Select the Review tab and expand the Measure command. 

 

In the expanded Measure command there are six measuring tools that are available for use.  

2. Point to Point  measures between two points.  

§ Click Point to Point . Then click the start and end points of the distance to be 

measured. A line is displayed between the two points and the value is displayed on 

the model. 

§ Click Clear  or right-click to remove existing points and select a new base point. 

3. 
Point to Multiple Points  measures between a base and various other points. 

§ Click Point to Multiple Points . Then click on the start and first end point to be 

measured. A line is displayed between the two points and the value is displayed on 

the model. 

§ Click the next end point to be measured. A line is displayed between the base point 

and the next end point and the value is displayed on the model. 

§ Repeat to measure additional end points if required. 

§ Click Clear  or right-click to remove existing points and select a new base point. 

4. 
Point Line  measures a total distance between multiple points along a route. 

§ Click Point Line . Then click the start and the second point to be measured. A line 

is displayed between the two points and the value is displayed on the model. 

§ Click the third point to be measured. The line extends to the third point.  

§ Repeat to measure the total distance between additional points if required. 

§ Click Clear  or right-click to remove existing points and select a new base point. 
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5. 
Accumulate  calculates the sum of several point-to-point measurements. 

§ Click Accumulate . Then click the start and end points of the first distance to be 

measured. A line is displayed between the two points. 

§ Click alternately on additional start and end points as needed. The sum of all the 

selected segments are displayed on the model. 

§ Click Clear  or right-click to remove existing points and select a new base point. 

6. 
Angle  calculates an angle between two lines. 

§ Click Angle . Then click on a point along the first line.  

§ Click on the first line at the point where the second line intersects. Finally, click on a 

point along the second line. 

§ The value is displayed on the model. 

§ Click Clear  or right-click to remove existing points and select a new base point. 

7. 
Area  calculates an area on a specific plane. 

§ Click Area . Then click on points along the perimeter of the area to be measured. 

Select as many points as required to obtain the accuracy you want. 

§ All the points added must lie on the same plane to be accurate. 

§ A line is displayed between the points and the value is displayed on the model. 

§ Click Clear  or right-click to remove existing points and select a new base point. 
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The Measure Tools window can also be displayed when measuring to provide additional information on 
the measurements. To display this window, select the View tab, expand the Windows option, and 
enable Measure Tools or click  on the Measure panel title bar on the Review tab. The Measure 
command icons on the Measure Tools window vary slightly from those on the ribbon. However, they 
can also be used to initiate a Measure command when the Measure Tools window is displayed. Hover 
your mouse over the icons to display a command tooltip. 

 

As selections are made on the model the locations of the start and end points are populated in the 
Measure Tools window and the Difference and Distance fields are calculated. The information in the 
Measure Tools window varies depending on the Measure command that is active. For example, when 
measuring an Angle or Area, the Distance field is changed to an Angle and Area field respectively.  

Measuring Tool Options 

The Measuring tools have a number of options for obtaining accurate measurements. The options can 

be accessed by clicking Options on the Measure Tools window or you can click Application Menu  > 

 > Interface > Measure. 

 Select options as needed. 
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  3. Open the Measure Tools window. 

§ On the Review ribbon, click the 

expand button shown in the following 

image. 

 
§ Pin the Measure Tools window open. 

 

4. Measure the size of the Robot Table. 

§ Start the Point to Point measurement 

tool located on the Measure flyout. 

 
§ Select the two vertexes shown in the 

following image.  Note the vertex 

snap symbol highlighted below. 

 

§ On the Measure Panel, click Convert 

to Redline.  This converts the current 

measurement to a redline object. 

Note: A Viewpoint is automatically 

created to support the Redline. 

 

 

 

 

 

 

Exercise: Using the 

Measure Tools 
 
In this exercise, you use the measure 
tools to extract information from the 
model. 

 

The Completed Exercise 

 

1. Open NAV_006_Measure_Tools.nwf. 

§ Click in the background to deselect. 

§ Activate the Measure Viewpoint. 

 

2. Check the current measurement 

options. 

§ On the Application Menu, Click 

Options. 

 
§ In the Options Editor, select Measure. 

 

§ Review the options available.  For this 

exercise we will use the default 

options. 

§ In the Options Editor, select Snapping.  

Make sure the options are set as 

shown in the following image. 
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  6. Measure the size and position of the 

Blower. 

§ Walk to the Blower component in the 

rear of the factory as shown in the 

following image. 

§ Using the measure tools, determine 

the height and width of the machine 

and how close it currently is to the 

back wall. 

 

§ Open a New File without saving 

§ End of Exercise. 

§ Add the additional measurements 

shown in the following image, 

converting each to a redline markup. 

 

 

5. Measure the distance to the nearest 

column. 

§ Using Edge Snaps, select the two 

edges shown in the following image.  

Note the highlighted edge snap 

below. 

 

§ Review the distance values in the 

Measure Tools window. Note the 

linear distances is shown in the view, 

but the X, Y, and Z values are 

displayed in the Measure Tools 

window. 

 
§ On the Measure Panel click the Clear 

tool. 
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Lesson: Cross Section Tools 
 

Sometimes the detail you need to see is hidden behind other components in the design.  The Cross 
Section tools allow you to display and inspect any area of your digital mockup.  
 
With sectioning, you can make up to six sectional cuts in any plane and still be able to navigate around 
the scene. You view models inside without hiding any item. Viewpoints of section planes can be saved 
and used in animations to show a dynamically sectioned model. 
 
Slices can also be created using multiple section planes and linking them as a slice. In this way the 
model can be navigated and the scene viewed as a slice in real time, and used in viewpoints and 
animations. 
 

Procedure: To Create Sectioned Planes  

1. Select a saved viewpoint or manipulate the model to an orientation to begin sectioning from. 

2 Select the Viewpoint tab and click Enable Sectioning  in the Sectioning panel. The 

Sectioning Tools context-sensitive tab appears. 

3. 
In the Mode panel, ensure that Planes  is enabled to define sections in the scene using 

planes. 

4. In the Current pull-down menu in the Plane Settings panel, select a plane to activate it. By 

default Plane 1 is activated.  

Notice in the pull-down menu that Plane1 is enabled as indicated by the yellow lightbulb 

icon. The remaining planes are not initially active. 

5. By default, each plane has a default Alignment already assigned (e.g., Top, Bottom, Front, and 

so on). To change this alignment, select the Alignment pull-down menu in the Planes Settings 

panel. The alignment options correspond to the faces of the ViewCube along with the 

following options: 

§ Click Align View to section through the model, parallel to the current viewpoint 

regardless of its viewing angle. 

§ Click Align to Surface to section through the model aligned with a selected surface. 

§ Click Align to Line to section through the model aligned to a selected line. 

6. To change the location of the sectioning plane in the model, select either the Move  or 

Rotate  commands in the Transform panel. 

7. Use the gizmo that appears on the plane in the Scene View to move/rotate the position of 

the plane in the viewpoint. To enter an exact positioning value, expand the Transform panel 

and enter coordinates or angular values. 

8. Enable additional planes by selecting them in the Current pull-down menu. Once enabled you 

can change their alignment or Move/Rotate them, as necessary.  

9. To disable a plane once it is displayed, select  on the Planes Settings panel header and 

disable the plane’s display in the Section Plane Settings window that appears. 

10. On the Save panel, click  to save the Viewpoint. Enter Section1 as the name of the 

viewpoint. 
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Linking Section Planes 

Use Link Section Planes  to link two or more section planes together, forming a slice, and then use the 

gizmo or the Transform fields to move the slice through the model. 

 

Procedure: To Link Section Planes 

1. Create all of the individual section planes that will be linked together. 

2. With the Sectioning Tools tab active, enable the appropriate planes that are required in the 

slice. The planes can be either parallel or perpendicular to one another. 

3. 
On the Planes Settings panel, click Link Section Planes  to link the planes together. 

4. Use the gizmo that is displayed on the linked section planes or the Transform fields to move 

the slice through the model. 

5. Repeat the above steps for other planes if required. 

6. 
On the Planes Settings panel, click Link Section Planes  again to disable the link. 

7. 
On the Save panel, click  to save the Viewpoint. Enter a descriptive name for the 

viewpoint. 

TIP: Record the model as it is progressively sectioned, either using the gizmo or by setting up 

two views of the model in different states of section and then adding them to an empty 

animation. 
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  2. Move the Section. 

§ In the Plane Settings panel, ensure 

that Plane 1 is displayed as the 

currently active plane in the 

Current pull-down menu. Pull-

down the menu and notice that 

Plane1 is enabled as indicated by 

the yellow lightbulb icon. The 

remaining planes are not active. 

§ By default, the Alignment option 

for Plane 1 is set to Top as shown 

in the Plane Settings panel. Ensure 

that Top is set as the alignment 

option  

§ In the Transform panel, ensure 

that the Move  command is 

enabled so that you can access the 

move gismo on the section plane. 

§ Select the gizmo that is displayed 

with the plane. Drag the gizmo 

upwards to change the position of 

the plane in the model.  

§ Place the plane as shown in the 

following image. 

 

Exercise: Sectioning 
 
In this exercise, you create section 
planes to reveal interior detail for the 
factory building. 

 

 

The Completed Exercise 

 

1. Open NAV_007_Section_Planes.nwf. 

§ Click in the background to deselect. 

§ On the Viewpoint ribbon, click Enable 

Sectioning. 

 
§ The model should appear as shown in 

the following image. 
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  5. Save a Sectioned Viewpoint. 

§ On the Save panel, click Save 

Viewpoint  to save the 

Viewpoint. Enter Section1 as the 

name of the viewpoint. 

§ While using section planes, you can 

use the navigation modes to review 

areas of interest in the model. 

 

6. Turn Off Section Planes. 

§ On the Plane Settings Panel, Click the 

small expand button. 

 
§ Clear the checkmark beside Plane 1 and 

2.  Also clear the check mark for Link 

Planes. 

 
 

Challenge – Create a Section view 

similar to the one in the following 

image. 

Hints:   

§ Use Plane 3 

§ Save a Viewpoint once the view is 

established. 

 

 

§ Open a new file without saving. 

§ End of Exercise. 

3. Activate a second Section Plane. 

§ In the Plane Settings panel, select 

the Current pull-down menu and 

select Plane 2 to enable it. Expand 

the Current pull-down menu again 

and notice that Plane 1 is also still 

displayed as indicated by the yellow 

lightbulb icon.  

 

Tip: To disable a plane once it is 

displayed, select  on the Planes 

Settings panel header and disable the 

plane’s display in the Section Plane 

Settings window that appears. 

§ By default, the Alignment option for 

Plane 2 is set to Bottom. Maintain 

this setting. 

§ In the Transform panel, ensure that 

the Move  command is enabled. 

Using the Gizmo, drag the section 

plane to a position similar to the one 

shown in the following image. 

 

 

4. Link two Section Planes. 

§ In the Plane Settings panel, click Link 

Section Planes  to link section 

planes 1 and 2 together, forming a 

slice of the first floor.  

§ Use the gizmo on the model to move 

the slice through the model 
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Lesson: TimeLiner 
 

Navisworks TimeLiner creates 4D simulations (a simulation that includes time) of the construction of 3D 

models. By attaching items in the model to tasks with a start and end  

date/time, you can create a simulation that shows sections of the model being added or  

removed over time, according to the scheduled tasks. 

With TimeLiner, you can also link the objects to tasks in an external scheduling file, and synchronize the 

simulation with the actual status of the project. Actual and planned dates can be associated with the 

tasks, simulating actual against planned schedules. 

 

This lesson describes how to open and position the TimeLiner window within Navisworks. It also 

introduces you to the Task and Simulation tabbed panes and demonstrates playing a simulation of the 

construction of a 3D building. 

Timeliner Task Window 

 

 

 

Timeliner Simulate Window 

 

 

 

Procedure: To Open and play a  Timeliner Simulation 

To open the TimeLiner window, select the Home tab and click TimeLiner  in the Tools panel. The 

TimeLiner window appears at the bottom of the Navisworks window.  The Simulation tab in the 

Timeliner window contains the player controls. 

1. Task Name 

2. Start Date 

3. End Date 

4. Task Type 

5. Attachment Status 

1. Player Tools 

2. Work in Progress 

Visualization 

3. Completed Task 

Visualization 

4. On Screen Status Text 

5. Active Task 

6. Task Progress 

7. Start and End Date 
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  4. Simulate the Timeline  

§ Click the Simulate tab in the Timeliner 

window. 

§ Click the Play button and review the 

construction schedule timeline. 

 
§ Drag the slider to any point in the 

simulation and use the navigation 

tools to explore the specific point in 

the construction timeline. 

 

§ Review the current timeline 

information on the screen. 

 

§ Open a new file without saving. 

§ End of Exercise. 

Exercise: Run a Timeliner 

Simulation 
 
In this exercise, you review an 
existing Timeliner simulation for the 
proposed construction process for 
the packaging line. 

 

The Completed Exercise 

 

1. Open NAV_008_TimeLiner.nwf 

§ Click in the background to deselect. 

§ Activate the ISO All Viewpoint. 

 

2. Open the Timeliner Window. 

§ On the Home tab in the Tools 

panel, click TimeLiner.   

 
The TimeLiner window appears at 

the bottom of the Navisworks 

window. 

 

3. Review the Task List. 

§ Pin the Timeliner window open. 

§ Review the Task List and the Start and 

End Date for each Task. 
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Chapter Summary 
 
 
 
 

This chapter focused on the large layout Visualization tools that allow you to navigate thru a 
Navisworks design.  The chapter also presented the available tools used to analyze the Digital 
Mockup of the factory layout. 
 

Having completed this chapter, you can: 

§ Use the various Navigation tools available in Navisworks. 

§ Establish Viewpoints and Animations 

§ Use the Factory Layout and Item Tools to manipulate model geometry. 

§ Use the Measuring tools to add dimensions to a Viewpoint. 
§ Create user defined Cross Sections. 

§ Review a Timeliner example. 
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Interference / Collaboration 
 

 

3D interferences are very common when you are bringing multiple models together for the first time.  

These interferences must be discovered as quickly as possible to assure a quality design and reduce 

construction problems.  Navisworks enables the effective identification, inspection and reporting of 

interferences from the digital model with a versatile set of Clash Detection tools. 

The digital model of factory layouts, work cells and production lines can be inspected to detect potential 

issues such as equipment collisions and space restrictions.  Navisworks also works with laser scanned 

point clouds.  Large volumes of point clouds can be imported into the digital environment to compare 

the “as built” laser scan with the 3D model data.   

Large designs often require input from various sources.  Communicating the design intent to these 

sources is a crucial factor in the design process.  Navisworks can publish the single digital model in high 

compressed, lightweight NDW and 3D DWF format for Free viewing.  This gives all stakeholders access to 

the complete manufacturing plant or factory layout.   

You can share your digital design with all the members of your design team.  If members of your team 

don’t have Navisworks, they can download Navisworks Freedom from Autodesk.com.  Navisworks 

Freedom allows anyone to view the NWD files created by Navisworks.  Navisworks Freedom can also 

view Autodesk 3D Design Review files or 3D DWF.   

Objectives 
 

After completing this chapter, you will be able to: 

 Use the selection tools to select model geometry. 

 Setup and run a Clash detection based on model geometry. 

 Setup and run a Clash Detection based on Point Clouds. 

 Add Redline markups to a viewpoint. 

 Collaborate with other team members utilizing the various export functions. 
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Lesson: Clash Detection 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Clash Detection is an important feature for the initial review of a factory design.  Interferences that 

are discovered during the construction process can cause major cost overruns.  Navisworks Manage, 

delivers interference checking capability with the Clash Detection tools.  Note: Clash Detection is only 

available in the Navisworks Manage version of the application, or Autodesk Factory Design Suite 

Advanced. 

Objectives 

After completing this lesson, you will be able to: 

§ Select geometry and create a selection set. 

§ Set up and run a Clash Detection between model geometry. 

§ Set up and run a Clash Detection between model geometry and a Point Cloud. 
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Clash Detection 
 

Navisworks Clash Detective identifies, inspects, and reports interference clashes in a 3D project 

model. Clash Detective can eliminate a tedious manual task, with the accompanying risk of human 

error, to significantly reduce the expensive consequences of incomplete, inaccurate, and poorly 

coordinated design information. 

 You can use Clash Detective for a quick “sanity check” for design work that an engineer has just 

completed, or for an ongoing audit check of the project by the project coordinator. 

  

Clash Detective can also conduct clash tests between traditional 3D geometry (triangles) and laser 

geometry. Clash test reports can be produced for communicating to other people. Batches of clash 

tests can be saved and exported to use in other projects. 

By Linking Clash Detective and Object Animation together, you can check animated versus animated 

or animated versus static object clashes. For example, linking a Clash Detective test to an existing 

animation scene would automatically highlight clashes for both static and moving objects during the 

animation (for example, a crane rotating through the top of a building or a delivery truck colliding 

with a work group).  

You can also link Clash Detective, TimeLiner, and Object Animation together for clash testing of fully 

animated TimeLiner schedules. So, instead of visually inspecting a TimeLiner sequence to make sure, 

for example, that the moving crane didn't collide with a work group, you can run a Clash Detective 

test.  

 

This lesson describes how to open the Clash Detective window within Navisworks. It also introduces 

you to the Select tab for defining and running the clash test and Results tab for viewing  

the results. 
 

Conducting a Clash Test 
The Clash Detective window enables you to set up rules and options for your clash tests, view the 
results, sort them, and produce clash reports. 
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Procedure: To Conduct a Clash Test 

1. 
Select the Home tab and click Clash Detective  in the Tools panel. 

2. Select the Select tab in the Clash Detective window. There are two identical panes in this tab 

called Left and Right. These panes represent the two sets of items that will be tested against 

each other during the clash test. 

TIP: The Left and Right panes in the Clash Detective window can be displayed in four view 

formats to aid in selecting items for clash testing. To change formats, select the Standard, 

Compact, Properties, or Sets tabs, as required. The Standard tab provides a full, expandable 

listing of the layers. The Compact tab provides a top-level listing of the layers. The Properties 

tab sub-divides the models according to its properties. If there are saved selection or search 

sets available, a Sets tab is also available. (Scroll to the right if necessary.) Using the Sets tab 

you can select from the lists to define the items to be tested. 

3. Click the required geometry type in the Left and Right panes. Clash tests can conducted on 

the following geometry types: 

§ Surfaces  – Clashes item surfaces (default setting). 

§ Lines – Clashes items with center lines (e.g., pipes). 

§ Points – Clashes (laser) points. See Laser Scan Data Clashing for more information. 

 

4. In each of the Right and Left panes, select the items that are to be compared against. To 

select the items for the clash detection, use one of the following techniques: 

§ Select the items directly in the Selection Tree. Consider using the Standard, Compact, 

or Properties tabs to change the view formats when making selections. 

§ In the Scene View, select an item or set of items to be clashed. If required, press and 

hold CTRL to select multiple items.  

§ In the Clash Detective window, click Select Current below the necessary panes to 

assign the currently selected items in the Scene View to that pane. 

§ Select the Sets tab associated with either the Left or Right panes and select from the 

saved selection or search sets that already exist in the model. 

NOTE: Items which have been hidden will not be included in a clash test. 

 

  

 

Clash testing can be faster, more effective, and easily repeatable if you use 

selection or search sets. Carefully consider which sets of objects will need clashing 

against each other and create selection and search sets accordingly. 

Creating batch clash tests is another way to speed up clash testing. 
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5. Clash Detective can clash test a selection against itself, in addition to clash testing against the 

set in the other pane. Add a check mark to the Self Intersect box for the Left, Right, or both 

panes, as necessary. 

6.  Define the Clash type in the Type pull-down menu. There are three types of clashes: 

 

§ Hard – Where two objects actually intersect. 

§ Clearance – Where two objects come within a specified distance of each other. 

§ Duplicates – Where two objects are identical, both in type and position. 

 

 
 
 

 

  

 

You can use Duplicates testing to clash the entire model against itself by selecting the 

whole model in both the Left and Right panes. Use this to detect any items in the 

scene that may have been duplicated by mistake. For example, a multiple instanced 

item may have been inserted in the same place twice or a reference file was loaded 

twice (it was referenced by more than one file in the scene). 

If you select Clearance, hard clashes are also detected. Any objects closer than the set 

tolerance and any interference are obviously less than the set clearance, as shown in 

the image above. 

7. Define the Tolerance that should be used in the test in the Tolerance pull-down menu (for 

1mm enter 0.001). 

8. Click Start to begin the clash analysis. 

NOTE: The progress bar that appears during a clash test shows how far through the test 

Clash Detective has got. Press the Cancel button to stop the test at any time. All clashes 

processed before test termination are reported and the test will be saved with a Partial 

status. 

TIP: Before running a clash test, it may be useful to go the Rules tab and select one or more 

of the rule definitions. This filters out unnecessary clashes and makes the results more 

meaningful. See Setting Clash Rules. 

9. Details on the number of clashing instances are identified in the Found field on the Select tab. 

Select the Results tab to review a detailed list of the clash test results. 
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Lesson: Selection Tree and Selecting Objects 
 

During any Clash Detection, it is necessary to select the desired objects to test.  Navisworks 
provides access to all geometry in the Selection Tree.  This section describes how to view items in 
the Selection Tree structure of files opened in Navisworks. It also introduces you to the selection 
options, and how to create sets of selected items. 
 

View the Selection Tree 
As a model is opened in Navisworks, the file name is added to the Selection Tree window.  

§ To display the Selection Tree window if it is not visible, select the Home tab, and on the Select & 

Search panel, enable Selection Tree . 

§  As an alternative, you can control the Selection Tree’s display on the View tab by expanding the 

Windows option, and enabling Selection Tree. 

From here, the model’s hierarchical structure can be expanded, revealing the files, layers, and 
objects used to build the model. 
 Navisworks uses this hierarchical structure to identify object specific paths (a unique path through 
the model data from the root partition, the file name, to a particular object). 
 

 

 

 

 

Selecting an Object 
 

§ Selecting an object in the Selection Tree also highlights it in the Navisworks Scene View. 

§ Selecting an object in the Navisworks Scene View using the Selection tool  also highlights it  

in the Selection Tree. 

 

 

Use the ESC key to remove selection from an object in the scene and the 

Selection Tree. 
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Selection Resolution (Level) 
When an item in the scene is selected using the Selection       tool, individual geometry or a group 
of geometry may be selected depending on the setting of the Selection Resolution. 
 

Procedure: To Change the Selection Resolution using the 

Options Editor 

1. 
To change the setting of the selection resolution, click Application Menu  >  > 

Interface > Selection > Resolution. 

 

 

 

 

 

 

 

 

  

2. Select the required option, and then click OK. 

NOTE: Any item in the Selection Tree can be selected regardless of the Selection Resolution 

setting for the Selection tool. 
 

 

Procedure: Change the Selection Resolution using the Ribbon 

1. To change the setting of the selection resolution, expand the Select & Search panel on the 

Home tab and select a resolution setting from the Selection Resolution pull-down menu. 

 

2. Select the required option. 

NOTE: Any item in the Selection Tree can be selected regardless of the Selection Resolution 

setting for the Selection tool. 
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 The available selection options are: 

§ File – Selects the appended portion of the selected model. 

§ Layer – Selects all objects within a layer. 

§ First Object – Selects the first object in the path that is not a layer. 

§ Last Unique – Selects the most specific object (furthest along the path) that is unique (not multiple 

instanced). 

§ Last Object – Selects the most specific item (furthest along the Selection Tree path) that is marked as 

a composite object. If no composite object is found, the geometry is selected.  

§ Geometry – Selects the last object in the path (most specific, may be multiple instanced). 

 

        Selection Sets 

Selection sets can be used so that once a set of objects has been selected, they can be saved as a 
selection set, then used again as needed.  This process greatly enhances the Clash Detection 
process. 
 
 Selection sets can be moved, reordered, or organized in folders if required. 

Procedure: To Create and Organize Selection Sets 

 

1. On the Home tab, in the Select & Search panel, expand the Sets pull-down and click Manage 

Sets to open the Sets Window. As an alternative, select the View tab and on the Workspace 

panel, expand the Windows option, and enable Sets. 

2. To create a selection set, select the first item to be saved, then hold down CTRL, and select all 

the other items to be saved. 

TIP: Items can be selected on the scene, or in the Selection Tree. When selecting in the 

Selection Tree, you can use SHIFT to select a range of consecutive items.  

3. Right-click in the Sets window. Click Add Current Selection. 

The selection is saved as Selection Set 1. 

4. To save the selection set to an appropriate name, enter the new name and press ENTER. To 

rename an existing selection set, right-click the selection set and click Rename. 

5. To move a selection set to a different position, drag to the new position. 

6. To sort the list of selection sets alphanumerically, right-click in the Selection Sets window, 

and then click Sort. 

7. To create a folder, right-click in the Selection Sets window, and then click New Folder. 

8. To rename a folder, right-click the folder, and then click Rename. In the Folder name field, 

enter a new name for the folder and press ENTER. 

9. To move selection sets to a folder, select all sets to be moved, and drag to the folder. 

10. To sort the list of folders (and sets) alphanumerically, right-click in the Selection Sets window, 

then click Sort. 
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§ On the Select and Search panel, under 

Select Same, click Select Same 

Geometry. 

 

§ All building columns are selected as 

shown below. 

 

§ On the Select and Search panel, expand 

Sets and click Manage Sets. 

§ Right Click in the Sets window and click 

Add Current Selection. 

 
§ Name the new Selection Set Columns 

and press ENTER. 

§ If necessary, click in the background to 

deselect. 

 

 

 

 

 

 

 

 

 

Exercise: Run a Clash 

Detection on Geometry 
 
In this exercise, you create a Clash 
Detection analysis between the 
Inspection line and the columns of the 
factory out building. 

 

 

The Completed Exercise 

 

1. Open NAV_009_Clash_Detection.nwf 

§ Click in the background to deselect. 

§ Activate the Clash Detection Viewpoint. 

 

2. Create a Selection Set of the building 

columns. 

§ On the Home ribbon, click the Select Tool. 

 
§ Select one of the building columns as 

shown. 
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  5.  Explore the Interference. 

§ Start the Walk tool and investigate 

the interference between the safety 

fence and the column. 

 

6. Create a Viewpoint for future use. 

§ Create a Viewpoint called Safety 

Fence Clash. 

 

§ Start a new file without saving. 

§ End of Exercise. 

3.  Set up the Clash Detection. 

§ On the Home ribbon click Clash 

Detection. 

 
§ Pin the Clash Detection window open. 

§ In the Clash Detection window, click 

the Select Tab. 

§ In the left hand column, select 

NAV_001_Inspection Line. 

§ At the bottom of the right hand 

column, select the Sets tab  

Note: you may have to scroll the tabs 

to the left. 

§ On the Sets tab, select Columns. 

 

§ At the bottom of the Clash Detective 

window, set the Clash Type to Hard. 

 

§ Click Start to run the analysis. 

 

 

4. View the Results. 

§ In the Clash Detective window, click 

the Results tab. 
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Lesson: Point Cloud Data Clashing 
Increasingly, users are bringing laser scan data into Navisworks alongside traditional geometry  

based models.  Laser scan data usually comes into Navisworks as a point cloud. You can use Clash 

Detective with these two types of data to check for interferences.  

Running a Clash Test with Laser Scan Data 

The value of being able to clash as-built point clouds with new-build designs is immense. 

Traditional hard clash testing of surfaces involves looking for intersections of triangles (that the 3D 

surfaces are made from). Similarly, when hard clashing points against lines with surfaces, there must be 

an interaction in order for a clash to be recognized. This can be difficult with points (laser point cloud). 

Even if the point is on the surface, it will not be registered as a clash, as it is not large enough to pass 

through the surface.  

For this reason, when clashing points and surfaces, a clearance type test is used to specify a tolerance 

around each point. This better represents the point cloud and therefore will identify any clashes. 

Procedure: To Run a Clash Test with Laser Scan Data 

1. In the Clash Detective window, select the Select tab. 

2. Define the files that are to be clash tested. In one pane, select the point cloud data file 

and click Point          to clash test the point cloud. Clear the other clash items. In the 

second pane, select the surface model and click Surfaces          to clash test the point 

cloud data against surface data. 

3. In the Run area, set Type to Clearance and assign the required Tolerance value. 

4. Click Start to run the clash test. 
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  3. Set the Clash Detection. 

§ Pin the Clash Detective window open. 

§ On the Select tab, in the left hand 

column, select Boiler Room.nwd 

§ In the right hand column, select Pipe 

Run 001.nwc. 

 

§ Click the point option for each column. 

 

§ Set the Clash Type to Clearance and 

enter a tolerance of .0833. 

 

§ Click Start. 

 

5.  View the Results 

§ Click the Results and investigate the 

results. 

 

§ Open a new file without saving. 

§ End of Exercise. 

 

 

 

Exercise: Run a Clash 

Detection between 

Geometry and a Point Cloud 
 
In this exercise, you create a Clash 
Detection analysis to see if a Point Cloud 
of a Boiler system can be placed in the 
corner of the factory out building. 

 

The Completed Exercise 

 

1. Open NAV_010_Point_Cloud.nwd. 

§ Click in the background to deselect. 

§ Activate the Point Cloud Viewpoint. 

 

2. Explore the Point Cloud. 

§ A laser scan point cloud of an existing 

facility has been overlaid on the factory 

out building.  Machinery from the existing 

facility is being evaluated for installation in 

the out building.   

§ Using the walk command, explore the 

Point Cloud overlay 

§ Turn off the Third Person avatar and 

navigate to the front of the out building 

where a point cloud of a boiler has been 

placed in the file.  The desired point of 

view is shown in the following image. 
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Lesson: Collaboration 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 
 

 

 

 

 

 

 

Navisworks digital models can be shared with all members of your collaborative team.  The highly 

compressed NWD files provide an efficient way of communicating the entire model and design 

intent to all stakeholders.  3D design intent and model data are more reliably and quickly 

communicated, facilitating better team collaboration, and accelerating the design review cycle, 

assuring delivery of projects on time and on budget. 

 

Communication between team members is extremely important.  When design problems occur, 

stakeholders need a method to comment on the situation.  The Navisworks Redline tools allow 

designers to markup any pre-established Viewpoint with text, balloons, clouds, or geometry.  

These markups can be exported in the NWF file format which is unique to each stakeholder.  Then 

the markups can be merged with other comments bringing the entire collaborative project into a 

single document.  The single standalone document is saved using the NWD file format.  NWD files 

are standalone and can be viewed by anyone using the Navisworks Freedom viewer available at 

Autodesk.com. 

 

Objectives 

After completing this lesson, you will be able to: 

§ Use the Redline tools to markup a viewpoint. 

§ Utilize the free viewer for Navisworks files, Navisworks Freedom. 

§ Review the available Export options for team collaboration. 
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Lesson: Redline Tools  

Redlining can be associated with saved viewpoints and clash detection result views. 

1. On the Review tab in the Redline panel, select the Draw pull-down menu to access the 

redline tools. 

 

2. In the Redline panel, select settings for the line (Thickness and Color) before using the 

tools. 

 

Icon Name Description 

 

Text Adds text in the viewpoint. Click the location where the text is to be 

placed.  Enter text in the Text window, then click OK to add to the 

viewpoint. 

 
Ellipse Creates an ellipse. Drag over the viewpoint and then release the 

mouse. 

 

Cloud Creates a cloud. Click in the viewpoint for each of the cloud base 

points. Select the start point to close the cloud. 

 

Freehand Creates freehand redlines. Drag in the viewpoint, then release the 

mouse. 

 

Line Creates a single segment linear redline between a start and end 

points. Click in the viewpoint at the start and end points of the 

desired lines. 

 

Line String Creates linear strings of lines. Click in the viewpoint at the start, 

intermediate, and end points of the desired lines. 

 

Erase Erases redlines. Drag over the redline to be deleted, then release the 

mouse. The entire redline must be enclosed in the box for the erase 

function to be applied. 
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Redline Tags 

Redline Tags combine the features of redlining, viewpoints, and comments into a single, easy-to-use review tool. 

This allows you to tag anything you want to identify in the model scene. A viewpoint will be created and you can 

add a comment and status to the tag. For example, during a review session, you may observe an item in the scene 

that is incorrectly sized or positioned. You can then tag this item, identifying the problem. If a tag is added the 

Add Comment dialog box is displayed, and you can add a comment. 

Procedure: To Add a Redline Tag 

1. 
On the Review tab in the Tags panel, click Add Tag . Click the object where the tag is to 

point to, then click where the tag label is to be located. 

The tag is added. 

2. In the Add Comments dialog box, enter the text for the tag, and then select a Status option. 

3. Click OK to save the comment. 

A tag viewpoint is created (you can rename it).  

NOTE: Additional Redline Tags can be added to anywhere on the model. Each tag is numbered 

in the sequence that it was added. 
 

Reviewing Redline Tags 

There are a variety of methods for finding Redline Tags including the following: 

§ On the Review tab in the Comments panel, click Find Comments . Use the Find Comments dialog box 

to do the following:  

o Click the Comments tab to search for comments that are associated with tags. Search for a specific 

tag, text, author, ID, or status. 

o Click the Date Modified tab to search for comments within a date criteria. 

o Click Source tab to search for comments created in certain sources. 

o Click Find to search the model. Tip: Leave the search fields blank to search for all comments and tags. 

§ If viewpoints have been created for each tag, browse the Viewpoints window for the required tag ID.   

§ Select the tag in the Saved Viewpoints window and review the comment in the Comments window. 

§ To navigate directly to a tag when you know its Tag number, select the Review tab and in the Tags panel, 

enter the tag number or select a number from the pull-down menu and click . 

§ To renumber tags, select the Review tab, expand the Tags pane and click Renumber Tag IDs. 
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§ Right Click and select Override Item > 

Override Color. 

 

§ Set the color to Red and click OK. 

 
§ On the Home ribbon, click the Select 

None tool to clear the selection. 

 

Exercise: Redline a 

Viewpoint 
 
In this exercise, you document the 
clash between the safety fence and 
the support column by adding 
Redline markups to a viewpoint. 

 

 

The Completed Exercise 

 

1. Open NAV_011_Redline.nwf. 

§ Activate the ISO All Viewpoint. 

§ If necessary, click in the background 

to deselect. 

§ Activate the Safety Fence Clash 

Viewpoint. 

 

2. Change the color of the clashing 

components by adding a color override. 

§ On the Home ribbon, set the Selection 

Resolution to Geometry. 

 

§ Activate the Select tool and select the 

safety fence and the support column. 

Note:  Hold the CTRL button down to 

select both components. 
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  5.  Export the Viewpoint to share with 

other team members. 

§ Right Click the Safety Fence Clash 

Viewport and select Edit from the 

menu. 

§ In the Edit Viewpoint dialog, place a 

check mark in the Override Material 

option. 

 
§ Click the Output tab. 

§ On the Export Data panel, click the 

Viewpoints tool. 

 
§ In the Export dialog, use the default 

name and save the .XML file in the 

Training Files directory. 

§ Click OK. 

§ Start a new file without saving. 

 

 

6. Open NAV_011A_Factory.nwf. 

§ Click in the background to deselect. 

§ Notice that there are now Viewpoint 

in this file. 

§ On the Application Menu, Click 

Import > Viewport XML. 

 
§ In the Import dialog, select 

NAV_011_Redline. 

§  Click OK. 

§ All Viewpoints from the previous file 

are not available in this file.  Activate 

the Safety Fence Clash Viewpoint. 

§ Start a new file without saving. 

§ End of Exercise. 

 

7. Add the Redline Markups to the 

Viewpoint. 

§ Click the Review tab. 

§ On the Redline panel, click the Text 

Tool. 

 
§ Click a spot below the interference 

and enter the text shown in the 

following image. 

 

§ Click OK. 

 

8.  Add a Redline Cloud. 

§ Use the Cloud tool and click multiple 

points in a clockwise motion around 

the interfering components as shown 

in the following image. 

Note:  Right Click finish the Cloud. 
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Lesson: Export Data 
 

Collaborating with team members can often require sharing data in various forms.  Each team member 
could be working with different CAD software or require the data in another format.  Navisworks can export 
design data collected from the complete design in a number of different formats.  This section will outline 
the various export capabilities located on the Output ribbon. 
 
 
 
 
 
 
 
 
 

1. Print 

 

 When the print option is selected, Autodesk Navisworks prints 

the current viewpoint scaled to fit and centered on the page. 

 

Before you print out a copy of the model you are working on, 

you may wish to see how it will appear. 

 

This option enables you to the set up paper size and 

orientation options. 

2. Send by 

Email 

 

Launched your Email application and attaches the file. 

3. Publish 

NWD 

 

Publishes the complete Navisworks file as a standalone document.  

This format can be viewed in the Navisworks Freedom viewer 

available, for free, at Autodesk.com 

4. Export 

Scene 

 

3D DWF files can be exported from Autodesk Navisworks. The file 

exporter creates a DWF file containing: 

§ All geometry  

§ All materials  

§ Per-vertex colors  

§ Properties (where available) 

Note:  3D DWF files can be viewed in the Navisworks Freedom 

viewer available, for free, at Autodesk.com 

 

FBX files can be exported from Autodesk Navisworks. The exporter 

creates an FBX file with the extension .fbx and supports the export 

of: 

§ Triangles  

§ Lines  

§ Materials (color, flat transparency, and wrapped 

image texture only)  

§ Viewpoints  

§ Lights  

§ Model Hierarchy 
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Google Earth KML files can be exported from Autodesk Navisworks. 

The exporter creates a compressed KML file with the extension 

.kmz and supports the export of: 

· Triangles  

· Lines  

· Materials (color and flat transparency only)  

· Viewpoints (adjustments may occur due to Google Earth 

limitations)  

· Model Hierarchy  

· Hyperlinks (currently only URLs work correctly in Google 

Earth) 

5. Visuals 

 

To export an image as a bitmap, PNG, or JPEG file 

1. Display the view you want to export in the Scene View, 

and click Output tab > Visuals panel > Image.  

2. In the Image Export dialog box, select the Format of the 

image you want to export.  

3. Use the Size and Options area to set the image size. See 

Image Export Dialog Box.  

§ For PNG files, click the Options button, and use the PNG 

Options dialog box to specify the Interlacing and 

Compression settings. 

§ For JPEG files, click the Options button, and use the JPEG 

Options dialog box to specify the Compression and 

Smoothing settings. 

4. Click OK.  

5. In the Save As dialog box, enter a new filename and 

location, if you want to change from those suggested.  

6. Click Save. 

 

Scenes rendered in Presenter can be exported out as images, so 

they can be used in presentations, on websites, in print, and so on. 

For more information, 

 

To export an animation to an AVI file, or a sequence of image files 

1. Click Output tab > Visuals panel > Animation.  

2. To export the currently selected viewpoint animation, 

select Current Animation in the Source box.  

§ To export the currently selected object 

animation, select Current Animator Scene in the 

Source box. 

§ To export a TimeLiner sequence, select TimeLiner 

Simulation in the Source box. 

3. Set up the rest of the boxes in the Animation Export dialog 

box, and click OK. For more information, see Animation 

Export Dialog Box.  

4. In the Save As dialog box, enter a new filename and 

location, if you want to change from those suggested.  
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5. Click Save. 

6. Export 

Data 

 

Clash tests can be exported from the Clash Detective tool for use 

by other Autodesk Navisworks users. 

 

You can export CSV data from TimeLiner. The columns exported, 

and their order, will be precisely as in the TimeLiner Task View. 

Note: When exporting a CSV from TimeLiner, the hierarchy of tasks 

is not represented. All available tasks are exported without any 

hierarchical structure. This means that collapsing/expanding task 

nodes in the TimeLiner grid does not affect whether or not tasks 

are output to CSV. 

 

 

The search criteria specified in the Find Items window can be 

exported to an XML file. This can then be imported into other 

Autodesk Navisworks sessions. For example, if you have specified a 

complicated search criteria, containing various logic statements, 

that relates to all projects you work on, then this feature allows 

you to specify it once and use it on all projects. 

 

Saved search sets can be exported from Autodesk Navisworks as an 

XML file. These can then be imported into other Autodesk 

Navisworks sessions and re-used. For example, if you have a 

number of generic searches that you perform on all of your 

projects, this feature allows you to specify the searches once and 

use them on all projects. 

 

Viewpoints can be exported from Autodesk Navisworks to an XML 

file. These viewpoints contain all associated data, including camera 

positions, sections, hidden items and material overrides, redlines, 

comments, tags and collision detection settings. 

Once the viewpoint data is exported to this text-based file format, 

it can either be imported into other Autodesk Navisworks sessions, 

or it can be accessed and used in other applications. For example, 

you may want to set up the same viewpoints in your CAD 

application. 

 

 

An HTML file can be exported containing a JPEG of all of the saved 

viewpoints and associated data, including camera position and 

comments. 

Note: To customize the appearance or layout of the HTML file, you 

will need to edit the viewpoints_report.xsl file. The installed file is 

located in the style sheets subdirectory of the Autodesk 

Navisworks install directory. You can copy the edited file to the 

style sheets subdirectory of any of the Autodesk Navisworks search 

directories. 
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  3. Export the Video File. 

§ Click the Output Tab. 

§ On the Visuals Panel, click the Animation 

tool. 

 

§ In the Animation Export dialog, set all 

options as shown in the following image. 

 

§ Click OK. 

§ Specify the save location as the Training 

Files directory and click Save. 

 

4. Play the video file. 

§ In Windows Explorer, navigate to file 

location specified in the previous step. 

§ Open and review the video file. 

Note: for the sake of time the video 

length was set to 10 seconds.  Longer 

time spans and greater anti-aliasing 

values will result in longer rendering time. 

 

§ End of Exercise. 

 

 

 

 

 

 

 

Exercise: Export an AVI file. 
 
In this exercise, you generate an video 
(.avi) file of a fly through animation. 

 

The Completed Exercise 

 

1.  Open NAV_012_Export_AVI.nwf. 

§ Click in the background to deselect. 

§ Activate the Fly Thru Viewpoint. 

Note: A preset fly thru animation has 

already been created for this exercise. 

 

 

2. Review the Fly Thru Animation. 

§ In the Saved Viewpoint window, select 

the Fly Thru Animation. 

§ Click the Animation tab. 

§ Confirm that the Fly Thru animation is 

displayed in the Playback panel and click 

the Play button. 
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Chapter Summary 
 
 
 
 

This chapter presented  essential tools used to analyze design interferences between multiple CAD 
models.  The chapter also demonstrated how to share your findings by adding Redline information 
to Viewpoints and exporting the Viewpoints for other team members to review.  Finally, the 
process of exporting design data from Navisworks was also covered. 

 

Having completed this chapter, you can: 

 Use the selection tools to select model geometry. 

 Setup and run a Clash detection based on model geometry. 

 Setup and run a Clash Detection based on Point Clouds. 

 Add Redline markups to a viewpoint. 

 Collaborate with other team members utilizing the various export functions. 

 


